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Preface

This preface describes the document accessibility features and conventions used in
this document.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Audience
This guide is written for people who use Oracle Social Network in their day-to-day
work.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
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monospace Monospace type indicates commands within a paragraph, URLs, code
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1
Getting Started with Oracle Social Network

These topics introduce basic features in Oracle Social Network and describe how to
use them:

• Why should I care about social networking in my application?

• What does social networking have to do with my job?

• How do I use the Oracle Social Network user interface?

• How do I get to Oracle Social Network?

• How do I set up or change my profile?

• How would someone typically use Oracle Social Network?

• Next Steps

Why should I care about social networking in my
application?

Wouldn't it be great if you could instantly share an aspect of your application with
everyone who plays a part in getting the job done? Without having to start an untold
number of email threads that then get forwarded to other people, until it's impossible to
know who's in charge of what?

When you share a business object with the social network—like a Sales Opportunity or
a Purchase Order—you create a Social Object. With the Social Object, you can bring
all your stakeholders together in a single place to get the collaborative ball rolling—and
keep a record of everything that's transpired so new folks can easily jump in and come
up to speed.

What does social networking have to do with my job?
Social networking isn't just for social situations anymore. Here are some key reasons
for using social networking in your business applications:

• In a business object, open Conversations on the spot and discuss details while
looking at them.

No worries about keeping two sets of data in sync. The details you see in your
social network are the same you see in your business application.

• All communications are organized automatically by business object, so no wasted
time with filing and searching through emails.

• Quickly engage resources as needed to address issues and solve problems.

Invite new members to the Conversation so they can easily see the complete
history.

• Share presentations and other documents and get input from other team
members.
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Web conference not required. Juggling email responses not required.

• Get real-time notifications about updates to key Conversations.

• Develop and expand your professional network.

• Connect and engage with others covering the same industry, product
specialization, or geography.

How do I use the Oracle Social Network user interface?
When you open Oracle Social Network, you see the Overview page, which shows the
most recent messages in the Conversations and walls you are a member of.

The Overview page, like most of the pages that include a list of items, provides easy
access to several features:

• Filter options—The Show menu enables you to filter the items in the list view.

– Yours—Shows items you are a member of.

– Available—Shows public items that are available for you to join.

– Favorites—Shows items you've marked as favorites.

– Muted—Shows items you've muted. Muting an item hides it in list views and
stops messages about it from appearing in your email digest and within Oracle
Social Network. It's still there; you just won't hear about it anymore. However,
you will still be notified if someone assigns a flag to you in a muted item.

– Open/Closed—Shows items that are open/closed. A closed item prevents
people from adding new messages to the item and removes the item from list
views and email digests.

• Sort options—The Sort By menu enables you to sort the items in the list view.

• Favorite—Click the star icon ( ) to add the item as a favorite. See How do I
mark a wall, Conversation, or message as a favorite?

• Flags—The flag icon ( ) shows you if the item has been marked for someone's
information or response, and enables you to add a flag for yourself or someone
else. See How do I assign flags to others?

• Unread message count—The number in the blue box ( ) shows the number of
unread messages in the Conversation or wall. Click the unread message count to
mark all messages in the Conversation or wall as read.

Tip: By default all the items in the list are expanded to show each item's most recent
messages. You can collapse an item (to show only the names of the items) by clicking

 next to the item. To collapse all the items, click .

You can access other pages, such as your wall, Flags, Favorites, and such, from the
menu on the left.

The right side of Oracle Social Network includes the following sections:

• Recent Activity—Displays the most recent messages from the Conversations and
walls you're a member of.

• Trending—Displays the Conversations, collections, hashtags, Social Objects, and
walls with the most people in them at the moment.

Chapter 1
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• Contacts—Displays your list of contacts and their presence. Click a contact to
quickly open a one-on-one Conversation or view the person's profile.

Note: If you don't see the sections on the right, your browser window is not wide
enough. Expand your browser window to see it.

When viewing the full-view of Oracle Social Network, you also see a banner with quick
access to your flags and a user menu from which you can access the following areas:

• Administration—Available to users with administrative privileges. Use
Administration to manage general settings (such as branding and global settings),
users, collaboration (such as enabling external users), apps, features (JavaScript
libraries), Social Definitions, and federated authentication. See Administering
Oracle Social Network.

• Settings—Configure your settings for things such as notifications, language, time
zone, who can post on your wall, web conference account information, and cloud
document storage account information. See Settings and Accessibility.

• Downloads—Download other Oracle Social Network clients: iPhone/iPad app,
Android app, Oracle Social Network Desktop, or the Add-In for Outlook. For more
information, see Using Oracle Social Network on Your iPhone, Using Oracle
Social Network on Your iPad, Using Oracle Social Network on Your Android
Device, Working from Your Desktop, or Using Oracle Social Network with
Microsoft Outlook.

• Analytics—This option is not available to all instances of Oracle Social Network,
but if you see it, you can click it to see your personal usage statistics. If you're an
administrator, you'll see more global information about the Oracle Social Network
instance, as well as individual user information.

• Community—The Oracle Social Network Community Forum is the place to go to
get more information about real-world use cases, tips, and troubleshooting. Share
info with your peers, or get advice from the people who helped to design and build
Oracle Social Network.

• Support—Learn how to log a service request with Oracle support.

• Product News—View the Oracle Social Network Facebook page that includes
product news.

• About—Shows version and copyright information.

How do I get to Oracle Social Network?
You can access Oracle Social Network from the following applications and devices:

• Your Oracle application—Oracle Social Network is integrated with your Oracle
application.

To view the all Social Objects, Conversations, and walls that are available to you,
open the Social panel. While viewing the landing page, click the Social icon.
Alternatively, in the Navigator, click Social.

To view the social activity surrounding a particular Social Object, open the Social
Object, then click the Social icon or link.

• Full view in web browser—You can access the full view of Oracle Social Network
from a URL (for example, you might be emailed a link to Oracle Social Network),
by clicking the full view button in an Oracle Social Network client, or by opening a
document in an Oracle Social Network client.
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• Add-In for Microsoft Outlook—You can use the add-in that displays Oracle Social
Network in a panel on the right side of Outlook. For more information, see Using
Oracle Social Network with Microsoft Outlook.

• Android or iOS apps—You can use the mobile apps to access Oracle Social
Network on the go. For more information, see Using Oracle Social Network on
Your Android Device, Using Oracle Social Network on Your iPhone, or Using
Oracle Social Network on Your iPad.

• Desktop client—You can use the standalone application that runs on your desktop.
For more information, see Working from Your Desktop.

You can download the Add-In for Outlook, mobile apps, or Desktop client from Oracle
Social Network's full view by clicking the arrow next to your name at the top of the
application, then clicking Downloads. Follow the directions from there.

Note: Depending on the Oracle application you use, you might not have access to all
of these options.

How do I set up or change my profile?
To edit your personal information or picture on your social network profile:

1. From the navigation menu on the left, select My Wall.

2. On your profile, click Edit Profile.

3. Edit your personal information. Don't forget to add a bit about what you do in the
Description box under Basic Information and your contact information in the
boxes under Contact Information.

Note: Some information is read only. If you need to change the read-only
information, contact your administrator.

4. To change your profile picture, click it, then select Upload Photo. Select
a .gif, .png, or .jpg file. After you select a picture, you can use the crop tools to re-
size it. Your picture is scaled to 150x150 pixels square.

Note: If you use Mozilla Firefox and JAWS, you must disable pop-ups before you
upload a profile picture. If you don't disable pop-ups, the upload dialog won't
appear.

Example 1-1    Who can see my information?

Oracle Social Network is completely secure. Only people with log-in credentials can
see and interact with Oracle Social Network content and view user's profiles.

Your profile also has a wall, where you can post messages and documents for
everyone to see. People who follow you can also post content to your wall if you allow
them to. For more information, see How do I change my preferences?

How would someone typically use Oracle Social Network?
Here's how someone might use Oracle Social Network in a typical day, just to give you
an idea. This is only an example—you might find that you don't do all these tasks, or
you don't do them in this order.

Chapter 1
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Table 1-1    Example Workflow in Oracle Social Network

Step Action For More Information …

01. Log in. Open Oracle Social Network and enter your user
name and password.

02. Check for assigned flags and reply to or clear them. How do I view my flags?

03. Check recent activity and reply to posts as
necessary.

Navigate to the Overview page.

04. In one Conversation, mark all messages as read. How do I mark a message as read or unread?

05. Check the status of an opportunity (Social Object). Social Objects

06. Add a message to the Social Object's wall. How do I post a message?

07. Add a document to the Social Object's wall. How do I upload a document?

08. Comment on the added document. How do I annotate a document?

09. Flag people who have an interest to call their
attention to the new document.

How do I assign flags to others?

10. Monitor recent activity. View the Recent Activity pane in How do I use the
Oracle Social Network user interface?

11. Start a One-on-One Conversation with a colleague. How do I start a one-on-one Conversation with
someone?

12. Post a reference to an uploaded request for
information (RFFI) in the One-on-One.

How do I add a link to another item?

13. With the colleague, co-browse the RFI referenced in
the One-on-One.

How do I co-browse a file with others?

14. Share an application object as a Social Object. How do I share or join a Social Object in the social
network?

15. Create a collection of Conversations related to the
new Social Object.

How do I create a collection?

Next Steps
Now that you have a general understanding of what you can do with Oracle Social
Network, you might want to start with one of the following tasks:

• Share or join a Social Object or Conversation. See What does sharing or joining a
Social Object do for me?

• Post to a Social Object wall or Conversation. See How do I post a message?

• Edit your profile. See How do I set up or change my profile?

• Follow people and add contacts. See What happens when I follow someone?

Chapter 1
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2
Common Actions

These actions are common to most Oracle Social Network objects.

• How do I work with messages?

• How do I post a document?

• How do I view or edit an item's membership?

• How do I make an item public or restrict access to members-only?

• How do I add or remove a related or referring item?

• How do I mute or unmute an item?

• How do I show or hide membership messages?

• How do I close, reopen, or discard an item?

• How do I rename an item?

• How do I set the language for an item?

• How do I download an archive of an item?

How do I work with messages?
To post a new message to an item, enter your text in the text box, and use the buttons
below the text box to format your text or add a reference to an item or upload a
document.

You can reply to, like, edit, or delete an existing message, as well as add a flag to it or
add it as a favorite.

For more information, see Messages.

How do I post a document?

Next to the message text box in an item, click , then select a file. For more
information, see How do I upload a document?

How do I view or edit an item's membership?
1. Open the item.

Tip: The membership bar shows the item's members and their presence status
(online, idle, offline). To quickly remove a member (including yourself), click the
person's picture in the membership bar, then select Remove from <item>. If you
want to add people or remove multiple people, continue with the next step.

2. Click  in the membership bar to open the list of current members.
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Note: You can't add people to the personal wall that is part of a profile.

3. Click Manage to open the Manage Members dialog.

Note: If you don't see the Manage button, the membership is locked and can't be
changed.

4. Optionally, change its visibility, either Only visible to members (members-only
Conversation) or Visible to everyone (public Conversation).

5. Move groups and people to the right column to add them or to the left column to
remove them. Use Ctrl+Click to select more than one person or group.

Note: You can add outside users to Conversations, but not to Social Objects or
collections. Outside users' names appear in purple text, and they have icons

( ) after their names. For more information on outside users, see Outside
Users.

You can also search by entering part of a person's or group's name, and select
them from the list that pops up.

If your administrator has configured the system to allow you to invite users, you
can add someone who isn't an Oracle Social Network user. Enter the person's
email address in the search box, then click Invite email_address. When asked if
you want to send an invitation, click OK. When you save your changes an email
will be sent to the person inviting the person to join Oracle Social Network.

By default, you see a list of contacts. Click a tab to change your view:

•  Contacts—View a list of your contacts.

•  Groups—View a list of your groups.

Tip: Groups make it easy to add several people in one action. For information
about creating groups, see How do I create a group?

Notes:

• If you remove yourself from a members-only Conversation, you can't add yourself
back. Ask someone who's a member of the Conversation to re-add you.

• If someone was added to a Conversation as part of a group, you can't remove the
person directly from the Conversation. You might be able to remove the person
from the group, but that removes you the person from all Conversations the group
belongs to.

How do I make an item public or restrict access to
members-only?

Anyone who's a member of an item can change its membership model.

To change an item from to public to members-only:

1. Open the item.
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2. Click , then click Make <Object> Publicly Available or Make <Object>
Members-Only.

When making an item members-only, everyone who has already joined the item is
kept as a member.

How do I add or remove a related or referring item?
Related items are items that have direct relevance to the item you're viewing. Think of
them as child items, where the child item is related to a parent item along with other
child items. For example, the Related list for a Social Object might contain
Conversations about planning, financing, ownership, and other types of topics
surrounding the Social Object. The list could include collections of relevant items,
groups comprised of the people involved in fulfilling the Social Object's goal, or other
Social Objects that are relevant to this Social Object.

Referring items are the Social Object and collections that the item you're viewing has
been added to (as a related item). Think of them as parent items, where the parent
item refers to one or more child items.

To add a related item:

1. Open the item, then click the Related tab.

2. Click + Add.

3. Select whether to create a new item or add an existing item:

• To create a new item:

a. Click New Conversation or New Collection.

b. Enter a name for the Conversation.

c. Set its visibility, either Only visible to members (members-only) or Visible
to everyone (public).

d. Select additional members (move from left column to right) or remove
members (move from right column to left).

Note: When you create a new Conversation related to an item, the
Conversation membership is taken from the referring item's membership.

• To add an existing item:

a. Click Related Item.

b. Search for an item or select one from one of the tabs (Recent or
Favorites).

c. Click Select.

To add a referring item:

1. Open the item, then click the Referring tab.

2. Click + Add.

3. Search for an item or select one from one of the tabs (Recent or Favorites).

4. Click Select.
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To remove a related or referring item:

1. Open the item, then click the Related tab or the Referring tab.

2. Click Edit.

3. Click Remove next to the item, then click Done.

How do I mute or unmute an item?
If you have items in your object lists that you never look at (for example a
Conversation that doesn't apply to you), or you're seeing updates in your recent
activities or in your email digests about items you don't care about, you can mute
those items. Muting an item hides it and its activity from your view. It's still there; you
just won't hear about it anymore. (The only exception is if you're flagged on a message
in a muted item, for which you will still be alerted by email based on your notification
settings.)

To mute an item:

1. Open the item.

2. Click , then select Mute <Object>.

A banner appears at the top, showing that the item is muted.

To unmute an item:

1. From the navigation menu on the left, select the type of item you want to view (for
example, Conversations.

2. In the Show menu, select Muted.

3. Click an item to open it.

4. In the banner showing that the item is muted, click Unmute.

If you dismissed the banner, click , then select Unmute <Object>.

How do I show or hide membership messages?
When a user is added to or removed from an item a membership message is posted to
the item (for example, The Conversation is now accessible to: John Doe). If you'd
prefer not to see those messages, you can hide them.

1. Open the item.

2. Click , then select Hide Membership Messages or Show Membership
Messages.

Note: You can set the default view of membership messages for all walls and
Conversations through your preferences. For more information, see How do I change
my preferences?
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How do I close, reopen, or discard an item?
You can close any item you belong to, even if you didn't create it. Closing an item
prevents people from adding new messages to it and removes it from item lists.

To close an item:

1. Open the item.

2. Click , then click Close <Object>

3. Optionally, enter a summary statement.

4. Click Close.

To reopen an item:

1. From the navigation menu on the left, select the type of object you want to reopen.

2. In the Show menu, select Closed.

3. Click an item to open it.

4. Click , then select Reopen <Object>.

To discard an item:

You can discard an item only if you're the sole member. A discarded item is removed
from all lists, including collections and Social Objects it's related to.

1. Open the item.

2. If necessary, remove all other members except yourself.

3. Click , then select Discard <Object>.

How do I rename an item?
1. Open the item.

2. Click , then click Rename <Object>.

Note: Social Objects can be renamed in the business application, not in Oracle
Social Network.

3. Enter a new name, then click OK.

How do I set the language for an item?
If you want system messages in a Conversation or wall to appear in a language other
than the default language, you can change the language setting. The language setting
affects all members' views of the Conversation or wall.

Any system messages posted after you change the language will appear in the new
language. System messages that were there before the language change, however,
remain in the language that was in place when they were posted. Messages and files
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posted to the Conversation or wall are unaffected; that is, they appear in the language
they were written in.

To change the language setting for an item:

1. Open the item.

2. Click , then select Set Language.

3. Select the language you want.

Note: The language used for field labels, button labels, banner headings, and so on, is
determined by your preferences in the full view of Oracle Social Network. For more
information, see How do I change my preferences?

How do I download an archive of an item?
Suppose you're heading for the airport and want to catch up on what's been going on
with an item while on the plane. Maybe you want to keep a record of the content in a
Conversation or wall at a certain point. You can save an archive of an item to your
local drive.

The archive is in the form of a .zip file (named after the item). It contains the list of
members, messages, and replies in an HTML file (named by default index.html) and
all the documents added to the item.

To download an archive of an item:

1. Open the item.

2. Click , then select Download and save the file.

To work with an archive:

1. Unzip the files to your computer.

2. Open index.html.

Clicking a document link opens the copy of the document that is included in
the .zip file. All other links in index.html (user names, like, reply, and so on) open
the full version of Oracle Social Network in the browser.

Note: You can't make changes to an archive (though you can click a link to open the
item in a browser and make changes there).
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3
Social Objects

These topics offer information about records from your business applications or
business processes—such as Oracle's Fusion Applications CRM and HCM systems—
that are integrated with Oracle Social Network. Such records in Oracle Social Network
are called Social Objects.

• What are Social Objects?

• What does sharing or joining a Social Object do for me?

• How do I share or join a Social Object in the social network?

• How do I view a Social Object?

• How do I create a new Social Object?

• How do I work with messages?

• How do I post a document?

• How do I view or edit a Social Object's membership?

• How do I make a Social Object public or restrict access to members-only?

• How do I add or remove related or referring items?

• How do I mute or unmute a Social Object?

• How do I show or hide membership messages in a Social Object?

• How do I close, reopen, or discard a Social Object?

• How do I rename a Social Object?

• How do I change a Social Object's language?

• How do I download an archive of a Social Object?

What are Social Objects?
Social Objects are records within a business application or business process that are
mapped into Oracle Social Network. When records like these appear in Oracle Social
Network, they are called Social Objects.

Your application administrator might set things up so that all business objects of a
given type are automatically made Social Objects, while other types require that you
click a Share button to explicitly turn them into Social Objects.

Now, why should you care? Imagine an opportunity named BigSale in your Oracle
Applications Cloud CRM system. You expose the BigSale opportunity record as a
Social Object in Oracle Social Network. Here you can add discussions, decisions, and
plans directly to BigSale's list of related items, making them easy to find.

You can post to the Conversation associated with the Social Object—its wall—to
report your progress, let everyone know your status, or anything else relevant to the
object.
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You can also advance the account from one state to the next, for example from open
to pending to closed, through a collaborative process that includes all involved teams.

In addition to people who have access to the record through the Oracle Applications
Cloud, you can add people who don't have that access to the Social Object's
membership. This way, you extend the pool of talent contributing to the discussions,
decisions, and plans associated with the Social Object.

What does sharing or joining a Social Object do for me?
Once you share or join a Social Object, you can:

• View updates to the Social Object instantly from any view of your social network,
including your browser, mobile device, desktop, and Microsoft Outlook application.

• See and navigate to items related to the Social Object.

Tip: You see just those Conversations you're a member of or those that are public,
which anyone can join.

• Post messages and files that all members of the Social Object will see.

• Join web conferences from the Conversations list or from a Conversation.

• See everyone else who's a member of the Social Object, and collaborate with
them in Conversations.

• Manage Conversation and wall memberships.

• Keep object details in view while you participate in related Conversations

How do I share or join a Social Object in the social network?
Before you can collaborate on your business object you share it with your social
network. Business objects that are shared with your social network are called Social
Objects, and Social Objects have access to all kinds of social networking features, like
Conversations and easy document collaboration.

You can share a business object by opening it, clicking the Social icon or link, then
clicking Share in the Social panel.

One of your co-workers might have already shared the business object. If that's the
case, you'll see a Join button instead of a Share button. Click it to become a member
of the Social Object.

Sharing or joining a Social Object lets you participate in social activities having to do
with the object. For example, you can have online Conversations with others about the
object while looking at the object's details.

How do I view a Social Object?
1. From the Social Object menu, select the type of Social Object you want to see.

2. On the list of Social Objects, click the one you want to see.
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How do I create a new Social Object?
Some Social Objects have been configured to prevent new ones from being created
through Oracle Social Network. The way to find out which ones can be created is to try
to create them following these steps.

1. Go to the Social Object's page, and click the New <Social_Object_Type> button
on the left to open the new Social Object's wall.

2. Fill in the required data for the Social Object, if any.

3. Under Membership, move groups and people to the right column to add them or to
the left column to remove them. Use Ctrl+Click to select more than one person or
group.

You can also search by entering part of a person's or group's name, and select
them from the list that pops up.

By default, you see a list of contacts. Click a tab to change your view:

•  Contacts—View a list of your contacts.

•  Groups—View a list of your groups.

Note: You can't add outside users (people outside your company) to a Social
Object. Outside users' names appear in purple text, and they have icons

( ) after their names.

4. Click OK.

How do I work with messages?
To post a new message, enter your text in the text box, and use the buttons below the
text box to format your text or add a reference to an item or upload a document.

You can reply to, like, edit, or delete an existing message, as well as add a flag to it or
add it as a favorite.

For more information, see Messages.

How do I post a document?

Next to the message text box, click , select where to upload the file from, then
select a file. For more information, see How do I upload a document?

How do I view or edit a Social Object's membership?
The membership bar shows the Social Object's members and their presence status

(online, idle, offline). To edit a Social Object's membership, click  in the
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membership bar, then click Manage. For more information, see How do I view or edit
an item's membership?

How do I make a Social Object public or restrict access to
members-only?

Click , then click Make <Social Object> Publicly Available or Make <Social
Object> Members-Only. For more information, see How do I make an item public or
restrict access to members-only?

How do I add or remove related or referring items?
Related items are the items that have been added to the you're viewing. They can
include Conversations, people's walls, group walls, Social Objects, or other collections.

Referring items are the Social Object and other collections that the Social Object
you're viewing has been added to (as a related item). Think of them as parent items,
where the parent item refers to one or more child items.

To add related item, on the Related tab, click + Add, and select whether to create a
new item or add an existing item.

To add referring item, on the Referring tab, click + Add, and select an existing item.

To remove a related item, on the Related tab, click Edit, then click Remove next to
the item you want to remove.

For more information, see How do I add or remove a related or referring item?

How do I mute or unmute a Social Object?
If you have items in your object lists that you never look at (for example a Social
Object that doesn't apply to you), or you're seeing updates in your recent activities or
in your email digests about items you don't care about, you can mute those items.
Muting an item hides it and its activity from your view. It's still there; you just won't hear
about it anymore. (The only exception is if you're flagged on a message in a muted
item, for which you will still be alerted by email based on your notification settings.)

To mute a Social Object, click , then select Mute <Social Object>.

To unmute a Social Object, from the navigation menu, select the type of Social Object
you want to view. In the Show menu, select Muted, then open the Social Object. Click

, then select Unmute <Social Object>

For more information, see How do I mute or unmute an item?
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How do I show or hide membership messages in a Social
Object?

When a user is added to or removed from an item a membership message is posted to
the Social Object (for example, The Social Object is now accessible to: John Doe). If
you'd prefer not to see those messages, you can hide them.

Click , then select Hide Membership Messages or Show Membership
Messages. For more information, see How do I show or hide membership messages?

How do I close, reopen, or discard a Social Object?
You can close any Social Object you belong to, even if you didn't create it. Closing a
Social Object prevents people from adding new messages to it and removes it from
people's list of Social Objects.

To close a Social Object, click , then select Close <Social Object>.

To reopen a Social Object, from the navigation menu, select <Social Object>. In the

Show menu, select Closed, then open the Social Object. Click , then select
Reopen <Social Object>.

You can discard a Social Object only if you're the sole member. A discarded Social
Object is removed from all lists, including collections and Social Objects it's related to.

To discard a Social Object, click , then select Discard <Social Object>.

For more information, see How do I close, reopen, or discard an item?

How do I rename a Social Object?
Click , then click Rename <Social Object>. For more information, see How do I
rename an item?

Note: Some Social Objects can be renamed only in the business application, not in
Oracle Social Network.

How do I change a Social Object's language?
If you want system messages in a Social Object to appear in a language other than
the default language, you can change the language setting. The language setting
affects all members' views of the Social Object.

Click , then select Set Language. For more information, see How do I set the
language for an item?
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How do I download an archive of a Social Object?
You can download an archive of a Social Object to view the Social Object offline or to
save the content at a certain point.

To download an archive of a Social Object, click , then select Download and save
the file.

To work with the archive, unzip the files to your computer, and open index.html.

For more information, see How do I download an archive of an item?
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4
Messages

These topics discuss how to work with messages:

• How do I post a message?

• How do I add a link to another item?

• How do I post a document?

• How do I mark a message as read or unread?

• How do I reply to a message?

• How do I like a message?

• How do I add a message as a favorite?

• How do I alert people to an important message?

• How do I edit a message?

• How do I delete a message?

How do I post a message?
1. Open the Messages tab of the Conversation or the Wall tab of the wall.

For walls, there is a text box at the top of the wall. For Conversations, there is a
text box at the bottom of the Conversation.

Note: If you don't see the text box at the top of a person's wall, you aren't following
the person or the person doesn't allow other people to post to his or her wall.

2. In the text box, type your message.

Formatting options are available beneath the text box to help you; hover over the
icons to see what they do.

To remove formatting, click . To remove only some of the formatting, select

text before clicking .

If you plan to write a long message (or find that the message becomes long while

typing), click  to open the Note Editor, which provides even more formatting
controls, plus a roomy text area.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

3. Click Post or press Enter, depending on how you set up your Preferences (see 
How do I change my preferences?).
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How do I add a link to another item?
While writing a message, you might find it handy to link to a Conversation, Social
Object, document, or other item. Here's how:

1. While writing your message, click  under the text box to open the Insert
Reference dialog.

2. Select a source:

• Recent—To select from items you've visited recently

• Viewed Documents—To select from files you've opened recently

• Favorites—To select from items you've marked as a favorite

• Search Results—Type text into the search box, then press Enter to search for
an item

3. Select the item you want to refer to.

4. Click Insert to add a link to your selection to the message field.

5. Optionally, enter text before or after the reference link.

6. Click Post.

How do I post a document?

Under the message text box, click , select where to upload the file from, then
select a file. For more information, see How do I upload a document?

How do I mark a message as read or unread?
Within a Conversation, unread messages are marked  to the left of the message.
Click the blue dot to mark a single message as read.

To mark all the messages in a Conversation as read, click the blue icon that contains a

number, like this: . You'll find this unread message count in many places
throughout Oracle Social Network.

To mark a message as unread, click  More under the message, then click Mark as
Unread.

How do I reply to a message?

Click  Reply under the message.
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Note: If you don't see  Reply under a personal wall post in recent activities
(from the navigation menu on the left, select Overview) or on someone's wall, the
person doesn't allow other people to reply to his or her wall posts.

How do I like a message?

Click  Like under the message.

Tip: To see who has liked a message, click the link that shows the number of people
who have liked it.

How do I add a message as a favorite?
To mark a message as a favorite, click  next to the message; click the star again to
unmark it. For more information on favorites, see How do I mark a wall, Conversation,
or message as a favorite?

How do I alert people to an important message?
You can assign a flag to the message by clicking the flag icon next to the message.
For more information, see How do I assign flags to others?

How do I edit a message?

Click  More under the message, then click Edit.

All edited messages show  Edited at the bottom of the message. You can click this
to see the earlier versions of that message.

Notes:

• You can edit only your own messages.

• Any special markup on a message is lost when you edit the message.

How do I delete a message?
You can delete messages you posted or messages on your profile wall.

Note: If you are a service administrator, you can delete any message.

Click  More under the message, then click Delete.

When you delete a message,  appears where the message used to be. You can
mouse over this icon to find out who deleted the message, who posted it originally,
and the date and time the message was deleted.
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To restore a deleted message, locate the deleted message icon ( ) where the

message used to be, click , then confirm that you want to restore the message.

Note: Only a service administrator, the person who posted the message, or the person
who deleted the message can restore the deleted message.
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5
Conversations

These topics describe the kinds of Conversations you can create and participate in
and how to work with them:

• What types of Conversations are available?

• How do I start a Conversation?

• How do I join a Conversation?

• How do I work with messages in a Conversation?

• How do I post a document to a Conversation?

• How do I view or edit a Conversation's membership?

• How do I make a Conversation public or restrict access to members-only?

• How can I limit Conversation membership to only certain people?

• How do I add a Conversation to a collection or Social Object?

• How do I mute or unmute a Conversation?

• How do I show or hide membership messages in a Conversation?

• How do I close, reopen, or discard a Conversation?

• How do I rename a Conversation?

• How do I change a Conversation's language?

• How do I download an archive of a Conversation?

• How do I manage Conversations?

• How do I create a new Conversation from an old one?

What types of Conversations are available?
There are lots of options available for sharing information, depending what you want to
achieve through the interaction:

• A one-on-one Conversation is one that only you and the person you're talking to
can see. You can't add other members to a one-on-one Conversation. You might
use one-on-one Conversations for private comments or questions before you
share information with a larger group.

• A private Conversation is one that only you can see. You might use a private
Conversation to store your private notes and comments, or as a staging ground
where you gather content until you're ready to share it with others.

• A members-only Conversation can be seen only by the people who are explicitly
added to the Conversation by other members.

• A public Conversation is open enrollment; anyone who is logged in can join. While
you can see posts in a public Conversation, you can't actually post anything until
you've clicked the Join button to become a member.
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• A scoped Conversation is the most tightly controlled type of Conversation. Scoped
Conversations are created under a scoping Social Object in an application that
has been integrated with Oracle Social Network. When the scoping Social Object
is created, a list of people is defined. Only those people are eligible to be added to
Conversations about that scoping Social Object.

Note: For information about Social Objects, see Social Objects

• While a Social Object's wall isn't really a Conversation, it is another place where
people can exchange information. If you've joined a Social Object, you can see
posts, make posts, and invite others to the wall, provided that they have a login to
the same instance of Oracle Social Network that you use.

Think of a wall as a common area for the Social Object, where people who might
not have access to your application can still collaborate with you on a particular
Social Object. For example, suppose you want to consult with someone in Legal,
who doesn't have access to the business object. All you have to do is add the
Legal employee to the Social Object in question, and start your online discussion
—either on the wall itself, or in a new Conversation.

What's the difference between Conversations and walls?

It might be useful to know what they have in common first: All of them are pages
where you can post messages and other types of content that other members can
read and reply to. All of them preserve this information so that it can be revisited
anytime, anywhere.

A Conversation is an online discussion typically about a specific topic. A Conversation
can have a restricted membership or be open to any person with a login to the social
network.

A wall is a page associated with a business object, group, or user. All members of the
object can post to a wall and read what other members have posted, so the
information posted there is usually more general, such as announcements.

While walls are meant for announcements, Conversations are more like discussions.
That means that new wall posts are presented at the top, to make the latest
information easy to see, while new Conversation posts are at the bottom, to continue
the discussion.

How do I start a Conversation?
Note: For information on starting a one-on-one Conversation, see How do I start a
one-on-one Conversation with someone?

1. Open the Create New Conversation dialog:

• To create a Conversation that is not associated with another item (such as a
business object), on the Overview or Conversations page, click New
Conversation.

• To create a Conversation that is associated with another item (such as a

business object or group), open the item, click , then select Create New
Conversation.

A link to this related Conversation appears on the Related tab of the item.

2. Enter a name for the Conversation.
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3. Set its visibility, either Only visible to members (members-only Conversation) or
Visible to everyone (public Conversation).

4. Select groups and people, and move them to the Members list to add them to the
Conversation. Use Ctrl+Click to select more than one person or group.

You can also search by entering part of a person's or group's name, and select
them from the list that pops up.

By default, you see a list of contacts. Click a tab to change your view:

•  Contacts—View a list of your contacts.

•  Groups—View a list of your groups.

Notes:

• If this Conversation is related to a Social Object or collection, the membership
is inherited from that Social Object or collection. To remove members, select
them from the Members list, and click the left arrow.

• Everyone in your company's LDAP directory appears in the Create New
Conversation dialog. If you add someone who has never logged in to Oracle
Social Network before, he or she will receive an email inviting them to join.

• You can add people to a public Conversation, and/or people can add
themselves. Other people see your public Conversations when they apply the
Available filter on their Conversations display. They can then click the Join
button to add themselves.

• People outside your company have a special avatar ( ) and their
names are in purple text. If you add an outside user to a Conversation, a
banner stating "Visible to outside users." appears at the top of the
Conversation and any associated message dialogs. Be careful not to post any
sensitive information to Conversations that include outside users.

How do I join a Conversation?
If the Conversation you want to join is members-only, ask someone who is already a
member to add you. To see all the public Conversations you can join:

1. Click Conversations along the top of your screen.

2. Click Available on the left to see all the public Conversations.

3. Click the Conversation you want to join.

4. Click the Join button.

How do I work with messages in a Conversation?
To post a new message, enter your text in the text box, and use the buttons below the
text box to format your text or add a reference to an item or upload a document.

You can reply to, like, edit, or delete an existing message, as well as add a flag to it or
add it as a favorite.
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For more information, see Messages.

How do I post a document to a Conversation?

Under the message text box, click , select where to upload the file from, then
select a file. For more information, see How do I upload a document?

How do I view or edit a Conversation's membership?
The membership bar shows the Conversation's members and their presence status

(online, idle, offline). To edit a Conversation's membership, click  in the
membership bar, then click Manage. For more information, see How do I view or edit
an item's membership?

How do I make a Conversation public or restrict access to
members-only?

Click , then click Make Conversation Publicly Available or Make Conversation
Members-Only. For more information, see How do I make an item public or restrict
access to members-only?

How can I limit Conversation membership to only certain
people?

Membership can be tightly controlled through scoping Social Objects. When a scoping
Social Object is created, a list of approved members is defined. When someone then
creates a Conversation from that Social Object, only people defined in the
membership list can be added—no one else. This ensures that sensitive or private
information is not inadvertently shared with others who might not have a need to know.

Not all deployments of Oracle Social Network have scoping Social Objects. Your
application administrator can tell you if yours does.

1. Open a scoping Social Object.

2. Next to Scoped Conversation, click  and select Create and add a new
Conversation to open a new Conversation.

3. Continue as you would with any other Conversation.

How do I add a Conversation to a collection or Social
Object?

A Conversation can be related to a collection or Social Object. For example, you might
have separate Conversations for planning, financing, ownership, and other types of
topics surrounding a Social Object. You can group all these Conversations together,
making all the relevant content easier to find, by adding the Conversations to the
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collection or Social Object. You can set up these relationships from the collection's or
Social Object's Related tab, or from the Conversation's Referring tab.

To add the Conversation to a referring collection or Social Object, click the Referring
tab, then click + Add, and select an item. For more information, see How do I add or
remove a related or referring item?

How do I mute or unmute a Conversation?
If you have items in your object lists that you never look at (for example a
Conversation that doesn't apply to you), or you're seeing updates in your recent
activities or in your email digests about items you don't care about, you can mute
those items. Muting an item hides it and its activity from your view. It's still there; you
just won't hear about it anymore. (The only exception is if you're flagged on a message
in a muted item, for which you will still be alerted by email based on your notification
settings.)

To mute a Conversation, click , then select Mute Conversation.

To unmute a Conversation, from the navigation menu, select Conversations. In the

Show menu, select Muted, then open the Conversation. Click , then select
Unmute Conversation

For more information, see How do I mute or unmute an item?

How do I show or hide membership messages in a
Conversation?

When a user is added to or removed from an item a membership message is posted to
the Conversation (for example, The Conversation is now accessible to: John Doe). If
you'd prefer not to see those messages, you can hide them.

Click , then select Hide Membership Messages or Show Membership
Messages. For more information, see How do I show or hide membership messages?

How do I close, reopen, or discard a Conversation?
You can close any Conversation you belong to, even if you didn't create it. Closing a
Conversation prevents people from adding new messages to it and removes it from
people's list of Conversations.

To close a Conversation, click , then select Close Conversation.

To reopen a Conversation, from the navigation menu, select Conversations. In the

Show menu, select Closed, then open the Conversation. Click , then select
Reopen Conversation

You can discard a Conversation only if you're the sole member. A discarded
Conversation is removed from all lists, including collections and Social Objects it's
related to.
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To discard a Conversation, click , then select Discard Conversation.

For more information, see How do I close, reopen, or discard an item?

How do I rename a Conversation?
Click , then click Rename Conversation. For more information, see How do I
rename an item?

How do I change a Conversation's language?
If you want system messages in a Conversation to appear in a language other than
the default language, you can change the language setting. The language setting
affects all members' views of the Conversation.

Click , then select Set Language. For more information, see How do I set the
language for an item?

How do I download an archive of a Conversation?
You can download an archive of a Conversation to view the Conversation offline or to
save the content at a certain point.

To download an archive of a Conversation, click , then select Download and save
the file.

To work with the archive, unzip the files to your computer, and open index.html.

For more information, see How do I download an archive of an item?

How do I manage Conversations?
If a very long Conversation becomes slow to load, or if the topic naturally diverges to a
new concern, consider branching off into a new Conversation. Both the old and new
Conversations will have links to each other, so you can move between them easily.
See How do I create a new Conversation from an old one? for more information.

If you have a long list of Conversations, here are some tips for managing them:

• Use collections to gather related Conversations together, like those that focus on a
common topic. Rather than scrolling through your Conversations list, you can go
directly to your Collections list instead. See Collections

• Mark the Conversations you really need to pay attention to as favorites (click the
star next to the Conversation name), then use the Favorites filter on your
Conversations list to focus on them (or click the star icon in the banner).

• Use the Sort By menu at the top right of the Conversations list to arrange the
Conversations alphabetically, by the date of the last update, and so on.
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How do I create a new Conversation from an old one?
You might want to create a new Conversation from an old one when the topic
changes, or when the discussion logically moves to a next step. For example, suppose
you're in a Conversation about Milestone I and the group is ready to start talking about
the next phase. You create a new Conversation, Milestone II, from the Milestone I
Conversation. A link to the Milestone II Conversation is automatically posted to
Milestone I, and vice versa. In this way, you maintain a chain of linked Conversations
that enable people to move easily back and forth among them.

While in the original Conversation, click  below the message field and add the
required information. Membership from the original Conversation is automatically
copied over to the new, but you can change that if you want.

Note: Any Conversation you create from a collection or Social Object's wall is added
by default to the collection or Social Object's list of Referring Conversations.
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6
People

These topics provide information about people in Oracle Social Network. They
describe how to invite people to join Oracle Social Network, how to add people and
groups to Conversations and walls, how to make someone your contact, follow
someone, and other types of people-related tasks. It includes the following sections:
Note: For information about accessing and developing your personal profile, see How
do I set up or change my profile?

• What social features are available in the social network?

• What happens when I follow someone?

• How do I follow people or add contacts?

• How do I view a person's profile or interact with someone in Oracle Social
Network?

• How do I post a message on someone's wall?

• How do I start a one-on-one Conversation with someone?

• How do I invite people to join the social network?

What social features are available in the social network?
You can invite anyone who has a login to your social network to collaborate in any
Conversation you're a member of. If your company has enabled extended
collaboration, the person doesn't even have to have access to your business
applications. For example, you can invite people to a Conversation about a Social
Object, even it they don't have access to your business application.

While social networking features are there to assist you in effectively conducting
business, lots of business involves socializing. Your social network also has features
that support social activities. For example, people can add their own avatars to
represent themselves, you can write on someone's wall, you can add people as
contacts, and you can like things that people post.

Avatars

Everyone has an avatar (picture). The picture lets you know what people look like or
how they want to represent themselves.

The colored circle around a person's picture signifies the person's presence:

•  - A full green circle around the person's picture shows that the person is
available (logged into and currently interacting with Oracle Social Network).

•  - A three-quarter yellow circle around the person's picture shows that the
person is idle (logged into but not currently interacting with Oracle Social Network).
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•  - A half gray circle around the person's picture shows that the person is
offline (not logged into Oracle Social Network).

People outside your company with limited access to Oracle Social Network (outside

users) have a special avatar ( ) and their names are in purple text, so it's
clear when someone from the outside is present. For more information on outside
users, see Outside Users.

Tip: An animated pencil icon in the lower right corner indicates that the person is
entering content in the current Conversation or on the current wall.

Profiles and Walls

Everyone who is a member of your social network has their own profile, and (other
than outside users) has a wall that you can post to. You can go to a person's profile by
clicking the linked name or picture on anything they posted throughout the social
network.

A person's profile includes the following information:

• At the top of the person's profile is the person's picture and some general
information such as their name, title, and whether the person is active.

Click One-on-One to start a private conversation with the person. For more
information, see How do I start a one-on-one Conversation with someone?

Click Follow to add the person to your contacts and follow the person's activity.

• Wall tab—View or post messages, replies, and documents for the person. For
information on posting to a person's wall, see How do I post a message on
someone's wall?

Note: You must follow the person before you can post to the person's wall. Some
people might not allow other people to post to his or her wall.

• Profile tab—View additional details about the person, such as contact information.

If you're viewing your own profile, click Edit Profile to edit your personal details or
your picture.

• Following tab—View the people the person follows. The number in the tab shows
the number of people the person follows.

• Followers tab—View the people following the person. The number in the tab
shows the number of people following the person.

• Documents tab—View any documents uploaded to the person's wall.

• Referring tab—View any items the person has been added to as a related
resource.

Note: Depending on how many people are following a person, you might not see all
the tabs. To see hidden tabs, click More.

Outside Users

Users with limited access are called outside users. There are indicators throughout
your social network that show you outside users and their presence. For example,
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outside users' names appear in purple text and have icons ( ) after their
names so you know who they are and can keep confidential information out of the
Conversations they belong to. In a Conversation with outside users, you see a banner
stating "Visible to outside users." at the top of the Conversation and any associated
message dialogs. Be careful not to post any sensitive information to Conversations
that include outside users.

Notes:

• Outside users have profiles like other users, but they don't have walls.

• You can't follow outside users, but you can add them as contacts. (Outside users
can't make contacts of their own.)

• You can invite outside users to Conversations but not to groups, collections, or
Social Objects.

What happens when I follow someone?
Following someone adds them as a contact, which means you can post messages to
their wall and track activity on their wall. The wall activity shows up on the Overview
page, in the Recent Activity panel on the right, and in your daily email digest.

Note: You can't follow outside users (people outside your company), but you can add
them to your contacts. Outside users' names appear in purple text, and they have

icons ( ) after their names.

For more information, see How do I follow people or add contacts?

How do I follow people or add contacts?
Following someone lets you track their wall activity and adds them to your list of
contacts.

• To follow someone and add them to your list of contacts, click Follow on the
person's profile or on the Followers tab on the People page or on your profile.

For more information, see How do I view a person's profile or interact with
someone in Oracle Social Network? or Viewing Your Followers.

• To stop following someone, click Unfollow on the person's profile or next to the
person's name on the Following tab of the People page or on your profile.

For more information, see Viewing the People You Follow.

You'll be asked if you also want to remove the person from your contacts.
Unfollowing someone means you won't see their wall activity. If you want to
continue to post to their wall and see them in your list of contacts (making it easy
to have one-on-one Conversations with them), don't remove them from your
contacts.
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Viewing Your Contacts

You can add users to your list of contacts to make them easier to find, and more
importantly, easier to start a one-on-one Conversation with. You add contacts by
following them (see How do I follow people or add contacts?

Your contacts are listed in the Contacts panel on the right and on the Contacts tab of
the People page.

Viewing the People You Follow

There are several ways to see who you're following:

• From the navigation menu on the left, select People, then click the Following tab.

• Open your profile page, then click the Following tab.

Note: The number on the Following tab shows how many people you follow.

Viewing Your Followers

There are several ways to see who's following you:

• From the navigation menu on the left, select People, then click the Followers tab.

• Open your profile page, then click the Followers tab.

You can easily see which of your followers you follow, because the button on the
right of someone you follow says Unfollow, whereas the button next to someone
you don't follow, says Follow. Click the button to change whether you follow the
person or not.

Note: The number on the Followers tab shows how many people are following
you.

How do I view a person's profile or interact with someone in
Oracle Social Network?

Throughout Oracle Social Network you'll see people's pictures and names. To view a
person's profile or interact with someone, click the picture or name. Depending on
where you are in Oracle Social Network, when you click the picture or name, you can
add the person as a contact, start a one-on-one conversation with the person, or, if the
person works in your company, you can follow the person.

For more information, see:

• How do I follow people or add contacts?

• How do I post a message on someone's wall?

• How do I start a one-on-one Conversation with someone?

• How do I invite people to join the social network?
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How do I post a message on someone's wall?
Note: Outside users (people outside your company) have profiles, but they don't have

walls. Outside users' names appear in purple text, and they have icons ( )
after their names. If you want to post something to an outside user, you can do so
through a one-on-one conversation. For more information, see How do I start a one-
on-one Conversation with someone?

When you post on someone's wall, the post is visible to other users (unlike a one-on-
one Conversation).

To post a message on someone's wall:

1. Click the person's picture or name to get to their profile. Their profile opens to their
wall.

2. Working with posts on someone's wall is like any other Conversation. For
information about working with posts in a Conversation, see the topics under 
Messages

Notes:

• You must be following the person to post to their wall.

• If you don't see the text box at the top of a person's wall, you aren't following
the person or the person doesn't allow other people to post to his or her wall.

To learn how to control who can post to your wall, see How do I change my
preferences?

How do I start a one-on-one Conversation with someone?
There are several ways to start a one-on-one Conversation with someone:

• In your Contacts list, next to the person, click . (If you don't see the person
you want in this list, see How do I follow people or add contacts?)

• On your Contacts page, next to the person, click One-on-One.

• In an item's membership bar, click the person's profile picture, then click Open
One-on-One.

• Anywhere else you see a person's name or picture, click it to open their profile. At
the top of their profile, click One-on-One.

One-on-one Conversations automatically open in a minimized view at the bottom of
your screen.

• To view the one-on-one Conversation in the main window, click 

• To hide minimized view, click  in the banner. The view collapses and the banner
turns gray. If your partner posts to you, the banner turns blue again. Click the
banner to re-display minimized view.
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• To close the minimized view, click  in the banner.

How do I invite people to join the social network?
You can invite unregistered users, and, if your company has enabled extended
collaboration, you can also invite new people to join your social network. You invite
people when adding members to a Conversation or wall.

Unregistered users are people who are in your company's directory but are not yet
members of Oracle Social Network. When you add people to a Conversation or wall,
the word unregistered appears next to the names of unregistered users and a warning
dialog alerts you to their unregistered status.

When you add an unregistered person to a Conversation, they receive an email with a
link to set up their account.

New users are added using their email address. Depending on the person's email
domain and how your administrator has configured user access, the user might get
access to all of Oracle Social Network or might be granted limited access.
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7
Documents and Folders

These topics step you through document-related features in Oracle Social Network.
They include the following information:

• How do I upload a document?

• What is document presence?

• How do I view a file?

• How do I download a file to my computer?

• How do I print a file?

• How do I delete a file?

• How do I annotate a document?

• How do I view document annotations?

• What is document co-browsing?

• How do I co-browse a file with others?

• How do I create a folder?

• How do I rename a folder?

• How do I download a folder?

• How do I delete a folder?

How do I upload a document?
You can add files from your local file systems.

Notes:

• You can upload files of all kinds and sizes to Oracle Social Network, but file
previews show only the first 100 pages, and not all file types show a preview.

• If you add a document with the same name as one that was previously added, a
new version is created.

To share a document with others:

1. Open the business object or Conversation you want to associate the document
with.

Note: If the Conversation or wall you select is visible to outside users, you see a
banner stating "Visible to outside users." at the top of the dialog. Be careful not to
post any sensitive information to Conversations or walls that include outside users.
For more information on outside users, see Outside Users.

2. On the Messages or Wall tab, click  next to the text box, or, on the
Documents tab, click Add, then select a file.
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3. Optionally, in the text box add a message to post with the document.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

4. Click Upload.

Your document, with any message you added, is posted to the wall or
Conversation.

What is document presence?
Document presence lets you see who is looking at a document. You can see
document presence information in your list of contacts, in the Social Bar under
Trending, on a profile page, and in someone's activity status in the item's membership
bar.

Document presence information also appears above a document preview, where the
profile picture of everyone who is looking at a document appears. You can click a
profile picture in this row to see options for co-browsing with this person, opening a
One-on-One Conversation with them, or navigating to their profile.

How do I view a file?
There are several ways to view a file:

• To open a preview of the file in Oracle Social Network, click the file's thumbnail.

To see a full-screen preview of the file, click Expanded View under the document,

or, while viewing the document, click .

Notes:

– When you preview the file in Oracle Social Network, you can add annotations
to the file. For more information, see How do I annotate a document?

– Document previews are limited to the first 100 pages of a document.

– The list of file types you can preview is long, but there are some file types you
can't preview, like an archive or executable file. Oracle Social Network
supports adding these types of files but not previewing them. For these file
types, you can download the file and open it on your computer.

• To download a file and open it on your computer, click Download under the
document.

To view a list of all documents and folders in a Conversation or wall, click the
Documents tab.

How do I download a file to my computer?
To download a document, click Download under the file.
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How do I print a file?
Download the file and print it like you would any other file (see How do I download a
file to my computer?).

How do I delete a file?
You can delete documents you posted or documents on your profile wall.

Notes:

• If you are a service administrator, you can delete any document.

• If a document has multiple versions, and you delete the document from the
messages list (rather than from the Documents tab), you delete only the selected
version.

To delete a file, on the Conversation's or wall's Documents tab, under the document
you want to delete, click More, then select Delete. Both the document and the
associated message are deleted.

To restore a deleted file, in the messages list, locate the deleted message icon ( )

where the document message used to be, click , then confirm that you want to
restore the message. The message and document are restored.

Note: Only a service administrator, the person who posted the file, or the person who
deleted the file can restore the deleted file.

How do I annotate a document?
Annotations are graphic markers and review remarks you can add to a document
preview. You can place annotations in a document preview wherever you want them.
For example, using annotations you can add a pushpin marker to a document preview,
and enter a comment about the document right where the pushpin is placed. Each
person's annotations appear in a unique color, making it easy to follow who said what.

1. Open the document preview (see How do I view a file?).

Note: Document previews are limited to the first 100 pages of a document.

2. Select a tool from the Tools menu.

Table 7-1    Annotation Tools

Tool Usage

None Select None when you want to move through the document without annotating
text.

Use the Pushpin tool to post an annotation to a pinpointed location.

Use the Pen tool to create a free-form mark on the material you're annotating.
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Table 7-1    (Cont.) Annotation Tools

Tool Usage

Use the Highlighter tool to highlight one line of the material you're annotating.

Use the Rectangle tool to draw a rectangle over the material you're annotating.

Use the Ellipse tool to draw a circle over the material you're annotating.

Notes:

• The icon to the left of the Tools menu shows the tool that is currently selected.

• If you don't see the Tools menu at the top of a document on a person's wall,
the person does not allow other people to post annotations to his or her
personal documents.

3. Click or highlight the text you want to annotate.

• For the pushpin, click the location you want to annotate.

• For the drawing tools, drag them to surround or highlight the text you want to
annotate. Drawing tools include the pen, the highlighter, the rectangle, and the
ellipse.

A dialog opens where you can enter your remarks.

4. In the dialog, enter a remark.

5. Click Continue to continue annotating the document.

6. When you're finished adding annotations, at the top of the preview, click Publish.

Example 7-1    Associating Multiple Annotations

You can mark several disconnected sections of text and combine them into a single
annotation. After adding the first mark, with the annotation box still open, use the
selected tool to make additional marks on the same page (you can't join marks on
multiple pages). After you add an annotation message and click Continue, the
application draws a larger box around all the marks, and ties the single annotation
message to all of them.

How do I view document annotations?
Annotations provide a way to comment on a document. You can view annotations
when previewing the document.

1. Open the document preview. For more information, see How do I view a file?

Note: Document previews are limited to the first 100 pages of a document.

2. Optionally, filter your view of annotations by user. Click the annotations drop-down
list to select All Annotations, No Annotations, or a particular person.

Each person who adds annotations is automatically assigned a color. When
viewing all annotations, you can tell which annotations were added by the same
person because they are all in the same color.

3. Click an annotation to view it.
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While viewing the annotation, you can reply to it, like it, add it as a favorite, or add
a flag to it, just like any other message.

Document annotations are also listed in the Conversation or on the wall where the
document was uploaded. From there you can click the annotation to navigate to it in
the document preview.

What is document co-browsing?
Document co-browsing lets you see another person's browsing activity in a document
preview. For example, you can use co-browsing to go through a slide presentation with
others who are previewing the same document.

In Oracle Social Network for browsers, a row of profile pictures appears above a
document preview. These are the people who are viewing the same document you
are. You can click one of these pictures and select Browse With to follow that
person's movement through the document.

Others can click your picture to see what you are seeing. So, if you're browsing, they
see your movement, and if you're following someone else, they see that person's
movement.

Here's an example of document co-browsing among three people:

Meet John and Jane. Both of them work in different satellite offices. They are on a
phone conference, and each is looking at a preview of the fourth quarter projections
document in their web version of Oracle Social Network.

John is on page 1 of the preview, and Jane is on page 5. John clicks Jane's profile
picture above the preview, and selects Browse With. John's preview now shows page
5, the page Jane is on at the moment. As Jane scrolls through the document, John's
view mirrors her movement.

In John's view, Jane's profile picture gets bigger than his and moves to the front of the
row, before John's. This tells him that he is seeing Jane's view of the file preview.

John messages Otis, inviting him to join the teleconference and sending him a link to
the file he and Jane are previewing. Otis dials in, opens his browser, and navigates to
the file preview that John and Jane are viewing. He clicks John's profile picture above
the preview and selects Browse With. In Otis' view, John's profile picture gets bigger
than Otis' and Jane's and moves to the front of the row. Otis sees what John sees; so,
like John, Otis sees Jane's movement through the file.

Note: If Otis wanted to, he could have clicked Jane's picture. Multiple people can co-
browse with the same person.

The three of them discuss the document and come to an agreement about projection
changes. When the next steps are decided, they each leave the teleconference. Otis
clicks John's picture again and selects Stop Browsing With to leave the co-browsing
session. John clicks Jane's picture and does the same.

For more information, see How do I co-browse a file with others?

How do I co-browse a file with others?
To co-browse is to follow someone else's browsing session in a document preview.
Multiple people can co-browse the same file (see What is document co-browsing?).
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1. Open the document preview (see How do I view a file?).

2. In the row of profile pictures above the document preview, click the profile picture
of the person you want to co-browse with.

3. Select Browse With.

The selected profile picture gets bigger and moves to the front of the row to show
it is selected, and your view of the document preview mirrors that person's view.

To return to your own view, click the enlarged profile picture, and from the resulting
menu, select Stop Browsing With.

How do I create a folder?
1. On the Conversation's or wall's Documents tab, click Add, then select New

Folder.

2. Enter a name for the folder name, then click OK.

Tip: Folder names should be no longer than 256 characters.

How do I rename a folder?
1. On the Conversation's or wall's Documents tab, under the folder you want to

rename, click More, then select Rename Folder.

2. Edit the folder name, then click OK.

Tip: Folder names should be no longer than 256 characters.

How do I download a folder?
On the Conversation's or wall's Documents tab, under the folder you want to
download, click Download.

Note: Downloading a folder downloads the folder and all its contents.

How do I delete a folder?
You can delete folders you created (as long as they don't contain anyone else's
documents or folders) or folders on your profile wall.

Notes:

• If you are a service administrator, you can delete any folder.

• Deleting a folder also deletes all the files and subfolders it contains.

• Deleting a folder deletes it for all members of the Conversation or wall.

To delete a folder, on the Conversation's or wall's Documents tab, click More, then
select Delete. The folder, its contents, and the associated message are deleted.

Alternatively, delete the message that includes the folder by clicking More, then
selecting Delete.
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To restore a deleted folder and its contents, in the Messages list, locate the deleted

message icon ( ) where the folder message used to be, click , then confirm that
you want to restore the folder. The message, folder, and folder contents are restored.

Note: Only a service administrator, the person who created the folder, or the person
who deleted the folder can restore the deleted folder.
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8
Flags

These topics discuss how to use flags:

• What do the flag icons mean?

• How do I assign flags to others?

• How do I manage flags assigned to me?

• How do I view my flags?

What do the flag icons mean?
Every message posted to a Conversation or wall shows a flag icon that tells you
instantly whether a flag is assigned on the message. For example:

• If the flag icon is hollow ( ), then no flag is assigned on the message.

• If the flag icon is not hollow ( ), then one or more flags are assigned on
the message. Flags assigned to you are red, flags assigned to others are blue.

A flag's priority level reflects its urgency. Here's what the priorities mean and how their
associated flags look:

•  For Your Information (flag with "i")—Look at this when you have time.

•  Please Reply (flag with black arrow)—Look at this, and let me know what you
think.

•  Please Reply - Urgent (flag with red arrow)—Look at this now, and let
me know what you think immediately. (An email notification is always sent for
Please Reply - Urgent flags.)

To get more information about a flag, you can either mouse over the flag to see a
tooltip (for example, "For Your Information flag for another from Name.") or click the
flag icon to see all the flag assignments.

Table 8-1 explains what each flag icon means.
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Table 8-1    Flag Icons and Their Meanings

Flag Icon Priority Level Assigned To

No flag assigned No one

Please Reply - Urgent You

Please Reply You

For Your Information You

Please Reply - Urgent You and others

Please Reply You and others

For Your Information You and others

Please Reply - Urgent Someone other than you

Please Reply Someone other than you

For Your Information Someone other than you

Flags assigned to multiple people,
but not you

Others, but not you

How do I assign flags to others?
1. Click the flag icon next to the message.

2. Assign flags using the following options:

• To quickly assign a For Your Information flag to someone, click the flag next to
the person.

• To assign a particular flag to someone, select the type of flag in the drop-down
list next to the person.

• To quickly flag everyone, click Flag All (in the Not Flagged section), and
select the type of flag you want to assign.

Note: If you use the Flag All option, you might see a confirmation dialog
asking you to verify that you really want to flag that many people. Your
administrator determines when this dialog is triggered, depending on how
many other people would be flagged by the action. If the number is very large,
your administrator might choose to suppress notifications for the group; flags
will be set, but no one will receive a notification.

• To search for someone, enter part of the person's name in the search box.

Notes:

• The person you flag might get an email, depending on what they've set up through
their notifications. (Everyone gets an email when a Please Reply - Urgent flag is
assigned; that can't be controlled through the Notifications page.)

• When you change a flag priority level, the flag shows that it was assigned by you,
even if someone else assigned the original flag.
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Tip: To ensure flags say “Look at this now!”, use them thoughtfully. A flood of flag
notifications all at once or all the time can reduce their impact.

To clear others' flags:

1. Click the flag icon next to the message.

2. Clear flags using the following options:

• To quickly remove all flags (whether assigned by you or not), click Clear All
(in the Others Flagged section).

• To remove a particular flag, click  next to the person.

• To search for someone, enter part of the person's name in the search box.

Note: When you clear a flag, the person who set the flag might get an email,
depending on what they've set up through their notifications.

How do I manage flags assigned to me?
You can see all the flags assigned to you on the Flags page—from the navigation
menu on the left, select Flags. From there you can view the flagged message (and
document, if there is one), reply to the message, and clear your flag.

To clear a flag assigned to you, click the flag icon next to the message, and then click

 next to your name (at the top of the flag pop-up).

Note: When you clear a flag, the person who set the flag might get an email,
depending on what they've set up through their notifications.

How do I view my flags?
To view your flags, from the navigation menu on the left, select Flags.

You can filter or sort the flags to change your view.

• To view flags you assigned to yourself or others, click Flags You Assigned. To
return to the flags assigned to you, click Flags for You.

• To filter the flags by type, select an option from the Show menu: All, For Your
Information, Please Reply, or Please Reply - Urgent.

• To sort the flags, select options in the Sort by menu: sort by options (Flag Date or
Message Date), and the order you want them sorted in (Ascending or
Descending).

You can manage flags on the Flags page, the same as you would on an individual
message. For more information, see How do I assign flags to others?
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9
Collections

These topics describe collections and provide information about how to use them.

• What are collections?

• How do I create a collection?

• How do I add or remove related or referring items?

• How do I join a collection?

• Why can't I see some items in a collection?

• How do I view or edit a collection's membership?

• How do I make a collection public or restrict access to members-only?

• How do I mute or unmute a collection?

• How do I show or hide membership messages in a collection?

• How do I close, reopen, or discard a collection?

• How do I rename a collection?

• How do I change a collection's language?

• How do I download an archive of a collection?

What are collections?
As your lists of Conversations, Social Objects, people, and groups grow, you can
organize the ones that focus on a common topic, project, or issue into an easy-access
list, called a collection. A collection is a list of links that you create for navigating to
Conversations and walls that relate to a common idea, goal, project, or other common
interest.

Imagine that you're working toward solving a supply-chain issue. One of your vendors
was acquired by a significantly larger company, and it's causing unexpected delays in
component deliveries. You begin a series of Conversations covering possible ways to
work around it: Expediting Deliveries, Alternate Sources, Designing Around
Dependencies. As your list grows, you find you need a way to keep these related
Conversations from getting swallowed up in the exponential increase of Conversations
created by your co-workers.

Here's where collections come in. You create a collection (Resourcing) and add to it
the relevant Conversations you've created. You add members from your product team
and key people from procurement. You post a message on its wall—Let's get what we
need on time!— and flag your new membership to bring it to their attention. Other
colleagues create their own related Conversations and add them to the collection:
Going Overseas; Local Sources; Redesign Roundtable.

Now when you want to review all relevant discussions, you can go to your collection
and access every single Conversation relating to your project in one convenient
location.
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When you create your collections, you can give them meaningful names so it's easy to
identify their purposes. You can add Conversations and walls (including people's walls
and group walls) to a collection. You can also add Social Objects and other collections
to a collection to create a hierarchy.

As you, your team, and other interested parties work towards solving resource issues,
it becomes apparent that there are three main working areas:

• Helping your original source succeed

• Finding another source

• Redesigning around the dependency

The heads of each of these efforts create their own collections under Resourcing—
Outreach, Re-Sourcing, and Exploring Redesign. They add the Conversations and
walls that relate to their particular effort, and remove them from Resourcing. So now,
when you open the Resourcing collection, you see three sub-collections, each
containing links to all the Conversations and walls that are relevant to their area.

There is no limit to the levels of hierarchy you can create.

How do I create a collection?
To create a new collection:

1. From the navigation menu on the left, select Collections.

2. Click New Collection.

3. Enter a name for your collection, with a meaningful name that describes the
purpose, common interest, or organizing principle of the collection.

4. Set its visibility, either Only visible to members (members-only collection) or
Visible to everyone (public collection).

5. Move groups and people to the right column to add them or to the left column to
remove them. Use Ctrl+Click to select more than one person or group.

You can also search by entering part of a person's or group's name, and select
them from the list that pops up.

If your administrator has configured the system to allow you to invite users, you
can add someone who isn't an Oracle Social Network user. Enter the person's
email address in the search box, then click Invite email_address. When asked if
you want to send an invitation, click OK. When you save your changes an email
will be sent to the person inviting the person to join Oracle Social Network.

By default, you see a list of contacts. Click a tab to change your view:

•  Contacts—View a list of your contacts.

•  Groups—View a list of your groups.

Note: You can't add outside users (people outside your company) to a collection.

Outside users' names appear in purple text, and they have icons ( ) after
their names. For more information on outside users, see Outside Users.
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Continue by adding related items to your collection as described in How do I add or
remove related or referring items?

How do I add or remove related or referring items?
Related items are the items that have been added to the collection you're viewing.
They can include Conversations, people's walls, group walls, Social Objects, or other
collections.

Referring items are the Social Object and other collections that the collection you're
viewing has been added to (as a related item). Think of them as parent items, where
the parent item refers to one or more child items.

To add related item, on the Related tab, click + Add, and select whether to create a
new item or add an existing item.

To add referring item, on the Referring tab, click + Add, and select an existing item.

To remove a related item, on the Related tab, click Edit, then click Remove next to
the item you want to remove.

For more information, see How do I add or remove a related or referring item?

How do I join a collection?
1. From the navigation menu on the right, click Collections.

2. In the Show menu, select Available.

3. Open the collection you want to join.

4. Click the Join button at the top of the collection.

Why can't I see some items in a collection?
Collection members see only the Conversations, profile and group walls, Social
Objects, and other collections they can access. For example, Jane has access to the
Conversations Incident Reports, Incident Statistics, and Incident Cost Analysis. Jane's
coworker John has access only to the Incident Reports Conversation. All of the
incidents Conversations are part of the collection Incidents. Jane and John are both
members of this collection. In the Incidents collection, John can see only the
Conversation Incident Reports, while Jane can see Incident Reports, Incident
Statistics, and Incident Cost Analysis.

How do I view or edit a collection's membership?
The membership bar shows the collection's members and their presence status

(online, idle, offline). To edit a collection's membership, click  in the membership
bar, then click Manage. For more information, see How do I view or edit an item's
membership?
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How do I make a collection public or restrict access to
members-only?

Click , then click Make Collection Publicly Available or Make Collection
Members-Only. For more information, see How do I make an item public or restrict
access to members-only?

How do I mute or unmute a collection?
If you have items in your object lists that you never look at (for example a collection
that doesn't apply to you), or you're seeing updates in your recent activities or in your
email digests about items you don't care about, you can mute those items. Muting an
item hides it and its activity from your view. It's still there; you just won't hear about it
anymore. (The only exception is if you're flagged on a message in a muted item, for
which you will still be alerted by email based on your notification settings.)

To mute a collection, click , then select Mute Collection.

To unmute a collection, from the navigation menu, select Collections. In the Show

menu, select Muted, then open the collection. Click , then select Unmute
Collection

For more information, see How do I mute or unmute an item?

How do I show or hide membership messages in a
collection?

When a user is added to or removed from a collection a membership message is
posted to the collection (for example, The collection is now accessible to: John Doe). If
you'd prefer not to see those messages, you can hide them.

Click , then select Hide Membership Messages or Show Membership
Messages. For more information, see How do I show or hide membership messages?

How do I close, reopen, or discard a collection?
You can close any collection you belong to, even if you didn't create it. Closing a
collection prevents people from adding new messages to it and removes it from
people's list of collections.

To close a collection, click , then select Close Collection.

To reopen a collection, from the navigation menu, select Collections. In the Show

menu, select Closed, then open the collection. Click , then select Reopen
Collection

You can discard a collection only if you're the sole member. A discarded collection is
removed from all lists, including other collections and Social Objects it's related to.
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To discard a collection, click , then select Discard Collection.

For more information, see How do I close, reopen, or discard an item?

How do I rename a collection?
Click , then click Rename Collection. For more information, see How do I rename
an item?

How do I change a collection's language?
If you want system messages in a collection to appear in a language other than the
default language, you can change the language setting. The language setting affects
all members' views of the collection.

Click , then select Set Language. For more information, see How do I set the
language for an item?

How do I download an archive of a collection?
You can download an archive of a collection to view the collection offline or to save the
content at a certain point.

To download an archive of a collection, click , then select Download and save the
file.

To work with the archive, unzip the files to your computer, and open index.html.

For more information, see How do I download an archive of an item?
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10
Working with Groups

These topics provide information about groups in Oracle Social Network. They
describe how to create a group, manage group membership, and other types of people
and group-related tasks. It includes the following sections:

• What are groups?

• How do I view groups?

• How do I create a group?

• How do I manage members in a group?

• How do I edit a group's name, description, or picture?

• How do I post, edit, reply to, or delete a message on a group's wall?

• How do I start a Conversation with a group?

• How do I mute or unmute a group?

• How do I deactivate or reactivate a group?

What are groups?
A group is a set of users that have a common position, goal, or concern. Using groups
makes it easy to ensure that you include the right people in new conversations or
when posting new documents and such. For example, you probably want to create
groups for each department in your organization, but also for each project or
committee, or for other designations that fit your company.

The great thing about using groups is that you can make sure no one is accidentally
left out of a discussion. And, if someone new needs to be included, you can add them
to the group rather than tediously adding them to each conversation, social object, and
such that they need to know about.

How do I view groups?
To view your groups:

1. From the navigation menu on the left, select Groups.

2. In the Show menu, select a filter to adjust your view:

• Yours—The groups you're a member of

• Favorites—The groups you have marked as favorites

• Muted—The groups you've muted

For more information, see How do I mute or unmute a group?

3. Optionally, select options in the Sort by menu to change how the groups are
sorted and whether they are sorted in ascending or descending order.
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4. Click a listed group to open its wall. For information on posting to a group wall, see 
How do I post, edit, reply to, or delete a message on a group's wall?

Tip: A group can be deactivated to prevent it from being added to more Conversations
and to disable new posts to its wall. A deactivated group is not removed from the
Conversations it already belongs to. To view Deactivated Groups, select Deactivated
in the Show menu. For more information, see How do I deactivate or reactivate a
group?

Click a listed group to open its wall. You can also view the following details about a
group:

• To see which items the group belongs to, click Member Of.

Optionally, select an object type in the Show menu (for example, Conversations or
collections) and select sort options in the Sort By menu.

• To see the documents posted to the group's wall, click Documents.

• To see who's in a group, scroll through the members in the membership bar, or

click .

• To see any items the group has been added to as a related resource, click
Referring.

How do I create a group?
To create a group:

1. From the navigation menu on the left, select Groups.

2. Click New Group.

3. In the Group Name box, enter a name for the group.

4. Under Search for and Add New Members, move groups and people to the right
column to add them. For more information about adding members, see How do I
manage members in a group?

To add a group description and profile picture, see How do I edit a group's name,
description, or picture?

How do I manage members in a group?
To add or remove members from a group:

1. Open the Group, click , then click Manage.

Note: If you don't see the Manage button, the group is managed externally (for
example, through LDAP), so you can't change the membership through Oracle
Social Network.

2. In the Manage Members dialog, move groups and people to the right column to
add them or to the left column to remove them. Use Ctrl+Click to select more than
one person or group.

You can also search by entering part of a person's or group's name, and select
them from the list that pops up.
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If your administrator has configured the system to allow you to invite users, you
can add someone who isn't an Oracle Social Network user. Enter the person's
email address in the search box, then click Invite email_address. When asked if
you want to send an invitation, click OK. When you save your changes an email
will be sent to the person inviting the person to join Oracle Social Network.

By default, you see a list of your contacts. Click a tab to change your view:

•  Contacts—View a list of your contacts.

•  Groups—View a list of your groups.

Notes:

• You can't add outside users to a group. Outside users' names appear in purple

text, and they have icons ( ) after their names. For more information on
outside users, see Outside Users.

• Some system configurations prevent you from removing yourself from a group. For
example, you can't remove yourself from a group that is synced up with a group in
your LDAP directory.

• If you remove yourself from a group, you also remove yourself from every item the
group is a member of. After you remove yourself from an item, you can't add
yourself back in. You must ask another member to do that for you.

How do I edit a group's name, description, or picture?
To edit a group:

1. Open the group.

2. Click , then click Edit Profile.

3. Edit the group's name or description as desired.

4. To change the group's picture, click the picture, then select Upload Photo. Select
a .gif, .png, or .jpg file. After you select a picture, you can use the crop tools to re-
size it. The picture is scaled to 150x150 pixels.

Note: If you use Mozilla Firefox and JAWS, you must disable pop-ups before you
upload a profile picture. If you don't disable pop-ups, the upload dialog won't
appear.

If you want to remove the group's picture and just use the default avatar, click then
picture, then select Remove Photo.

How do I post, edit, reply to, or delete a message on a
group's wall?

Like individual people, groups have their own identities, which include their own walls.
On a group wall, group members can post messages and content of interest to the
group.
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You work with group wall messages like any other message. For more information,
see Messages.

How do I start a Conversation with a group?
1. Open the group.

2. Click , then click Create New Conversation.

3. Enter a title for the Conversation, and, optionally, change the visibility or
membership of the Conversation. For more information, see How do I start a
Conversation?

How do I mute or unmute a group?
When you mute a group, it affects only your view. Muting hides the group from your list
of groups and prevents the group's recent activities from appearing in your daily email
digest, in the Recent Activities panel, and on the Overview page. Here are some
more facts about muting:

• Muting hides the group from the Yours and Favorites lists on the Groups page.

• Flags assigned on a message in a muted group wall still appear in your daily email
digest (for information about the daily email digest, see How do I set up or change
my notifications?).

• You can continue to post messages to a muted group's wall.

To mute a group:

Open the group, click , then select Mute Group.

To view muted groups:

From the navigation menu on the left, select Groups, then, in the Show menu, select
Muted.

To unmute a group:

Open the muted group, click , then select Unmute Group.

How do I deactivate or reactivate a group?
You can deactivate a group you belong to, even if you didn't create it. Deactivating a
group prevents it from being added to more Conversations, disables new posts to its
wall, and moves the group to the Deactivated list in the Groups panel. A deactivated
group is not removed from the Conversations it already belongs to.

To deactivate a group:

Open the group, click , then select Deactivate Group.
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To view deactivated groups:

From the navigation menu on the left, select Groups, then, in the Show menu, select
Deactivated.

To reactivate a group:

Open the deactivated group, click , then select Activate Group.
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11
Finding Content

This section talks about finding content through search, hashtags, and favorites.

• How do I perform a global search?

• How do I search within a Conversation or wall?

• How does search work?

• What are hashtags (#) and how do I use them?

• How do I mark a wall, Conversation, or message as a favorite?

How do I perform a global search?
1. Enter at least two characters in the search box at the top of the Social panel, then

press Enter or click .

2. Optionally, select a filter from the Show menu to show a particular result type (for
example, Conversations or documents).

3. After filtering by a result type, you see some additional sort and filter options. Click
 to see additional options.

• Sort By: Select how to sort your results.

• Posted By: Limit your search to messages or documents posted by a
particular person.

• Posted When: Limit your search to messages or documents posted within a
particular period.

• Updated By: Limit your search to Conversations, collections, hashtags, or
Social Objects updated by a particular user.

• Updated When: Limit your search to Conversations, collections, hashtags, or
Social Objects updated within a particular period.

• Created By: Limit your search to Conversations, collections, groups, or Social
Objects created by a particular user.

• Created When: Limit your search to Conversations, groups, or Social Objects
created within a particular period.

• Includes Member: Limit your search to Conversations, collections, groups, or
Social Objects with a particular member.

• Favorites Only: Limit your search to only your favorite Conversations,
collections, or Social Objects.

• Include Public: Control whether to show public Conversations, collections, or
Social Objects in your results.

• Include Closed: Control whether to show closed Conversations, collections,
or Social Objects in your results.
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• Document Type: If you filter your results to show documents, you can select
which types of documents to show.

• Include Deactivated: Control whether to show deactivated groups in your
results.

Click a result to open it.

How do I search within a Conversation or wall?

• To find unread messages, click the unread messages count ( ) in the

toolbar, and use the up and down arrows ( ) to navigate through the
unread messages.

• To find flags assigned to you, click the flag count ( ) in the toolbar, and use

the up and down arrows ( ) to navigate through your flags.

• To find text in the messages or documents, click the search icon in the toolbar,
enter the text you want to search for, then press Enter. The matching text is

highlighted in the messages. Use the up and down arrows ( ) to
navigate through the results.

How does search work?
Search is full-text: It looks in titles as well as in content.

Search looks for terms, phrases, and excluded terms. For example:

• brown cow (no quotes) finds all results that contain both "brown" and "cow." A
result is treated as more relevant if the search terms appear together in order
("brown cow"). A result is also more relevant if it's in the object's title. The result
set also includes stemmed variants, like "browned cows."

• "brown cow" (quotes) finds all results that contain the exact phrase "brown cow." It
doesn't find "brown cows" or "the cow is brown."

• brown cow -dairy (no quotes) finds all results that contain the words "brown" and
"cow" but do not contain the word "dairy."

Global search provides two types of search results: substring and keyword.

Substring search results appear in the search results pop-up and include items with
names that match your search terms. In substring search results, you can click a result
type, like Conversations, to view just the results for that type.

Keyword search results:
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• Include items with names or content that match some or all of your search terms,
or variations on some or all of your search terms (like run, runs, ran, running).

• Are listed by default according to how relevant they are to your search terms. You
can change the sorting to date order. After changing your sort to date order, you
can click the Sort by menu again, to change the sort from Descending to
Ascending (to see the oldest results first).

• On the search results page, you can use filters to narrow your results to just the
type of items you want to see. For example, click Documents to see only the
documents that were returned by your search.

After you select a filter, you can sort or further filter by the user who posted the
item or the date it was posted. In the Posted By box, enter the user whose posts
you want to see in the results. Select the user from the drop-down list. You can
combine the Posted By filter with item type filters to narrow your results further.

What are hashtags (#) and how do I use them?
You can use a hashtag (#) in a message to call out a meaningful term or topic, making
it easy to find all content associated with that term or topic. For example, imagine
discounts is a popular topic in your group, but the discounts can come in the form of
dealer incentives, cash-back deals, seasonal discounts, or any other number of forms.
How do you find what everyone is saying about all those things? You use a hashtag.
Every time you or your colleagues say something about some form of discount, you
include the hashtag #discounts.

You can then click a #discounts hashtag link to view a list of all messages in otherwise
unrelated Conversations and walls that contain the hashtagged term.

Adding Hashtags

You can add one or more hashtags to any message (comments, replies, annotations,
and document messages) simply by typing "#" before a term. When you start typing a
hashtag by typing "#" plus at least one letter, existing hashtags (ones that have been
used before) appear for you to select from.

Tips:

• You can include the following characters in a hashtag: A through Z, a through z, 0
through 9 and _.

• A hashtag can be a maximum of 25 characters (not including the "#").

Searching for and Viewing Hashtags

When you perform a search, available hashtags are included in the results. You can
limit your search results to hashtagged messages by starting your search term with a
hashtag (#).

Wherever you see them, hashtagged terms are clickable and will open a hashtag page
where all messages that include that hashtag are shown. So clicking #discounts in any
Conversation opens a #discounts page which shows any message (in a Conversation,
document annotation, wall, or such) that you have access to that includes the
discounts hashtag.

On the hashtag page, you can filter the messages to show all messages that include
the hashtag (All Results) or just those messages posted by people you are following
(By People You Follow).
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Following Hashtags

You can also follow hashtags. When you follow a hashtag, messages in public
Conversations and walls that contain that hashtag appear in recent activities (from the
navigation menu on the left, select Overview), even if you are not a member of those
Conversations or walls.

To follow a hashtag, click the hashtag to open the hashtag page, then click Follow at
the top of the page. To stop following the hashtag, click Unfollow.

How do I mark a wall, Conversation, or message as a
favorite?

Marking an item as a favorite is an easy way to keep track of the items you use most

frequently. To mark an item as a favorite, click  next to the item; click the star again
to unmark it.

While viewing a list of objects (Conversations, collections, groups, or Social Objects),
you can limit the list to your favorites by clicking Show, then clicking Favorites.

To view all your favorites, including messages, from the navigation menu on the left,
select Favorites.

You can filter or sort your favorites to change your view.

• To filter your favorites by object type (for example, messages, documents, or
groups), select an option from the Show menu.

• To sort your favorites, select options in the Sort by menu: sort by options (Date
Added or Name), and the order you want them sorted in (Ascending or
Descending).
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12
Settings and Accessibility

These topics discuss how to customize your settings and use accessibility in Oracle
Social Network settings:

• How do I set up or change my notifications?

• How do I change my preferences?

• How do I change my wall settings?

• How is the social network accessible?

• What keyboard shortcuts are available to the social network?

How do I set up or change my notifications?
Notifications let you know when certain events occur in Oracle Social Network, like
when someone flags you, or when someone clears a flag that you have set. When
you're using Oracle Social Network in your browser, notifications are sent via email.
You can set up your notifications to send emails just for the events you're interested in.

1. Click the arrow next to your name at the top of the application, then click Settings.

2. Make sure Notifications is selected on the left.

3. In the Email field, type the address where you want your notifications to be sent.

4. Use the check boxes to indicate the events you want to be notified about. Set the
time and date stamp format, if desired.

Note: Regardless of the options you set, when a Please Reply - Urgent flag is
assigned to you, you'll always receive an email notifying you of the assignment.

How do I change my preferences?
You can customize your Oracle Social Network experience by using the Settings
option in your browser.

1. Click the arrow next to your name at the top of the application, then click Settings.

2. Click Preferences.

Use the options on the Preferences page to:

• Change your interface language or date format.

If you change the primary language, all the buttons, labels, and so on are
changed to the language you choose. The things you supply, like messages
and documents, are in the language used when you posted the message or
when the file was created.

Note: You can also specify a language for just a single Conversation. See 
How do I set the language for an item?

• Specify whether to use the Enter key or the Post key to post messages.
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• Control whether you see a message every time someone joins or leaves a
Conversation or wall.

• Specify whether to open One-on-One Conversations in a mini window or as a
full Conversation.

• Mark all messages in every Conversations as read, so you don't have to do it
on a Conversation-by-Conversation basis.

3. Click Wall.

Use the options on the Wall page to:

• Control whether your followers or only you can post to your wall

• Control whether your followers or only you can reply to messages and
annotate documents on your wall

• Delegate users to post on your behalf

How do I change my wall settings?
1. Click the arrow next to your name at the top of the application, then click Settings.

2. Click Wall.

Use the options on the Wall page to:

• Control whether your followers or only you can post to your wall

• Control whether your followers or only you can reply to messages and
annotate documents on your wall

• Delegate users to post on your behalf

How is the social network accessible?
You can use your keyboard to navigate your social network. To see a list of keyboard
shortcuts, make sure focus is in the social network area of your application, and press
the question mark key (?). For more information, see What keyboard shortcuts are
available to the social network?

Tips

• To navigate between list items and messages, use up and down arrow keys.

• To navigate into the elements of a listed item, like a Conversation, press Shift
+Enter.

• To manage flags in the Manage Flags pop-up, press Enter to assign or change a
flag, or press Delete to clear a flag.

• When you press Esc to close a dialog, focus moves to the button used to open the
dialog, even if you used a keyboard shortcut to open the dialog.

Notes:

• The supported screen reader browser is Mozilla Firefox 26 or later with the latest
version of your screen reader software.

• If you use a Mac, by default Tab moves to the next object that isn't a link.
Therefore, to move to the next tappable element, you must use Option+Tab or
change your browser preferences to switch the behavior.
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There are a few known issues with screen readers:

• When you search in the Manage Membership dialog, your screen reader might not
indicate that focus has moved from search results to the Groups and Contacts
list. You also might not be able to select the first listed result.

• Your screen reader will read annotation messages in a Conversation or on a wall,
but it can't also describe where it is placed in a document preview. An annotated
document preview is essentially a picture of a document with marks on it, and
screen readers do not read pictures.

For information about accessibility in the Add-In for Microsoft Outlook, see How do I
increase the add-in's accessibility?

For information about Oracle and accessibility, visit the Oracle Accessibility Program
at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

What keyboard shortcuts are available to the social
network?

Your social network offers keyboard shortcuts and support for keyboard navigation. To
see a list of keyboard shortcuts, make sure focus is in the social network area of your
application, and press the question mark key (?).

Note: If you're using a screen reader, the social network keyboard shortcuts work only
if your focus is in application mode (for example, in a list of messages in a
Conversation or on a wall), so they won't otherwise interfere with your screen reader's
keyboard shortcuts. However, you can use your screen reader's pass-through or
bypass functionality if you want to use the social network keyboard shortcuts outside
of application mode.

Keyboard shortcuts are available for the following types of actions:

• Application—Use these shortcuts anywhere they are relevant in the application.
For example, pressing ESC works when you're in a menu or dialog, and doesn't
work when you're not; pressing "j" or "k" works in a list, but doesn't work outside a
list.

• Jumping—Use these shortcuts anywhere in the application. They jump you to a
different view or to the current view's navigation actions.

Notes:

– Jumping shortcuts are available only when the navigation menu is in view.
When the navigation menu is not in view, the social network does not respond
when you use jumping shortcuts.

– A Social Object's wall does not show the navigation menu when you open it
from its details page.

• List Actions—Use these shortcuts with the list item that currently has focus.

• Conversation/Wall Actions—Use these shortcuts within Conversations and on
walls.

Note: Some of these shortcuts work regardless of the current focus, for example,
"t," "b," "o," "u." Some of them operate differently depending on the current focus,
for example, in a Conversation "m" and "v" mark all messages as read and mark/
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unmark the Conversation as a favorite; on a message, "m" and "v" mark the
message as read and mark/unmark it as a favorite.

• Message Actions—Use these shortcuts with the message that currently has
focus.

• Post and Reply Entry Actions—Use these shortcuts within the post and reply
entry areas.

You can add one or more hashtags to any message (comments, replies,
annotations, and document messages) simply by typing "#" before a term. When
you start typing a hashtag by typing "#" plus at least one letter, existing hashtags
(ones that have been used before) appear for you to select from. Use the up and
down arrows to select an existing hashtag, then press Enter or Tab to use the
selected hashtag. For more information, see What are hashtags (#) and how do I
use them?
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13
Tips and Tricks

Here are some suggestions for using Oracle Social Network more effectively.

• How can I see usage information about my session?

• How do I access the administration features?

• Where can I find additional tips and troubleshooting information or report a
problem?

• How do I get support?

• How do I find out more about the Oracle Social Network product?

• How do I remove past employees from Conversations?

• How can I search for a term within a single Conversation?

• How can I flag a group?

• How can I link to a particular post in a Conversation?

• How do I enable others to request membership to my group?

• I get added to too many Conversations. How do I stop that?

• How can I work offline?

• How do I know what version I'm using?

How can I see usage information about my session?
If you click the arrow next to your name at the top of the application, you might see an
option called Analytics. This option is not available to all instances of Oracle Social
Network, but if you see it, you can click it to see your personal usage statistics. If
you're an administrator, you'll see more global information about the Oracle Social
Network instance, as well as individual user information.

How do I access the administration features?
If you're an administrator, you can manage the Oracle Social Network instance by
clicking the arrow next to your name at the top of the application, and selecting
Administration.

Note: The Administration option is displayed only if you are logged in as a user with
administrator privileges.

Where can I find additional tips and troubleshooting
information or report a problem?

The Oracle Social Network Community Forum is the place to go to get more
information about real-world use cases, tips, and troubleshooting. Share info with your
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peers, or get advice from the people who helped to design and build Oracle Social
Network.

If you're in a browser, click the arrow next to your name at the top of the application,
then select Community, or go there directly with this URL:

https://forums.oracle.com/community/developer/english/cloud_computing/oracle-social-
network-cloud-service

If you're using Outlook, Desktop, or mobile, look for a Community option on the Help,
Settings, or About menus.

How do I get support?
Click the arrow next to your name at the top of the application, then click Support.
Then follow the numbered steps on the Support page.

You can also visit the Oracle Social Network Community Forum (see Where can I find
additional tips and troubleshooting information or report a problem?).

How do I find out more about the Oracle Social Network
product?

The Oracle Social Network has a Facebook presence that includes product news. You
can view the Facebook feed by clicking the arrow next to your name at the top of the
application, and selecting Product News

How do I remove past employees from Conversations?
You can remove anyone from a Conversation's membership bar by clicking  in the
membership bar, then clicking Manage. However, you can't remove the name and
avatar from posts someone made before leaving the company, because that person
might have been assigned flags or assigned flags to others. Leaving the person's
posts in Conversations allows other Conversation participants to decide how to deal
with those flags; for example, reassigning or simply clearing them. (Note that the
person's account is disabled, so the avatar should be in permanent offline status.) In
addition, although someone might have left the company, his or her posts might still
supply valuable information, and they also provide an accurate historical record of
what transpired within the Conversation(s). Stripping the person's name and avatar
from those posts would essentially leave those posts unattributed, likely causing a
great deal of confusion for anyone reading the Conversation end to end.

How can I search for a term within a single Conversation?
The Outlook add-in provides controls for this:

1. Open the Conversation you want to search.

2. Click Find messages in Conversation, which is the icon that looks like a
magnifying glass.

3. In the Find drop-down, select Messages.
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4. Enter the search term in the Text field.

5. Use the up and down arrows to step through the search results.

If you're using Oracle Social Network in your browser, it's still possible to search for
individual keywords across all Conversations:

1. Enter the search term in the search field at the top.

2. Press Enter or click the search icon to display the full-text search results.

3. In the search results, click Conversations on the left.

4. Find the Conversation you want, then click Show more messages to see all the
messages containing the keyword.

How can I flag a group?
Because you'll typically want to set a different priority level for each member of a group
individually, based on each person's level of responsibility relative to the post, Oracle
Social Network does not currently provide the ability to flag all members of a group
simultaneously.

How can I link to a particular post in a Conversation?
Although there's no formal support for this in Oracle Social Network, here's a handy
workaround:

1. In your browser, find the message you want to link to.

2. Click  to mark it as a favorite.

3. Click the post you marked in step 2 to go to it.

4. In the browser address bar, copy the URL, then paste it where you want the link to
appear.

How do I enable others to request membership to my
group?

There is no formal method for this, but consider starting a public Conversation called
something like "Group Access Requests", where you can announce the creation of
groups and allow interested parties to post a message requesting membership. Then
you can go through and add those folks to the requested groups explicitly.

I get added to too many Conversations. How do I stop that?
If you’re a member of a group that frequently gets added to a lot of Conversations or a
collection that spawns a lot of Conversations that you don't care about, you can
remove yourself from the group or collection. However, do so only after careful
consideration. Once you're outside the group or collection, you can be added back in
only by someone on the inside, and you may miss out on valuable information in the
meantime. A better alternative is to simply mute the Conversations you don't want to
keep track of. By default those Conversations will no longer appear in your
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Conversations list, although you can see them at any time by applying the Muted filter.
(And if you're flagged in a Conversation that you've muted, you'll still be notified.)

How can I work offline?
You have several options:

• If you've downloaded the Desktop application, you can take advantage of its
Offline Briefcase feature. Before you go offline, scan through your Conversations
and choose the ones you want to download into your virtual briefcase. When
offline, bring up the Desktop application and open your briefcase. Open a
Conversation, then make new posts, respond to posts, add documents—in other
words, interact just as you would if you were online. When you get back online,
just click a button to upload all Conversations with the changes you've made.

• While in a Conversation, you can click More, then click Download to download
the Conversation to your hard drive. The resulting zip file contains a directory for
documents belonging to the Conversation, as well as an index.html file with all the
Conversation's posts. (The Offline Briefcase, by contrast, has everything
integrated for you.) When you open the index file, you can use the Reply link to
respond to a post via email. As soon as you're back online and open your email
client, your messages are posted to the Conversation(s).

• If you've set your notifications to send an email digest at the end of each day, you
can also view that while offline, provided that your email application provides such
a mode.

How do I know what version I'm using?
Version information is available on the About page, which appears in different places
depending on if you're using the web, Outlook, Desktop, or a mobile client:

Table 13-1    Getting to the About Page in Oracle Social Network Clients

Client Navigation

Web Browser Click the arrow next to your name at the top of the application,
then click About.

Outlook Add-In Open the Help menu ( ) at the bottom of the add-in, then click
About Oracle Social Network.

Desktop
Click the Help menu ( ) at the bottom left of the sidebar, then
click About Oracle Social Network.

Mobile: Android

Tap  in the action bar to open the slide-out navigation,

then tap  Settings, and look under About.

Mobile: iPhone and iPad In the navigation bar, tap About.
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14
Using Oracle Social Network with Microsoft
Outlook

These sections introduce the Oracle Social Network add-in for Microsoft Outlook and
describe how to use it:

• Getting Started with the Oracle Social Network Add-In for Outlook

• Disabling and Re-Enabling the Add-In for Outlook

• Managing Your Oracle Social Network Account in the Add-In for Outlook

• Configuring Your Settings for the Add-In for Outlook

• Setting Up Your Profile in the Add-In for Outlook

• Using Flags in the Add-In for Outlook

• Using Conversations in the Add-In for Outlook

• Using Collections in the Add-In for Outlook

• Using Documents and Folders in the Add-In for Outlook

• Working with People and Groups in the Add-In for Outlook

• Using Social Objects in the Add-In for Outlook

• Interacting with Microsoft Outlook in the Add-In

• Liking and Adding Favorites in the Add-In for Outlook

• Using Search in the Add-In for Outlook

• Working Offline

Getting Started with the Oracle Social Network Add-In for
Outlook

This section describes how to get started with the Oracle Social Network Add-In for
Outlook:

• What is the Oracle Social Network add-in for Outlook?

• How do I download and install the add-in for Outlook?

• How do I log-in to the add-in for Outlook?

• Understanding add-in panel and action icons

• What do the icons next to items mean?

• How do I increase the add-in's accessibility?

• How do I enable screen reader mode?

• What keyboard shortcuts are available for navigating the add-in for Outlook?
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• What keyboard shortcuts are available in Conversations and walls?

What is the Oracle Social Network add-in for Outlook?
The add-in is the Oracle Social Network client that is integrated with your Microsoft
Outlook application. Use the add-in to access your Oracle Social Network
Conversations, collections, documents, flags, Social Objects, and other features within
Outlook.

The add-in supports both 32 and 64 bit versions of Microsoft Outlook 2007, 2010, and
2013.

For more information, see:

• How do I download and install the add-in for Outlook?

• How do I increase the add-in's accessibility?

• What keyboard shortcuts are available for navigating the add-in for Outlook?

How do I download and install the add-in for Outlook?
1. Close Microsoft Outlook.

2. Get the .exe installation file from the Downloads page in the full version of Oracle
Social Network (in your browser):

a. Log in to Oracle Social Network in your browser.

b. Click the arrow next to your name at the top of the application, then click
Downloads.

c. On the Downloads page, click the link under Add-in for Microsoft Outlook
to start the download.

3. Run the .exe installation file.

4. Follow the instructions in the install wizard.

How do I log-in to the add-in for Outlook?
Important: If you received an email invite to join Oracle Social Network, you must log
in through the web client and change your temporary password before you use the
add-in for Outlook. Click the link in the invite to open the web client.

After you install the add-in, the first time you open Outlook, you'll be prompted for your
Oracle Social Network login information:

1. If necessary, in the Server field, enter the URL to your Oracle Social Network
client.

For example, if your Oracle Social Network URL is
acme.social.us1.oraclecloud.com/osn then you would enter
acme.social.us1.oraclecloud.com/client.

2. In the User Name field, enter your Oracle Social Network user name.

3. In the Password field, enter your Oracle Social Network password.

4. To log in automatically in future sessions, select Remember password.

Chapter 14
Getting Started with the Oracle Social Network Add-In for Outlook

14-2



5. To give yourself the option of selecting a different account at login, select Ask for
an account at startup.

6. Click Sign In.

You can pre-configure one or more Oracle Social Network accounts and easily switch
between them. For more information, see:

• How do I set up a new account?

• How do I switch between add-in accounts?

Understanding add-in panel and action icons
In addition to labels, the add-in for Outlook uses many icons to make destinations,
object types, and actions easy to discover. For example, the navigation bar at the top
of the add-in uses icons to represent the add-in's main destinations. Your add-in
instance might show all or a selection of these icons.

This table catalogs the main add-in icons and explains what they're for.

Table 14-1    Icons in the Oracle Social Network Add-In for Outlook

Icon Name Description

Overview Shows the latest actions of the people you follow,
the latest posts in the Conversations and walls
you're a member of, and messages that include
hashtags you follow (from public Conversations
and walls, even those you are not a member of).

• New Conversation
• Options

On the Overview panel, these icons are available
for creating a new Conversation and accessing
Overview panel options. Options include creating a
new Conversation and filtering your list of
messages.

Flags Shows a list of flags assigned to you or that you
assigned, depending on the filter you apply.

For more information, see Using Flags in the Add-
In for Outlook.

Options The Options menu on the Flags panel has filtering
and sorting options for your list of flag
assignments.

Favorites Shows the items you marked as a favorite. The list
can include messages, documents,
Conversations, walls, Social Objects, and
collections.

For more information, see Liking and Adding
Favorites in the Add-In for Outlook.
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Table 14-1    (Cont.) Icons in the Oracle Social Network Add-In for Outlook

Icon Name Description

Options The Options menu on the Favorites panel has
filtering and sorting options for your list of
favorites.

Conversations Shows the Conversations you're a member of or
that are available to you to join (public
Conversations), depending on how you filtered
and sorted the list.

For more information, see Using Conversations in
the Add-In for Outlook.

• New Conversation
• Options

On the Conversations panel, these icons are
available for creating a new Conversation and
accessing Conversation panel options. Options
include creating a new Conversation, and filtering,
sorting, and arranging your list of Conversations.

Collections Shows the collections you created or are a
member of.

For more information, see Using Collections in the
Add-In for Outlook.

• Create a new Collection
• Options

On the Collections panel, these icons are available
for creating a new collection and accessing
Collections panel options. Options include creating
a new collection and filtering, sorting, and
arranging your list of collections.

• Find documents
• Add Documents
• Options

On the Documents panel, these icons are
available for searching exclusively for documents,
adding documents from your local file system, and
accessing Documents panel options. Options
include finding, adding, and filtering documents.

People and Groups Depending on which tab you select, the People
and Groups panel shows your list of contacts; a list
of the groups you are a member of; and lists of
people who follow you, who you follow, and people
recommended to you as contacts.

For more information, see Working with People
and Groups in the Add-In for Outlook.

• Contacts
• Groups
• People You Follow
• Your Followers

This row of tabs on the People and Groups panel
is for navigating to its various lists of people and
groups.

Social Objects Shows all the Social Objects you are a member of.
Click this icon to open a selection list of all types of
Social Objects.

For more information, see Using Social Objects in
the Add-In for Outlook.

At the bottom of the panel, icons are available for opening three menus:

• Accounts—  The Accounts menu has options for switching your view to
additional Oracle Social Network accounts, opening the Manage Accounts dialog
to create or delete accounts, and working offline or reconnecting to the server.
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(For more information, see What are Oracle Social Network accounts? and 
Working Offline.)

• Help—  The Help menu has options for opening Oracle Social Network Help
Center, contacting Oracle Support, navigating to discussion forums about Oracle
Social Network (Community), and accessing the About dialog with its links to the
latest versions of the add-in and troubleshooting help (see How can I troubleshoot
my accounts?).

• Settings—  The Settings menu has options for navigating to your wall or your
preferences, editing your profile, displaying message fragments or full view,
monitoring file transfer progress, or opening the full view of Oracle Social Network.
(For more information, see Configuring Your Settings for the Add-In for Outlook.)

What do the icons next to items mean?
When item names appear in selection lists, they are accompanied by small icons that
identify the item's type. Here's what they mean.

Table 14-2    Item Type Icons in the Add-In for Outlook

Icon Item

Private, members-only, or One-on-One Conversation

Public Conversation

Profile or group wall

Collection

  

Social Object (Social Object icons will vary from business to
business)

Outside user (a person outside your company)

How do I increase the add-in's accessibility?
When the default setting Enable Screen Reader is enabled in the add-in for Outlook,
messages are accessible (this view is called compact view). In compact view, you can
access the full text of any message by navigating to the message, which automatically
opens the full message in a tooltip. In compact view, you can also navigate to any
message that you posted and press Enter to open the full message in an editor.

Note: To ensure your screen reader delivers the entire message, be sure to set it to its
most verbose level.

For more information, see:
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• How do I enable screen reader mode?

• What keyboard shortcuts are available for navigating the add-in for Outlook?

How do I enable screen reader mode?

Click  at the bottom of the panel, then click Enable Screen Reader Mode.

Messages are now shown in compact view (where no more than two lines of any
message are shown), and the add-in for Outlook is switched to accessibility mode.

Alternatively, you can enable screen reader mode in Preferences:

1. Click  at the bottom of the panel, then click Preferences to open the User
Profile dialog.

2. Under Conversation View, select Enable Screen Reader Mode.

3. Click OK.

What keyboard shortcuts are available for navigating the add-in for
Outlook?

• Ctrl+Alt+Shift+T—Toggle the add-in panel between open and closed

• Ctrl+Alt+Shift+O—Switch keyboard focus from Outlook to the add-in panel

• Up Arrow/Down Arrow—Move around within a section

• Tab—Move down from section to section

• Shift+Tab—Move up from section to section

• Ctrl+Tab—Move out of any message area to other controls

• Select item+Spacebar or select item+Shift+F10—Opens the Options menu on
any item, including messages, flags, banners—wherever there is an Options
menu

Use your keyboard's Up and Down Arrow keys to navigate menu options.

Note: You can navigate tab bars using your keyboard's left and right arrow keys. For
example, you can use your keyboards arrow keys to navigate the tab bar in a
Conversation.

Note, however, if you navigate left from the first tab or right from the last, the tab bar
loses focus, and you must use your keyboard's Tab (forward) or Shift+Tab (backward)
keys to return focus to it.

What keyboard shortcuts are available in Conversations and walls?
• Select Conversation+Enter—Opens a detailed view of the selected Conversation
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• Ctrl+Alt+Shift+V—Moves from a Conversation or wall's detailed view to the list
view

For example, this shortcut moves from a Conversation's details to the list of
Conversations; from a group wall to the list of groups; from a collection's wall to
the list of collections; and so on.

• Select message+Enter—Opens a dialog for viewing and editing messages you
post

• Ctrl+Tab—Move from area to area in the Edit Entry dialog

Note: You can navigate tab bars using your keyboard's left and right arrow keys. For
example, you can use your keyboards arrow keys to navigate the tab bar in a
Conversation.

Note, however, if you navigate left from the first tab or right from the last, the tab bar
loses focus, and you must use your keyboard's Tab (forward) or Shift+Tab (backward)
keys to return focus to it.

Disabling and Re-Enabling the Add-In for Outlook
This section describes how to disable and re-enable the add-in for Outlook:

• How do I disable the add-in for Outlook in Outlook 2007?

• How do I disable the add-in for Outlook in Outlook 2010 or 2013?

• How do I re-enable the add-in for Outlook in Outlook 2007?

• How do I re-enable the add-in for Outlook 2010 or 2013?

How do I disable the add-in for Outlook in Outlook 2007?
The Oracle Social Network add-in for Outlook is like any other Outlook add-in. The
steps you take to disable it are the same for all types of add-ins.

1. From the Tools menu, select Trust Center to open the Trust Center dialog.

2. Click Add-ins to show the list of Outlook add-ins.

3. Verify that Oracle Social Network Add-In for Outlook is included in the list.

4. At the bottom of the dialog, ensure that COM Add-Ins is selected next to Manage.

5. Clear the check box Apply macro security settings to installed add-ins

6. Click Go to open the COM add-ins dialog.

7. Clear the check box next to Oracle Social Network Add-In for Outlook.

8. Click OK.
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How do I disable the add-in for Outlook in Outlook 2010 or 2013?
The Oracle Social Network add-in for Outlook is like any other Outlook add-in. The
steps you take to disable it are the same for all types of add-ins.

1. From the File menu, select Options then add-ins to open the Trust Center dialog
with add-ins selected.

2. Verify that Oracle Social Network Add-In for Outlook is on the list of add-ins.

3. At the bottom of the dialog, ensure that COM Add-ins is selected next to Manage.

4. Clear the check box, Apply macro security settings to installed add-ins.

5. Click Go to open the COM add-ins dialog.

6. Clear the check box next to Oracle Social Network Add-In for Outlook.

7. Click OK.

How do I re-enable the add-in for Outlook in Outlook 2007?
If you have disabled the add-in for Outlook, in Outlook 2007, you can re-enable it as
you would any other Outlook add-in.

1. First check whether Outlook has added the add-in to their Disabled Items list:

a. On the Help menu, select Disabled Items to open the Disabled Items dialog.

b. If the add-in is listed in the dialog, go to step c. Otherwise, go to step 2.

c. Select Oracle Social Network Add-In for Outlook, and click Enable.

2. From the Tools menu, select Trust Center to open the Trust Center dialog.

3. Click Add-ins to show your current list of Outlook add-ins.

4. Verify that Oracle Social Network Add-In for Outlook is included on the list.

5. Next to Manage, select COM Add-ins.

6. Clear the check box Apply macro security settings to installed add-ins.

7. Click Go to open the COM add-ins dialog.

8. In the dialog, select the check box Oracle Social Network Add-In for Outlook.

9. Click OK.

How do I re-enable the add-in for Outlook 2010 or 2013?
Once you have disabled the add-in for Outlook, in Outlook 2010 or 2013, you can re-
enable it as you would any other Outlook add-in.

1. First check whether Outlook as added the add-in to their Disabled Items list:

a. On the Help menu, select Disabled Items to open the Disabled Items dialog.

b. If the add-in is listed, go to step c. Otherwise, go to step 2.

c. Select Oracle Social Network Add-In for Outlook, and click Enable.

2. From the File menu, select Options then Add-Ins to open the Trust Center dialog.

3. Verify that Oracle Social Network Add-In for Outlook is included on the list.
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4. Next to Manage, select COM Add-ins.

5. Clear the Apply macro security settings to installed add-ins check box.

6. Click Go to open the COM add-ins dialog.

7. In the dialog, select the check box Oracle Social Network Add-In for Outlook.

8. Click OK.

Managing Your Oracle Social Network Account in the Add-In
for Outlook

This section describes how to manage your Oracle Social Network account in the add-
in for Outlook:

• What are Oracle Social Network accounts?

• How do I set up a new account?

• How can I see my account status?

• How do I switch between add-in accounts?

• How do I disconnect from an account?

• How do I delete an account?

• How can I troubleshoot my accounts?

What are Oracle Social Network accounts?
An Oracle Social Network account is your connection to a server that is hosting an
instance of Oracle Social Network. Your organization might have multiple servers,
each offering its own instance of Oracle Social Network. If you can log on to two or
more of these, then you can say you have multiple accounts.

Note: In the add-in for Outlook, you can interact with only one Oracle Social Network
account at a time.

Your system administrator will likely set up your system to automatically connect to the
necessary accounts. However, you might be required to supply your name and
password at the start of every session.

The first time you start the add-in for Outlook, the Manage Accounts dialog opens with
options for configuring this and future sessions. There are options for:

• Hiding the Manage Accounts dialog at future start-ups

• Selecting the account you want to use in this session

• Saving your password for future sessions

• Working offline (for more information, see Working Offline)

If you have only one account, you might want to save your password and hide the
Manage Accounts dialog. Or, you might want to save your password, but continue to
open this dialog so that you always have the option to select the account to use in this
session.

Chapter 14
Managing Your Oracle Social Network Account in the Add-In for Outlook

14-9



How do I set up a new account?
When your company has multiple Oracle Social Network accounts, you can preset
connections to all of them in the add-in for Outlook.

Tip: Switching between accounts is as simple as selecting an account from the
Accounts menu (see How do I switch between add-in accounts?).

1. If necessary, click Show Panel in the Outlook ribbon to open the add-in panel.

2. At the bottom of the panel, open the Accounts menu, and select Manage
Accounts.

3. In the Manage Accounts dialog, click  to the right of the Account field.

4. In the Account field, enter a name for the account to appear on the Accounts
menu.

5. In the Server URL field, enter the URL to the server that hosts the new Oracle
Social Network account, then click Next.

Enter server name, port number, and instance. For example:

acme.social.us1.oraclecloud.com:443/client

If you don't provide a port number, a default value for the connection type is used.

6. If your company uses federated authentication, your newly created account is
selected in the Manage Accounts dialog. Click OK, then enter your login
information as requested.

If your company doesn't use federated authentication, skip to the next step.

7. If necessary, enter the Identity Domain.

8. In the User Name field, enter your Oracle Social Network user name.

9. In the Password field, enter your Oracle Social Network password.

10. To save your user name and password and log in automatically in future sessions,
select Remember password.

11. Click OK.

How can I see my account status?
Account status tells you which account you are using and whether you are active,
inactive, or offline. In the add-in for Outlook, account status is shown at the bottom of
the add-in.
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A colored ball to the left of the Accounts menu and a line of text to the right show
whether you are active (green), inactive (yellow), or offline (gray).

How do I switch between add-in accounts?
In the add-in for Outlook, open the Accounts menu and select the account you want
to use. You might be prompted to log in.

How do I disconnect from an account?
From the Accounts menu, either select another account or click Work Online to
deselect it (for more information about Work Online, see Working Offline).

How do I delete an account?
1. From the Accounts menu, select Manage Accounts.

2. From the Account list, select the account to delete.

3. Click  to the right of the Account list.

4. In the confirmation dialog, click Yes.

How can I troubleshoot my accounts?
The Support dialog provides access to reports and logs to help you troubleshoot (with
the help of My Oracle Support) issues you might encounter.

1. Click , select Support.

2. Click one of the buttons at the bottom of the dialog to view reports or logs:

• Click Reports to generate a report about activities in your social network's
code over a selected period.

• Click Logging to set a logging level, configure log output, and to save your log
to a file.

You can then send the reports or logs to My Oracle Support.

The Oracle Social Network Community Forum is a discussion forum where you can

talk with experts and fellow users. Click , and select Community.

Configuring Your Settings for the Add-In for Outlook
This section describes how to configure your settings for the add-in for Outlook:

• How do I set my add-in preferences?

• Where do I specify whether to enable screen reader mode?
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• How do I hide message tooltips?

• How do I set the options for marking messages as read?

• How do I get notified about new messages in my One-on-One Conversations?

• How do I hide membership messages by default?

• How do I set up how to post messages?

• How do I control who can post to my wall?

• How do I set my add-in for Outlook notification options?

• How do I tell Outlook to prompt me to use Oracle Social Network?

• How do I set offline preferences?

How do I set my add-in preferences?

1. Click , and select Preferences.

2. On the General tab, set preferences for messages.

• Where do I specify whether to enable screen reader mode?

• How do I hide message tooltips?

• How do I set the options for marking messages as read?

• How do I get notified about new messages in my One-on-One Conversations?

• How do I hide membership messages by default?

• How do I set up how to post messages?

3. On the Walls tab, select who can post to and reply on your wall.

• How do I control who can post to my wall?

4. On the Notifications tab, select when to receive email notifications about activities
in Oracle Social Network.

• How do I set my add-in for Outlook notification options?

5. On the Posting Email tab, select whether you want to be prompted to post email
messages to Oracle Social Network and what happen when you do post those
messages.

• How do I tell Outlook to prompt me to use Oracle Social Network?

6. On the Offline tab, select what gets downloaded when you mark a Conversation
for offline use and the location the offline data is saved to.

• How do I set offline preferences?

Where do I specify whether to enable screen reader mode?
If you want messages to be accessible to a screen reader, select Enable Screen
Reader Mode. For more information, see How do I increase the add-in's accessibility?

1. Click , and select Preferences.

2. On the General tab, select or clear display options under Message View:
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• Select Enable Screen Reader Mode to show messages in compact view. In
compact view, no more than two lines of text is shown with a given message.
Screen readers can read the entire message in the message's tooltip.

• Clear Enable Screen Reader Mode to show the full text of all messages.

How do I hide message tooltips?

1. Click , and select Preferences.

2. On the General tab, select or clear tooltip options under Conversation View:

• Select Hide Tooltips to prevent tooltips from appearing when you mouse over
a message and over icons and options in banners.

• Clear Hide Tooltips to show tooltips when you mouse over a message and
over icons and options in banners.

Note: If you want messages to be accessible—for example, to a screen reader—do
not select this option.

How do I set the options for marking messages as read?

1. Click , and select Preferences.

2. On the General tab, select or clear options under Message View:

• Mark items as read when viewed in a tooltip—Select this option so that,
when you view a message in a tooltip for the specified amount of time, it's
marked as read. Specify the number of seconds in the field that follows the
label Mark item as read when viewed for (seconds).

In Outlook, when you mouse over a message, a tooltip opens showing the full
text of the message. If you specify that a view is 2 seconds, then after the
tooltip is open for 2 seconds, the item is marked as read.

Note: When Enable Screen Reader Mode is selected, Mark items as read
when viewed in a tooltip affects only Overview and flags views.

• Mark items as read when selection changes—A message is marked as
read when you move from it to another item.

How do I get notified about new messages in my One-on-One
Conversations?

1. Click , and select Preferences.

2. On the General tab, under Message View, select Alert me to new messages in
One-on-One Conversations to trigger three flashes in Outlook when someone
posts a message to a One-on-One Conversation with you and the Outlook window
is not in focus.

How do I hide membership messages by default?
When a user is added to or removed from an item a membership message is posted to
the item (for example, This Conversation is now accessible to: Jane Doe). If you'd
prefer not to show those messages, you can hide them.
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1. Click , and select Preferences.

2. Select or clear hide membership options under Message View:

• Select Hide membership messages by default to prevent membership
messages from showing in all items.

• Clear Hide membership messages by default to allow membership
messages to show in all items.

You can override this setting on individual items (see How do I hide membership
messages?).

How do I set up how to post messages?

1. Click , and select Preferences.

2. On the General tab, select or clear submit message options under Message
Posting Behavior:

• Select Use Post button to post messages by clicking Post. Enter line breaks
in your messages using the Enter key

• Select Use Enter key to post messages by pressing the Enter key. Enter line
breaks in your messages using Shift+Enter.

How do I control who can post to my wall?
Use Walls preferences to control whether other people can post or reply to messages
and documents on your wall:

1. Click , then click Preferences.

2. Click Walls.

3. Under Post to Your Wall, specify whether other people (your followers) can post
messages on your wall.

4. Under Reply on Your Wall, specify whether other people (your followers) can
reply to messages or annotate documents on your wall.

How do I set my add-in for Outlook notification options?

1. Click , then click Preferences.

2. Click Notifications.

3. Set your notification options:

• Select Send me an email when someone: to get an email when one or more
of the following options is selected:

– Assigns a Please Reply Urgent flag to me

Note: This option is grayed-out because you always receive a notification
email when someone assigns one to you.

– Assigns a Please Reply flag to me

– Assigns a For Your Information Flag to me
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– Clears a Please Reply Urgent flag assigned to or by me

– Clears a Please Reply flag assigned to or by me

– Clears a For Your Information flag assigned to or by me

– Posts on my wall—When someone posts a message to your wall

– Posts to a One-on-One Conversation with me when I am offline

– Adds me to a Conversation, collection, or other item

• Select Send me a daily summary of the activity of all the people and
content I care about to get an email that summarizes your day's flags,
messages, and memberships.

• Select your time zone.

How do I tell Outlook to prompt me to use Oracle Social Network?
If you start to send an email to at least one user who is part of your social network, the
add-in for Outlook can prompt you to create a new Conversation or post to an existing
Conversation or wall in Oracle Social Network to improve collaboration. You can
control the prompt and the default action in your preferences.

1. Click , then click Preferences.

2. Click Posting Email.

3. Under When sending email to Oracle Social Network members, select what
you want to happen when you start to send an email to users who are part of your
social network:

• Select Prompt to post outgoing email to Conversation if you want to be
prompted to post to your social network each time you start to send an email
to users who are part of your social network. If you select this option, when
you click Send, you'll be asked if you want to create a Conversation.

When prompted, click Post Message to post to Oracle Social Network or click
Send Email to just send an email.

Note: In the prompt, you can select Do not show me this again, which
changes your preference setting.

• Select the default option for where the message should be posted/sent:

– Post to a Conversation instead of sending email

– Send email and also post to a Conversation

Note: This option is useful if your message includes some users who are
not part of your social network. You would generally want to use this for
simple posted information, not messages that will spark a discussion,
otherwise the email thread and the Conversation will become out of sync.
For example, you might want to send meeting details such as location and
agenda to a user who is not part of your social network, and copy it to a
Conversation in your social network so that you have a record of the
communication along with other related information for internal use, like
documents for the meeting.

– Do not post to a Conversation (always send email)

Chapter 14
Configuring Your Settings for the Add-In for Outlook

14-15



Note: If you select this option, the Prompt to Post option becomes
grayed out. You won't be prompted to post to a Conversation.

Tip: You can change this option for a particular message in the "ribbon" of the
email message. Changing the option in the email message applies only to that
message. For more information, see How do I add email, meeting details, or
tasks to a Conversation or wall?

4. In the Ignore Emails and Domains box, you see a list of any email addresses or
domain names you've asked to be ignored when adding email messages to Oracle
Social Network (for example, distribution lists or support email addresses). The
ignored email addresses and domain names don't show up in the Recipients list
when you're adding an email to a Conversation or wall. Also, if you're prompted to
post outgoing email messages to Oracle Social Network (see How do I tell Outlook
to prompt me to use Oracle Social Network?), the ignored email addresses and
domain names won't generate a prompt.

You can edit the list in the following ways:

• To add an email address or domain name, click Add, then enter the email
address or domain name (in the form @example.com) you want to be ignored.

• To change an entry, select it in the list, then click Edit.

• To get rid of an entry, select it in the list, then click Remove.

Note: You can also add entries to the ignore list when adding an email to Oracle
Social Network. For more information, see How do I tell Oracle Social Network to
ignore particular email addresses or domains when posting email messages to a
Conversation or wall?

How do I set offline preferences?
When you mark a Conversation for offline use, the data from that Conversation is
saved to your computer. You can set Offline preferences to select what data is saved,
whether changes are published automatically or manually, and where the data is
saved to:

1. Click , then click Preferences.

2. Click Offline.

3. Under When marking a Conversation for offline, select what kind of data you
want to see while viewing a Conversation offline:

• Download the avatars of its members—Select this option to see people's
pictures next to their posts and on the Members tab.

• Download the profile information of its members—Select this option if you
want to be able to view a person's profile information.

Note: To view a person's profile information, click the person's avatar, then

click .

• Download the walls of its members—Select this option if you want to be
able to open a person's wall.

Note: To view a person's wall, click the person's avatar.

• Download the thumbnails of its documents—Select this option to see
thumbnail previews of the Conversation's documents.
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• Download the related Conversations—Select this option if you want to be
able to view Conversations related with the item you're viewing (on the
Related Items tab).

4. Under Publish and Refresh Settings, select whether to automatically publish
offline changes and whether to hide the Offline Transfer Progress window:

• Automatically publish offline changes when connecting—Select this
option if you want to automatically post any changes you made to offline
content when you connect to your account.

• Minimize the Offline Transfer Progress window when refreshing or
publishing—Select this option if you don't want to see the Offline Transfer
Progress window (which shows the progress of when you refresh offline files
or publish changes to offline files).

5. Under Offline Path, select where to save offline content—your local app data
folder, your roaming app data folder, or a custom location.

Setting Up Your Profile in the Add-In for Outlook
This section describes how to set up your profile in the add-in for Outlook:

• How do I view my profile?

• How do I edit my profile?

• How can I see other people's profiles?

• How do I post a message to someone's wall?

How do I view my profile?

On the Outlook ribbon, click Your Wall, and on your wall's banner, click . Your
profile details appear in the User Profile dialog.

How do I edit my profile?
In the User Profile dialog, edit your profile information as desired:

• To change your profile picture, on the General tab, click Change, then navigate to
and select the picture (a .gif, .jpg, or .png file.) to upload.

The Crop Picture dialog shows your image with a circle over the area that will
show in Oracle Social Network. You can drag the corners of the crop area to
change the size of your picture, or drag your picture to change the position of the
crop area. When you're happy with the size and position, click Crop.

Note: Oracle Social Network scales your profile picture up or down as needed to
display it within 60 by 60 pixels and places it in a circle showing your online status.

• To change your name and other general information, on the General tab, enter the
information in the editable fields.

• To set the language for your user interface, on the General tab, select an option
from the Language drop-down list.

• To change your address, click the Contact tab, then enter the information in the
fields.
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• To add a phone number:

1. Click the Contact tab.

2. Next to the Phone numbers area, click Add.

3. Enter a label for the number, like home or cell.

4. Select the country or region from the list to add the appropriate country code.

Note: The country/region information is available only if you have previously
opened the Check Phone Number dialog in an Outlook contact.

5. Enter the city/area code and local number.

6. Optionally, enter an extension.

How can I see other people's profiles?
One way to navigate to a profile is to click the person's profile picture wherever you
see it in the add-in for Outlook. Another way is to double-click the person's name in the
People and Groups panel. Here is a third way to navigate to a profile:

1. On the navigation bar, click .

2. Click a tab to select a view .

3. Click the person's or group's picture to open the person's or group's wall.

4. On the wall's banner, click  to open the person's or group's profile.

How do I post a message to someone's wall?
Before you can post messages to another person's wall, you must first follow the
person who owns the wall. For information about how to follow someone, see How do I
follow people and add them as contacts?

1. On the navigation bar, click .

2. Click a tab to select a view .

3. Right-click a person or group, and select Go To <name>'s Wall.

4. Post a message in the text box at the top of the wall as you would to any other
Conversation (see How do I post messages to a Conversation?).

Note: If you don't see a text box at the top of someone's wall, you aren't following the
person or the person doesn't allow other people to post to his or her wall.

Using Flags in the Add-In for Outlook
This section describes how to use flags in the add-in for Outlook:

• What are flags?

• How can I see all flags assigned to me or by me?

• How do I assign or clear flags?
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What are flags?
Flags (formerly follow-ups) provide a way to bring someone's attention to a message in
a Conversation or on a wall. When you assign flags, the people you assign them to are
flagged in the application, and, depending on their notifications settings, receive an
email (see How do I set my add-in for Outlook notification options?).

When you flag someone, you also select a priority level. Flag priority levels let the
people you assign flags to know whether or not the flag is urgent. There are three
levels of priority:

• For Your Information—Least urgent. Asks recipients to look at the item when
they have time.

• Please Reply—Moderately urgent. Asks recipients to post a reply to the item.

• Please Reply - Urgent—Asks recipients to look at the item now and reply
immediately. An email notification is sent automatically to anyone assigned a
Please Reply - Urgent flag.

For an explanation of all the flag icons, see Table 8-1

To make sure flags send the message look at this now! use them thoughtfully. A flood
of flag notifications all at once or all the time can reduce their impact.

How can I see all flags assigned to me or by me?

1. On the navigation bar, click .

2. Click  on the Flags banner, and select to show:

• Flags for You

• Flags You Assigned

Select the type of flags to show:

• All flags

• Flags of a selected type: Please Reply - Urgent, Please Reply, or For Your
Information

Select Flagged By then a name.

Select Sort, then:

• Ascending, to show flagged items from 0 to 9 then A to Z

• Descending to show flagged items from Z to A then 9 to 0

How do I assign or clear flags?

1. Go to a message you want to flag, click .

2. Assign or clear flags:

• To remove a flag assigned to you, click .

• To quickly assign a For Your Information flag to someone, click the flag next to
the person.
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• To assign a particular flag to someone, select the type of flag in the drop-down
list next to the person.

• To quickly flag everyone, click Flag All (in the Others Not Flagged section),
and select the type of flag you want to assign.

• To quickly remove all flags (whether assigned by you or not), click Clear All
(in the Others Flagged section).

• To remove a particular flag, click  next to the person.

• To search for someone, enter part of the person's name in the search box.

Using Conversations in the Add-In for Outlook
This section describes how to use Conversations in the add-in for Outlook:

• What Conversation tabs are available?

• How do I view Conversation messages?

• How do I view a list of Conversation documents?

• How do I view a list of Conversation members?

• How can I view a list of all Conversations I'm a member of?

• How can I view a list of Conversations I can join?

• How can I view my list of favorite Conversations?

• How can I view my list of muted Conversations?

• How can I view a list of closed Conversations?

• How can I view a list of open Conversations?

• How do I start a Conversation?

• How do I start a Conversation with a group?

• How do I join a public Conversation?

• How do I start a One-on-One Conversation?

• How do I add members to a Conversation?

• How do I remove members from a Conversation?

• How do I make a private Conversation public?

• How do I change a public Conversation to members-only?

• How do I close a Conversation?

• How do I reopen a closed Conversation?

• How do I delete a Conversation?

• How do I change a Conversation name?

• What are referring items?

• How do I add an existing item to a list of referring items?

• How do I add a new item to a list of referring items?

• How do I change a Conversation's language?
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• How do I mute a Conversation?

• How do I copy a Conversation URL to my clipboard?

• How do I download an archive of a Conversation?

• How do I view recent messages?

• How do I post messages to a Conversation?

• How do I hide membership messages?

• How do I navigate from a message to its Conversation?

• How do I post a message through the note editor?

• How do I edit my messages and replies?

• How can I view earlier versions of an edited message?

• How do I reply to a message?

• How do I find items in a Conversation or wall?

• How do I mark a message as read or unread?

• How do I mark all messages in a Conversation as read?

• How do I copy a message URL to my clipboard?

• How do I delete a message?

What Conversation tabs are available?
In a Conversation, use tabs to navigate its views:

• Posts—  View everything added to the Conversation.

• Documents—  View just the documents.

• Members—  View and manage the Conversation's membership.

• Referring Items—  Navigate to the items that link to this Conversation.

How do I view Conversation messages?
By default, the add-in for Outlook is configured to show messages in full view. If you
like, you can double-click a message or select it and press Enter to see it in a separate
dialog. If you posted the message, it opens in an editor.

Note: People outside your company can sometimes be given limited access to
Conversations in the Oracle Social Network. If there are outside users in the
Conversation, a banner appears near the top of the page to let you know. All outside

users have the same avatar ( ) and their names are in purple text. For more
information, see What are "outside users"?

1. On the navigation bar, click .

2. Click , and select a filter to show the types of Conversations you want to see.
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3. Double-click a Conversation to open it.

How do I view a list of Conversation documents?

1. On the navigation bar, click .

2. Click , and select a filter to show the types of Conversations you want to see.

3. Double-click a Conversation to open it.

4. Click  to view the Conversation's list of documents.

How do I view a list of Conversation members?

1. On the navigation bar, click .

2. Open the Conversation with members you want to show.

3. Click  to view the Conversation's list of members.

Note: All outside users show the same avatar ( ) and their names are in
purple text. For more information, see What are "outside users"?

How can I view a list of all Conversations I'm a member of?

On the navigation bar, click . The on the Conversations banner, click  and
select Yours.

How can I view a list of Conversations I can join?

On the navigation bar, click . Then click  and select Available.

To join a Conversation, open it, then, at the top of the Conversation, click Join
Conversation.

How can I view my list of favorite Conversations?

1. On the navigation bar, click .

2. On the banner above the list of Conversations, click  and select Favorites.

How can I view my list of muted Conversations?
When you view a list of muted Conversations, you see only those Conversations you
have muted. The Conversations others have muted show only in their views of this list.
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On the navigation bar, click , click , and select Muted.

How can I view a list of closed Conversations?
When you view closed Conversations, you see all the Conversations that are closed,
no matter who closed them.

On the navigation bar, click , click , and select either Yours, Available,
Favorites, or Muted. Click Closed to show all closed Conversations included in the
selected view.

How can I view a list of open Conversations?
When you view open Conversations, you see all open Conversations that you are a
member of or that are available to you to join.

On the navigation bar, click , click , and select either Yours, Available,
Favorites, or Muted. Click Open to show all open Conversations included in the
selected view.

How do I start a Conversation?
Here's how to start a Conversation from the Conversations panel. You can also start
a Conversation the same way (starting with Step 2) from the Outlook ribbon and from
the Overview panel.

1. On the navigation bar, click .

2. On the Conversations banner, click .

3. Enter a name for the Conversation in the Name field.

4. Select the options to apply to the new Conversation:

• Make publicly available—Make this Conversation available to all. Anyone
with a user name and password can join this Conversation.

• Add to favorites—Add this Conversation to your favorites list.

5. Click OK to create and open the new Conversation.

How do I start a Conversation with a group?
Starting a Conversation with a group automatically adds all members of the group to
the Conversation.

1. On the navigation bar, click .

2. Click  to show the list of groups you are a member of.

3. Select the group to start a Conversation with.
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4. Right-click the group, and select Start New Conversation.

5. In the Name field, enter a name for the Conversation.

6. Select the options you want to apply to the new Conversation:

• Make publicly available—Make this Conversation available to all to join.

Note: All members of the group are automatically added to the Conversation,
but, when you select this option, anyone with a user name and password can
join it.

• Add to favorites—Add this Conversation to your favorites list.

7. Click OK.

How do I join a public Conversation?

1. On the navigation bar, click .

2. Set the Conversations list to show available Conversations (see How can I view a
list of Conversations I can join?).

3. In the list of Conversations, right-click the Conversation you want to join, and
select Join Conversation.

Alternatively, open the Conversation, then, at the top of the Conversation, click Join
Conversation.

How do I start a One-on-One Conversation?
1. Navigate to the wall of the person you want to converse with.

For example, in a Conversation, right-click the person's profile picture and select
Go To <name>'s Wall.

2. On the wall, click the Start One-on-One Conversation icon.

3. Add messages as you would to any Conversation.

For more information, see How do I post messages to a Conversation?

How do I add members to a Conversation?

1. On the navigation bar, click .

2. Open the Conversation to add members to.

3. Click  to view the Conversation's list of members.

4. Click  to open the Select Members dialog.
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5. In the Select Members dialog, select groups and people you want to add as
members. Use Ctrl+Click to select more than one person or group.

Double-click a name to add it to the Select list at the bottom of the dialog, or select
names, then click Select to add all selections.

By default, you see a list of contacts. Click a tab to change your view:

• Contacts—View a list of your contacts.

• Groups—View a list of your groups.

• Current Members—View a list of current members.

Alternatively, you can enter part of a person's or group's name, and select them
from the list that pops up.

6. Click OK to add your selections to the Conversation.

How do I remove members from a Conversation?

1. On the navigation bar, click .

2. Open the Conversation to remove members from.

3. Click  to view the Conversation's list of members.

4. On the list, right-click the person you want to remove, and select Remove from
Membership.

5. In the confirmation dialog, click Yes.

6. Repeat these steps until you remove everyone you want.

How do I make a private Conversation public?

1. On the navigation bar, click .

2. Right-click the Conversation, then select Modify.

3. In the dialog, select the Make publicly available check box.

4. Click OK.

How do I change a public Conversation to members-only?
Public Conversations that are converted to members-only retain the members who
had already joined the public Conversation.

1. On the navigation bar, click .

2. Right-click the Conversation, then select Modify to open the Modify dialog.

3. In the dialog, clear the Make publicly available check box.

4. Click OK.
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How do I close a Conversation?

1. On the navigation bar, click .

2. Right-click the Conversation, then select Modify.

3. Select Mark as closed to open the Close Conversation dialog.

4. Enter a reason for closing the Conversation, and click OK.

5. In the Modify dialog, click OK.

The Conversations panel is refreshed to show the list of closed Conversations.

How do I reopen a closed Conversation?

1. On the navigation bar, click .

2. From the Options menu on the Conversations banner, select Closed to show a
list of closed Conversations.

3. Right-click the closed Conversation, and select Modify.

4. Clear the Mark as closed check box.

5. In the confirmation dialog, click Yes.

6. In the Modify dialog, click OK.

How do I delete a Conversation?
Before you can delete a Conversation, you must remove all members of the
Conversation, except you. Once you are the only member of a Conversation, you can
delete it. (For information about removing others from a Conversation, see How do I
remove members from a Conversation?)

1. On the navigation bar, click .

2. Right-click the Conversation to delete, and select Discard.

3. In the confirmation dialog, click Yes.

How do I change a Conversation name?

1. On the navigation bar, click .

2. Right-click the Conversation, and select Modify.

3. Rename the Conversation.

4. Click OK.
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What are referring items?
A Conversation or wall's Referring list includes links to the Social Objects and
collections that link to that Conversation or wall. This provides a convenient way to
navigate between a Conversation and a collection of Conversations with related
content or a Conversation and a Social Object that it discusses.You can set up these
relationships from a Social Object or a collection, or from the Conversation or wall
itself.

How do I add an existing item to a list of referring items?

1. Go to the Conversation, and click .

2. On the Referring Items banner, click .

3. Select a source for the Social Object:

• Recent Social Objects—Select from a list of Social Objects that you recently
viewed.

• Favorites—Select from a list of Social Objects that you have marked as a
favorite.

• Search—Enter a search term, and select from results or click .

When you click , results appear on this tab.

4. Select a Social Object, and click OK.

Note: For information about creating a new item to add to a Conversation's list of
referring items, see How do I add a new item to a list of referring items?

How do I add a new item to a list of referring items?

1. Go to the Conversation, and click .

2. Click , then select the type of Social Object you want to create.

3. In the Name field, enter a name for the Social Object.

4. Select or clear the Add to favorites check box.

5. Click OK.

Note: For information about adding an existing item, see How do I add an existing
item to a list of referring items?

How do I change a Conversation's language?
When you change a Conversation language, new system messages, like The
Conversation attributes changed, appear in the selected language. System messages
that were present before the language change continue to appear in the language in
place when they were posted. Messages and files posted to the Conversation are
unaffected. They appear in the language that was used to write them.
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The language used for user interface elements in the add-in for Outlook, like field
labels, button labels, dialog box names, banner headings, and other user interface
elements, is determined by your Microsoft Office settings and your Operating System.

Changing a Conversation language affects everyone's view of the Conversation.

1. On the navigation bar, click .

2. Right-click the Conversation to configure, and select Modify.

3. Select Modify to open the Modify dialog.

4. Expand the Language menu, and select a language

5. Click OK.

How do I mute a Conversation?

On the navigation bar, click , then right-click the Conversation you want to mute,
and select Mute.

Muting affects only your view of a Conversation. You can mute a Conversation so it
does not appear to you in the Conversations panel when the filter Yours, Available,
or Favorites is applied.

Messages posted to a muted Conversation don't appear on the Overview panel or in
your daily email digest. Flags assigned on a message in a muted Conversation do
appear in your daily email digest (for information about the daily email digest, see How
do I set my add-in for Outlook notification options?).

How do I copy a Conversation URL to my clipboard?

On the navigation bar, click , then right-click the Conversation, and select Copy
Link. The Conversation URL is added to your clipboard. You can paste it anywhere
you like. When clicked, it opens the Conversation in standalone mode in your browser.

How do I download an archive of a Conversation?
In the add-in for Outlook, the Download Archive option saves a Conversation to a .zip
file. So, whether you are online or off, you can unzip the file to your local drive to read
its messages and replies and view the documents added to it. The .zip file (named
after the Conversation) contains the Conversation's list of members, messages, and
replies in an HTML file (named by default index.html).

To download and work with an archive of a Conversation:

1. Open the Conversation, click , then click Download Archive.

2. Unzip the files to your computer.

3. Open index.html.

Clicking a document link opens the copy of the document that is included in
the .zip file. All other links in index.html (user names, like, reply, and so on) open
Oracle Social Network in the browser.
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Note: You can't make changes to an archive of a Conversation (though you can click a
a link to open the Conversation in a browser and make changes there). If you want to
be able to make offline changes, instead download an offline copy of the Conversation
(see How do I download an Offline Copy of an item?

How do I view recent messages?

The Overview panel ( ) shows the latest messages posted to the Conversations
and walls you're a member of and public Conversations you've joined.

A red dot appears on the icon when you have unread messages in any of the listed
Conversations.

To view recent messages, click . If tooltips are enabled (see How do I hide
message tooltips?), mouse over a message in the list to view its details in a tooltip.

Double-click a message to view it in the Conversation or wall.

Click the Conversation or wall name to go to the bottom of the Conversation or the top
of the wall.

Right-click a message to access a menu of useful actions.

How do I post messages to a Conversation?
This describes how to post messages to a Conversation when the default setting to
show messages in full view is selected.

1. On the navigation bar, click .

2. Click , and select a filter to show the types of Conversations you want to see.

3. Double-click the Conversation to open it.

4. Click  to open a view of all of the selected Conversation's messages.

5. Enter a message in the field at the bottom of the panel, and click Post or press
Enter, depending on your Preferences (see How do I set up how to post
messages?).

How do I hide membership messages?
When a user is added to or removed from a Conversation, collection, group, or Social
Object a membership message is posted to the item (for example, This Conversation
is now accessible to: Jane Doe). If you'd prefer not to show those messages in an
item, you can hide them.

1. On the navigation bar, click the type of object you want to open (for example, click

 for Conversations).

2. Double-click an item to open it.

3. Click  in the group banner, and select Hide Membership Messages.
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For information about hiding membership messages for all items, see How do I hide
membership messages by default?

How do I navigate from a message to its Conversation?
When you view messages somewhere other than in a Conversation, for example,
when you view messages in the Overview panel, you have a few ways to navigate to
its home Conversation:

• Click the link to the Conversation included in the message.

• Double-click the message.

• Right-click the message and select Go To Item.

How do I post a message through the note editor?
The Note Editor provides options for formatting your messages. Use the method
described here to post messages to a Conversation when the default setting to show
messages in full view is selected.

1. On the navigation bar, click .

2. Click , and select a filter to show the types of Conversations you want to see.

3. Double-click the Conversation to open it.

4. Click  to show all messages posted to this Conversation.

5. At the bottom of the panel, click  to open the Note Editor.

6. Enter and format your message in the editor.

7. Click OK.

How do I edit my messages and replies?
You can edit the messages you post. You can't edit other people's messages.

1. Navigate to the message or reply you want to edit.

2. Right-click the message, then select Edit Message (or Edit Reply); or click More,
then select Edit Message (or Edit Reply).

3. Make your revisions, and click OK.

How can I view earlier versions of an edited message?
1. Navigate to the message or reply you want to edit.

2. Right-click the message, then select Edit Message (or Edit Reply).

3. Select a version to show in the dialog's message area.

4. Click Cancel to close the dialog.
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How do I reply to a message?
In the add-in panel, you can reply to flags and Social Object, wall, and Conversation
messages. When your add-in instance is configured to show messages in full view
(the default setting), the reply area appears below the currently selected item. When
messages are not configured to display in full view, the reply area appears at the
bottom of the add-in panel.

For more information, see How do I set my add-in preferences?

1. Navigate to the message you want to reply to.

2. Click  Reply under the message to open a reply entry field.

3. Enter your reply.

4. Optionally, click  to open the Note Editor to enter and format your reply.

5. Click the Post button or OK, whichever applies.

Note: If you don't see  Reply under a personal wall post shown on the
Overview panel or on a person's wall, the person doesn't allow other people to reply to
his or her wall posts.

How do I find items in a Conversation or wall?
Search and navigation tools enable you to find unread messages, flags assigned to
you, or text within the Conversation or wall.

While viewing a Conversation or a wall, you can use the search and navigation tools:

• To find unread messages, click the unread messages count in the Posts header,
and use the up and down arrows to navigate through the unread messages.

• To find flags assigned to you, click the flag count in the Posts header, and use the
up and down arrows to navigate through your flags.

• To find messages or documents that include specific text or posted by a particular
person, click the search icon in the Posts header, enter the text or poster you want
to search for, press Enter, and use the up and down arrows to navigate through
the results.
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How do I mark a message as read or unread?
To the left of the message, click the blue bullet to remove it and to mark the message
as read; right-click the message, then select Mark as Read; or click More, then select
Mark as Read.

Note: See also, How do I mark all messages in a Conversation as read?

If you want a message status to be unread, but you've already marked it as read, you
can return the message to unread by right-clicking it and selecting Mark as Unread.
This works only with messages others have posted and not your own posts.

How do I mark all messages in a Conversation as read?
In the list of Conversations or in the Conversation title bar, click the unread message
count in the blue box.

Note: See also, How do I mark a message as read or unread?

How do I copy a message URL to my clipboard?

1. On the navigation bar, click .

2. Click , and select a filter to show the types of Conversations you want to see.

3. Double-click the Conversation to open it.

4. Right-click the message, and select Copy Message Link to add the message's
URL to your clipboard.

You can paste the URL wherever you like. When clicked, it opens the Conversation in
your browser.

How do I delete a message?
You can delete messages you posted or messages on your profile wall.

Note: If you are a service administrator, you can delete any message.

Right-click the message, then click Delete Message; or click More, then select Delete
Message.

To restore a deleted message, locate the deleted message icon ( ) where the

message used to be, click , then confirm that you want to restore the message.
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Note: Only a service administrator, the person who posted the message, or the person
who deleted the message can restore the deleted message.

Using Collections in the Add-In for Outlook
This section describes how to use collections in the add-in for Outlook:

• What are collections?

• How do I create a collection?

• How do I add members to a collection?

• How do I remove members from a collection?

• How do I add an existing item to a collection?

• How do I add a new item to a collection?

• How do I remove an item from a collection?

• How can I rearrange a list of collections?

• How do I hide membership messages in a collection?

• How do I rename a collection?

What are collections?
As your lists of Conversations, Social Objects, people, and groups grow, it might be
useful to organize those that focus on a common topic, project, or issue into an easy-
access list, called a collection. Use collections to create your own lists of related
Conversations, collections, profile and group walls, and Social Objects.

You can give the collection a meaningful name so it's easy to identify its purpose. You
can add Conversations and walls (including people's walls and group walls) to a
collection. You can also add Social Objects and other collections to a collection to
create a hierarchy. There is no limit to the levels of hierarchy you can create.

In the add-in for Outlook navigation bar, click the Collections icon to open the list of
collections.

For more information, see How do I create a collection?

How do I create a collection?

1. On the navigation bar, click .

2. Click  to open the New Collection dialog.

3. In the Name field, enter a name for the collection.
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4. Select check boxes to enable collection options:

• Make publicly available—Make this a public collection that anyone with an
Oracle Social Network account can join.

• Add to favorites—Add this collection to your Favorites list.

5. Click OK.

How do I add members to a collection?

1. On the navigation bar, click .

2. Double-click a listed collection to open it.

3. Click  to open the collection's list of members.

Tip: To see how many members a collection has, mouse over the Members tab.

4. Click  to open the Select Members dialog.

5. In the Select Members dialog, select groups and people you want to add as
members. Use Ctrl+Click to select more than one person or group.

Double-click a name to add it to the Select list at the bottom of the dialog, or select
names, then click Select to add all selections.

By default, you see a list of contacts. Click a tab to change your view:

• Contacts—View a list of your contacts.

• Groups—View a list of your groups.

• Current Members—View a list of current members.

Alternatively, you can enter part of a person's or group's name, and select them
from the list that pops up.

6. Click OK to add your selection to the collection's membership.

How do I remove members from a collection?

1. On the navigation bar, click .

2. Double-click a listed collection to open it.

3. Click  to open the collection's list of members.

4. Right-click the person or group, and select Remove from Membership.

5. In the confirmation dialog, click Yes.

How do I add an existing item to a collection?

1. On the navigation bar, click .

2. Double-click a listed collection to open it.
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3. Click  to show the items in this collection.

4. Click 

5. In the Browse Items dialog, select one or more items to add to the collection, then
click OK. Use Ctrl+Click to select more than one item.

By default, you see a list of recent items. Click a tab to change your view:

• Recent Items—Select from items you have visited recently.

• Favorites—Select from items you have marked as a favorite.

Alternatively, you can enter part of a item's name, and select it from the list that
pops up. When you select from the search's pop-up results, the dialog closes and
your selection is added to the collection.

How do I add a new item to a collection?

1. On the navigation bar, click .

2. Double-click a listed collection to open it.

3. Click  to show the related items in this collection.

4. Click , and select:

• Add New Conversation—To create a new Conversation and add it to the
collection.

• New Collection—To create a new collection and add it to the current
collection.

5. Enter a name for the item in the Name field.

6. Select the options you want to apply to the new item:

• Make publicly available—Make this a publicly available item that anyone with
an Oracle Social Network account can join.

• Add to favorites—Add this item to your favorites list.

7. Click OK to add the new item to the collection.

How do I remove an item from a collection?
When you remove an item from a collection, there's no confirmation dialog—the item is
simply removed. If you decide removal was a mistake, you can always add it back
(see How do I add an existing item to a collection?).

1. On the navigation bar, click .

2. Double-click a listed collection to open it.

3. Click to show the related items in this collection.

4. Right-click the item, and select Remove Item from the Collection.
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How can I rearrange a list of collections?
You can select the type of collections you want to appear on the collections list
(Yours, Available, Favorites, Muted), then arrange that view so that it appears in the
order you find the most useful.

1. On the navigation bar, click .

2. On the Collections banner, click , then select the type of collection you want to
see.

3. Click Arrange By, then select your preferred sort order.

Tip: In a collection, you can choose to see different types of content in the panel. Use
the tabs at the top of a collection to navigate to each type:

• Posts—  View all messages and documents added to the collection's wall.

• Documents—  View just the documents added to the collection's wall.

• Members—  View and manage the collection's membership.

• Related Items—  View a list of the Conversations, profile and group walls,
Social Objects, and other collections in this collection.

• Referring Items—  View the Social Objects that include this collection in their
lists of related items.

How do I hide membership messages in a collection?
When a user is added to or removed from an item a membership message is posted to
the item (for example, This wall is now accessible to: Jane Doe). If you'd prefer not to
show those messages, you can hide them. See How do I hide membership
messages?

How do I rename a collection?

1. On the navigation bar, click .

2. Right-click a listed collection, and select Modify.

3. In the Modify dialog, rename the collection and click OK.

Using Documents and Folders in the Add-In for Outlook
This section describes how to use documents and folders in the add-in for Outlook:

• How do I add files to a Conversation or wall?

• How do I view files from the add-in for Outlook?

• How do I download a file from the add-in for Outlook?
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• How do I copy a file from one Conversation to another?

• How do I navigate from a document to its location in the Conversation or wall?

• How do I edit a document?

• How do I view document annotations?

• How can I find a file on a Conversation or wall's Documents tab?

• How can I view a document's access history?

• How do I show or hide a document's versions?

• How do I copy a file URL to the clipboard?

• How do I send a document as an email?

• How do I delete a document?

• How do I create a folder?

• How do I rename a folder?

• How do I copy a folder?

• How do I move a folder?

• How do I add new documents to a folder?

• How do I move documents into a folder?

• How do I move documents out of a folder?

• How do I download a folder from the add-in for Outlook?

• How do I copy a folder URL to the clipboard?

• How do I open a folder in the add-in, in the web version of Oracle Social Network?

• How do I delete a folder?

How do I add files to a Conversation or wall?
You can upload files from your local file systems.

Note: If you add a document with the same name as one that was previously added, a
new version is created.

1. Open the Conversation or wall you want to add the file to.

2. On the Posts or Documents tab, click .

Tip: On the Documents tab, the Add Documents icon ( ) appears on the
banner. On the Posts tab, the Add Documents icon appears on the banner in
compact-view mode and next to the Post button in full-view mode.

3. Browse to and select one or more files.

Once you make your selection, an upload area opens at the bottom of the panel.

4. Optionally, to prevent people from downloading or copying this file select Disable
download and copy.

5. Optionally, enter a description where it says [Optional] Enter a description
about the document(s).
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6. Click Post or press Enter to start the upload.

Note: There are no restrictions on the file types you can upload.

How do I view files from the add-in for Outlook?
Wherever you see the file, click Open to open the file in the native viewer, or click the
file name or thumbnail to open the file in the web client.

How do I download a file from the add-in for Outlook?

1. Navigate to the file you want to download.

2. Under the file, click Download.

This option isn't available if downloading and copying were disabled when the file
was uploaded.

3. Select a destination, and click Save.

How do I copy a file from one Conversation to another?
1. Navigate to the file you want to copy.

2. Right-click the file, select Copy, then select Copy to Items.

Alternatively, on the Documents tab ( ) of the Conversation or wall, click More
under the document, select Copy, then select Copy to Items.

This option isn't available if downloading and copying were disabled when the file
was uploaded.

3. Select a way to locate the target Conversation or wall:

• Recent Items—For a list of Conversations and walls you have visited recently

• Favorites—For a list of Conversations and walls you have marked as a
favorite

• Search—To use search to locate the Conversation or wall

• New—To create a new Conversation

4. For all but New, select the destination Conversation or wall.

5. Click OK to copy the file to the selected Conversation or wall.

How do I navigate from a document to its location in the Conversation
or wall?

When viewing the list of documents in the Documents tab, right-click the document,
then select Go to Comment to get to the place in the Conversation or wall where the
document was posted.

Alternatively, click More under the document, then select Go to Comment.
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How do I edit a document?
1. Navigate to the file you want to edit.

2. Under the document, click Edit, then select an option:

• Edit Document opens the file in its native application. This is determined by
the file's extension.

• Edit Document With lets you choose the editor you want to use. When you
select this option, you must also select an editor.

3. Edit the file, and save, keeping the same file name and same default directory.

4. In the add-in panel, right-click the file, select Document, then select Publish
Changes.

5. Finish uploading the new version as you would any other file.

For more information, see, How do I add files to a Conversation or wall?

Note: If you use Edit Document With, you might need to select Stop Editing from
the file's Options menu. This is necessary when the file continues to appear
highlighted.

How do I view document annotations?
The add-in for Outlook provides a pathway to document annotations in your browser.

1. Navigate to the file.

2. Right-click the file, then select View Annotations.

3. If prompted to, log in to your web version of Oracle Social Network.

A detailed view of the document opens, showing its annotations.

How can I find a file on a Conversation or wall's Documents tab?
The Documents tab in a Conversation or on a wall has a search feature for locating a
file by its name.

1. Go to the Conversation or wall and click .

2. On the Documents banner, click .

This opens a search field with other controls, like an Options menu.

3. Optionally, to return only the files that match your search terms that you have
marked as a favorite, click , then select Favorite Only.

4. In the search field, enter all or part of the file's name.

Search results appear in a pop-up. Click a result to highlight it in the documents
list.

5. Click  to leave search mode.
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How can I view a document's access history?
You can see the types of actions that have been taken on a given document in the
add-in for Outlook.

1. Navigate to the document in the Documents tab ( ) of the Conversation or
wall.

2. Right-click the document, and select Access History; or click More, then select
Access History.

The Document Activity dialog shows when the document was:

• Added

• Copied from a cloud document store

• Copied to a cloud document store

• Downloaded

• Updated

• Removed

• Unremoved

• Viewed

How do I show or hide a document's versions?

1. Navigate to the document in the Documents tab ( ) of the Conversation or
wall.

2. Right-click the document, and select View All Versions; or click More, then select
View All Versions.

How do I copy a file URL to the clipboard?
When you copy a file URL to your clipboard, you can paste it anywhere you like. When
clicked, it goes to a preview of the document in your browser.

1. Navigate to the file.

2. Right-click the file, and select Copy Document Link.

How do I send a document as an email?
When you send a file as an email, a new email opens. It includes an attachment to the
file and a link to the Conversation or wall the file is posted to. Everyone who receives
the email can see the file link, but only those who are also members of the
Conversation or who have access to the wall can open the file.

1. Navigate to the file.

2. Right-click the file, and select Send As E-Mail.
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How do I delete a document?
You can delete documents you posted or documents on your profile wall.

Notes:

• If you are a service administrator, you can delete any document.

• Deleting a document or document version deletes it for all members of the
Conversation or wall.

To delete a specific version of a file:

1. Navigate to the file in the Conversation or wall.

2. Right-click the file, and select Delete Version; or click More, then select Delete
Version.

To delete all versions of a file:

1. Navigate to the file in the Documents tab ( ) of the Conversation or wall.

2. Right-click the file, and select Delete; or click More, then select Delete.

To restore a deleted file:

1. On the Posts tab, locate the deleted message icon ( ) where the file message
used to be.

2. Click , then confirm that you want to restore the file.

The message and file are restored.

Note: Only a service administrator, the person who posted the file, or the person who
deleted the file can restore the deleted file.

How do I create a folder?
You can create a folder on the Documents tab of any Conversation or wall. Look for

 on the Documents banner.

1. Go to the Conversation or wall, and click .

2. On the Documents banner, click  to open the New Folder dialog.

3. In the Name field, enter a name for the folder.

4. Click OK.

Note: When you open a folder, a breadcrumb appears at the top of the Documents
tab to show you where you are in the folder structure. To return to a parent folder, click
the folder name in the breadcrumb.

How do I rename a folder?

1. Go to the Conversation or wall with the folder you want to rename, and click .
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2. Right-click the folder you want to rename, and select Rename to open the Edit
Folder dialog.

3. In the Name field, enter a new name for the folder.

How do I copy a folder?
Copying a folder copies the folder and all of its files from one Conversation or wall to
another or duplicates it within the same Conversation or wall. Because the folder is a
copy, it's independent of the original folder. This means, for example, the copied folder
is not affected if you delete the original folder or add more files to it.

1. Go to the Conversation or wall with the folder you want to copy, and click .

2. Right-click the folder you want to copy, and select Share to open the Browse
Conversations dialog.

3. In the dialog, select a way to locate the destination folder, Conversation, or wall.

• Click Recent Items to select from destinations that have recently been active.

• Click Favorites to select from your favorite destinations.

• Click Search to select from search results for the destination.

4. Select the destination, and click OK.

How do I move a folder?

1. Go to the Conversation or wall that has a folder you want to move, and click .

2. Right-click the folder you want to move, then select Move.

3. In the Move Items dialog, select a destination for the moved folder, and click OK.

How do I add new documents to a folder?
1. Go to the Conversation or wall that has a folder you want to add new files to, and

click .

2. Double-click the folder you want to add a new file to, to open it.

3. Click .

4. Add the file as you would to any Conversation or wall (see How do I add files to a
Conversation or wall?).

How do I move documents into a folder?
1. Go to the Conversation or wall with a folder you want to move files to, and click

.

2. Right-click the file you want to add to a folder, and select Move to open the Move
Items dialog. Select an existing folder for the file, or click New Folder to create a
folder for the file.
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Alternatively, to move documents and folders to a subfolder, drag them to the new
folder.

How do I move documents out of a folder?
1. Go to the Conversation or wall with a folder you want to move files out of.

2. Click .

3. Double-click the folder to open it.

4. Right-click the file you want to move, and select Move.

5. Select a destination for the file, and click OK.

How do I download a folder from the add-in for Outlook?
Downloading a folder downloads a .zip file of the folder and its content. The .zip file is
named after the folder. For example, if you download an All Business folder, you get
a .zip file named All Business.zip.

1. Go to the Conversation or wall with a folder you want to download.

2. Click .

3. Right-click the folder you want to download, and select Download to open a save
dialog.

4. Select a destination for the folder, and click Save.

The folder and its contents are saved as a .zip file to the destination you selected.

How do I copy a folder URL to the clipboard?
1. Go to the Conversation or wall with the folder.

2. Click .

3. Right-click the folder, and select Copy Folder Link to add the folder's URL to your
system's clipboard.

4. Paste the link wherever you like.

How do I open a folder in the add-in, in the web version of Oracle
Social Network?

1. Go to the Conversation or wall with a folder you want to open in your browser.

2. Click .

3. Right-click the folder you want to open, and select Open in Web Browser to open
the folder in the browser version of Oracle Social Network.
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How do I delete a folder?
You can delete folders you created (as long as they don't include anyone else's
documents or folders) or folders on your profile wall.

Notes:

• If you are a service administrator, you can delete any folder.

• Deleting a folder also deletes all the files and subfolders it contains.

• Deleting a folder deletes it for all members of the Conversation or wall.

• There's no undelete, so be sure about deleting the folder before you act.

To delete a folder:

1. Go to the Conversation or wall with a folder you want to delete.

2. Click .

3. Right-click the folder you want to delete, and select Remove.

4. In the confirmation dialog, click Yes.

To restore a deleted folder and its contents:

1. On the Posts tab, locate the deleted message icon ( ) where the folder
message used to be.

2. Click , then confirm that you want to restore the folder.

The message, folder, and its contents are restored.

Note: Only a service administrator, the person who created the folder, or the person
who deleted the folder can restore the deleted folder.

Working with People and Groups in the Add-In for Outlook
This section describes how to work with people and grounds in the add-in for Outlook:

• What is the People and Groups panel?

• What are "outside users"?

• What are "unregistered users"?

• How do I navigate to a person's profile?

• How can I view my list of contacts?

• How do I add new contacts?

• How do I invite my contacts from my Outlook address book to join Oracle Social
Network?

• How do I remove a contact?

• How do I follow people and add them as contacts?

• How can I view a list of the people I follow?

• How can I view a list of the people who follow me?

Chapter 14
Working with People and Groups in the Add-In for Outlook

14-44



• What are groups?

• How do I view a group's details?

• How do I navigate to a group's wall?

• How can I view a group's membership?

• How do I create a group?

• How do I add people to a group?

• How do I revise a group's membership?

• How do I hide membership messages on a group wall?

• How do I rename a group or revise its description?

• How do I add or change a group's profile picture?

• How do I deactivate a group?

• Is there a way to reactivate a deactivated group?

What is the People and Groups panel?
The People and Groups panel gives you quick access to your entire social network.
Your network includes your contacts, the people you follow, the people who follow you,
and the groups you are a member of.

To open the People and Groups panel, click  in the navigation bar.

The People and Groups panel has five tabs:

• Contacts ( )—People you selected as contacts

• Groups ( )—The groups you belong to

• People You Follow ( )—People you have selected to follow

• Your Followers ( )—People who have selected to follow you

What are "outside users"?
Outside users are people who don't work for your company, but who collaborate with
you and your co-workers in Oracle Social Network. They are members of Oracle
Social Network with limited privileges. For example, outside users can be contacts but
they can't have contacts in Oracle Social Network. They can participate in
Conversations only when they are added by you or some other member of the
Conversation.

Note: One outside user can't add another to a Conversation.

Wherever an outside user is a member of a Conversation, a banner appears at the top

of the page to alert you. All outside users have the same avatar ( ) and their
names are in purple text so you can easily tell who they are.

When you open an outside user's wall, you'll notice that you can't post to it. However,
you can still view profile information (if the user has added any).
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Since outside users do not have walls they can post to, you won't see Follow or
Following buttons on their profile page. Instead, you'll see Add as Contact or
Remove from Contacts options.

What are "unregistered users"?
Unregistered users are people who are in your company's directory but are not yet
members of Oracle Social Network. When you add people to a Conversation or wall,
the word unregistered appears next the names of the unregistered in the Manage
Members dialog. When you try to add an unregistered user, a warning alerts you to
their unregistered status.

When you add an unregistered person to a Conversation, they receive an email with a
link to set up their account.

How do I navigate to a person's profile?
Wherever you see a person's picture or name, you can click it to go to the person's
profile.

Alternatively, you can right-click a person and select Go To <name>'s Wall. You can
also open a contact in Outlook, and click Go to Wall in the ribbon.

How can I view my list of contacts?

1. On the navigation bar, click .

2. Click the Contacts tab ( ).

3. Optionally, arrange your list of contacts. Click , then select your options:

• Select or clear Show Offline Contacts to either show (select) or hide (clear)
your contacts who are currently offline.

• Select Arrange By then either Name, to arrange your list of contacts by a
contact's first name, or Presence Status, to arrange the list by the person's
online status: active, away, and offline.

• Select Sort and choose from either Ascending (from 0 to 9 and A to Z or
active to offline) or Descending (from Z to A and 9 to 0 or offline to active).

How do I add new contacts?
You can add a new contact on the Contacts tab of the People and Groups panel or
by following them (see How do I follow people and add them as contacts?).

Note: You can add an outside user as a contact, but outside users can't add you.
Outside users can't have contacts in Oracle Social Network.

1. On the navigation bar, click .

2. Click the Contacts tab ( ).

3. On the Contacts banner, click  to open the Select Members dialog.
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4. Add users in any of the following ways:

• To search for a particular person, enter a name in the Search field, then select
from the results.

• If your administrator has configured the system to allow you to invite users,
you can invite people from your Outlook address book.

To add a contact from your Outlook address book, click Outlook Contacts,
then double-click the person you want to add.

Note: Only contacts that include email addresses appear on the Outlook
Contacts tab.

Confirm that you want to invite the person. When you click OK, an email is
sent to the contact inviting them to join Oracle Social Network.

Note: You can also invite someone from the Outlook ribbon while viewing the
contact's card. See How do I invite my contacts from my Outlook address
book to join Oracle Social Network?

5. Click OK to add the people you selected as your contacts.

How do I invite my contacts from my Outlook address book to join
Oracle Social Network?

If your administrator has configured the system to allow you to invite users, you can
invite people from your Outlook address book. Inviting users to join Oracle Social
Network makes it easier to collaborate with them.

1. From your Outlook address book, open the contact you want to add to Oracle
Social Network.

Note: The contact must include an email address.

2. In the Outlook ribbon, click Invite from the Oracle Social Network actions.

An email is sent to the contact inviting them to join Oracle Social Network.

Note: If the contact is already an Oracle Social Network user, you see Go to Wall in
the Outlook ribbon.

Alternatively, you can invite multiple Outlook contacts from the Contacts tab of the
People and Groups panel. See How do I add new contacts?

How do I remove a contact?

1. On the navigation bar, click .

2. Click the Contacts tab ( ).

3. Right-click the person, and select Remove from Contacts.

4. If you're also following the person, specify whether to also stop following them.

• Click Yes to also stop following the person.

• Click No to remove the person as a contact but continue to follow them.
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How do I follow people and add them as contacts?
Following someone:

• Adds them to your list of contacts

• Lets you post messages to their wall

• Includes information about their wall activity on the Overview panel.

• Includes information about the activity on their walls in your daily email digest.

1. On the navigation bar, click .

2. Select the Your Followers tab ( ) to view a list of people you are not already
following.

3. Then either:

• Click  next to the person; or

• Right-click the person, and select Follow <name>.

How can I view a list of the people I follow?

1. On the navigation bar, click .

2. Click the People You Follow tab ( ).

How can I view a list of the people who follow me?

1. On the navigation bar, click .

2. Click the Your Followers tab ( ).

What are groups?
Groups provide a way to organize a set of people into one entity: the group. All
members of a group can be added to a Conversation, collection, or Social Object in
one operation.

Every group has its own wall where group members can post content of interest to the
group (for more information, see How do I create a group? and How do I navigate to a
group's wall?).

Just as each person has a profile in Oracle Social Network, a group has a profile with
its own unique set of details: its name and description and a group image or avatar.
Any member of the group can revise a group's profile details and image.
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How do I view a group's details?

On the navigation bar, click , then click .

Double-click a group to see its details, like its wall, its members, the Conversations
and walls it belongs to, and so on. The area at the top of a group has tabs you can use
to navigate to these views:

• Posts—View everything posted to the group's wall.

• Documents—View the documents posted to the group's wall.

• Members—View all members of the group.

• Member Of—View a list of the Conversations and walls this group is a member of.

• Belongs To—View a list of the other groups that this group is a member of.

• Referring Items—View a list of the items that link to this group.

How do I navigate to a group's wall?
Whenever a group is created, it is automatically given its own wall. Here group
members can post information of particular interest to the group.
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1. On the navigation bar, click , then click .

2. Double-click a group, or right-click a group and select Go To <name>'s Wall.

3. Post content to the group's wall as you would to any Conversation or wall.

How can I view a group's membership?

1. On the navigation bar, click , then click .

2. Double-click a group to open its wall.

3. In the tab bar above the wall, click the Members tab to see who's in the group.

How do I create a group?

1. On the navigation bar, click , then click .

2. On the Groups banner, click .

3. In the Name field, enter a name for the group, and click OK.

How do I add people to a group?

1. On the navigation bar, click , then click .

2. Double-click a group to open its wall.

3. Click the Members tab.

4. On the Members banner, click .

5. Select a source of potential members.

• Click Groups & Contacts to select from your contacts and other groups.

In this dialog, you can expand a group and pick individual members.

• Click Search to enter search terms; click the Search icon to show all results.

6. Double-click a person or a group to add them to the Select list.

7. Click OK to add your selections to the group membership.
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How do I revise a group's membership?

1. On the navigation bar, click , then click .

2. Double-click a group to open its wall.

3. Click the Members tab.

4. Revise the group:

• To add members, start with step 5 in How do I add people to a group?

• To remove members, right-click a person or group, and select Remove from
Membership.

How do I hide membership messages on a group wall?
When a user is added to or removed from an item a membership message is posted to
the item (for example, This wall is now accessible to: Jane Doe). If you'd prefer not to
show those messages, you can hide them. See How do I hide membership
messages?

How do I rename a group or revise its description?

1. On the navigation bar, click , then click .

2. Double-click a group, or right-click a group and select Go To <name>'s Wall.

3. Click , and select Edit Profile.

4. In the Group Profile dialog, revise the group's name and description.

How do I add or change a group's profile picture?

1. On the navigation bar, click , then click .

2. Double-click a group, or right-click a group and select Go To <name>'s Wall.

3. Click , and select Edit Profile.

4. In the Group Profile dialog, click Change.

5. Navigate to and select a group profile picture.

How do I deactivate a group?
When you deactivate a group, the group keeps its memberships in Conversations and
walls, but it can't be added to additional Conversations and walls. Deactivating a group
also prevents further additions to the group's wall. When deactivated, a group's icon
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and name are grayed out (the group name is grayed out on membership lists and on
the Groups tab).

Note: You can reactivate a deactivated group at any time. For more information, see 
Is there a way to reactivate a deactivated group?

1. On the navigation bar, click , then click .

2. Double-click a group to open its wall.

3. In the groups banner, click , then select Deactivate.

4. In the confirmation dialog, click Yes.

Is there a way to reactivate a deactivated group?
Enabling a deactivated group makes the group available for adding to Conversation
and other types of membership lists.

1. On the navigation bar, click , then click .

2. In the groups banner, click , then select Deactivated to show all deactivated
groups.

3. Double-click the deactivated group to open its wall.

4. Click , then select Activate.

Using Social Objects in the Add-In for Outlook
This section describes how to use Social Objects in the add-in for Outlook:

• Understanding Social Objects

• How can I arrange a list of Social Objects?

• How do I view the details of a Social Object?

• What are referring items?

• How do I add an existing item to a list of related items?

• How do I add a new Conversation to a Social Object's list of related items?

• How do I view the members of a Social Object?

• How can I view the messages posted to a Social Object's wall?

• How do I hide membership messages on a Social Object's wall?

Understanding Social Objects
Social Objects are business objects in a business application or business process that
are shared with Oracle Social Network. A shared business object is called a Social
Object in Oracle Social Network.

A Social Object has its own wall for messages and documents and its own
membership. A Social Object's membership includes all of the people involved in
projects centering around that object. For example, the membership for a customer
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Social Object that comes from your CRM system, could include someone from your
sales team, product management, fulfillment, and other lines of business.

Your implementation of Oracle Social Network might use Social Objects from your own
systems-of-record.

How can I arrange a list of Social Objects?

1. On the navigation bar, click  and select a type of Social Object to show.

2. Click  on the Social Object banner, select Arrange By, then select the sorting
option to apply.

How do I view the details of a Social Object?

1. On the navigation bar, click  and select a type of Social Object to show.

2. In the panel, double-click the object you want to view to open its details.

In the details of a selected Social Object, you can switch between the following views
using the tabs that appear above the details:

• Posts—  View all messages and documents added to this object's wall.

• Documents—  View just the documents added to this object's wall.

• Members—  View and manage the object's membership.

• Related Items—  View a list of the items related to this object.

• Referring Items—  View the other Social Objects that refer to this Social
Object (see What are referring items?).

Tip: A Social Object might include a link back to the associated record in the source
system (for example, customer relationship management, enterprise resource
planning, or human capital management). If available, you can open the source record
by clicking View Details in the options menu (click  on the Social Object banner) or
at the bottom of the list of the Social Object's attributes.

What are referring items?
Referring items are items that link to the current item. For example, the Acme
collection includes the Conversation Wiley. The Wiley Conversation, in turn, lists the
Acme collection on its list of referring items.

How do I add an existing item to a list of related items?

1. On the navigation bar, click  and select a type of Social Object to show.

2. Double-click the object to open it.

3. Click .
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4. Click the Add Existing Item icon in the Social Object banner.

5. Select a way to locate the item, for example, select:

• Recent Items—For a list of items you have visited recently

• Favorites—For a list of items you have marked as a favorite

• Search—To use search to locate the item

When you select from the pop-up results, the dialog closes and your selection
is added to the list of related items. You can skip the next step.

6. Select one or more items.

7. Click OK to add your selections to the Social Object's list of related items.

How do I add a new Conversation to a Social Object's list of related
items?

1. On the navigation bar, click  and select a type of Social Object to show.

2. Double-click the object to open it.

3. Click .

4. Click the New Conversation icon to open the New dialog.

5. Enter details as you would for any other item.

6. To copy the Social Object's membership list to the new item, select Copy
membership of source Social Object.

7. Click OK to add the item to the object's list of related items.

How do I view the members of a Social Object?

1. On the navigation bar, click  and select a type of Social Object to show.

2. Double-click the object to open it.

3. Click .

How can I view the messages posted to a Social Object's wall?

1. On the navigation bar, click  and select a type of Social Object to show.
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2. Double-click the object to open it.

3. Click .

How do I hide membership messages on a Social Object's wall?
When a user is added to or removed from an item a membership message is posted to
the item (for example, This <Social Object> is now accessible to: Jane Doe). If you'd
prefer not to show those messages, you can hide them. See How do I hide
membership messages?

Interacting with Microsoft Outlook in the Add-In
This section describes how to interact with Microsoft Outlook in the add-in:

• What kinds of shared activities are there between Outlook and the add-in for
Outlook?

• How do I add email, meeting details, or tasks to a Conversation or wall?

• How do I tell Oracle Social Network to ignore particular email addresses or
domains when posting email messages to a Conversation or wall?

• How do I add an Oracle Social Network contact to my Microsoft Outlook Contacts
list?

• How do I schedule a Microsoft Outlook Calendar meeting through the add-in for
Outlook?

• How do I create a Microsoft Outlook Task from the add-in for Outlook?

• How do I send an email from the add-in for Outlook?

What kinds of shared activities are there between Outlook and the
add-in for Outlook?

You can add Microsoft Outlook emails, meeting details, and tasks to an Oracle Social
Network Conversation or wall; and, in the Oracle Social Network add-in for Microsoft
Outlook, you can initiate Outlook-related activities. For example, you can add an
Oracle Social Network contact to your Outlook Contacts list; create an Outlook task;
send an email with links and attachments from the add-in; schedule an Outlook
calendar meeting, and select participants from Oracle Social Network as well as your
Outlook address book and your other usual sources.

How do I add email, meeting details, or tasks to a Conversation or
wall?

You can add Outlook email, meeting details, and tasks to an Oracle Social Network
Conversation through the Oracle Social Network add-in for Microsoft Outlook.
Additionally, you can add the item's recipients and attachments. You can edit the item
to leave out some or all of the its content, recipients, and attachments. You can add
more content, people, and files along with the originals.

Be thoughtful about which items you add and how much of their content you include.
Depending on their length, added Outlook items can quickly clutter a Conversation.
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Before finalizing an addition, you can edit it to sanitize and simplify it. Consider
removing header information, signatures, and any other unnecessary or unwanted
parts.

1. Perform one of the following actions to add an Outlook item (email, meeting, or
task) to a Conversation or wall:

• Select an Outlook item, then click Add To Oracle Social Network in the
Outlook ribbon.

• Right-click an Outlook item, then click Add To Oracle Social Network.

• Select an Outlook item, then go to the Conversation or wall you want to add
the email to, and in its top-most banner, click , then select Add To Oracle
Social Network.

• Open the target Conversation or wall, then drag and drop the Outlook item into
the open Conversation or wall.

• In a meeting or task, click Add to in the item's ribbon at the top of the form.

• In an email's ribbon, select one of the following options under When sending:

– Move to—Post the message to a Conversation or wall, rather than
sending the email.

– Copy to—Post the message to a Conversation or wall, but also send the
email.

This option is useful if your message includes some users who are not
part of your social network. You would generally want to use this for
simple posted information, not messages that will spark a discussion,
otherwise the email thread and the Conversation will become out of sync.
For example, you might want to send meeting details such as location and
agenda to a user who is not part of your social network, and copy it to a
Conversation in your social network so that you have a record of the
communication along with other related information for internal use, like
documents for the meeting.

The email is moved or copied to the Conversation or wall when you click
Send.

Note: If you don't want to post the email to a Conversation or wall, select No
Post to just send the email.

2. In the resulting dialog, the Conversation is populated with the Conversation or
wall you targeted or with the title of the email, meeting, or task (which will be the
title of the new Conversation). To select another Conversation, click
Conversation, then select a recent Conversation or a favorite Conversation, or, to
create a new Conversation with a different name, click New.

Note: For more information about creating a new Conversation, see How do I start
a Conversation?

3. Any people included in the email, meeting, or task who are Oracle Social Network
users are added to the Invitees. To select other people to invite, click Invitees,
then, in the Select Members dialog, select groups and people you want to add as
members.

Double-click a name to add it to the Select list at the bottom of the dialog, or select
names, then click Select to add all selections. Use Ctrl+Click to select more than
one person or group.
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By default, you see a list of email recipients. Click a tab to change your view:

• Recipients—View the list of people who received the email.

• Contacts—View a list of your contacts.

• Groups—View a list of your groups.

• Current Members—If you are adding the email to an existing Conversation,
you can see the people and groups that are members of the Conversation.

Alternatively, you can enter part of a person's or group's name, and select them
from the list that pops up.

Note: You can hide unwanted email recipients by telling Oracle Social Network to
ignore particular email addresses or domain names when adding an email to
Oracle Social Network. For more information, see How do I tell Oracle Social
Network to ignore particular email addresses or domains when posting email
messages to a Conversation or wall?

4. Any documents that were part of the email, meeting, or task are added to the
Attachments. To add more attachments, click Attachments, then, in the dialog,
click Add, select documents to attach, and add descriptions of the selected
documents.

Note: The documents you select are uploaded to the Conversation or wall, but
they are not also attached as additional documents to the email, meeting, or task.

5. Click Post As to select how the text should be posted:

• Top-Level Messages—Post the email as one or more individual messages.
Message splits mark the end of each message. See Step 6 for more
information on message splits.

• Single Message with Replies—Post the first email message in the dialog as
a top-level message in the Conversation or wall, and post all other messages
as replies to the top-level message. Message splits mark the end of each
message. See Step 6 for more information on message splits. This option is
useful for email threads.

• Word Document—Post the email as a Microsoft Word document. Formatting
and inline images will be preserved. Message splits aren't supported.

• HTML Document—Post email as an HTML document. Formatting and inline
images will be preserved. Message splits aren't supported.

6. Any text in the email, meeting, or task is included in the dialog's editor. You can
edit the text and formatting, add or remove links, insert references to Oracle Social
Network items, and change how the messages are split up.

Oracle Social Network automatically adds message splits ("End of Message"
indicators) based on the messages in the email, but you can also manually add or
remove message splits to control how the email is posted to the Conversation or
wall:

• To remove a message split, delete the whole "End of Message" line.

• To add a message split, place your cursor where you want to split the
messages, then click Add Message Split.

If you're adding an email with multiple messages, the newest message appears in
the dialog first (at the top), the same as it does in the email. When the messages
are added to Oracle Social Network, the first message in the dialog is posted to
the Conversation or wall first, followed by the remaining messages.
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If you want to reverse the order of the messages in the dialog (to show the oldest
message first), click Sort Messages, then select Last Message on Top.

Note: The sort order has no effect if there are no message splits.

7. Click Post.

How do I tell Oracle Social Network to ignore particular email
addresses or domains when posting email messages to a
Conversation or wall?

You might send or receive email from addresses or domain names that are part of
Oracle Social Network but that you don't want to include when posting email
messages to Conversations or walls (for example, distribution lists or support email
addresses). You can tell Oracle Social Network to ignore these email addresses and
domain names so they don't show up in the Recipients list when you're adding an
email to a Conversation or wall. Also, if you're prompted to post outgoing email
messages to Oracle Social Network (see How do I tell Outlook to prompt me to use
Oracle Social Network?), the ignored email addresses and domain names won't
generate a prompt.

You can add email addresses or domain names to the ignore list in the following ways:

• When adding an email to a Conversation or wall:

1. In the Add to Oracle Social Network dialog, click Invitees.

2. In the Select Members dialog, on the Recipients tab, right-click the recipient
whose email address/domain name you want to ignore.

3. Select Add Invitee to Ignore List or Add Invitee's Domain to Ignore List.

Recipients that match the ignored email addresses/domain names are
immediately removed from the list.

• Add, edit, or remove entries in your Posting Email preferences. For more
information, see How do I tell Outlook to prompt me to use Oracle Social
Network?, step 4.

How do I add an Oracle Social Network contact to my Microsoft
Outlook Contacts list?

You can accomplish this task wherever people or groups are listed, like on a
Conversation or wall's membership list or on one of the tabs on the View people and
groups panel. This describes how to add an Outlook Contact from the add-in's View
people and groups panel.

1. In the navigation bar, click .

2. Click a tab to open it.

Chapter 14
Interacting with Microsoft Outlook in the Add-In

14-58



Tip: On the Groups tab, double-click a group to open its wall, then click the
Members tab to see its members.

3. Right-click someone on the list, and select Add to Outlook Contacts.

How do I schedule a Microsoft Outlook Calendar meeting through the
add-in for Outlook?

1. Right-click a message, person, Conversation, wall, or other item, and select
Schedule Meeting to open an Outlook Calendar Meeting scheduler.

You can also invite multiple people or groups in one action:

a. On the People and Groups tab, use Ctrl+Click to select multiple people or
groups.

b. Right-click, and select Schedule Meeting from the context menu.

The people or groups you selected are added to the meeting's list of invitees.

2. Finish setting up the meeting as you would for any Outlook Calendar entry.

Note: You can add meeting details from your Outlook Calendar to a Conversation or
wall. For more information, see How do I add email, meeting details, or tasks to a
Conversation or wall?

Where you initiate a new meeting in the add-in affects who is automatically invited to
the meeting and what is included in the invitation. For example:

• Right-click a message, and the person who posted the message is automatically
added to the To field in the meeting scheduler. Additionally, a link to the message
is included in the body of the invitation.

• Right-click a document, and the person who uploaded the document is added to
the To field in the meeting scheduler. Additionally, a link to the document is added
to the body of the invitation.

• Right-click a listed Conversation, wall, collection, or Social Object, and no one is
automatically added to the To field in the meeting scheduler. But a link to the item
that you right-clicked is included in the body of the message.

Tip: You can invite people who use Oracle Social Network using the scheduler's
Attendees list. Select Invite Attendees, then Attendees, and Address Book. In the
Select Attendees and Resources dialog in Outlook Calendar, open the Address Book
menu and select Oracle Social Network under Outlook Address Book (or Other
Address Books).

How do I create a Microsoft Outlook Task from the add-in for Outlook?
You can accomplish this wherever people or groups are listed, like on a Conversation
or wall's list of members or on one of the tabs on the View people and groups panel.
This describes how to create an Outlook Task from the add-in's View people and
groups panel.
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1. In the navigation bar, click .

2. Click a tab to open it.

3. Right-click someone on the list, and select Create Task.

Note: For groups, double-click a group, open its Members tab, then right-click a
group member.

4. Fill out and save the Task form like you would with any other Outlook task.

How do I send an email from the add-in for Outlook?
You can send an Outlook email from just about anywhere in the add-in for Outlook,
like the list of messages in a Conversation, on a person or a group on the View
people and groups panel, on a document on the Documents panel or on the
Documents tab of any Conversation or wall.

Note: You can also add an Outlook email to a Conversation or wall. For more
information, see How do I add email, meeting details, or tasks to a Conversation or
wall?

1. Right-click an item, person, or group, and select Send Email or Send As Email
(depending on your starting point).

2. Write and send the message like you would any other Outlook email.

The person, group, or type of item you initiate this action from determines what you
are sending. Table 14-3 lists people, groups, and item types and describes what
occurs when you select Send Email or Send As Email.

Table 14-3    What Gets Sent When You Send Email from the Add-In?

Send (As) Email From a An Email Form Opens With …

Conversation The name of the Conversation in the Subject field and a link to the Conversation in
the body of the email

Collection The name of the collection in the Subject field and a link to the collection in the body
of the email

Message The email address of the person who posted the message in the To field; the name of
the Conversation where the message was posted in the Subject field; and the
message and a link to the message in the body of the email

When recipients click the link, it opens the Conversation where the message was
posted in the web version of Oracle Social Network

Document The person who uploaded the document in the To field; the name of the Conversation
where the documents was posted in the Subject field; and the document added as an
attachment
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Table 14-3    (Cont.) What Gets Sent When You Send Email from the Add-In?

Send (As) Email From a An Email Form Opens With …

Person The person's name in the To field

Group All members of the group in the To field

Liking and Adding Favorites in the Add-In for Outlook
This section describes how to like items and add favorites in the add-in for Outlook:

• What are Likes and Favorites?

• How do I find out who likes an item?

• How do I like an item?

• How do I unlike an item?

• How do I mark an item as a favorite?

• How do I unmark a favorite?

• How can I see all my favorites?

What are Likes and Favorites?
Liking something communicates to others that you approve or support a posted item.
Once you like something, a You like this link appears on the item. As likes
accumulate, the link text changes to, for example, You and 1 person like this, You
and 2 people like this, or 2 people like this, as the case might be. Click the link to
open a dialog showing who has liked the item.

When you unlike something, the check mark that appears next to You like this is
removed and the message's like count is reduced, or, if you were the only person to
like the item, the like link is removed entirely.

Marking an item as a favorite makes it easy to locate—you can find it on the Favorites
panel or filter many panels to show only favorites. The Overview, Collections,
Conversations, Social Objects, and Documents panels all provide a Favorites
filter, which you can use to filter out all items except those you have marked as a
favorite. When you show groups on the People and Groups page, you can filter your
list of groups by favorites, too.

How do I find out who likes an item?
Click the like link text below the message—for example, You and 1 person like this—
to open the View Like dialog. The View Like dialog lists the people who like the
message.

How do I like an item?
1. Navigate to the item you want to like.

2. Click the Like link at the bottom of the message or reply.
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A link appears on the item, for example, You and 1 person like this, which you
can click to see who has liked the item.

How do I unlike an item?
The quick way to unlike an item is to click its Unlike link. Here is another way to unlike
an item:

1. Navigate to the item you want to unlike.

2. Right-click the item, select Like <item_type>, then You like this.

How do I mark an item as a favorite?
Click the item's , or right-click the item, then select Mark as Favorite.

How do I unmark a favorite?

Click the item's , or right-click the item, then select Mark as Favorite.

How can I see all my favorites?

On the navigation bar, click .

Using Search in the Add-In for Outlook
This section describes how to use search in the add-in for Outlook:

• What do hashtags (#) have to do with search?

• How do I run a search?

• How do I rerun a recent search?

What do hashtags (#) have to do with search?
You can add hashtags to meaningful terms in messages so all messages containing
your hashtagged term can be collected together in a list of search results. For
example, imagine you're writing about discounts. This topic comes up in a few
unrelated Conversations and walls. Every time you or your colleagues say something
about discounts, you all write discounts as a hashtag (#discounts). You can search for
#discounts and return a list of all messages in otherwise unrelated Conversations and
walls that contain the hashtagged term.

Tip: You can include the following characters in a hashtag: A through Z, a through z, 0
through 9 and _.

With any search, available hashtags are suggested when you enter your search term.
Selecting one of these takes you to the Hashtags panel where all messages that
include that hashtag are shown.
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Hashtagged terms are clickable wherever they appear. So clicking #discounts in any
Conversation takes you to the Hashtags panel, where all messages that include the
hashtagged term are returned.

You can also follow hashtags. When you follow a hashtag, messages in public
Conversations and walls that contain that hashtag appear on the Overview page,
even if you are not a member of those Conversations or walls.

To follow a hashtag, click it wherever you see it to go to the Hashtags panel, then click

 at the top of the page. To stop following the hashtag, click  again.

How do I run a search?
1. Enter at least two characters in the search box at the top of the add-in.

Top rated results appear in a drop-down list. Click a result to open the item.

2. To see all results, press Enter or click .

To see only a particular result type (for example, Conversations or documents),
click , then select a filter.

The search results open in the Search Results panel.

Note: You can also filter the results after running your search by selecting a filter
from the Options menu on the Search Results banner.

3. If you filtered by a result type, additional sort options are available. Click the
Options menu on the Search Results banner, select Sort, then select a sort
option.

How do I rerun a recent search?

To rerun a recent search, open , select Recent Searches, then select the term
you want to reuse.

Tip: To clear your Recent Searches list, open , select Recent Searches, then
Clear.

Working Offline
This section describes how to work offline:

• How do I work offline?

• How do I download an Offline Copy of an item?

• What's the difference between online and offline items?

• How can I view a list of my offline Conversations while I'm online?

• How can I view an offline copy of an item?

• How do I clear changes I made offline?

• How do I refresh an offline copy of an item?

• How do I post the changes I made offline to an online item?

• How do I remove an offline copy of an item?
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How do I work offline?
Suppose you're heading for the airport and want to catch up on your Conversations
while on the plane. Before you leave, you can download an offline copy of the
Conversation; or you can save a Conversation to a .zip file, then unzip the file on your
local drive. Both versions contain all Conversation content available at the time you
created the archive, including messages, replies, and files. However, when you
download an offline copy, you can make changes to the Conversation to be published
the next time you're online.

• For information on downloading an offline copy of a Conversation, collection,
social object, or wall, see How do I download an Offline Copy of an item?

• For information on downloading an archive of a Conversation, see How do I
download an archive of a Conversation?

How do I download an Offline Copy of an item?
To download an offline copy of a Conversation, collection, social object, or wall, open

the item, click , then click Download for Offline. An icon ( ) appears next to the
item to indicate that it has been downloaded.

Alternatively, you can right-click the item, then click Download for Offline.

Note: You can set Offline preferences to select what data gets downloaded for offline
use. See How do I set offline preferences?

What's the difference between online and offline items?
An offline copy of an item has a few differences from an online item:

• The Insert Reference button is disabled.

• You can't see referring items.

How can I view a list of my offline Conversations while I'm online?
When you're online, you can view a list of the Conversations you've downloaded for

offline use by clicking  on the navigation bar.

Alternatively, on the navigation bar, click , click , and select Offline.

How can I view an offline copy of an item?
You can view an offline copy of an item while you're offline or online:

Offline

Double-click a listed item to open it.

A banner at the top of the window reminds you that you are viewing this item offline.
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Note: To work offline, at the bottom of the panel, in the Accounts menu, clear the
check mark next to Work Online.

Online

To preview the changes you made to an offline copy of an item, right-click the item,
click Offline Copy, then click Preview.

Alternatively, if you are viewing the item you changed offline, click , select Offline
Copy, then click Preview.

How do I clear changes I made offline?
When you are online (connected to your account), you can remove the changes you
made to items offline.

• To remove changes for a specific item, right-click the item, click Offline Copy,
then click Clear Changes.

• To remove all your offline changes at the same time, at the bottom of the panel,

click , click Offline Copy, then click Clear Changes.

How do I refresh an offline copy of an item?
When you connect to your account, your offline copies are automatically refreshed
periodically. However, you can also manually refresh offline copies while you're
connected.

• To refresh the offline copy of a specific item, right-click the item, click Offline
Copy, then click Refresh.

• To refresh all offline copies at the same time, at the bottom of the panel, click ,
click Offline Copy, then click Refresh.

How do I post the changes I made offline to an online item?
If you have made changes to an offline item, the next time you go online (connect to
your account) a banner appears saying that there are changes pending.

You can set Offline preferences to select whether your changes are published
automatically when you go online or if you'd rather publish them manually. See How
do I set offline preferences?

If you select to automatically publish your changes, the changes are posted when you
connect to your account, and the banner disappears.

If you choose to publish your changes manually, you can preview the change to an
item, by right-clicking the item, clicking Offline Copy, then clicking Preview.

Use one of the following methods to manually publish those changes for others to see.

• To publish changes to all items at the same time, in the banner, click Publish.

• To publish changes for a specific item, right-click the item, click Offline Copy, then
select Publish Changes.

Alternatively, while viewing the item, click  in the title bar, click Offline Copy,
then click Publish Changes.
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Changes are posted to the live versions of the selected items, and the banner
disappears.

How do I remove an offline copy of an item?
Right-click the item, click Offline Copy, then click Remove.

Alternatively, to remove all offline copies at the same time, when you are online, at the

bottom of the panel, click , click Offline Copy, then click Remove.

Chapter 14
Working Offline

14-66



15
Working from Your Desktop

These topics introduce the features of Oracle Social Network Desktop and describe
how to use them:

• Getting Started with Oracle Social Network Desktop

• What You Can Do in Oracle Social Network Desktop

• Working with Messages

• Working with Documents

• Working with Related and Referring Items

• Using Hashtags and Search in Oracle Social Network Desktop

• Using the Overview Panel in Oracle Social Network Desktop

• Using Flags in Oracle Social Network Desktop

• Using Favorites in Oracle Social Network Desktop

• Using Conversations in Oracle Social Network Desktop

• Using Collections in Oracle Social Network Desktop

• Working with People in Oracle Social Network Desktop

• Working with Groups in Oracle Social Network Desktop

• Using Social Objects in Oracle Social Network Desktop

• Working Offline in Oracle Social Network Desktop

• Using Notifications in Oracle Social Network Desktop

• Managing Your Account in Oracle Social Network Desktop

• Configuring Your Settings for Oracle Social Network Desktop

• Getting Help, Support, and Updates for Oracle Social Network Desktop

Getting Started with Oracle Social Network Desktop
• What is Oracle Social Network Desktop?

• How do I install Oracle Social Network Desktop?

• How do I Open Oracle Social Network Desktop?

• How do I log in to Oracle Social Network Desktop?

• What is the sidebar?

• What is the Detail window?

• How do I set up or change my profile?

• How do I close and exit Oracle Social Network Desktop?
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What is Oracle Social Network Desktop?
Oracle Social Network Desktop provides easy access to Oracle Social Network from
your computer desktop. Use it for quick access to your contacts and groups; to
participate in and view Conversations; and to stay notified of important activity.

Oracle Social Network Desktop is available for both Windows and Mac OS.

How do I install Oracle Social Network Desktop?
1. Get the installation file from the Downloads page in the web version of Oracle

Social Network:

a. Log in to the web version of Oracle Social Network.

b. Click the arrow next to your name at the top of the application, then click
Downloads.

c. On the Downloads page, click Download Oracle Social Network Desktop.

d. On the resulting page, click the link to download the appropriate installer for
your operating system.

2. Install the application:

In Microsoft Windows, locate the installation file
(social_network_desktop_setup.exe), open it, and follow the instructions in the
install wizard.

On a Mac, locate the installation file (oracle_social_network_desktop.dmg), and
open it. The disk image window should open with a representation of Oracle Social
Network Desktop on one side and a representation of your Applications home on
the other. Drag Oracle Social Network Desktop to Applications, and drop it there.

How do I Open Oracle Social Network Desktop?
In Microsoft Windows, use one of the following options:

• On your desktop, double-click .

• From the Start menu, select All Programs, Oracle Social Network, Oracle
Social Network.

On a Mac, use one of the following options:

• In the Dock, click .

Note: The icon appears in the Dock only if you put it there.

• From the Go menu, select Applications, then double-click Oracle Social
Network.
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The Oracle Social Network Desktop icon ( ) appears in the system tray (for
Microsoft Windows) or in the Dock (Mac).

Note: A green dot on the icon means you have unread notifications. See Using
Notifications in Oracle Social Network Desktop.

How do I log in to Oracle Social Network Desktop?
Important: If you received an email invite to join Oracle Social Network, you must log
in through the web client and change your temporary password before you use the
Oracle Social Network Desktop. Click the link in the invite to open the web client.

After you install Oracle Social Network Desktop, the first time you open it, you'll be
prompted for your Oracle Social Network login information:

1. Your system administrator likely set up your system to automatically connect to the
necessary accounts, but, if not, in the Server URL field, enter the URL to your
Oracle Social Network account, then click Next.

For example, enter: https://acme.social.us1.oraclecloud.com/client.

2. If your company uses federated authentication, your newly created account is
selected in the Manage Accounts dialog. Click OK, then enter your login
information as requested.

If your company doesn't use federated authentication, skip to the next step.

3. If necessary, enter the Identity Domain.

4. In the User Name field, enter your Oracle Social Network user name.

5. In the Password field, enter your Oracle Social Network password.

6. To log in automatically in future sessions, select Remember password.

7. Click Finish.

You can configure one or more Oracle Social Network accounts and easily switch
between them. For more information, see:

• What are Oracle Social Network accounts?

• How do I enable account switching when I start Oracle Social Network Desktop?

What is the sidebar?
The sidebar is a panel on your desktop with tabs for accessing the main features of
Oracle Social Network. In Microsoft Windows, you can dock the sidebar to the right or
left side of your screen, or leave the sidebar undocked.

Use the icons on the sidebar to navigate and take action in Oracle Social Network
Desktop.
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Table 15-1    Icons in the Oracle Social Network Desktop Sidebar

Icon Name Description

Overview Click this icon to show a list of the latest actions
of the people you follow, the latest posts in the
Conversations and walls you are a member of,
and messages that include hashtags you follow
(from public Conversations and walls, even
those you are not a member of).

Using the Overview Panel in Oracle Social
Network Desktop

New Object Click to create a new object. For example, on
the Conversations panel, click to create a new
Conversation.

Open Existing Object Click to open a dialog for selecting and opening
an existing object. For example, on the
Conversations panel, click to open an existing
Conversation.

• Help (for this panel)
• Options menu
These icons appear on each
panel and provide the same
service on each (though with
different options). One
exception is the Offline
Briefcase panel, which
doesn't have an Options
menu.

Click to navigate to help for the current panel.

Select options from the Options menu to apply
to the current panel. For example, on the
Overview panel, click  to choose the types of
messages to show and whether to show
message previews.

Flags Click to view a list of flags—either the ones you
assigned or the ones assigned to you.

The number in the red circle shows how many
flags are assigned to you.

Using Flags in Oracle Social Network Desktop

Clear My Flags Click to remove selected flags from your list of
flags. Ctrl+Click listed flags to select more than
one, then click the icon.

You can't undo this action.

Another way to clear a single flag is to click the
Flag icon to its right. This opens a menu with
Clear Flag and Manage Flags options.

Favorites Click to view a list of items you've marked as
your favorites.

How do I view my favorites?

Conversations Click to view a list of all Conversations available
to you.

Using Conversations in Oracle Social Network
Desktop
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Table 15-1    (Cont.) Icons in the Oracle Social Network Desktop Sidebar

Icon Name Description

Unread Messages, Add to
Favorites, and New item
notification

These appear on each listed Conversation
("New!" shows only on Conversations that
you've just been added to). The number shows
how many messages in the Conversation are
unread. Click the unread number to mark all
messages in that Conversation as read.

The star is the Add to Favorites icon. Click it to
mark the Conversation as a favorite.

Collections Click this icon to show a list of collections.

Using Collections in Oracle Social Network
Desktop

People Click this icon to show your list of contacts, the
people you already follow, and the people who
follow you.

Working with People in Oracle Social Network
Desktop

Add Contact Click to open a search field for locating people
and adding them to your list of contacts.

Open One-on-One
Conversation

Select someone on your contacts list, and click
this icon to open a One-on-One Conversation
with them.

Open Wall Select a contact or, on the Groups panel, a
group, and click this icon to open a view of the
selected person's or group's wall.

Groups Click to show the groups you are a member of.

Working with Groups in Oracle Social Network
Desktop

Social Objects Click this icon to open a list of Social Objects.

Note: This icon appears when one or more
Social Objects are available and you have
access to them.

Using Social Objects in Oracle Social Network
Desktop

Social Object selection list Click this icon to open a selection list of all
available types of Social Objects. Select to
show all types or a selected type.

Where can I see a list of Social Objects?

Offline Briefcase Click to view a list of the Conversations and
walls you have added to your Offline Briefcase.

• Working Offline in Oracle Social Network
Desktop

• How do I work offline in Oracle Social
Network Desktop?

Refresh All Offline
Conversations

Click this icon to refresh all Conversations in
your Offline Briefcase with any messages
added since you last refreshed them.
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Table 15-1    (Cont.) Icons in the Oracle Social Network Desktop Sidebar

Icon Name Description

Add Conversation to the
Offline Briefcase

Click to open a dialog where you can select a
Conversation to add to your Offline Briefcase.

Refresh Offline Conversation Click this icon to refresh a selected
Conversation with any messages added since
you last refreshed the Conversation.

Publish Changes When you post messages to an offline
Conversation, once you are online again, you
can click this icon to upload those changes to
the Conversation.

Remove from Offline
Briefcase

Select a Conversation and click this icon to
remove it from your Offline Briefcase.

Unread Messages In the Offline Briefcase on a listed Conversation
or wall, the number in the blue box shows the
number of unread messages. If no number
appears, it means you have marked all
messages in that Conversation or wall as read.

Notifications Click this icon to show your notifications.

The number in the red circle shows how many
notifications you have

Using Notifications in Oracle Social Network
Desktop

Remove Select a notification, and click this icon to
remove it.

Settings Opens the Settings window.

Configuring Your Settings for Oracle Social
Network Desktop

Begin Search This icon appears at the top of the sidebar.
Click it to execute a search based on your
search terms and to show results in a new
window. When you search without clicking
Begin Search, results show in a pop-up list. You
can still click Begin Search to open a separate
window with the full set of results.

What is the Detail window?
The Detail window provides a tabbed view of all the items (Conversations, collections,
people, groups, Social Objects, and hashtag pages) you have open. Each tab includes
an icon representing the type of item, the item name, and, when appropriate, a number
showing how many unread messages you have in the Conversation or wall.

Note: The tab flashes when a new message is added to the Conversation or wall.

The plus sign to the right of the tabs enables you to open existing items or create a
new Conversation.
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You can right-click a tab to perform the following actions:

• Close This Tab—Closes the tab you right-clicked.

• Close Other Tabs—Closes all tabs other than the one you right-clicked.

• Close All Tabs—Closes the Detail window and all tabs.

• Mark All as Read—Marks all the messages in the tab you right-clicked as read.

• Mute/Unmute <Item>—Mutes or unmutes the item displayed on the tab you right-
clicked. For more information, see How do I mute or unmute an item?

• Add to/Remove from Favorites—Adds or removes the item displayed on the tab
you right-clicked as a favorite. For more information, see How do I add an item as
a favorite?

• Rename <Item>—Lets you rename the item displayed on the tab you right-
clicked. For more information, see How do I rename an item?

• View in Web Browser—Open the item displayed on the tab you right-clicked in
the web version of Oracle Social Network. For more information, see How do I
view an item in the web version of Oracle Social Network?

When many tabs are open in the Detail window, an overflow menu appears, which you
can click to see additional open items. To the right of the overflow menu, the number
in the blue box indicates the total number of all unread messages in all overflow
Conversations and walls.

The controls on a tab vary depending on the type of item displayed:

• Membership bar—shows pictures of the item members and an icon for managing

the list of members ( ). For more information, see How do I view and manage an
item's members?

Appears on Conversations, collections, groups, and Social Objects tabs.

• Find and navigate tools—enable you to find unread messages, flags assigned to
you, or text within the Conversation or Social Object.

– To find unread messages, click the unread messages count in the tab bar, and
use the up and down arrows to navigate through the unread messages.

– To find flags assigned to you, click the flag count in the tab bar, and use the up
and down arrows to navigate through your flags.
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– To find text in the messages or documents, click the search icon in the tab bar,
enter the text you want to search for, press Enter. The matching text is
highlighted in the messages. Use the up and down arrows to navigate through
the results.

• Options menu ( )—enables you to perform actions on the item, like adding the
item as a favorite or changing the item's settings.

Appears on all tabs except hashtag page tabs, but the options on each menu vary
according to the item type.

• Tabs—shows lists of associated items (such as messages and documents), but
the tabs vary according to the item type:

– Messages (Conversations) or Wall (all other items)—Shows the messages
relating to the item you're viewing.

– Documents—Shows the documents added to the item you're viewing and any
folders that exist.

– Followers (people)—Shows who is following the person you're viewing.

– Following (people)—Shows who the person you're viewing is following.

– Member Of (groups)—Shows what items the group you're viewing is a
member of.

– Related Items—Shows the items added to the item you're viewing.

– Referring Items—Shows the items that include the item you're viewing in their
list of related items.

How do I set up or change my profile?
1. Click your picture in the upper left corner to display your wall. Your profile

information is at the top of your wall. (You can get to anyone's wall and profile by
clicking their name or picture almost anywhere you see them in Oracle Social
Network.)

2. Click Edit Profile.

3. Edit your profile information as desired. Some information is read-only and can't be
edited.

4. To change your profile picture, click Change Picture. Select a .gif, .png, or .jpg
file. Your picture is scaled to 150x150 pixels and placed in a circle showing your
online status.

The Crop Picture dialog shows your image with a circle over the area that will
show in Oracle Social Network. You can drag the corners of the crop area to
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change the size of your picture, or drag your picture to change the position of the
crop area. When you're happy with the size and position, click Crop.

If you want to remove your profile picture and just use the default avatar, click
Clear Picture.

Note: Your wall is a place where you can post messages and other types of content
for everyone to see. Other people can also post content to your wall, but only if they're
following you. You can turn off the ability for others to post to your wall through
Settings (see How do I control whether other people can post or reply to messages
and documents on my wall?).

How do I close and exit Oracle Social Network Desktop?
You have a couple of options:

Close

You can close Oracle Social Network Desktop but leave it running in the background
to continue seeing pop-up alerts:

• In Microsoft Windows: Click the Close icon in the top right of the sidebar.

• On a Mac: Click the red close button in the top left of each window.

Exit

You can exit Oracle Social Network Desktop, closing all its windows and discontinuing
pop-up alerts in this session:

• In Microsoft Windows: In the system tray, click the Oracle Social Network icon
and select Exit. Click OK in the confirmation dialog.

• On a Mac: From the application menu, select Quit Oracle Social Network. Click
OK in the confirmation dialog. Alternatively, right-click the Dock icon, and select
Quit.

What You Can Do in Oracle Social Network Desktop
Most tasks you perform in Oracle Social Network Desktop are similar no matter what
type of object you're working with.

• How do I open an item?

• How do I add an item as a favorite?

• How do I create an item?

• How do I view and manage an item's members?

• How do I hide an item's membership messages?

• How do I share a link to an item?

• How do I rename an item?

• How do I split a Conversation off from an existing Conversation or wall?

• How do I mute or unmute an item?

• How do I close or reopen an item?

• How do I discard an item?
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• How do I download an archive of an item?

• How do I add an item to my Offline Briefcase?

• How do I view an item in the web version of Oracle Social Network?

• Other Common Tasks

How do I open an item?
Click the item wherever you see it linked. The item opens in the Detail window. For
more information, see What is the Detail window?

To open an item from the object panel:

1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

2. Click the item.

To open an item from the Detail window:

1. While viewing an item in the Detail window, click , then select Open
Conversation.

2. Enter the name of the item in the Search Conversations field, or click a filter to
select from a list:

• Click Recent to select from a list of items you've visited recently.

• Click Favorites to select from a list of your favorite items.

• Search Results opens automatically when search results are returned.

3. Click the item.

How do I add an item as a favorite?
To mark an item as a favorite, click  next to the item. Click the star again to unmark
it. For more information, see Using Favorites in Oracle Social Network Desktop.

How do I create an item?
1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

2. Click .

For contacts, enter at least two characters to search for people, then click a
person to add them as a contact.
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For Social Objects, select the type of object to create.

3. Enter a name for the item.

4. Select whether the item is private (only visible to members) or public (visible to
everyone).

Note: This setting doesn't appear for groups.

5. Select members by moving groups and people to the right column to add them or
to the left column to remove them. Use Ctrl+Click to select more than one person
or group.

You can also search by entering part of a person's or group's name, and select
them from the list that pops up.

By default, you see a list of contacts. Click a tab to change your view:

•  Contacts—View a list of your contacts.

•  Groups—View a list of your groups.

Alternatively, you can create a new Conversation from the Detail window.

1. While viewing an item in the Detail window, click , then select New
Conversation.

2. Enter a name for the Conversation.

How do I view and manage an item's members?
1. Open the item. For more information, see How do I open an item?

At the top of the item's tab is a membership bar with pictures of all the people who
are members of that item.

2. In the membership bar, click  to open the Update Members dialog.

Notes:

• If you don't see the manage members button ( ) when viewing a group, the
group is managed externally (for example, through LDAP), so you can't
change the membership through Oracle Social Network.

• If you're viewing a public item that you haven't joined, you can view the
members by clicking the Options menu ( ), then selecting Show
Membership.

3. In the Update Members dialog, move groups and people to the right column to add
them or to the left column to remove them. Use Ctrl+Click to select more than one
person or group.

If your administrator has configured the system to allow you to invite users, you
can add someone who isn't an Oracle Social Network user. Enter the person's
email address in the search box, then click Invite email_address. When asked if
you want to send an invitation, click Yes. When you save your changes an email
will be sent to the person inviting them to join Oracle Social Network.

You can also search by entering part of a person's or group's name, and select
them from the list that pops up.
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By default, you see a list of contacts. Click a tab to change your view:

•  Contacts—View a list of your contacts.

•  Groups—View a list of your groups.

Alternatively, you can remove a member (that was not added as part of a group) by
right-clicking the member in the membership bar, then clicking Remove from <item
type>.

Note: The Remove from <item type> option isn't available if you right-click a member
that was added as part of a group. To remove a member who was added as part of a
group, you must remove the whole group through the Update Members dialog (as
described above).

How do I hide an item's membership messages?
When a user is added to or removed from an item a membership message is posted to
the item (for example, This Conversation is now accessible to: Jane Doe). If you'd
prefer not to show those messages, you can hide them.

1. Open the item. For more information, see How do I open an item?

2. Click , select <Object Type> Settings, then select Hide Membership
Messages.

Note: User walls have followers rather than members, so this setting doesn't apply to
user walls.

How do I share a link to an item?
Let's say you want to share a link to an item (for example, a Conversation) in an email
or while you're instant messaging. Open the item, click the Options menu ( ), then
select Copy Link. The link to the item is copied to your clipboard, and you can paste it
anywhere you like.

Note: When people click the link, they are taken to Oracle Social Network in their
browser.

How do I rename an item?
1. Open the item. For more information, see How do I open an item?

2. In the Detail window, click the Options menu ( ), click Conversation Settings,
then select Rename <Object>.

3. Enter the new name.

How do I split a Conversation off from an existing Conversation or
wall?

If one your messages start going off-topic or a new question or idea is raised, you
might want to split that discussion into a new Conversation.

1. Open the Conversation or wall, see How do I open an item?
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2. Under the text box, click .

3. In the New Conversation dialog box, enter a name, select the visibility, and add
members. For more information, see How do I create an item?

When you create the new Conversation, messages are posted in both the new and the
original Conversations showing a link to the other Conversation.

How do I mute or unmute an item?
If you have items in your object lists that you never look at (for example a
Conversation that doesn't apply to you), or you're seeing updates on the Overview
panel or in your email digests about items you don't care about, you can mute those
items. Muting an item hides it and its activity from your view. It's still there; you just
won't hear about it anymore. (The only exception is if you're flagged on a message in a
muted item, for which you will still be alerted by email.)

To mute an item:

1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

2. Right-click the item and select Mute <Object>.

Alternatively, open the item, click the Options menu ( ), then select Mute <Object>.

To unmute an item:

1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

2. Click the Options menu ( ), and select Muted to show all muted items.

3. Right-click the item and select Mute <Object> to clear the check mark.

Alternatively, open the item, click the Options menu ( ), then select Mute <Object> to
clear the check mark.

How do I close or reopen an item?
You can close any item you belong to, even if you didn't create it. Closing an item
prevents people from adding new content to it and moves the item to the list of closed
items in everyone's object panel.

To close an item:

1. Open the item. For more information, see How do I open an item?

2. In the Detail window, click the Options menu ( ), click <Object> Settings, then
select Close <Object>.
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3. Optionally, add an explanation about why you closed the item.

To reopen an item:

1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

2. Click the Options menu ( ), then select Closed to show a list of all the closed
items.

3. Open the closed item.

4. In the Detail window, click the Options menu ( ), click <Object> Settings, then
select Reopen <Object>.

How do I discard an item?
You can discard an item if you are the only member and it's private. The item, its
messages, and its documents are deleted. Although the relationships between the
discarded item and any related and referring items are deleted, the related and
referring items aren't affected in any other way.

Note: All content is retained on the system for legal or forensic purposes, but only an
application administrator can recover discarded content.

1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

2. Right-click the item, and select Discard <Object>.

Alternatively, open the item, click the Options menu ( ), click <Object> Settings,
then select Discard <Object>.

How do I download an archive of an item?
At some point you might want to download an archive of an item, possibly to view
when you're offline or maybe to keep a record of the item's content at a certain point.

The archive is in the form of a .zip file (named after the item). It contains the item's list
of members, messages, and replies in an HTML file (named by default index.html) and
all the documents added to the item.

To download an archive of an item:

1. Open the item. For more information, see How do I open an item?

2. In the Detail window, click the Options menu ( ), then click Download Archive.

A progress window opens showing the download progress. After the download is
done, you can double-click the archive to open it, or you can right-click it and select to
open the containing folder or remove it from the progress window list.

To work with an archive of an item:
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1. Unzip the files to your computer.

2. Open index.html.

Clicking a document link opens the copy of the document that is included in
the .zip file. All other links in index.html (user names, like, reply, and so on) open
Oracle Social Network in the browser.

Notes:

• You can't make changes to an archive of an item (though you can click a link to
open the item in a browser and make changes there). If you want to be able to
make offline changes, instead add the item to your Offline Briefcase (see Working
Offline in Oracle Social Network Desktop).

• You can get back to the progress window after you've closed it by clicking

 in the system tray for Microsoft Windows, or by clicking the Action Menu
for Mac, then clicking File Transfer Progress.

How do I add an item to my Offline Briefcase?
Tip: For information about offline briefcases, see Understanding the Offline Briefcase.

1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

2. Right-click the item, and select Add to Offline Briefcase.

Alternatively, open the item, click the Options menu ( ), then click Add to Offline
Briefcase.

How do I view an item in the web version of Oracle Social Network?
1. Open the item. For more information, see How do I open an item?

2. In the Detail window, click the Options menu ( ), then click View in Web
Browser.

Your browser opens to the selected item.

Other Common Tasks
Here is a list of other things you can do in Oracle Social Network Desktop:

Table 15-2    List of Other Things You Can Do in Oracle Social Network Desktop

Action For more information, see …

Post, reply to, like edit, and delete messages; mark
messages as read

Working with Messages

Add, download, and manage documents; create and
manage folders

Working with Documents
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Table 15-2    (Cont.) List of Other Things You Can Do in Oracle Social Network Desktop

Action For more information, see …

View, add, or remove items related to or referring to
the item you're viewing

Working with Related and Referring Items

Add hashtags to messages and use them to easily
find messages around a particular topic

What are hashtags (#) and how do I use them?

Search for items How do I search?

Use the Overview panel to quickly see recent activity
across Oracle Social Network

Using the Overview Panel in Oracle Social Network Desktop

View, assign, and respond to flags Using Flags in Oracle Social Network Desktop

Mark items as favorites Using Favorites in Oracle Social Network Desktop

View, start, and participate in Conversations Using Conversations in Oracle Social Network Desktop

Have a one-on-one Conversation in real time with
someone

How do I start a One-on-One Conversation?

View and manage collections of items surrounding a
topic

Using Collections in Oracle Social Network Desktop

View and manage your contacts; view a person's
profile and post to his or her wall; manage the
people you're following and see who's following you

Working with People in Oracle Social Network Desktop

View and manage groups, group membership, and
the messages and documents posted to them

Working with Groups in Oracle Social Network Desktop

View and manage Social Objects and the messages
and documents posted to them

Using Social Objects in Oracle Social Network Desktop

Save items to a briefcase and view and contribute to
them offline

Working Offline in Oracle Social Network Desktop

Receive and respond to notifications about Oracle
Social Network activity

Using Notifications in Oracle Social Network Desktop

View, manage, and switch between the accounts
you use to connect to Oracle Social Network
Desktop

Managing Your Account in Oracle Social Network Desktop

Configure settings for things like security,
notifications, and conferences

Configuring Your Settings for Oracle Social Network
Desktop

Working with Messages
This section describes how to work with messages from your desktop:

• How do I post a message?

• How do I check for unread messages?

• How do I quickly navigate through the messages in a Conversation or wall?

• How do I mark messages as read or unread?

• How do I like or unlike a message?

• How do I mark or remove a message as a favorite?

• How do I flag a message for someone?
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• How do I reply to a message?

• How do I edit a message I posted?

• How do I delete a message?

• How do I post a link to a Conversation, wall, or document?

• How do I post a snapshot of my screen?

• How do I add documents from the Messages or Wall tab?

• How do I split a Conversation off from an existing Conversation or wall?

• How do I select the language for system messages for a Conversation or wall?

How do I post a message?
1. Open the Conversation or wall. For more information see How do I open an item?

A Conversation has the message text box at the bottom of the window. A wall has
the message text box at the top of the window.

Note: If you don't see a text box at the top of someone's wall, you aren't following
the person or the person doesn't allow other people to post to his or her wall.

2. In the text box, enter your message.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

Controls below the text box offer more options:

• Select text and click  to format your selection as bold.

• Select text and click  to format your selection as italic.

• Select text and click  to underline your selection.

• Select text and click  to remove formatting.

For example, when you cut-and-paste content, it can carry over undesirable
formatting from the source. You can easily remove that formatting by selecting

it and clicking .

• Click  to enter your message in the Rich Text Editor.

The Rich Text Editor offers a richer set of text formatting tools—for example,
bullets and numbering options—to post a more formally formatted message.

• Click  to add a link to an Oracle Social Network Conversation, wall, or
document.

For more information, see How do I post a link to a Conversation, wall, or
document?

• Click  to take a screen shot of your desktop and post it.
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For more information, see How do I post a snapshot of my screen?

• Click  to add a document.

For more information, see How do I add documents from the Messages or
Wall tab?

Note: Under the text box there's also a control to create a new Conversation, split off

from the existing item ( ). For more information, see How do I split a Conversation
off from an existing Conversation or wall?

How do I check for unread messages?
1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

The number of unread messages in each object appears in a blue box ( ) next
to the object name.

2. Filter the view to show only items with unread messages. Click , select Only
Unread.

3. Optionally, sort the objects by the number of unread posts. Click , select Sort
By, then select Unread Posts.

By default, the list is sorted in descending order (objects with the most unread
posts are listed first).

Note: Your sort settings are saved and applied whenever you view the
Conversations panel.

How do I quickly navigate through the messages in a Conversation or
wall?

While viewing a Conversation or wall, you can scroll up or down but you can also use
a couple features to quickly navigate a Conversation or wall.

• To jump directly to the previous or next unread message, click the unread
messages count in the tab bar, and use the up and down arrows to navigate
through the unread messages.

• To jump to the top or bottom of a Conversation or wall:

– On Microsoft Windows, press Ctrl+Home (top) or Ctrl+End (bottom).

– On Macintosh, press Cmd+Ctrl+Up (top) or Cmd+Ctrl+Down (bottom).
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How do I mark messages as read or unread?
In an object panel you can mark all messages for a particular object as read by

clicking the number of unread messages in the blue box ( ) next to the object.

Open the Conversation or wall, use the following methods to mark messages as read
or unread:

• To mark a message as read, click the  to the left of it, right-click the message and

select Mark Message as Read, or click  More and select Mark Message
as Read.

• To mark all messages as read, click  in the header.

This number shows how many unread messages there are in the current
Conversation. Once you click this number, it resets to zero and all messages in
the current Conversation are marked as read.

You can also click , and select Mark All as Read.

• If you want a message status to be unread, but you've already marked it as read,
you can right-click the message and select Mark Message as Unread, or click

 More and select Mark Message as Unread. This works only with
messages others have posted and not your own posts.

Tip: For information on marking messages as read automatically when you view them,
see How do I set up when to mark messages as read?

How do I like or unlike a message?

Open the Conversation or wall, click  Like under the message to like it. Click the
like icon again to unlike it.

You can also like an item from the Overview panel (click  in the sidebar).

Tip: To see who has liked a message, click the link that shows the number of people
who have liked it.

How do I mark or remove a message as a favorite?
Open the Conversation or wall, click  next to the message to mark it as a favorite.
Click the star icon again to unmark it.

For information on viewing your favorites, see How do I view my favorites?

How do I flag a message for someone?
Open the Conversation or wall, click the flag icon next to the message to manage
flags. For more information, see How do I assign or clear flags?

For information on viewing your flags, see Where can I see all my flags?
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How do I reply to a message?
1. Open the Conversation or wall. For more information see How do I open an item?

You can also reply to an item from the Overview panel (click  in the
sidebar).

2. Click  Reply under the message (or right-click the message, then click Reply)
to open a reply entry field.

3. Add your reply.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

Note: If you don't see  Reply under a post on a person's wall, the person doesn't
allow other people to reply to his or her wall posts.

How do I edit a message I posted?
Right-click the message you posted (you can edit only your own messages) and click

Edit, or click  More and select Edit, to open a text editor and revise the
message.

All edited messages show  at the bottom of the message. You can click this to see
the earlier versions of that message and to open the message for editing.

Notes: For information about the message text editor, see How do I post a message?

How do I delete a message?
You can delete messages you posted or messages on your profile wall.

Note: If you are a service administrator, you can delete any message.

Right-click the message, then click Delete, or click  More and select Delete.

To restore a deleted message, locate the deleted message icon ( ) where the

message used to be, click , then confirm that you want to restore the message.

Note: Only a service administrator, the person who posted the message, or the person
who deleted the message can restore the deleted message.

How do I post a link to a Conversation, wall, or document?
1. Open the Conversation or wall. For more information see How do I open an item?

2. Under the text box, click .
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3. In the resulting dialog, select a source for the Conversation, wall, or document.

• Recent Items—Select from a list of items you have recently interacted with.

• Recent Documents—Select from a list of documents you have recently
viewed.

• Favorites—Select from the items you have marked as a favorite.

• Search Results—Enter a search term in the Search field at the top of the
dialog; results appear on the Search Results tab.

4. Select the item you want to link to, and click OK.

5. Optionally, add your own text to the message.

Tip: You can add text before you add the link and after.

How do I post a snapshot of my screen?
You can take a picture of your screen and post it to a Conversation or wall.

1. Open the Conversation or wall. For more information see How do I open an item?

2. Bring the windows that you want to capture forward.

3. Under the text box, click  to open an image of your entire desktop in the
Snapshot Editor.

This minimizes all Oracle Social Network Desktop windows, and provides you
with, by default, five seconds to arrange your desktop for the snapshot. You can
configure the waiting period in your settings. For more information, see How do I
set the time to delay before a snapshot is taken?

To skip the waiting period, click Grab Now.

4. Select the region to snapshot by clicking and dragging over the area you want to
use.

5. Optionally, in the text box at the bottom of the Snapshot Editor, enter a message
to include with the image.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

How do I add documents from the Messages or Wall tab?
You can add files from your local file systems. For instructions, see How do I add
documents?

How do I split a Conversation off from an existing Conversation or
wall?

If your messages start going off-topic or a new question or idea is raised, you might
want to split that discussion into a new Conversation.
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Open the Conversation or wall, click  (under the text box), then complete the
information in the dialog. For more information, see How do I split a Conversation off
from an existing Conversation or wall?

When you create the new Conversation, messages are posted in both the new and the
original Conversations showing a link to the other Conversation.

How do I select the language for system messages for a Conversation
or wall?

Imagine that you and your colleagues post messages and documents in one
language, but system messages keep appearing in another. You can easily change
the language for these messages.

1. Open the Conversation or wall. For more information see How do I open an item?

2. Click the Options menu ( ), click <Object> Settings, click Change <Object>
Language, then select a new language.

When you change the language for an item, new system messages appear in the new
language. System messages posted before the language change remain in the
language they were in when posted. Messages, files, button labels, and links are not
affected by an item language change.

Note: Selecting a language for system messages affects all members' views of the
item.

Working with Documents
This section describes how to work with documents from your desktop:

• How do I view a document?

• How do I create or delete a folder?

• How do I add documents?

• How do I delete a document?

• How do I copy documents or folders to another item?

• How do I move documents or folders to another folder?

• How do I download documents or folders?

• How do I view other versions of a document?

• How do I see who has accessed a document?

• How do I navigate from a document to its location in the Conversation or wall?

• How do I view an annotation on a document?

How do I view a document?
From wherever you see the document (for example, in the Overview panel, in a list of
messages, on the Documents tab for an item), you can open the document in one of
the following ways:
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• Click the document image to open the document in the web version of Oracle
Social Network.

• Under the document, click Open; or right-click the document, then select Open
Document to open the document in it's native application.

Note: If Oracle Social Network can't find an application associated with the file
type, you are prompted to select an application (for Windows) or you are taken to
the file in Finder (for Mac).

How do I create or delete a folder?
To create a folder:

1. Open the item that you want to add the folder to or remove the folder from. For
more information see How do I open an item?

2. Click the Documents tab.

3. Click .

4. Enter a name and click Create.

Note: When you open a folder, a breadcrumb appears at the top of the Documents
tab to show you where you are in the folder structure. To return to a parent folder, click
the folder name in the breadcrumb.

Example 15-1    To delete a folder:

You can delete folders you created (so long as it doesn't include anyone else's
documents or folders) or folders on your profile wall.

Note: If you are a service administrator, you can delete any folder.

To delete a folder, right-click the folder, then click Delete.

Example 15-2    To restore a deleted folder:

To restore a deleted folder and its contents, on the Messages tab, locate the deleted

message icon ( ) where the folder message used to be, click , then confirm that
you want to restore the folder.

Note: Only a service administrator, the person who created the folder, or the person
who deleted the folder can restore the deleted folder.

How do I add documents?
You can upload files from your local file systems.

Note: If you add a document with the same name as one that was previously added, a
new version is created.

1. Open the item that you want to add the document to. For more information see 
How do I open an item?

2. On the Messages tab, click  under the text box.
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Alternatively, on the Documents tab, navigate to the folder where you want to add

documents, then click  at the top of the tab.

3. Select one or more documents, then click OK.

4. To prevent people from downloading or copying the file select Disable download
and copy.

5. Optionally, enter a message to accompany the file.

Tips:

• If you selected multiple files, click  to the left of a file to open a message
entry area.

• When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

When you click Post, you see the progress of the upload.

How do I delete a document?
You can delete documents you posted or documents on your profile wall.

Notes:

• If you are a service administrator, you can delete any document.

• Deleting a document or document version deletes it for all members of the
Conversation or wall. There's no undelete, so be sure about deleting the file before
you act.

To delete a document and all its versions:

1. Open the item that includes the document you want to delete. For more
information see How do I open an item?

2. Click the Documents tab.

3. Click More under the document, or right-click the document, then click Delete.

To delete a specific version of a document:

1. Navigate to the message associated with the document version you want to
delete.

You can browse for the message or you can get to the document version message
from the Documents tab. To get to the document version message from the
Documents tab:

a. Click the version number link next to the document name, or right-click the
document, then select Show All Versions.

b. Right-click the version you want to delete, then click Go to Comment.

2. Right-click the document version message, then click Delete.
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To restore a document:

To restore a deleted document, on the Messages tab, locate the deleted message

icon ( ) where the document message used to be, click , then confirm that you
want to restore the document.

Note: Only a service administrator, the person who posted the document, or the
person who deleted the document can restore the deleted document.

How do I copy documents or folders to another item?
1. Open the item that includes the documents or folders you want to copy. For more

information see How do I open an item?

2. Click the Documents tab.

3. Select one or more documents and folders.

4. Right-click your selection, select Copy, then select whether to copy the selected
documents and folders to a new Conversation or an existing Conversation.

5. If you selected Copy to New Conversation, enter the information for the new
Conversation. If you selected Copy to Existing Conversation, select the
Conversation you want to copy the documents and folders to.

How do I move documents or folders to another folder?
1. Open the item that includes the documents or folders you want to move. For more

information see How do I open an item?

2. Click the Documents tab.

3. Select one or more documents and folders.

4. Right-click your selection, then select Move. In the dialog, select the folder you
want to move the documents and folders to, or click New Folder to create a new
folder.

Alternatively, to move documents and folders to a subfolder, drag them to the new
folder.

How do I download documents or folders?

1. Open the item that includes the documents or folders you want to download. For
more information see How do I open an item?

2. Click the Documents tab.

3. Select one or more documents and folders, right-click your selection, then select
Download.

Note: If you select a folder or more than one document, the selected items are
downloaded as a .zip file.

Alternatively, to download a single file, click Download under the file.

A progress window opens showing the download progress. After the download is
done, you can double-click the document to open it, or right-click it and select to open
the containing folder or remove it from the progress window list.
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Alternatively, while viewing messages, right-click a document, then select Download

Document, or click  More and select Download Document.

Note: You can get back to the progress window after you've closed it by clicking

 in the system tray for Microsoft Windows, or by clicking the Action Menu for
Mac, then clicking File Transfer Progress.

How do I view other versions of a document?
When a document has more than one version, it displays a link in brackets ([x
versions]) that indicates the number of versions.

1. Open the item that includes the document you want to view. For more information
see How do I open an item?

2. Click the Documents tab.

3. Click the version number link, or right-click the document, then select Show All
Versions.

4. Click the version to open it, or right-click it for additional options.

To hide the versions, click the version number link again; or right-click the document,
then select Show Latest Version.

How do I see who has accessed a document?
You can look at a document's access history to see who has viewed or performed
other actions on the document.

1. Open the item that includes the document for which you want to see the access
history. For more information see How do I open an item?

2. Click the Documents tab.

3. Click More under the document, or right-click the document, then select Access
History.

The Access History dialog you see who viewed, copied, or added new versions of
the document along with the date and time they did so.

4. To filter the list by a type of activity, click All Activity and select an activity type.

How do I navigate from a document to its location in the Conversation
or wall?

You can get from a document in the Documents tab to the place in the Conversation or
wall where the document was posted.

1. Open the Conversation or wall. For more information see How do I open an item?

2. Click the Documents tab.

3. Click More under the document, or right-click the document, then select Go to
Comment.
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How do I view an annotation on a document?
When you see a message stating that someone has added an annotation to a
document, click the name of the document to navigate to the annotation. The
document opens in the web version of Oracle Social Network and displays the
annotation.

Alternatively, right-click the document, then select View Annotation, or click 
More and select View Annotation.

Working with Related and Referring Items
This section describes how to work with related and referring items from your desktop:

• What are related and referring items?

• How do I view an item's related items?

• How do I view an item's referring items?

• How do I add an existing item as a related or referring item?

• How do I add a new item as a related or referring item?

What are related and referring items?
Related items are the items that have been added to the item you're viewing. They can
include Conversations, Social Objects, people's walls, group walls, and other
collections.

Referring items are the items that the item you're viewing has been added to. They
can include Social Objects and collections.

How do I view an item's related items?
1. Open the collection or Social Object. For more information see How do I open an

item?

2. In the Detail window, if the tab isn't already open, click the Related Items tab to
show the list of items that has been added to the item you're viewing.

How do I view an item's referring items?
1. Open the item. For more information see How do I open an item?

2. In the Detail window, click the Referring Items tab to show the list of items that
the item you're viewing has been added to.

How do I add an existing item as a related or referring item?
1. Open the item to which you want to add the related or referring item. For more

information see How do I open an item?

2. Click the appropriate tab (Related Items or Referring Items) tab, then click .
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Note: Referring items are available only for collections and Social Objects.

3. In the dialog, select a source:

• Recent—Select from a list of items you have recently interacted with.

• Favorites—Select from the items you have marked as a favorite.

• Search Results—Enter a search term in the Search field at the top of the
dialog; results appear on the Search Results tab.

4. Select the desired related or referring item.

How do I add a new item as a related or referring item?
1. Open the item to which you want to add the related or referring item. For more

information see How do I open an item?

2. Click the appropriate tab (Related Items or Referring Items) tab, click , then
select the type of item you want to create.

Note: Referring items are available only for collections and Social Objects.

3. In the dialog, enter a name, set the visibility, and add members.

Using Hashtags and Search in Oracle Social Network
Desktop

This section describes how to use hashtags from your desktop:

• What are hashtags (#) and how do I use them?

• How do I search?

What are hashtags (#) and how do I use them?
You can use a hashtag (#) in a message to call out a meaningful term or topic, making
it easy to search for all content associated with that term or topic. For example,
imagine discounts is a popular topic in your group, but the discounts can come in the
form of dealer incentives, cash-back deals, seasonal discounts, or any other number
of forms. How do you find what everyone is saying about all those things? You use a
hashtag. Every time you or your colleagues say something about some form of
discount, you include the hashtag #discounts. You can then search for #discounts and
get a list of all messages in otherwise unrelated Conversations and walls that contain
the hashtagged term.

Adding Hashtags

You can add one or more hashtags to any message (comments, replies, annotations,
and document messages) simply by typing "#" before a term. When you start typing a
hashtag by typing "#" plus at least one letter, existing hashtags (ones that have been
used before) appear for you to select from.

Tips:

• You can include the following characters in a hashtag: A through Z, a through z, 0
through 9 and _.
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• A hashtag can be a maximum of 25 characters (not including the "#").

Searching for and Viewing Hashtags

When you perform a search, available hashtags are included in the results. If your
search term starts with a hashtag (#), one of two things will happen. If the hashtag
exists, the hashtag page opens. If the hashtag doesn't exist, you see search results
that contain any tags similar to the hashtag you searched for.

Wherever you see them, hashtagged terms are clickable and will open a hashtag tab
page where all messages that include that hashtag are shown. So clicking #discounts
in any Conversation opens a #discounts tab which shows any message (in a
Conversation, document annotation, wall, or such) that you have access to that
includes the discounts hashtag.

On the hashtag tab, you can filter the messages to show all messages that include the
hashtag (All Results) or just those messages posted by people you are following (By
People You Follow).

Following Hashtags

You can also follow hashtags. When you follow a hashtag, messages in public
Conversations and walls that contain that hashtag appear on the Overview panel,
even if you are not a member of those Conversations or walls.

To follow a hashtag, click the hashtag to open the hashtag tab, then click Follow at
the top of the tab. To stop following the hashtag, click Stop Following.

How do I search?
1. Enter at least two characters in the search box at the top of the sidebar.

Top rated results appear in a drop-down list. Click a result to open the item in the
Detail window.

2. To see all results, press Enter or click .

The search results open in the Detail window.

3. Optionally, select a filter from the Show menu to show a particular result type (for
example, Conversations or documents).

4. After filtering by a result type, you see some additional sort and filter options:

• Sort By: Select how to sort your results.

• Posted By: Limit your search to messages or documents posted by a
particular person.

• Posted When: Limit your search to messages or documents posted within a
particular period.

• Document Type: If you filter your results to show documents, you can select
which types of documents to show.

• Updated By: Limit your search to Conversations, collections, or Social
Objects updated by a particular user.

• Updated When: Limit your search to Conversations updated within a
particular period.
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• Created By: Limit your search to Conversations or groups created by a
particular user.

• Created When: Limit your search to Conversations or groups created within a
particular period.

• Favorites Only: Limit your search to only your favorite Conversations.

• Include Public: Control whether to show public Conversations in your results.

• Include Closed: Control whether to show closed Conversations in your
results.

• Include Deactivated: Control whether to show deactivated groups in your
results.

• With Member: Limit your search to Conversations or groups with a particular
member.

If you don't see an option that applies to your selected item type, click  to show
more options.

Click a result to open it, or right-click a result to see additional actions.

To edit your search term, click , then press Enter or click .

Using the Overview Panel in Oracle Social Network Desktop
The Overview panel provides a view of recent activity across Oracle Social Network.
On the Overview panel, you see only the information you're interested in (that you
have access to). For example, you see messages only from Conversations that you're
a member of and walls of people you're following.

1. Click  in the sidebar to open the Overview panel.

2. Use the Options menu ( ) to adjust your view:

• Only Unread—When selected, view only the Conversations and walls you're
a member of that have unread messages.

• Message Preview—When selected, shows a preview of the latest message
posted to each Conversation and wall you're a member of.

Note: These options are saved and applied whenever you view the Overview.

Double-click a message or reply to view it in the Conversation or wall.

If there are more than two replies, you can also click See <x> more replies to view
the replies in the Conversation or wall.

Click the Conversation or wall name to go to the bottom of the Conversation or the top
of the wall.

Right-click a message to access a menu of useful actions.

Using Flags in Oracle Social Network Desktop
This section describes how to use flags from your desktop:
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• What are flags?

• Where can I see all my flags?

• How do I assign or clear flags?

What are flags?
Note: For detailed information about flags, including explanations of what the different
flag icons mean, see What do the flag icons mean?

Every message posted to a Conversation or wall shows a flag icon that tells you
instantly whether a flag is assigned on the message. For example:

• If the flag icon is hollow ( ), then no flag is assigned on the message.

• If the flag icon is not hollow ( )—that is, it's a solid color, possibly with secondary
marker on it—then one or more flags are assigned on the message.

There are several types of flags:

• For Your Information—Look at this when you have the time.

• Please Reply—Look at this, and let me know what you think.

• Please Reply - Urgent—Look at this now, and let me know what you think
immediately. (An email notification is always sent for Please Reply - Urgent flags.)

To get more information about a flag, you can either mouse over the flag to see a
tooltip (for example, "For Your Information flag for another from Name.") or click the
flag icon, then click Manage Flags to see all the flag assignments.

Where can I see all my flags?

1. Click  in the sidebar to open the Flags panel, where you can see a list of
all the flags assigned to you, all the flags you assigned, or a subset of these.

Note: The number displayed on the flag icon in the sidebar shows how many flags
are assigned to you.

2. Use the Options menu ( ) to filter and sort the list:

• Flags for You—Flags assigned to you.

• Flags You Assigned—Flags assigned by you.

• Please Reply - Urgent, Please Reply, and For Your Information—Filter by
flag type. The number to the right of the flag type shows how many of that type
of flag is on the list.

• Sort By—Sort the messages by message date in ascending or descending
order. For flags assigned to you, you can also sort by the date the flag was
assigned.

Note: Your sort settings are saved and applied whenever you view the Flags
panel.

• Flagged For/Flagged By—Filter by the person you assigned the flag to or
who assigned the flag to you.
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Click a message to view it in its associated Conversation or wall.

How do I assign or clear flags?
To manage flags on an individual message:

1. While viewing the message in the Overview panel (click  in the sidebar),

the Flags panel (click  in the sidebar), or the Detail window (see How do I
open an item?), click the flag icon next to the message.

2. Assign or clear flags:

• To remove a flag assigned to you, click Clear.

• To quickly assign a For Your Information flag to someone, click the flag next to
the person.

• To assign a particular flag to someone, select the type of flag in the drop-down
list next to the person.

• To quickly flag everyone, click Flag All (in the Not Flagged section), and
select the type of flag you want to assign.

• To quickly remove all flags (whether assigned by you or not), click Clear All
(in the Others Flagged section).

• To remove a particular flag, click  next to the person.

• To search for someone, enter part of the person's name in the search box.

Note: Although you can remove existing Please Reply and Please Reply - Urgent
flags in closed Conversations, you can't assign new ones. You can assign only For
Your Information flags in closed Conversations. For information on closing or
reopening a Conversation, see How do I close or reopen an item?

To clear flags assigned to you on one or more messages from the Flags panel:

1. Click  in the sidebar to open the Flags panel.

2. If necessary, select a view from the Options menu ( ): Flags for You or Flags
You Assigned.

3. Select the flags you want to clear (using Ctrl+click or Shift+click), then click  (at
the top of the Flags panel).

Any flags assigned to you in the selected messages are cleared.

Using Favorites in Oracle Social Network Desktop
This section describes how to use favorites from your desktop:

• How do I mark an item as a favorite?

Chapter 15
Using Favorites in Oracle Social Network Desktop

15-32



• How do I view my favorites?

How do I mark an item as a favorite?
Marking an item as a favorite is an easy way to keep track of the items you use most
frequently.

To mark an item as a favorite, click  next to the item. Click the star again to unmark
it.

How do I view my favorites?

1. Click  in the sidebar to open the Favorites panel, where you can see a
list of items you've marked as favorites.

2. Use the Options menu ( ) to filter the list by item type (for example, messages or
Conversations).

You can also sort the list by the date the favorite was added or by the item name,
in ascending or descending order.

Note: Your sort settings are saved and applied whenever you view the Favorites
panel.

Alternatively, you can view your favorites in an object panel:

1. Click the appropriate icon in the sidebar to open the object panel. For example,

click  to open the Conversations panel.

For a description of the icons in the sidebar, see What is the sidebar?

2. In the Options menu ( ), select Favorites.

Using Conversations in Oracle Social Network Desktop
This section describes how to use conversations from your desktop:

• How can I browse Conversations?

• How do I open a Conversation?

• How do I join a public Conversation?

• How do I mark a Conversation as a favorite?

• How do I start a One-on-One Conversation?

• How do I start a Conversation?

• How do I view and manage Conversation members?

• How do I work with messages in the Conversation?

• How do I work with documents and folders in the Conversation?

• How do I work with related and referring items in the Conversation?

• How do I share a link to a Conversation?
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• How do I rename a Conversation?

• How do I split a Conversation off from an existing Conversation or wall?

• How do I mute or unmute a Conversation?

• How do I close or reopen a Conversation?

• How do I discard a Conversation?

• How do I download an archive of a Conversation?

• How do I add a Conversation to my Offline Briefcase?

• How do I view a Conversation in the web version of Oracle Social Network?

How can I browse Conversations?

1. Click  in the sidebar to open the Conversations panel, where you can
see all the Conversations you have access to.

2. Use the Options menu ( ) to change the view of the Conversations panel:

• Yours—View all Conversations you are a member of

• Available—View all Conversations that are available to you to join (also called
public Conversations)

• Favorites—View all Conversations you have marked as a favorite

• Muted—View all Conversations you have muted

• Open—View all Conversations that are open for additions and posts

• Closed—View all Conversations that are closed to additions and posts

• Sort By: Name—Arrange the Conversations on the list alphabetically by name

• Sort By: Last Updated—Arrange the Conversations on the list by when a
Conversation was last updated

• Sort By: Active Members—Arrange the Conversations on the list by the
number of currently active members

• Sort By: Unread Posts—Arrange the Conversations on the list by the number
of unread posts

• Sort By: Ascending—Arrange the Conversations on the list from 0 to 9 and A
to Z

• Sort By: Descending—Arrange the Conversations on the list from Z to A and
9 to 0

• Only Unread—When selected, shows only items with unread messages.

• Message Preview—When selected, shows a preview of the latest message
posted to each Conversation's wall

Note: Your sort and message preview settings are saved and applied whenever you
view the Conversations panel.
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How do I open a Conversation?
Click the Conversation name. The Conversation opens in the Detail window. For more
information, see How do I open an item?

Note: People outside your company can sometimes be given limited access to
Conversations in Oracle Social Network. If there are outside users in the
Conversation, a banner appears near the top of the page to let you know. All outside

users have the same avatar ( ) and their names are in purple text. For more
information, see What are "outside users"?

How do I join a public Conversation?
Open the public Conversation, and click Join Conversation in the yellow banner at
the top of the Conversation.

Note: If people outside your company are members of the Conversation, a purple
banner appears near the top of the page to let you know. All outside users have the

same avatar ( ) and their names are in purple text.

How do I mark a Conversation as a favorite?
Marking a Conversation as a favorite is an easy way to keep track of the
Conversations you use most frequently.

To mark a Conversation as a favorite, click  next to the Conversation. Click the star
again to unmark it.

How do I start a One-on-One Conversation?
A one-on-one Conversation is between you and one other person.

There are several ways to open a one-on-one Conversation with someone:

• Anywhere you see a person's picture (except in the Overview panel), right-click it,
then select Open One-on-One Conversation.

• On the People panel, select someone, then click .

• While viewing a person's profile, click Open One-on-One.

When someone starts a one-on-one Conversation with you, it opens a new tab in the
Detail window. If you're already looking at another Conversation, the tab with the one-
on-one opens in the background so you can keep working in the current Conversation.
For information, see How do I get One-on-Ones to open automatically when new
messages are posted?
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How do I start a Conversation?

In the Conversations panel (click  in the sidebar), click , and complete the
information in the dialog.

For more information, see How do I create an item?

How do I view and manage Conversation members?
Open the Conversation. At the top of the Conversation's tab is a membership bar with
pictures of all the people who are members of the Conversation.

Note: If you're viewing a public Conversation that you haven't joined, you can view the
members by clicking the Options menu ( ), then selecting Show Membership.

To manage members, in the membership bar, click  to open the Update Members
dialog. For more information, see How do I view and manage an item's members?

How do I work with messages in the Conversation?
See Working with Messages.

How do I work with documents and folders in the Conversation?
Open the Conversation, click the Documents tab. For more information, see Working
with Documents.

How do I work with related and referring items in the Conversation?
Open the Conversation, click the Related Items or Referring Items tab. For more
information, see Working with Related and Referring Items.

How do I share a link to a Conversation?
Let's say you want to share a link to a Conversation in an email or while you're instant
messaging. Open the Conversation, click the Options menu ( ), then select Copy
Link. The link to the Conversation is copied to your clipboard, and you can paste it
anywhere you like.

Note: When people click the link, they are taken to Oracle Social Network in their
browser.

How do I rename a Conversation?
Open the Conversation, click the Options menu ( ), click Conversation Settings,
select Rename Conversation, then enter a new name.

For more information, see How do I rename an item?
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How do I split a Conversation off from an existing Conversation or
wall?

If your messages start going off-topic or a new question or idea is raised, you might
want to split that discussion into a new Conversation.

Open the Conversation, click  (under the text box), then complete the information
in the dialog. For more information, see How do I split a Conversation off from an
existing Conversation or wall?.

When you create the new Conversation, messages are posted in both the new and the
original Conversations showing a link to the other Conversation.

How do I mute or unmute a Conversation?
If you have items in your Conversation lists that you never look at (for example a
Conversation that doesn't apply to you), or you're seeing updates on the Overview
panel or in your email digests about Conversations you don't care about, you can mute
those Conversations. Muting a Conversation hides it and its activity from your view. It's
still there; you just won't hear about it anymore. (The only exception is if you're flagged
on a message in a muted Conversation, for which you will still be alerted by email.)

To mute a Conversation, in the Conversations panel (click  in the sidebar),
right-click the Conversation, then select Mute Conversation.

To unmute a Conversation, view the Muted Conversations in the Conversations
panel, right-click the Conversation you want to unmute, then select Mute
Conversation to clear the check mark.

For more information, see How do I mute or unmute an item?

How do I close or reopen a Conversation?
You can close any Conversation you belong to, even if you didn't create it. Closing a
Conversation prevents people from adding new content to it and moves the
Conversation to the list of closed Conversations in everyone's Conversations panel.

To close a Conversation, open the Conversation, click the Options menu ( ), click
Conversation Settings, then select Close Conversation.

To reopen a Conversation, open the closed Conversation, click the Options menu ( ),
click Conversation Settings, then select Reopen Conversation.

For more information, see How do I close or reopen an item?

How do I discard a Conversation?
You can discard a Conversation if you are the only member and it's private. The
Conversation, its messages, and its documents are deleted. Although the relationships
between the discarded Conversation and any related and referring items are deleted,
the related and referring items aren't affected in any other way.
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Note: All content is retained on the system for legal or forensic purposes, but only an
application administrator can recover discarded content.

In the Conversations panel (click  in the sidebar), right-click the
Conversation, then select Discard Conversation.

For more information, see How do I discard an item?

How do I download an archive of a Conversation?
At some point you might want to download an archive of a Conversation, possibly to
view when you're offline or maybe to keep a record of the Conversation's content at a
certain point.

The archive is in the form of a .zip file (named after the Conversation). It contains the
Conversation's list of members, messages, and replies in an HTML file (named by
default index.html) and all the documents added to the Conversation.

Open the Conversation, click the Options menu ( ), then click Download Archive.

For more information, see How do I download an archive of an item?

Note: You can't make changes to an archive of a Conversation (though you can click a
link to open the Conversation in a browser and make changes there). If you want to be
able to make offline changes, instead add the item to your Offline Briefcase (see 
Working Offline in Oracle Social Network Desktop).

How do I add a Conversation to my Offline Briefcase?
Tip: For information about offline briefcases, see Understanding the Offline Briefcase.

In the Conversations panel (click  in the sidebar), right-click the
Conversation, then select Add to Offline Briefcase.

For more information, see How do I add an item to my Offline Briefcase?

How do I view a Conversation in the web version of Oracle Social
Network?

Open the Conversation, click the Options menu ( ), then click View in Web Browser.
Your browser opens to the selected Conversation.

For more information, see How do I view an item in the web version of Oracle Social
Network?

Using Collections in Oracle Social Network Desktop
This section describes how to use collections from your desktop:

• How do I view my list of collections?

• How do I open a collection?
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• How do I mark a collection as a favorite?

• How do I create a collection?

• How do I view and manage collection members?

• How do I work with messages in the collection's wall?

• How do I work with documents and folders in the collection?

• How do I work with related and referring items in the collection?

• How do I share a link to a collection?

• How do I rename a collection?

• How do I split a Conversation off from a collection's wall?

• How do I mute or unmute a collection?

• How do I close or reopen a collection?

• How do I discard a collection?

• How do I download an archive of a collection?

• How do I add a collection to my Offline Briefcase?

• How do I view a collection in the web version of Oracle Social Network?

How do I view my list of collections?
In Oracle Social Network Desktop, you can view collections, create new collections,
post messages to a collection's wall, view the items added to a collection (related), and
view the items the collection has been added to (referring).

Note: To learn about collections, see Collections.

To see your list of collections, click  in the sidebar.

The Options menu under the Collections banner ( ) has filters for adjusting your
view of the collections list.

Table 15-3    Collections Filtering and Sorting Options

Filter or Sorting Option Description

Yours View all collections you are a member of

Available View all collections that are available to you to join (also called public collections)

Favorites View all collections you have marked as a favorite

Muted View all collections you have muted

Open View all collections that are open for additions and posts

Closed View all collections that are closed to additions and posts

Sort By: Name Arrange the collections on the list alphabetically by name

Sort By: Last Updated Arrange the collections on the list by when a collection was last updated

Sort By: Active Members Arrange the collections on the list by the number of currently active members

Sort By: Unread Posts Arrange the collections on the list by the number of unread posts
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Table 15-3    (Cont.) Collections Filtering and Sorting Options

Filter or Sorting Option Description

Sort By: Ascending Arrange the collections on the list from 0 to 9 and A to Z

Sort By: Descending Arrange the collections on the list from Z to A and 9 to 0

Only Unread When selected, shows only collections with unread messages

Message Preview When selected, shows a preview of the latest message posted to each collection's
wall

Note: Your sort and message preview settings are saved and applied whenever you
view the Collections panel.

How do I open a collection?
Click the collection name. The collection opens in the Detail window. For more
information, see How do I open an item?

How do I mark a collection as a favorite?
Marking a collection as a favorite is an easy way to keep track of the collections you
use most frequently.

To mark a collection as a favorite, click  next to the collection. Click the star again to
unmark it.

How do I create a collection?

In the Collections panel (click  in the sidebar), click , and complete the
information in the dialog.

For more information, see How do I create an item?

How do I view and manage collection members?
Open the collection. At the top of the collection's tab is a membership bar with pictures
of all the people who are members of the collection.

Note: If you're viewing a public collection that you haven't joined, you can view the
members by clicking the Options menu ( ), then selecting Show Membership.

To manage members, in the membership bar, click  to open the Update Members
dialog. For more information, see How do I view and manage an item's members?

How do I work with messages in the collection's wall?
See Working with Messages.
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How do I work with documents and folders in the collection?
Open the collection, click the Documents tab. For more information, see Working with
Documents.

How do I work with related and referring items in the collection?
Open the collection, click the Related Items or Referring Items tab. For more
information, see Working with Related and Referring Items.

How do I share a link to a collection?
Let's say you want to share a link to a collection in an email or while you're instant
messaging. Open the collection, click the Options menu ( ), then select Copy Link.
The link to the collection is copied to your clipboard, and you can paste it anywhere
you like.

Note: When people click the link, they are taken to Oracle Social Network in their
browser.

How do I rename a collection?
Open the collection, click the Options menu ( ), click Collection Settings, select
Rename Collection, then enter a new name.

For more information, see How do I rename an item?

How do I split a Conversation off from a collection's wall?
If your messages start going off-topic or a new question or idea is raised, you might
want to split that discussion into a new Conversation.

Open the collection's wall, click  (under the text box), then complete the
information in the dialog. For more information, see How do I split a Conversation off
from an existing Conversation or wall?.

When you create the new Conversation, messages are posted both in the new
Conversation and on the wall of the original collection showing a link to the other item.

How do I mute or unmute a collection?
If you have items in your collection lists that you never look at (for example a collection
that doesn't apply to you), or you're seeing updates on the Overview panel or in your
email digests about collections you don't care about, you can mute those collections.
Muting a collection hides it and its activity from your view. It's still there; you just won't
hear about it anymore. (The only exception is if you're flagged on a message in a
muted item, for which you will still be alerted by email.)

To mute a collection, in the Collections panel (click  in the sidebar), right-
click the collection, then select Mute Collection.

Chapter 15
Using Collections in Oracle Social Network Desktop

15-41



To unmute a collection, view the Muted collections in the Collections panel, right-click
the collection you want to unmute, then select Mute Collection to clear the check
mark.

For more information, see How do I mute or unmute an item?

How do I close or reopen a collection?
You can close any collection you belong to, even if you didn't create it. Closing a
collection prevents people from adding new content to it and moves the collection to
the list of closed collections in everyone's Collections panel.

To close a collection, open the collection, click the Options menu ( ), click Collection
Settings, then select Close Collection.

To reopen a collection, open the closed collection, click the Options menu ( ), click
Collection Settings, then select Reopen Collection.

For more information, see How do I close or reopen an item?

How do I discard a collection?
You can discard a collection if you are the only member and it's private. The collection,
its messages, and its documents are deleted. Although the relationships between the
discarded collection and any related and referring items are deleted, the related and
referring items aren't affected in any other way.

Note: All content is retained on the system for legal or forensic purposes, but only an
application administrator can recover discarded content.

In the Collections panel (click  in the sidebar), right-click the collection, then
select Discard Collection.

For more information, see How do I discard an item?

How do I download an archive of a collection?
At some point you might want to download an archive of a collection, possibly to view
when you're offline or maybe to keep a record of the collection's content at a certain
point.

The archive is in the form of a .zip file (named after the collection). It contains the
collection's list of members, messages, and replies in an HTML file (named by default
index.html) and all the documents added to the collection.

Open the collection, click the Options menu ( ), then click Download Archive.

For more information, see How do I download an archive of an item?

Note: You can't make changes to an archive of a collection (though you can click a
link to open the collection in a browser and make changes there). If you want to be
able to make offline changes, instead add the item to your Offline Briefcase (see 
Working Offline in Oracle Social Network Desktop).
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How do I add a collection to my Offline Briefcase?
Tip: For information about offline briefcases, see Understanding the Offline Briefcase.

In the Collections panel (click  in the sidebar), right-click the collection, then
select Add to Offline Briefcase.

For more information, see How do I add an item to my Offline Briefcase?

How do I view a collection in the web version of Oracle Social
Network?

Open the collection, click the Options menu ( ), then click View in Web Browser.
Your browser opens to the selected collection.

For more information, see How do I view an item in the web version of Oracle Social
Network?

Working with People in Oracle Social Network Desktop
This section describes how to work with people in the desktop:

• What is the People panel?

• What are "unregistered users"?

• What are "outside users"?

• How do I view someone's profile and wall?

• How do I add a contact?

• How do I remove a contact?

• How do I view a profile from the People tab?

• How do I work with messages on a person's wall?

• How do I work with a person's documents and folders?

• How do I see who I'm following?

• How do I see who's following me?

• How do I share a link to a person's wall?

• How do I split a Conversation off from a person's wall?

• How do I download an archive of a person's wall?

• How do I add a person's wall to my Offline Briefcase?

• How do I view a person in the web version of Oracle Social Network?

Chapter 15
Working with People in Oracle Social Network Desktop

15-43



What is the People panel?

You can access people-related features by clicking  in the sidebar.

The People panel has a menu of viewing options.

Table 15-4    People Panel Viewing Options

Viewing Option Description

Contacts View the people you've added as your contacts

People You Follow View the people you follow

Your Followers View the people who follow you

The Options menu under the Contacts banner ( ) has additional filtering and sorting
options for adjusting your view of the list.

Table 15-5    Contacts Filtering and Sorting Options

Filter or Sorting Option Description

Online Only When selected, view everyone, whether online or off. When not selected, show only
contacts who are online.

Sort By: Name Sort the list alphabetically by first name

Sort By: Status Sort the list, putting all those online first, away second, and offline last

Sort By: Ascending Arrange the list of contacts from 0 to 9 and A to Z

Sort By: Descending Arrange the list of contacts from Z to A and 9 to 0

Note: Your online only preferences and sort settings are saved and applied whenever
you view the Contacts panel.

Here's a short list of what you can do on the People panel in Oracle Social Network
Desktop:

Table 15-6    Short List of Things You Can Do with People Features

Action For more information, see …

Create and maintain a list of contacts

Note: You can add an outside user as a contact, but
outside users can't add you. Outside users can't have
contacts in Oracle Social Network.

• How do I add a contact?
• How do I remove a contact?

Hold One-on-One Conversations How do I start a One-on-One Conversation?

View someone's profile How do I view someone's profile and wall?

View and post on your wall and other people's walls How do I view someone's profile and wall?

View a list of people you follow How do I see who I'm following?

View a list of people who follow you How do I see who's following me?
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Right-click a person in the list for a menu of useful actions.

What are "unregistered users"?
Unregistered users are people who are in your company's directory but are not yet
members of Oracle Social Network. When you add people to a Conversation or wall,
the word unregistered appears next to the names of unregistered users in the Manage
Members dialog. When you try to add an unregistered user, a warning alerts you to
their unregistered status.

When you add an unregistered person to a Conversation, they receive an email with a
link to set up their account.

What are "outside users"?
Outside users are people who don't work for your company, but who collaborate with
you and your co-workers in Oracle Social Network. They are members of Oracle
Social Network with limited privileges. For example, outside users can be contacts but
they can't have contacts in Oracle Social Network. They can participate in
Conversations only when they are added by you or some other member of the
Conversation.

Note: One outside user can't add another to a Conversation.

Wherever an outside user is a member of a Conversation, a banner appears at the top

of the page to alert you. All outside users have the same avatar ( ) and their
name is in purple text so you can easily tell who they are.

Wherever an option to view a person's wall is available, rather than seeing the option
View Wall, for outside users you'll see View Profile. That's because outside user's
don't have walls where you can post messages.

Since outside users do not have walls they can post to, you won't see Follow or
Following buttons on their profile page. Instead, you'll see Add to Contacts or
Remove from Contacts buttons.

How do I view someone's profile and wall?
A person's profile and wall both appear in the Detail window. The profile view can be
expanded and collapsed, and appears above the wall's message area.

When a person is an outside user—someone who works for another company but is
using Oracle Social Network in collaboration with your company—you, as an inside
user, can follow them, add them as a contact, and initiate a One-on-One with them.
But you can't post to their wall because outside users don't have a traditional wall.

Note: The stream of messages posted to walls differs from those posted to
Conversations. In Conversations, the latest message is listed last. On walls, the latest
message is listed first.

To view someone's wall:

1. Click  to bring the panel forward.
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2. Click the person's picture to open his or her wall in the Detail window. For more
information, see What is the Detail window?

3. To see someone's full profile, click the Profile link.

To see fewer details, click Profile again.

4. Post to the wall as you would to any other Conversation.

For more information, see How do I post a message?

Profiles show three tabs:

• Wall—Shows the messages posted to the person's wall

• Followers—Shows a list of those following the current person

Note: If you follow the person, you can also see the person's followers in the
membership bar on their wall. For more information on the membership bar, see 
How do I view and manage an item's members?

• Following—Shows a list of those the current person is following

How do I add a contact?

Note: You can add an outside user ( ) as a contact, but outside users can't
add you. Outside users can't have contacts in Oracle Social Network.

1. Click  to bring the panel forward.

2. Click  to open a search field.

3. Enter a name or part of a name to open a list of results.

4. Click a name in the results list to add that person to your contacts.

How do I remove a contact?
On the Contacts panel, right-click the person you want to remove and select Remove
from Contacts.

How do I view a profile from the People tab?
On the People tab:

• Right-click a person's name, and select View Profile.

• Select the person's name, and click the View Profile icon.

How do I work with messages on a person's wall?
See Working with Messages.
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How do I work with a person's documents and folders?
Open the person's profile, click the Documents tab. For more information, see 
Working with Documents.

How do I see who I'm following?
There are several ways to see who you're currently following:

• Click , then, in the menu, click People You Follow.

• Open your profile page, then click Following.

How do I see who's following me?
There are several ways to view the people who follow you:

• Click , then, in the menu, click Your Followers.

• Open your profile page, then click Followers.

How do I share a link to a person's wall?
Let's say you want to share a link to a person's wall in an email or while you're instant
messaging. Open the person's wall, click the Options menu ( ), then select Copy
Link. The link to the person's wall is copied to your clipboard, and you can paste it
anywhere you like.

Note: When people click the link, they are taken to the web version of Oracle Social
Network.

How do I split a Conversation off from a person's wall?
If your messages start going off-topic or a new question or idea is raised, you might
want to split that discussion into a new Conversation.

Open the person's wall, click  (under the text box), then complete the information
in the dialog. For more information, see How do I split a Conversation off from an
existing Conversation or wall?.

When you create the new Conversation, messages are posted both in the new
Conversation and on the wall of the original person showing a link to the other item.

How do I download an archive of a person's wall?
At some point you might want to download an archive of a person's wall, possibly to
view when you're offline or maybe to keep a record of the person's wall content at a
certain point.
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The archive is in the form of a .zip file (named after the person). It contains the
person's messages, and replies in an HTML file (named by default index.html) and all
the documents added to the person's wall.

Open the person's wall, click the Options menu ( ), then click Download Archive.

For more information, see How do I download an archive of an item?

Note: You can't make changes to an archive of a person's wall (though you can click a
link to open the person's wall in a browser and make changes there). If you want to be
able to make offline changes, instead add the item to your Offline Briefcase (see 
Working Offline in Oracle Social Network Desktop).

How do I add a person's wall to my Offline Briefcase?
Tip: For information about offline briefcases, see Understanding the Offline Briefcase.

In the People panel (click  in the sidebar), right-click the person, then select
Add to Offline Briefcase.

For more information, see How do I add an item to my Offline Briefcase?

How do I view a person in the web version of Oracle Social Network?
Open the person's wall, click the Options menu ( ), then click View in Web Browser.
Your browser opens to the selected person's wall.

For more information, see How do I view an item in the web version of Oracle Social
Network?

Working with Groups in Oracle Social Network Desktop
This section describes how to work with groups in the desktop:

• What are groups?

• What is the Groups panel?

• How do I view the groups I'm a member of?

• How do I open a group's wall?

• How do I mark a group as a favorite?

• How do I create a group?

• How do I view and manage group members?

• How do I edit a group's name, description, or picture?

• How do I work with messages on a group's wall?

• How do I work with a group's documents and folders?

• How do I discover the Conversations and walls a group belongs to?

• How do I work with a group's referring items?

• How do I share a link to a group?

Chapter 15
Working with Groups in Oracle Social Network Desktop

15-48



• How do I split a Conversation off from a group's wall?

• How do I mute or unmute a group?

• How do I deactivate or reactivate a group?

• How do I download an archive of a group?

• How do I add a group to my Offline Briefcase?

• How do I view a group in the web version of Oracle Social Network?

What are groups?
Groups organize people into a single entity: the group. A group can be added to or
removed from a Conversation in a single step. Or you can start a Conversation that
instantly includes all members of a group. Like individual profiles, groups have their
own identities, which include their own walls and profile pictures. On a group wall,
group members can post messages and content of interest to the group.

What is the Groups panel?
You can see a list of the groups you belong to and access group features by clicking

 the sidebar.

The Options menu under the Groups banner ( ) has filtering and sorting options for
adjusting your view of the groups list.

Table 15-7    Groups Filtering and Sorting Options

Filter or Sorting Option Description

Yours View all groups you are a member of

Favorites View all groups you have marked as a favorite

Muted View all groups you have muted

Sort By: Name Arrange the groups on the list alphabetically by name

Sort By: Last Updated Arrange the groups on the list by when a group wall was last updated

Sort By: Total Members Arrange the groups on the list by the number of total members

Sort By: Unread Posts Arrange the groups on the list by the number of unread posts

Sort By: Ascending Arrange the groups on the list from 0 to 9 and A to Z

Sort By: Descending Arrange the groups on the list from Z to A and 9 to 0

Only Unread When selected, shows only groups with unread messages on their walls

Message Preview When selected, shows a preview of the latest message posted to each group's wall

Show Deactivated Groups When selected, shows the groups no longer in use

Note: Your sort, message preview, and deactivated groups settings are saved and
applied whenever you view the Groups panel.

Here is a short list of things you can do on the Groups panel.
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Table 15-8    Short List of Things You Can Do on the Groups Panel in Oracle Social Network
Desktop

Action For more information, see …

See the groups you're a member of How do I view the groups I'm a member of?

Navigate to a group's profile and wall How do I post a message?

Mute a group's wall How do I mute or unmute a group?

Add a group wall to your Offline Briefcase How do I add a group to my Offline Briefcase?

Mark a group as a favorite Click the Add to Favorites icon to the right of the
group.

Right-click a group on the list for a menu of useful actions.

How do I view the groups I'm a member of?

Click  to open the Groups panel. The default view (Yours) shows all of the
groups you are a member of.

How do I open a group's wall?
Click the group's name. The group opens in the Detail window. For more information,
see How do I open an item?

How do I mark a group as a favorite?
Marking a group as a favorite is an easy way to keep track of the groups you use most
frequently.

To mark a group as a favorite, click  next to the group. Click the star again to
unmark it.

How do I create a group?

In the Groups panel (click  in the sidebar), click , and complete the
information in the dialog.

For more information, see How do I create an item?

To add a description or picture, see How do I edit a group's name, description, or
picture?

How do I view and manage group members?
Open the group. At the top of the group's tab is a membership bar with pictures of all
the people who are members of the group.
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To manage members, in the membership bar, click  to open the Update Members
dialog. For more information, see How do I view and manage an item's members?

Note: If you don't see the manage members button ( ), the group is managed
externally (for example, through LDAP), so you can't change the membership through
Oracle Social Network.

How do I edit a group's name, description, or picture?
1. Open the group. For more information, see How do I open an item?

2. Click Edit Profile.

3. Edit the group's name or description as desired.

4. To change the group's picture, click Change Picture. Select a .gif, .png, or .jpg
file. The picture is scaled to 150x150 pixels.

The Crop Picture dialog shows your image with a circle over the area that will
show in Oracle Social Network. You can drag the corners of the crop area to
change the size of your picture, or drag your picture to change the position of the
crop area. When you're happy with the size and position, click Crop.

If you want to remove the group's picture and just use the default avatar, click
Clear Picture.

How do I work with messages on a group's wall?
See Working with Messages.

How do I work with a group's documents and folders?
Open the collection, click the Documents tab. For more information, see Working with
Documents.

How do I discover the Conversations and walls a group belongs to?
1. Open the group. For more information, see How do I open an item?

2. In the Detail window, click the Member Of tab to see a list of all the
Conversations, Social Objects, collections, and other groups this group is a
member of.

How do I work with a group's referring items?
Open the group, click the Referring Items tab. For more information, see Working
with Related and Referring Items.

How do I share a link to a group?
Let's say you want to share a link to a group in an email or while you're instant
messaging. Open the group, click the Options menu ( ), then select Copy Link. The
link to the group is copied to your clipboard, and you can paste it anywhere you like.
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Note: When people click the link, they are taken to the web version of Oracle Social
Network.

How do I split a Conversation off from a group's wall?
If your messages start going off-topic or a new question or idea is raised, you might
want to split that discussion into a new Conversation.

Open the group's wall, click  (under the text box), then complete the information
in the dialog. For more information, see How do I split a Conversation off from an
existing Conversation or wall?.

When you create the new Conversation, messages are posted both in the new
Conversation and on the wall of the original group showing a link to the other item.

How do I mute or unmute a group?
If you have items in your group lists that you never look at (for example a group that
doesn't apply to you), or you're seeing updates on the Overview panel or in your email
digests about groups you don't care about, you can mute those groups. Muting a
group hides it and its activity from your view. It's still there; you just won't hear about it
anymore. (The only exception is if you're flagged on a message on a muted group
wall, for which you will still be alerted by email.)

To mute a group, in the Groups panel (click  in the sidebar), right-click the
group, then select Mute Group.

To unmute a group, view the Muted groups in the Groups panel, right-click the group
you want to unmute, then select Mute Group to clear the check mark.

For more information, see How do I mute or unmute an item?

How do I deactivate or reactivate a group?
You can deactivate a group you belong to, even if you didn't create it (unless it's
managed externally through LDAP or another similar system). Deactivating a group
prevents it from being added to more Conversations, disables new posts to its wall,
and the group's icon and name are grayed out (the group name is grayed out on
membership lists and on the Groups tab).

To deactivate a group, open the group, click the Options menu ( ), click Group
Settings, then select Deactivate Group.

Note: If you don't see the Group Settings option, the group is managed externally (for
example, through LDAP), so you can't activate or reactivate the group through Oracle
Social Network.

To reactivate a group, open the deactivated group, click the Options menu ( ), click
Group Settings, then select Activate Group.

Tip: If you don't see deactivated groups on the Groups tab, click the Options menu
( ), then select Show Deactivated Groups.
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How do I download an archive of a group?
At some point you might want to download an archive of a group, possibly to view
when you're offline or maybe to keep a record of the group's content at a certain point.

The archive is in the form of a .zip file (named after the group). It contains the group's
list of members, messages, and replies in an HTML file (named by default index.html)
and all the documents added to the group.

Open the group, click the Options menu ( ), then click Download Archive.

For more information, see How do I download an archive of an item?

Note: You can't make changes to an archive of a group (though you can click a link to
open the group in a browser and make changes there). If you want to be able to make
offline changes, instead add the item to your Offline Briefcase (see Working Offline in
Oracle Social Network Desktop).

How do I add a group to my Offline Briefcase?
Tip: For information about offline briefcases, see Understanding the Offline Briefcase.

In the Groups panel (click  in the sidebar), right-click the group, then select
Add to Offline Briefcase.

For more information, see How do I add an item to my Offline Briefcase?

How do I view a group in the web version of Oracle Social Network?
Open the group, click the Options menu ( ), then click View in Web Browser. Your
browser opens to the selected group.

For more information, see How do I view an item in the web version of Oracle Social
Network?

Using Social Objects in Oracle Social Network Desktop
This section describes how to use Social Objects in the desktop:

• Where can I see a list of Social Objects?

• How do I show or hide message previews and summary information in my list of
Social Objects?

• How do I open a Social Object?

• How do I mark a Social Object as a favorite?

• How do I create a Social Object?

• How do I view and manage Social Object members?

• How do I work with messages on a Social Object's wall?

• How do I work with a Social Object's documents and folders?
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• How do I work with a Social Object's related and referring items?

• How do I share a link to a Social Object?

• How do I rename a Social Object?

• How do I split a Conversation off from a Social Object's wall?

• How do I mute or unmute a Social Object?

• How do I close or reopen a Social Object?

• How do I discard a Social Object?

• How do I download an archive of a Social Object?

• How do I add a Social Object to my Offline Briefcase?

• How do I view a Social Object in the web version of Oracle Social Network?

Where can I see a list of Social Objects?
Note: For information about Social Objects, see Social Objects.

To see a list of Social Objects, click  on the sidebar.

To narrow the list to a selected type or group of related types of Social Object, open
the selection list in the Social Objects banner and select a Social Object type or group
of types.

Right-click a Social Object on the list for a menu of useful actions.

The Options menu under the Social Objects banner ( ) has filters and sorting options
for adjusting your view of Social Objects.

Table 15-9    Social Objects Filtering and Sorting Options

Filter or Sorting Option Description

Yours View all Social Objects of the selected type that you are a member of

Available View all Social Objects of the selected type that are available to you to join (also
called public Social Objects)

Favorites View all Social Objects of the selected type you have marked as a favorite

Muted View all Social Objects of the selected type you have muted

Open View all Social Objects of the selected type that are open for additions and posts

Closed View all Social Objects of the selected type that are closed to additions and posts

Sort By: Name Arrange the Social Objects on the list alphabetically by name

Sort By: Last Updated Arrange the Social Objects on the list by when a collection was last updated

Sort By: Active Members Arrange the Social Objects on the list by the number of currently active members
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Table 15-9    (Cont.) Social Objects Filtering and Sorting Options

Filter or Sorting Option Description

Sort By: Unread Posts Arrange the Social Objects on the list by the number of unread posts

Sort By: <other metadata> If only one type of Social Object is displayed, and the Social Object has other
metadata fields that are sortable, you can sort by those metadata fields.

Sort By: Ascending Arrange the Social Objects on the list from 0 to 9 and A to Z

Sort By: Descending Arrange the Social Objects on the list from Z to A and 9 to 0

Only Unread When selected, shows only Social Objects with unread messages

Message Preview When selected, shows a preview of the latest message posted to each Social
Object's wall

See How do I show or hide message previews and summary information in my list of
Social Objects?

Summary Information When selected, shows the details associated with each Social Object in the list of
Social Objects

For example, a Job Candidate Social Object includes field labels and values, like
Open Position: System Administrator, Job Classification: MGR4, and so on. These
labels and values appear in the list of Social Objects when Summary Information is
set to show.

Note: The field labels and values that show depend on how the Social Object type
was defined. So sometimes you might see a lot of summary information on one type
of Social Object, while seeing no summary information on another.

(See )

Note: Your sort, message preview, and summary information settings are saved and
applied whenever you view the Flags panel.

How do I show or hide message previews and summary information in
my list of Social Objects?

When you're looking at the list of Social Objects, you might see a preview of the latest
message posted to each object's wall (Message Preview) and all the field labels and
values associated with the object (Summary Information). You can control your view of
the Social Objects list to show or hide any of this information.

Note: For Summary Information, the field labels and values that show depend on how
the Social Object type was defined when it was created. So sometimes you might see
a lot of summary information on one type of Social Object, while seeing no summary
information on another type.

1. Click  on the sidebar.

2. Optionally, select a type of Social Object to show from the selection list in the
banner.

3. Click , then:

• Select or clear Message Preview to show (select) or hide (clear) the latest
message posted to each Social Object's wall.
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• Select or clear Summary Information to show (select) or hide (clear) the field
labels and values associated with each Social Object.

For example, a Job Candidate Social Object includes field labels and values,
like Open Position: System Administrator, Job Classification: MGR4, and so
on. These labels and values appear in the list of Social Objects when
Summary Information is set to show.

How do I open a Social Object?
Click the Social Object name. The Social Object opens in the Detail window. For more
information, see How do I open an item?

How do I mark a Social Object as a favorite?
Marking a Social Object as a favorite is an easy way to keep track of the Social
Objects you use most frequently.

To mark a Social Object as a favorite, click  next to the Social Object. Click the star
again to unmark it.

How do I create a Social Object?

In the Social Objects panel (click  in the sidebar), click , and complete the
information in the dialog.

For more information, see How do I create an item?

How do I view and manage Social Object members?
Open the Social Object. At the top of the Social Object's tab is a membership bar with
pictures of all the people who are members of the Social Object.

Note: If you're viewing a public Social Object that you haven't joined, you can view the
members by clicking the Options menu ( ), then selecting Show Membership.

To manage members, in the membership bar, click  to open the Update Members
dialog. For more information, see How do I view and manage an item's members?

How do I work with messages on a Social Object's wall?
See Working with Messages.

How do I work with a Social Object's documents and folders?
Open the Social Object, click the Documents tab. For more information, see Working
with Documents.
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How do I work with a Social Object's related and referring items?
Open the Social Object, click the Related Items or Referring Items tab. For more
information, see Working with Related and Referring Items.

How do I share a link to a Social Object?
Let's say you want to share a link to a Social Object in an email or while you're instant
messaging. Open the Social Object, click the Options menu ( ), then select Copy
Link. The link to the Social Object is copied to your clipboard, and you can paste it
anywhere you like.

Note: When people click the link, they are taken to the web version of Oracle Social
Network.

How do I rename a Social Object?
Open the Social Object, click the Options menu ( ), click Social Object Settings,
select Rename Social Object, then enter a new name.

For more information, see How do I rename an item?

How do I split a Conversation off from a Social Object's wall?
If your messages start going off-topic or a new question or idea is raised, you might
want to split that discussion into a new Conversation.

Open the Social Object's wall, click  (under the text box), then complete the
information in the dialog. For more information, see How do I split a Conversation off
from an existing Conversation or wall?.

When you create the new Conversation, messages are posted both in the new
Conversation and on the wall of the original Social Object showing a link to the other
item.

How do I mute or unmute a Social Object?
If you have items in your Social Object lists that you never look at (for example a
Social Object that doesn't apply to you), or you're seeing updates on the Overview
panel or in your email digests about Social Objects you don't care about, you can mute
those Social Objects. Muting a Social Object hides it and its activity from your view. It's
still there; you just won't hear about it anymore. (The only exception is if you're flagged
on a message in a muted Social Object, for which you will still be alerted by email.)

To mute a Social Object, in the Social Objects panel (click  in the sidebar),
right-click the Social Object, then select Mute Social Object.

To unmute a Social Object, view the Muted Social Objects in the Social Objects
panel, right-click the Social Object you want to unmute, then select Mute Social
Object to clear the check mark.
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For more information, see How do I mute or unmute an item?

How do I close or reopen a Social Object?
You can close any Social Object you belong to, even if you didn't create it. Closing a
Social Object prevents people from adding new content to it and moves the Social
Object to the list of closed Social Objects in everyone's Social Objects panel.

To close a Social Object, open the Social Object, click the Options menu ( ), click
Social Object Settings, then select Close Social Object.

To reopen a Social Object, open the closed Social Object, click the Options menu ( ),
click Social Object Settings, then select Reopen Social Object.

For more information, see How do I close or reopen an item?

How do I discard a Social Object?
You can discard a Social Object if you are the only member and it's private. The Social
Object, its messages, and its documents are deleted. Although the relationships
between the discarded Social Object and any related and referring items are deleted,
the related and referring items aren't affected in any other way.

Note: All content is retained on the system for legal or forensic purposes, but only an
application administrator can recover discarded content.

In the Social Objects panel (click  in the sidebar), right-click the Social
Object, then select Discard Social Object.

For more information, see How do I discard an item?

How do I download an archive of a Social Object?
At some point you might want to download an archive of a Social Object, possibly to
view when you're offline or maybe to keep a record of the Social Object's content at a
certain point.

The archive is in the form of a .zip file (named after the Social Object). It contains the
Social Object's list of members, messages, and replies in an HTML file (named by
default index.html) and all the documents added to the Social Object.

Open the Social Object, click the Options menu ( ), then click Download Archive.

For more information, see How do I download an archive of an item?

Note: You can't make changes to an archive of a Social Object (though you can click a
link to open the Social Object in a browser and make changes there). If you want to be
able to make offline changes, instead add the item to your Offline Briefcase (see 
Working Offline in Oracle Social Network Desktop).

How do I add a Social Object to my Offline Briefcase?
Tip: For information about offline briefcases, see Understanding the Offline Briefcase.
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In the Social Objects panel (click  in the sidebar), right-click the Social
Object, then select Add to Offline Briefcase.

For more information, see How do I add an item to my Offline Briefcase?

How do I view a Social Object in the web version of Oracle Social
Network?

Open the Social Object, click the Options menu ( ), then click View in Web Browser.
Your browser opens to the selected Social Object.

For more information, see How do I view an item in the web version of Oracle Social
Network?

Working Offline in Oracle Social Network Desktop
This section describes how to work offline in the desktop:

• How can I see items when I'm offline?

• Understanding the Offline Briefcase

• What's the difference between online and offline items?

• How do I add an item to my Offline Briefcase?

• How do I view an item offline from my Offline Briefcase?

• How do I refresh items in my Offline Briefcase?

• How do I post the changes I made offline?

• How do I remove an item from my Offline Briefcase?

How can I see items when I'm offline?
Suppose you're heading for the airport and want to catch up on your Conversations
while on the plane. Before you leave, you can add the Conversations to your Offline
Briefcase; or you can save the Conversations to a .zip file (an archive), then unzip the
file on your local drive. Both versions contain all content available at the time you
created the archive, including messages, replies, and files. However, when you add
the Conversations to your Offline Briefcase, you can make changes to the
Conversations to be published the next time you're online.

• For information about adding an item to your Offline Briefcase, see How do I add
an item to my Offline Briefcase?

• For information on downloading an archive, see How do I download an archive of
an item?

Understanding the Offline Briefcase
Oracle Social Network Desktop offers an Offline Briefcase for viewing Conversations
and walls when you're offline. The Offline Briefcase panel has convenient controls for
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adding items to your Offline Briefcase, updating one or all offline Conversations and
walls, and publishing any content you have added while offline.

• Refresh All Offline Conversations—(1) Click to update all Conversations and
walls in your Offline Briefcase with any messages added after you saved the
offline version (see How do I refresh items in my Offline Briefcase?).

• Add Conversation to the Offline Briefcase—(2) Click to open a dialog for
selecting a Conversation or wall to add to your Offline Briefcase (see also, How do
I add an item to my Offline Briefcase?).

• Refresh Conversation—(3) Select an offline Conversation or wall and click the
Refresh Conversation icon to refresh your selection with any messages posted
to the Conversation or wall since it was last refreshed (see How do I refresh items
in my Offline Briefcase?).

• Publish Changes—(4) Select an offline Conversation or wall and click the
Publish Changes icon to add messages you posted to your selection offline to the
online version of the Conversation or wall (see How do I post the changes I made
offline?).

• Remove from Offline Briefcase—(5) Select an offline Conversation or wall and
click the Remove from Offline Briefcase icon to remove your selection from your
Offline Briefcase (see How do I remove an item from my Offline Briefcase?).

What's the difference between online and offline items?
Items viewed from your Offline Briefcase have a few differences from online items:

• Only the Messages/Wall, Documents, and Related Items tabs appear in the
Detail window.

• The members bar isn't shown.

• You can search for unread and flagged messages, but you can't search for text in
Conversation. For information on search, see How do I search?

• You can't mark or remove a Conversation as a favorite.

• There's no option for renaming the item on the Options menu ( ).

• The Insert Reference button is disabled.

• Documents open locally rather than in the web version of Oracle Social Network.

• Once you make offline additions, a banner appears at the top of the Conversation
or wall. The banner shows forward and back buttons, which you can use to
navigate directly to your offline additions.

How do I add an item to my Offline Briefcase?
There are several ways to add an item to your Offline Briefcase:

Chapter 15
Working Offline in Oracle Social Network Desktop

15-60



• While viewing the item in the Detail window, click the Options menu ( ), then click
Add to Offline Briefcase.

• While viewing a list of items (for example, on the Conversations panel), right-click
the item, then click Add to Offline Briefcase.

• Add items in the Offline Briefcase panel:

1. On the sidebar, click  to open the Offline Briefcase panel.

2. Click .

3. In the Add to Briefcase dialog, either search for an item or select a source:

Recent—To select from items you have recently visited

Favorites—To select from items you have marked as favorites

Search Results—When you search for an item, the results appear here

4. Select an item, and click Open to add it to your Offline Briefcase.

Note: If there are related Conversations associated with the item you add to your
offline briefcase, you'll be asked if you want to add the related Conversations to your
briefcase as well.

How do I view an item offline from my Offline Briefcase?

1. On the sidebar, click  to open the Offline Briefcase panel.

2. Click a listed item to view it in the Detail window.

A banner at the top of the window reminds you that you are viewing the item
offline.

How do I refresh items in my Offline Briefcase?
Before you shut down your computer, you can refresh all items in your Offline
Briefcase so that when you have a chance to look at them offline you're looking at the
most current information possible.

1. On the sidebar, click  to open the Offline Briefcase panel.

2. Click .

Rather than refreshing all offline items at once, you can instead select one offline item
and refresh just that.

1. On the sidebar, click  to open the Offline Briefcase panel.

2. Right-click the item, then click Refresh <Object>.
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How do I post the changes I made offline?
After you've added messages to an offline item, a banner appears at the top of the
Offline Briefcase panel. The next time you're online, you can publish those messages
for others to see.

1. On the sidebar, click  to open the Offline Briefcase panel.

2. Click Publish All at the top of the panel.

Changes are posted to the live versions of all items in your Offline Briefcase, and
the banner disappears.

Rather than publishing all offline changes at once, you can instead select one offline
item and publish just the changes to that item.

1. On the sidebar, click  to open the Offline Briefcase panel.

2. Right-click the item, then click Publish Changes.

How do I remove an item from my Offline Briefcase?

1. On the sidebar, click  to open the Offline Briefcase panel.

2. Select an item, and click .

Using Notifications in Oracle Social Network Desktop
This section describes how to use notification in the desktop:

• What are notifications?

• What are pop-up alerts?

• How do I configure my notification settings?

• How do I turn notifications on or off?

• How do I turn pop-up alerts on or off?

• How do I select the events that trigger notifications?

• Where can I see my notifications?

• How do I filter my view of notifications in the sidebar?

• How do I delete notifications?
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What are notifications?
Notifications appear on the Notifications panel in the sidebar. They alert you to
something that affects you, like you were added to a Conversation or someone flagged
you when you were offline.

Some notifications contain actions you can use to respond to a notification right away.
For example, a notification about a message that was added to one of your One-on-
One Conversations while you were offline is linked, so you can click it to open the
One-on-One and view the missed message.

Note: If you have missed many messages in multiple One-on-Ones, clicking a missed-
message notification will open up to 10 tabs in the Detail window.

You can configure your notifications to show pop-up alerts to more immediately bring a
notification to your attention. See What are pop-up alerts?

What are pop-up alerts?
Pop-up alerts are dialogs that pop up on your screen when an event that triggers a
notification occurs (see How do I select the events that trigger notifications?).

Pop-up alerts contain links that enable you to respond immediately to the event. For
example:

• When someone assigns a Please Reply - Urgent flag to you, you can click a link
in the pop-up alert to navigate to the message that was flagged.

• When you're added to a Conversation or Social Object, this can trigger a pop-up
alert that provides a link to the Conversation on your desktop or to a Social Object
in your browser.

• You might receive a pop-up alert saying you missed a One-on-One message while
you were offline. The alert provides a link to the Conversation, so you can easily
navigate to the missed message.

How do I configure my notification settings?

See the following sections for information on Notifications settings tab ( ):

• How do I turn notifications on or off?

• How do I turn pop-up alerts on or off?

• How do I select the events that trigger notifications?

How do I turn notifications on or off?

1. Click .

2. On the Notifications tab ( ), select Enable Notifications to turn notifications
on; clear Enable Notifications to turn notifications off.
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How do I turn pop-up alerts on or off?

1. Click .

2. On the Notifications tab ( ), select Show pop-up alerts to turn pop-ups on;
clear Show pop-up alerts to turn pop-ups off.

Optionally, when you select to show pop-up alerts:

• Select Play a sound to play a sound when an alert pops up.

The sound is a system default sound.

• Set the number of seconds to show an alert next to Dismiss after (seconds).

How do I select the events that trigger notifications?
Notifications and pop-up alerts are triggered by the same selected events. So, if you
select a trigger for a notification, it also applies to your pop-ups (For more information,
see What are pop-up alerts?)

1. Click .

2. On the Notifications tab ( ), click Notification Events.

3. Under Notify me when someone, select the events that should trigger a
notification:

• Posts in a Conversation or Social Object—Send a notification whenever
someone posts to a Conversation or Social Object. By default, you get
notifications only for Conversations or Social Objects you've marked as
favorites, but you can change the setting to All, to show notifications for any
Conversation or Social Object you are a member of.

Note: This option is off by default.

• Posts to a One-on-One Conversation with me—Send a notification
whenever someone posts to a One-on-One Conversation with you.

Notes:

– This option is off by default.

– You are always notified of messages posted to one of your One-on-One
Conversations while you were offline.

• Posts on my wall—Send a notification whenever someone posts something
on your wall.

• Adds me to a Conversation or Social Object—Send a notification whenever
someone adds you as a member to an Oracle Social Network Conversation or
Social Object.

• Assigns a flag to you and clears a flag assigned to you—Send a notification
when someone:
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– Assigns a "Please Reply - Urgent" flag to me

– Assigns a "Please Reply" flag to me

– Assigns a "For Your Information" flag to me

– Clears a "Please Reply - Urgent" flag assigned to me

– Clears a "Please Reply" flag assigned to me

– Clears a "For Your Information" flag assigned to me

4. Optionally, click Restore Defaults to reset these triggers to their original values.

Where can I see my notifications?

You can see your notifications by clicking  on the sidebar.

A maximum of 100 notifications is shown; when this limit is reached, the oldest
message is removed as each new message arrives.

The notifications list is cleared when you disconnect from the account that supplied
them or when you exit Oracle Social Network Desktop.

How do I filter my view of notifications in the sidebar?
On the Notifications panel, you can show all types of notifications or just one type. To
set this up, click ( ) and select the type of notification to show.

• All—To see all of your notifications

• Flags—To see only notifications about the flags assigned to you

• Missed One-on-One Messages—To see only notifications about messages sent
to you when you were offline

• New Memberships—To see only notifications letting you know you have been
added to a Conversation, Social Object, group, or any other type of new
membership

• Message Preview—When selected, shows a preview of any message associated
with the notification.

Note: Your message preview setting is saved and applied whenever you view the
Notifications panel.

How do I delete notifications?

Select the notification you want to delete, and click  at the top of the Notifications
panel.

Managing Your Account in Oracle Social Network Desktop
This section describes how to manage your account in the desktop:

• What are Oracle Social Network accounts?

• How do I enable account switching when I start Oracle Social Network Desktop?
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• Where can I see my account details?

• How do I add an account in Oracle Social Network Desktop?

• How can I see my account status in Oracle Social Network Desktop?

• How do I switch between accounts in Oracle Social Network Desktop?

• How do I save my password in Oracle Social Network Desktop?

• How do I disconnect from an account in Oracle Social Network Desktop?

• How do I delete an account in Oracle Social Network Desktop?

• How do I work offline in Oracle Social Network Desktop?

What are Oracle Social Network accounts?
An Oracle Social Network account is your connection to a server that is hosting an
instance of Oracle Social Network. Your organization might have multiple servers,
each offering its own instance of Oracle Social Network. If you have connection
privileges to two or more of these, then you can say you have multiple accounts.

Note: With the desktop client, you can interact with only one Oracle Social Network
account at a time.

Your system administrator likely set up your system to automatically connect to the
necessary accounts. However, you might be required to supply your name and
password at the start of every session.

The first time you start Oracle Social Network Desktop, the Manage Accounts dialog
opens with options for configuring this and future sessions. There are options for:

• Showing or hiding the Manage Accounts dialog at future start-ups (for more
information, see How do I enable account switching when I start Oracle Social
Network Desktop?)

• Selecting the account you want to use in this session (for more information, see 
How do I enable account switching when I start Oracle Social Network Desktop?)

• Saving your password for future sessions (for more information, see How do I
save my password in Oracle Social Network Desktop?)

• Working offline (for more information, see How do I work offline in Oracle Social
Network Desktop?)

If you have just one account, you might want to save your password and disable
account switching. If you have multiple accounts, you might want the Manage
Accounts dialog to show at the start of each session so you can select the account to
use (see How do I enable account switching when I start Oracle Social Network
Desktop?).

How do I enable account switching when I start Oracle Social Network
Desktop?

You can select to always show the Manage Accounts dialog at start-up so that you can
select the account you want to use in the current session.

1. At the top of the sidebar, open the Accounts menu and select Manage
Accounts.
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2. Select Ask for an account at startup.

Every time you start up Oracle Social Network Desktop, the Manage Accounts
dialog opens, and you can select an account from the Account list.

Clear this option to disable account switching.

Where can I see my account details?
1. At the top of the sidebar, open the Accounts menu, then select Manage

Accounts.

2. Select an account from the Account list.

You can see the account name, server URL, your user name, and the options
you've selected for the account.

How do I add an account in Oracle Social Network Desktop?
1. At the top of the sidebar, open the Accounts menu, then select Manage

Accounts.

2. In the Manage Accounts dialog, click  to clear all current values.

3. In the Server URL field, enter the URL to your Oracle Social Network account,
then click Next.

For example, enter: https://acme.social.us1.oraclecloud.com/client.

4. If your company uses federated authentication, your newly created account is
selected in the Manage Accounts dialog. Click OK, then enter your login
information as requested.

If your company doesn't use federated authentication, skip to the next step.

5. If necessary, enter the Identity Domain.

6. In the User Name field, enter your Oracle Social Network user name.

7. In the Password field, enter your Oracle Social Network password.

8. To log in automatically in future sessions, select Remember password.

9. Click Finish.

If you have multiple accounts, you might want the Manage Accounts dialog to show at
the start of each session so you can select the account to use (see How do I enable
account switching when I start Oracle Social Network Desktop?).

How can I see my account status in Oracle Social Network Desktop?
The status of the current account appears at the top of the sidebar, to the right of your
profile picture and under your name.

How do I switch between accounts in Oracle Social Network Desktop?
1. At the top of the sidebar, open the Accounts menu and select the account you

want to switch to.
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2. If you haven't saved the selected account's name and password, a dialog will open
and you can enter them there.

How do I save my password in Oracle Social Network Desktop?
1. At the top of the sidebar, open the Accounts menu and select Manage Accounts.

2. Select Remember password.

3. Click OK.

How do I disconnect from an account in Oracle Social Network
Desktop?

Your connection to an account is maintained until you try to connect to another
account or until you select to work offline (see How do I work offline in Oracle Social
Network Desktop?).

For information about closing or exiting Oracle Social Network Desktop, see How do I
close and exit Oracle Social Network Desktop?

How do I delete an account in Oracle Social Network Desktop?
1. At the top of the sidebar, open the Accounts menu and select Manage

Accounts.

2. From the Account list, select the account you want to delete.

3. Click .

How do I work offline in Oracle Social Network Desktop?
When you work offline, the only feature available in Oracle Social Network Desktop is
the Offline Briefcase and any Conversation or wall you have added to it. For more
information, see Understanding the Offline Briefcase

1. Open the Accounts menu at the top of the sidebar.

2. Select Work Offline.

A check mark appears to the left to the Work Offline option.

Configuring Your Settings for Oracle Social Network
Desktop

This section describes how to configure your settings in the desktop:

• How do I get to my desktop settings?

• How do I configure my general settings?

• How do I get Oracle Social Network Desktop to start when I log in to my
computer?

• How do I prevent my previously opened tabs from showing up when I reconnect?
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• How do I set the time interval for changing my status to away?

• How do I set my time and date format?

• Where can I choose a docking position for the sidebar?

• How do I configure Conversations settings?

• How do I set up when to mark messages as read?

• How do I set the time to delay before a snapshot is taken?

• How do I set up how to post messages?

• How do I get One-on-Ones to open automatically when new messages are
posted?

• How do I control whether other people can post or reply to messages and
documents on my wall?

• How do I configure my notification settings?

• How do I restore default settings in Oracle Social Network Desktop?

How do I get to my desktop settings?

• On the sidebar, click  at the bottom on the left.

• In Microsoft Windows: Click  in the system tray, and select Settings.

• On a Mac: Open the Oracle Social Network menu, and choose Preferences.

The Settings dialog has the following tabs:

 General

See the following sections for information on General settings:

• How do I get Oracle Social Network Desktop to start when I log in to my
computer?

• How do I prevent my previously opened tabs from showing up when I reconnect?

• How do I set the time interval for changing my status to away?

• How do I set my time and date format?

• Where can I choose a docking position for the sidebar?

 Conversations

See the following sections for information on Conversations settings:

• How do I set up when to mark messages as read?

• How do I set the time to delay before a snapshot is taken?

• How do I set up how to post messages?
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• How do I get One-on-Ones to open automatically when new messages are
posted?

 Walls

See How do I control whether other people can post or reply to messages and
documents on my wall?

 Notifications

See the following sections for information on Notification settings:

• How do I turn notifications on or off?

• How do I turn pop-up alerts on or off?

• How do I select the events that trigger notifications?

How do I configure my general settings?

See the following sections for information on General settings tab ( ):

• How do I get Oracle Social Network Desktop to start when I log in to my
computer?

• How do I prevent my previously opened tabs from showing up when I reconnect?

• How do I set the time interval for changing my status to away?

• How do I set my time and date format?

• Where can I choose a docking position for the sidebar?

How do I get Oracle Social Network Desktop to start when I log in to
my computer?

In Settings, you can set an option to start Oracle Social Network Desktop once you log
in to your computer.

1. Click  to open the Settings window.

2. On the General tab ( ), select Start Social Network Desktop on login.

3. Click OK.

How do I prevent my previously opened tabs from showing up when I
reconnect?

By default, your open tabs are saved when you exit Oracle Social Network Desktop.
The next time you log on, the Detail window opens, showing those saved tabs. If you
don't want your open tabs saved, you can change the option in your Settings.
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1. Click  to open the Settings window.

2. On the General tab ( ), clear the Save open tabs on exit check box.

3. Click OK.

How do I set the time interval for changing my status to away?
Your online status (or presence) in Oracle Social Network Desktop is indicated by a
colored circle around your profile picture. For example, a green circle indicates that
you're online.

Your status changes to Away—a partial yellow circle—when you haven't used your
keyboard or mouse within the time you specify here. Your status changes to Offline—a
gray half-circle—when you log out of Oracle Social Network.

1. Click  to open the Settings window to the General tab ( ).

2. For Change status to Away after, select a number of minutes from 1 to 100 (the
default is 10).

3. Click OK.

How do I set my time and date format?
You can specify how times and dates should display in the Desktop client.

1. Click  to open the Settings window to the General tab ( ).

2. In the Date format drop-down list, select a format.

3. Click OK.

Where can I choose a docking position for the sidebar?
• In Microsoft Windows, you can choose an initial docking position through Settings.

Docking the sidebar keeps a constant space for the sidebar on one side of your
screen; other applications will open next to the sidebar.

1. Click  to open the Settings window to the General tab ( ).

2. Select whether you want the sidebar to be able to be docked automatically. If
you clear this option, the sidebar won't be docked even if you drag it to the
side of your screen.
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3. If you chose to make the sidebar dockable, select a docking position—either
Left, Right, or Undocked.

4. Click OK.

• You can also grab the title area of the sidebar and move it to a new location.

How do I configure Conversations settings?

See the following sections for information on Conversations settings tab ( ):

• How do I set up when to mark messages as read?

• How do I set the time to delay before a snapshot is taken?

• How do I set up how to post messages?

• How do I get One-on-Ones to open automatically when new messages are
posted?

How do I set up when to mark messages as read?

1. Click  to open the Settings window, then click the Conversations tab

( ).

2. Select one or both Conversation options:

• Mark message as read when selected—Messages will be marked as read
when you move your mouse and click to change focus away from the
message.

• Mark visible messages as read after (seconds)—Messages that currently
appear on your screen will be marked as read when the time you specify
passes. Select the number of seconds for the interval. The default is five
seconds.

3. Click OK.

See also How do I mark messages as read or unread?

How do I set the time to delay before a snapshot is taken?
Before you add an image to a Conversation using the snapshot feature, you can set

an interval between the time you click  and the time the snapshot is taken. You
can use this time to arrange your desktop for the snapshot.

1. Click  to open the Settings window, then click the Conversations tab

( ).

2. Next to Delay before snapshot capture (seconds), select the number of
seconds to wait after you've clicked the Grab snapshot icon.

3. Click OK.
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Note: You can skip the waiting period by clicking the Grab Now button when you
initiate a snapshot.

See also How do I post a snapshot of my screen?

How do I set up how to post messages?
Using Settings, you can specify whether to post messages using your Enter key or by
clicking a Post button. When you post messages using your Enter key, you can use
Shift+Enter to add line breaks to a message. When you post messages using the Post
button, you can use the Enter key to add line breaks.

1. Click  to open the Settings window, then click the Conversations tab

( ).

2. Under Message posting behavior, select an option:

• Use Post button (Enter creates a new line)—Select this option to post
messages using the Post button.

• Use Enter key (Shift+Enter creates a new line)—Select this option to post
messages using your Enter key.

3. If you want to be able to press ESC to cancel a message before you post it, select
Clear post text when hitting ESC key. When this option is selected, pressing
ESC clears your text, and, for replies, closes the editor.

4. Click OK.

For information about posting messages, see How do I post a message?

How do I get One-on-Ones to open automatically when new messages
are posted?

You can set Oracle Social Network Desktop to open the One-on-One Conversation in
the Detail window and bring it forward, or to play a sound when a new message
arrives in one of your One-on-One Conversations. You can select one option, both
options, or neither option.

1. Click  to open the Settings window, then click the Conversations tab

( ).

2. Under One-on-One Conversations, select Play a sound to play a sound when a
new message is added to any of your One-on-One Conversations.

3. Select Bring window to top to open the One-on-One Conversation in the Detail
window and bring it forward when a new message is added to any of your One-on-
One Conversations.

4. Click OK.
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How do I control whether other people can post or reply to messages
and documents on my wall?

Use Walls settings to control whether other people can post or reply to messages and
documents on your wall:

1. Click  to open the Settings window, then click the Walls tab ( ).

Alternatively, while viewing your wall, click the Wall Settings button or click the
Options menu ( ), then click Wall Settings.

2. Under Post on your wall, specify whether other people can post messages on
your wall.

3. Under Reply on your wall, specify whether other people can reply to messages
or annotate documents on your wall.

4. Click OK.

How do I configure my notification settings?

See the following sections for information on Notifications settings tab ( ):

• How do I turn notifications on or off?

• How do I turn pop-up alerts on or off?

• How do I select the events that trigger notifications?

How do I restore default settings in Oracle Social Network Desktop?

1. Click  to open the Settings window.

2. Click the tab with settings you want to restore.

3. Click Restore Defaults.

4. Click OK.

Getting Help, Support, and Updates for Oracle Social
Network Desktop

This section describes how to get help, support, and updates for the desktop:

• How can I get help with Oracle Social Network Desktop?

• How do I save my Oracle Social Network activity logs?

• How do I check for updates to Oracle Social Network Desktop?
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How can I get help with Oracle Social Network Desktop?

The Help menu ( ) has a few options for getting help with your social network:

• Select Online Help to navigate to the Help Center, where many topics are
available that describe features and step you through their use.

• Select Community to navigate to Oracle Social Network community forums,
where you can talk about your experience with fellow users and experts.

• Select Support for information about how to get support and for access to
troubleshooting logs to help in diagnosing problems.

• Select About Oracle Social Network to get version information and to download
the latest available version.

How do I save my Oracle Social Network activity logs?
Saving your activity logs creates an archive file (.zip) that contains .log, .txt, .xsl,
and .xml files. When addressing an issue with Oracle Social Network, someone from
support might ask you to save your activity logs.

1. Click , then select Support.

2. In the Support dialog, click Save Logs.

3. Use the Save As dialog to select a destination and save.

The default name of the archive file is client-logs.zip. If you don't want to
overwrite a previous archive file, rename it before saving.

How do I check for updates to Oracle Social Network Desktop?

1. Click , then select About Oracle Social Network.

2. In the About dialog, click Check for Update and follow prompts.
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16
Using Oracle Social Network on Your
iPhone

These topics provide information about the features of Oracle Social Network on your
iPhone and describe how to use them.

• How do I start a Conversation?

• How do I edit Conversation settings?

• How do I add or remove members from a Conversation?

• How do I open a One-on-One Conversation?

• How do I mute or unmute a Conversation?

• How do I create, reply to, edit, or delete a message?

• How do I post a link to an Oracle Social Network item?

• How do I add a referring item to a Conversation?

• How do I mark messages as read?

• Are there any features that are not supported on an iPhone?

• How do I view collections?

• How do I add a Conversation to a collection?

• How do I add a related item to a Social Object?

• How do I add documents?

• How do I view a document?

• How do I view an earlier version of a document?

• How do I annotate a document?

• How do I copy a document?

• How do I delete a document?

• How do I see who has viewed a document?

• How do I join or leave a file co-browsing session?

• How do I create or remove a folder?

• How do I move files?

• How do I view and edit my profile and picture?

• How do I view or post to another person's wall?

• How do I post a status update to my wall?

• How can I tell if a person is online?

• How do I view my contacts?

• How do I follow or stop following someone?
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• How do I add Oracle Social Network contacts?

• How do I invite my iPhone contacts to join Oracle Social Network?

• How do I save an Oracle Social Network contact to my iPhone contacts list?

• How do I create a group?

• How do I add or remove members from a group?

• How do I assign or clear flags?

• How do I "like" a message?

• How do I mark an object as a favorite?

• How do I view my favorites?

• How do I search Oracle Social Network?

• What are hashtags (#) and how do I use them?

• How do I set up notifications?

• How do I change notification settings for a selected Conversation or wall?

• How do I add, edit, or remove an account?

• How do I switch from one account to another?

• How do I change an Oracle Social Network password?

• How do I bring up help?

• How do I access support for Oracle Social Network?

• How do I show the user tips if I previously dismissed them?

How do I start a Conversation?

1. On the sidebar menu, tap  Conversations.

2. In the Conversations list, tap .

3. Enter a title for the new Conversation, then tap Create.

How do I edit Conversation settings?
1. Open the Conversation.

2. Tap , then tap Settings.

• Tap the Conversation Name to change the name of the Conversation.

• Tap the Visibility setting to change whether the Conversation is available only
to members (Shared) or is public (can be discovered and joined by anyone).

• Tap the Status setting to close or open the Conversation.
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Note: When you close a Conversation, it is closed for all members, not just
you. You are prompted to confirm your action.

• Tap the Membership Messages setting to show or hide membership
messages.

• Tap the Notifications setting to change whether you receive push
notifications for this Conversation. For more information see, How do I set up
notifications?

How do I add or remove members from a Conversation?
To add members:

1. Open the Conversation.

2. Tap Members.

3. In the bottom bar, tap .

4. In the Add Members dialog, select the people or groups you want to add.

By default, you see Recommendations.

To view a list of your contacts, tap Contacts.

To view a list of your groups, tap More, then select the list you want to see.

Alternatively, search for a person or group to add.

To view the list of people and groups you've selected, tap > next to <Number>
selected.

Note: People outside your company have a special avatar ( ) and their
names are in purple text. If you add an outside user to a Conversation, a banner
stating "Visible to outside users." appears at the top of the Conversation and any
associated message dialogs.

5. Tap Add.

To remove members:

1. Open the Conversation.

2. Tap Members.

3. In the bottom bar, tap Edit.

4. Tap  next to the member you want to remove, then tap Delete.
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How do I open a One-on-One Conversation?
To open a One-on-One Conversation with a member of a Conversation:

1. While viewing a Conversation, tap the picture of the person you want to start a
One-on-One Conversation with to open their profile.

2. Tap Open One-on-One.

To open a One-on-One Conversation with one of your contacts:

1. On the sidebar menu, tap  People.

2. Tap  next to the person you want to start a One-on-One Conversation with
to open their profile.

3. Tap Open One-on-One.

How do I mute or unmute a Conversation?
To mute a Conversation:

1. Open the Conversation you want to mute.

2. Tap , then tap Mute.

The muted Conversation appears under the Muted filter.

To unmute a Conversation:

1. On the sidebar menu, tap  Conversations.

2. Tap Muted.

3. Open the Conversation you want to unmute.

4. Tap , then tap Unmute.

How do I create, reply to, edit, or delete a message?
Note: If a Conversation is visible to people outside your company, you see a banner
stating "Visible to outside users." at the top of the Conversation and any associated
message dialogs.
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To create a new message:

1. Open a Conversation or wall.

2. In the bottom bar, tap .

• To post a message, enter your message text.

• To post a photo, video, voice message, or document, tap . For more
information, see How do I add documents?

• To post a link to another Oracle Social Network item, such as a Conversation

or wall, tap , then tap the item.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

Note: If you don't see  in the bottom bar of someone's wall, you aren't
following the person or the person doesn't allow other people to post to his or her
wall.

3. Tap Post.

To reply to a message:

1. Tap  under the message you want to reply to.

2. Enter your reply, then tap Post.

Note: If you don't see  under a personal wall post shown on the Overview
panel or on a person's wall, the person doesn't allow other people to reply to his or her
wall posts.

To edit a message:

1. Tap  under the message you want to edit.

2. Tap Edit Message.

3. Make your changes, then tap Post.

Notes:

• You can edit only your own messages.

• Any special formatting on a message is lost when you edit the message.
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To delete a message:

You can delete messages you posted or messages on your profile wall.

Note: If you are a service administrator, you can delete any message.

1. Tap  under the message you want to delete.

2. Tap Delete.

How do I post a link to an Oracle Social Network item?
1. Open the Conversation.

2. In the bottom bar, tap .

3. Tap .

4. Tap the Conversation, document, or Social Object you want to reference.

5. Tap Post.

How do I add a referring item to a Conversation?
To add an existing item:

1. Open the Conversation.

2. Tap More, then tap Referring.

3. In the bottom bar, tap .

4. Tap the collection or Social Object you want to add.

To add a new collection:

1. Follow steps 1 through 3 above.

2. Tap , then tap New Collection.

3. Enter a name for the new collection, then tap Create.

How do I mark messages as read?
1. Open the Conversation.

2. Mark messages as read using one of the following methods:

• To mark all messages as read, at the bottom of the Conversation, tap
<Number> Unread, then tap Mark All Read.
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• To mark a single message as read, tap the message.

Alternatively, tap  under the message, then tap Mark as Read.

If you want a message status to be unread, but you've already marked it as read, you

can return the message to unread by tapping  under the message, then
tapping Mark as Unread. This works only with messages others have posted and not
your own posts.

Are there any features that are not supported on an iPhone?
The following Oracle Social Network features are not available for iPhone devices.

• Apps

How do I view collections?

1. On the sidebar menu, tap  Collections.

2. Tap one of the following views:

• Yours to show the collections you created.

• Available to show all the collections available to you.

• Favorites to show the collections that you have marked as favorite.

• Muted to show the collections that you have muted.

How do I add a Conversation to a collection?

1. On the sidebar menu, tap  Collections.

2. Tap the collection you want to add a Conversation to.

3. In the bottom bar, tap .

4. Tap a Conversation or wall to add it to the collection.

Alternatively, you can create a new Conversation or collection.

1. Follow steps 1 through 3 above.

2. Tap .

3. Tap New Collection to create a collection or New Conversation to create a
Conversation.

4. Enter a name, then tap Create.
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How do I add a related item to a Social Object?
1. Open the Social Object.

2. Tap More, then tap Related.

3. In the bottom bar, tap .

4. Tap the Conversation, wall, or Social Object you want to add.

Alternatively, you can create a new Conversation or collection.

1. Follow steps 1 through 3 above.

2. Tap .

3. Tap New Collection to create a collection or New Conversation to create a
Conversation.

4. Enter a name, then tap Create.

How do I add documents?
To add a picture, video, voice message, or document from Oracle Social
Network:

1. Open the Conversation or wall you want to add to.

2. Tap  to create a new message, or tap More, then tap Documents to add
items from the Documents panel.

3. Tap  (at the top of the message or at the bottom of the Documents
panel), then select one of the following options:

• To add a new photo or video, tap Take Photo or Video, take the photo or
video, then tap Use Photo.

• To add an existing photo or video, tap Choose Photo or Video, select one or
more photos or videos, then tap Done.

• To add a voice message, tap Record Voice Message. Tap Start Recording.
If necessary, allow Oracle Social Network to access your microphone. Record
your message. Tap Stop Recording. Tap Use.

• To add a document, tap Add Documents, select the cloud document store
(for example, iCloud, Dropbox, Google Drive), then select a document.

Note: To enable another document storage provider, tap More, then select the
provider.

If you want to crop or rotate your photo, tap the photo thumbnail, then tap Edit.
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Edit mode opens.

• Use the pinch gesture to make your photo bigger or smaller.

• Tap  to crop your photo vertically. Tap again to crop your photo
horizontally.

• Tap , to rotate your photo 90 degrees. Tap again to continue the
rotation.

When you are done editing, tap Save.

4. Optionally, add a message to be posted with the document.

5. Tap Post.

To upload a document from another application:

1. Open the document in the application you want to upload from.

2. Tap the action button, then tap Open In.

3. Tap Open in Social to open the document in Oracle Social Network.

Note: iOS lists up to 10 applications in the Open In menu. If you have more than
10 applications that support a file type, Oracle Social Network might not appear in
the menu. Unfortunately, there is no way to manage which applications appear in
the menu. If you uninstall other applications, Oracle Social Network eventually
appears.

4. In the Open In dialog, you can change the file name and add a description.

5. Choose a destination for your document:

• To post the document to your wall, tap Upload to your Wall.

• To post the document to another location, tap Choose Destination. Select a
destination, (optionally) select a folder, then tap Upload.

Notes:

– If you select a location that is visible to people outside your company, you
see a banner stating "Visible to outside users." at the top of the Open In
dialog. When you tap Upload, you are warned that the document will be
visible to outside users. Tap Yes if you want to post the document.

– If you can't upload a document to someone's wall, you either aren't
following the person or the person doesn't allow other people to post to his
or her wall.

How do I view a document?
To view a document, tap the document image.

After opening the document, you can switch to viewing it in its native viewer (the
application most suitable to the document type). Tap the action icon, then tap View in
Native Viewer.
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Tip: To view documents added to a particular Conversation, wall, or collection open
the Conversation, wall, or collection, tap More, then tap Documents.

How do I view an earlier version of a document?
1. Locate the Conversation or wall that contains the document (see How do I view a

document?).

2. Tap More, then tap Documents.

3. Next to the document, tap <Number> Versions (<number> is the number of
versions of the document).

How do I annotate a document?
Note: If the document is visible to people outside your company, you see a banner
stating "Visible to outside users." at the top of the document preview and any
associated annotation dialogs.

1. Open the document you want to annotate.

2. Tap , then tap the type of annotation you want to use:

• Tap , and tap the place you want the annotation to appear.

• Tap , and draw a rectangle over an area of any size.

• Tap , and draw a circle around an area of any size.

• Tap , and write or draw over an area of any size.

• Tap , and highlight one line.

3. Tap  to open the comment box. Add comment text, then tap Save.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

Chapter 16
How do I view an earlier version of a document?

16-10



4. Tap Publish <number> (<number> is the number of annotations that need to be
published) to add them to the document and the Conversation.

To view annotations:

Open the annotated document or tap  under the annotation message.

To view a list of all annotations, tap the open annotation.

To show and hide annotations:

1. Open the annotated document.

2. Tap .

3. Tap All annotations to show all the annotations on the document, No
annotations to hide all the annotations, a person's name to view annotations
published by that user, or Unpublished annotations to see the annotations that
have not been published yet.

Note: Tap , to show the existing annotations in a list.

How do I copy a document?

1. From the Conversation or wall, tap  under the document, then tap Copy
Document

2. Select where you want to copy the document to.

• To create a new Conversation for the copied document, tap New
Conversation, then enter a name for the Conversation.

• To select an existing Conversation, Social Object, or wall, tap Existing, then
select a location.

Alternatively, while viewing the document, tap the action icon, then tap Copy
Document, and select where you want to copy the document to.

How do I delete a document?
You can delete documents you created or documents on your profile wall.

Note: If you are a service administrator, you can delete any document.

1. Locate the document (see How do I view a document?).

2. Tap  under the document, then tap Delete.

You can also delete a document while viewing it, by tapping the action button, then
tapping Delete.

Note: If you don't see the Delete option when working with a document on someone's
wall, the person doesn't allow other people to post to (or change) his or her wall.
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How do I see who has viewed a document?
1. Open the document (see How do I view a document?).

2. Tap the action button, then tap Access History.

How do I join or leave a file co-browsing session?
1. Open the document.

2. Above the file, tap .

A list of the people looking at the file appears.

3. Tap the person whose movement you want to follow.

To stop following the other person's movement through a file, open the co-browsing
menu, and tap the name of the person you're browsing with.

How do I create or remove a folder?

1. On the sidebar menu, tap  Conversations.

2. Open the Conversation, tap More, then tap Documents.

3. In the bottom bar, tap .

Note: If you don't see the  button when working on someone's wall, the
person doesn't allow other people to post to (or change) his or her wall.

4. Enter a name for the new folder, then tap Create.

Note: When you open a folder, a breadcrumb appears at the top of the Documents
tab to show you where you are in the folder structure. To return to a parent folder, tap
the folder name in the breadcrumb or tap the document icon to return to the top-level
folder.

You can delete folders you created (so long as it doesn't include anyone else's
documents or folders) or folders on your profile wall.

Notes:

• If you are a service administrator, you can delete any folder.

• If you don't see the Delete option when working with a folder on someone's wall,
the person doesn't allow other people to post to (or change) his or her wall.

Chapter 16
How do I see who has viewed a document?

16-12



To remove a folder, tap  next to the folder, then tap Delete.

How do I move files?
You can't move existing Oracle Social Network documents from one location to
another. Instead, you can add the document to the new location (see How do I add
documents?), and delete the document from the original location (see How do I delete
a document?).

How do I view and edit my profile and picture?
1. On the sidebar menu, tap your picture.

2. Tap More, then tap Profile.

3. On the bottom bar, tap Edit.

4. Tap any field to edit it.

5. Tap Save.

Note: To add a new photo, tap your picture, then tap Take Photo or Choose Photo.
Move or scale your image, then tap Choose.

How do I view or post to another person's wall?
To view another person's profile:

1. On the sidebar menu, tap  People.

2. Tap  next to the person to view their profile.

Note: Alternatively, tap a person's name or picture wherever you see it, to open that
person's profile.

To post to another person's wall:

1. Open the person's profile.

2. Tap More, then tap Wall.

3. In the bottom bar, tap .

4. Enter your message.

5. Tap Post.

Chapter 16
How do I move files?

16-13



Note: Outside users (people outside your company) have profiles, but they don't have

walls. Outside users' names appear in purple text, and they have icons ( )
after their names. If you want to post something to an outside user, you can do so
through a one-on-one conversation. For more information, see How do I open a One-
on-One Conversation?

How do I post a status update to my wall?

1. On the sidebar menu, tap  next to your name.

2. Enter your status update.

3. Tap Post.

How can I tell if a person is online?
You can view a person's presence status in the Conversation membership bar or on
the People page. The person's presence status is represented by the colored circle
around the person's picture:

•  - A full green circle around the person's picture shows that the person is
available (logged in to and currently interacting with Oracle Social Network).

•  - A three-quarter yellow circle around the person's picture shows that the
person is idle (logged in to but not currently interacting with Oracle Social
Network).

•  - A half gray circle around the person's picture shows that the person is
offline (not logged in to Oracle Social Network).

How do I view my contacts?

On the sidebar menu, tap  People.

How do I follow or stop following someone?
To follow someone:

1. Open the person's profile by tapping their name or picture wherever you see it.

2. On the person's profile, tap Follow.

To view a list of recommendations, tap More, then tap Recommendations. Oracle
Social Network generates the Recommendations list based on actions you have in
common with others—documents you've both read, Conversations you're both
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members of, and other commonly taken actions. Each recommendation includes the
person's name, the reason they were recommended, a Follow button, and an Ignore
button.

Note: When you ignore a recommendation, the person might be recommended again
in the future based on additional activity by you or the other person.

Note: You can't follow outside users (people outside your company), but you can add
them to your contacts. Outside users' names appear in purple text, and they have

icons ( ) after their names. For more information, see How do I add Oracle
Social Network contacts?

To stop following someone:

To stop following someone, open the person's profile and tap Unfollow.

Alternatively, in the People list, you can long press the person you want to stop
following, then tap Stop Following.

To view the people you are following:

1. On the sidebar menu, tap  People.

2. Tap More, then tap Following.

How do I add Oracle Social Network contacts?

1. On the sidebar menu, tap  People.

2. Tap , then tap Add Contacts.

3. Enter a name, part of a name, or an email address.

4. In the results list, select the people you want to add, then tap Add.

How do I invite my iPhone contacts to join Oracle Social
Network?

If your administrator has configured the system to allow you to invite users, you can
invite people from your iPhone contacts. Inviting users to join Oracle Social Network
makes it easier to collaborate with them.

1. On the sidebar menu, tap  People.
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2. Tap , then tap Invite People.

3. Select the people you want to invite, then tap Invite.

An email is sent to the selected contacts inviting them to join Oracle Social
Network.

How do I save an Oracle Social Network contact to my
iPhone contacts list?

1. Open the person's profile by tapping their name or picture wherever you see it.

2. At the bottom of the person's profile, tap Add to iPhone Contacts.

How do I create a group?

1. On the sidebar menu, tap  Groups.

2. In the Groups list, tap .

3. Enter a Group name.

4. Optionally, enter a Group description.

5. Tap Add Photo, to add a photo to your group profile.

6. Tap Done.

The new group opens and you are added to the group.

How do I add or remove members from a group?
To add members:

1. On the sidebar menu, tap  Groups.

2. Open the group.

3. Tap More, then tap Members.

4. In the bottom bar, tap .

5. In the list of Contacts, select the people and groups you want to add.

Alternatively, search for users or groups to add.
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Note: You can't add outside users (people outside your company) to a group.

Outside users' names appear in purple text, and they have icons ( ) after
their names.

6. Tap Add.

To remove members:

1. Open the group.

2. Tap More, then tap Members.

3. In the bottom bar, tap Edit.

4. Tap  next to the member you want to remove, then tap Delete.

5. Tap Done.

How do I assign or clear flags?
To assign a flag:

1. Next to the message you want to flag, tap .

2. Tap  next to the person you want to flag, then select the type of flag to
assign:

•  - For your information

•  - Please reply

•  - Please reply - urgent

To clear a flag:

1. Navigate to the flag you want to clear:

• On the sidebar menu, tap  Flags.
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By default, you see the flags assigned to you. To clear a flag you assigned to
someone else, tap Filter, then tap Flags You Assigned.

• Find the flagged message in the Overview or Conversation.

2. Tap the flag you want to clear.

3. Tap  next to the flag you want to clear.

How do I "like" a message?

Next to the message you want to like, tap .

How do I mark an object as a favorite?

Next to the object you want to mark as a favorite, tap .

How do I view my favorites?

On the sidebar menu, tap  Favorites.

You can also view your favorites from the Collections or Conversations pages by
tapping Favorites on the segment bar.

How do I search Oracle Social Network?
To search all of Oracle Social Network:

1. On the sidebar menu, tap  Search.

2. Enter your search term, then tap Search.

3. You can filter by object type, by tapping All Results, then tapping an object type.

4. If you filtered by object type, you can sort the results by tapping Sort, then tapping
a sort order (relevancy or date).

5. If you filtered by an object type, you can further filter the results by tapping

 and selecting a filter option:

• Posted By: Limit your search to messages or documents posted by a
particular person.
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• Posted When: Limit your search to messages or documents posted within a
particular period.

• Document Type: If you filter your results to show documents, you can select
which types of documents to show.

• Updated By: Limit your search to Conversations, collections, hashtags, or
Social Definitions updated by a particular user.

• Updated When: Limit your search to Conversations, collections, hashtags, or
Social Definitions updated within a particular period.

• Created By: Limit your search to Conversations, collections, groups, or Social
Definitions created by a particular user.

• Created When: Limit your search to Conversations, collections, groups, or
Social Definitions created within a particular period.

• Favorites Only: Limit your search to only your favorite Conversations,
collections, or groups.

• Include Public: Control whether to show public Conversations, collections, or
Social Definitions in your results.

• Include Closed: Control whether to show closed Conversations, collections,
or Social Definitions in your results.

• Include Deactivated: Control whether to show deactivated groups in your
results.

• With Member: Limit your search to Conversations, collections, groups, or
Social Definitions with a particular member.

6. Tap a result to open the item.

• Tap a Conversation to open the Conversation.

• Tap a person's name to open the person's wall.

Note: Outside users (people outside your company) don't have walls. If you
tap an outside user, the outside user's profile opens. Outside users' names

appear in purple text, and they have icons ( ) after their names.

• Tap a group's name to open the group's wall.

• Tap a hashtag to open a page with all messages that include that hashtag.

You can mark an object in the list of search results as a favorite by tapping  next
to the result. For more information, see How do I view my favorites?

Example 16-1    To search in a Conversation:

To search and navigate through the results in a Conversation, tap  at the
bottom of the screen. By default, you see the unread messages controls, but you can
switch to the other options to find flags assigned to you or text in messages and
documents.
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• Tap  to navigate through the unread messages in the Conversation.

• Tap  to navigate through any flags assigned to you in the Conversation.

• Tap  to search for text in the messages or documents. After tapping

, enter your search term, then tap Search.

Your search term is highlighted in the Conversation.

To clear your search, tap .

The number of unread messages, flags, or messages that include your text is shown
next to the navigation arrows. To step through the items, use the up and down arrows.

What are hashtags (#) and how do I use them?
You can use a hashtag (#) in a message to call out a meaningful term or topic, making
it easy to search for all content associated with that term or topic. For example,
imagine discounts is a popular topic in your group, but the discounts can come in the
form of dealer incentives, cash-back deals, seasonal discounts, or any other number
of forms. How do you find what everyone is saying about all those things? You use a
hashtag. Every time you or your colleagues say something about some form of
discount, you include the hashtag #discounts. You can then search for #discounts and
get a list of all messages in otherwise unrelated Conversations and walls that contain
the hashtagged term.

Adding Hashtags

You can add one or more hashtags to any message (comments, replies, annotations,
and document messages) simply by typing "#" before a term. When you start typing a
hashtag by typing "#" plus at least one letter, existing hashtags (ones that have been
used before) appear for you to select from.

Tips:

• You can include the following characters in a hashtag: A through Z, a through z, 0
through 9 and _.

• A hashtag can be a maximum of 25 characters (not including the "#").

Searching for and Viewing Hashtags

When you perform a search, available hashtags are included in the results. If your
search term starts with a hashtag (#), one of two things will happen. If the hashtag
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exists, the hashtag page opens. If the hashtag doesn't exist, you see search results
that contain any tags similar to the hashtag you searched for.

Wherever you see them, hashtagged terms are tappable and will open a hashtag page
where all messages that include that hashtag are shown. So tapping #discounts in any
Conversation opens a #discounts page which shows any message (in a Conversation,
document annotation, wall, or such) that you have access to that includes the
discounts hashtag.

On the hashtag page, you can filter the messages to show all messages that include
the hashtag (Recent) or just those messages posted by people you are following (By
People You Follow).

To mark a message as a favorite, next to the message, tap . For more
information, see How do I view my favorites?

Following Hashtags

You can also follow hashtags. When you follow a hashtag, messages in public
Conversations and walls that contain that hashtag appear on the Overview page,
even if you are not a member of those Conversations or walls.

To follow a hashtag, tap the hashtag to open the hashtag page, then tap Follow at the
top of the page. To stop following the hashtag, tap Unfollow.

How do I set up notifications?
Push notifications enable you to receive notifications from your Conversations and
walls when you are not currently active in Oracle Social Network.

Note: You can set up notifications only when you're logged in to the account.

1. On the sidebar menu, tap  Accounts.

2. Tap  next to the account you're logged in to.

3. Under Alerts, tap Push Notifications.

4. By default, all notifications are set to On. Change the settings as desired:

Push Notifications: Turn on or off all notifications on this device.

All Posts: Set to On to receive notifications for all new posts to all of your
Conversations and walls.

This can be overridden on a Conversation-by-Conversation basis in the
Conversation's settings. To learn more, see How do I change notification settings
for a selected Conversation or wall?

General Notifications

• Posts to Your Wall: Notifies you when someone posts a message to your
wall.
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• One-on-One Posts: Notifies you when someone starts a One-on-One with
you.

• Added To: Notifies you when you are added as a member to a Conversation
or wall.

Flags Assigned To Me

• FYI: Notifies you when someone assigns a For Your Information flag to you.

• Please Reply: Notifies you when someone assigns a Please Reply flag to
you.

Note: You are always notified when someone assigns a Please Reply - Urgent
flag to you.

Flags Cleared

• FYI: Notifies you when a For Your Information flag you assigned is cleared.

• Please Reply: Notifies you when a Please Reply flag you assigned is cleared.

• Please Reply-Urgent: Notifies you when a Please Reply - Urgent flag you
assigned is cleared.

Note: If you use more than one account, you must set up notifications for each
account individually.

How do I change notification settings for a selected
Conversation or wall?

To select your notification settings for a selected Conversation or wall:

1. Open the Conversation.

2. Tap , then tap Settings.

3. Tap the Notifications setting and change it as desired:

• Tap On to enable Oracle Social Network to send notifications for this
Conversation.

• Tap Off to disable notifications for this Conversation.

• Tap Use Global Setting to use your push notification settings. For more
information, see How do I set up notifications?

How do I add, edit, or remove an account?
To add a new account:

1. On the sidebar menu, tap  Accounts.

2. Tap Add Account.
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3. In the Username field, enter your Oracle Social Network user name.

4. In the Password field, enter your Oracle Social Network password.

5. Turn on Save Password to make future connections automatically.

6. In the Account Name field, enter a name for the new account.

7. In the Server field, enter the path to the server that is hosting your Oracle Social
Network instance.

For example, enter:

 acme.social.us1.oraclecloud.com/client

8. Tap Connect.

To edit an account:

Note: To edit settings for an account, you must not be connected to it.

1. On the sidebar menu, tap  Accounts.

2. Tap  next to the account you want to edit.

3. Change the information as desired.

4. Tap Connect.

To remove an account:

Note: To remove an account, you must not be connected to it.

1. On the sidebar menu, tap  Accounts.

2. Tap  next to the account you want to remove.

3. Tap Delete.

How do I switch from one account to another?

1. On the sidebar menu, tap  Accounts.

2. Tap the account you want to switch to.
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How do I change an Oracle Social Network password?
If your company's password policy lets you change your password, you can do this in
the web version of Oracle Social Network. You can't change your password on mobile
devices.

How do I bring up help?

On the sidebar menu, tap  Help.

Note:  Help appears only when you are logged in.

How do I access support for Oracle Social Network?

On the sidebar menu, tap  Support.

The Support dialog shows the following information:

• Oracle Social Network Version - The version number of the Oracle Social
Network application running on the server to which you are connected.

• iOS App Version - The version number of the Oracle Social Network application
you have installed on your iPhone.

Note:  Support appears only when you are logged in and connected to an
Oracle Social Network server that supports the Support menu.

How do I show the user tips if I previously dismissed them?

1. On the sidebar menu, tap  About.

2. At the bottom of the About dialog, tap Show User Tips Again to show user tips
when you first visit a new area.

The About dialog also displays the Oracle Social Network copyright. Tap Legal Terms
or Oracle Privacy Policy to view the associated information.
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17
Using Oracle Social Network on Your iPad

These topics provide information about the features of Oracle Social Network on your
iPad and describe how to use them:

• How do I start a Conversation?

• How do I edit Conversation settings?

• How do I open a One-on-One Conversation?

• How do I mute or unmute a Conversation?

• How do I create, reply to, edit, or delete a message?

• How do I post a link to an Oracle Social Network item?

• How do I add a referring item to a Conversation?

• How do I mark messages as read?

• Are there any features that are not supported on an iPad?

• How do I view collections?

• How do I add a Conversation to a collection?

• How do I add a related item to a Social Object?

• How do I add documents?

• How do I view a document?

• How do I view an earlier version of a document?

• How do I annotate a document?

• How do I copy a document?

• How do I delete a document?

• How do I see who has viewed a document?

• How do I join or leave a file co-browsing session?

• How do I create or remove a folder?

• How do I move files?

• How do I view and edit my profile and picture?

• How do I view or post to another person's wall?

• How do I post a status update to my wall?

• How can I tell if a person is online?

• How do I view my contacts?

• How do I follow or stop following someone?

• How do I add Oracle Social Network contacts?

• How do I invite my iPad contacts to join Oracle Social Network?
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• How do I save an Oracle Social Network contact to my iPad contacts list?

• How do I create a group?

• How do I add or remove members from a group?

• How do I assign or clear flags?

• How do I "like" a message?

• How do I mark an object as a favorite?

• How do I view my favorites?

• How do I search Oracle Social Network?

• What are hashtags (#) and how do I use them?

• How do I set up notifications?

• How do I change notification settings for a selected Conversation or wall?

• How do I add, edit, or remove an account?

• How do I switch from one account to another?

• How do I change an Oracle Social Network password?

• How do I bring up help?

• How do I access support for Oracle Social Network?

• How do I show the user tips if I previously dismissed them?

How do I start a Conversation?

1. On the sidebar menu, tap .

2. In the upper right corner of the Conversations page, tap .

3. Enter a name for the new Conversation, then tap Create.

How do I edit Conversation settings?
1. Open the Conversation.

2. Tap , then tap Settings.

• Tap the Conversation Name to change the name of the Conversation.

• Tap the Visibility setting to change whether the Conversation is available only
to members (Shared) or is public (can be discovered and joined by anyone).

• Tap the Status setting to close or open the Conversation.

Note: When you close a Conversation, it is closed for all members, not just
you. You are prompted to confirm your action.
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• Tap the Membership Messages setting to show or hide membership
messages.

• Tap the Notifications setting to change whether notifications are sent for the
Conversation. For more information see, How do I set up notifications?

How do I add or remove members from a Conversation?
To add members:

1. Open the Conversation.

2. Tap .

3. Tap .

4. In the Add Members dialog, select the people or groups you want to add.

By default, you see Recommendations.

To view a list of your contacts, tap More, then select the list you want to see.

To view a list of your groups, tap More, then select the list you want to see.

Alternatively, search for a person or group to add.

To view the list of people and groups you've selected, tap > next to <Number>
selected.

Note: People outside your company have a special avatar ( ) and their
names are in purple text. If you add an outside user to a Conversation, a banner
stating "This Conversation is visible to outside users." appears at the top of the
Conversation and any associated message dialogs.

5. Tap Add.

6. Tap outside the Members dialog box to close it.

To remove members:

1. Open the Conversation.

2. Tap .

3. Tap Edit.

4. Tap  next to the member you want to remove, then tap Delete.
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5. Tap Done.

6. Tap outside the Members dialog box to close it.

How do I open a One-on-One Conversation?
To open a One-on-One Conversation with a member of a Conversation:

1. While viewing a Conversation, tap the picture of the person you want to start a
One-on-One Conversation with to open their profile.

2. Tap One-on-One.

To open a One-on-One Conversation with one of your contacts:

1. On the sidebar menu, tap .

2. Tap the person you want to start a One-on-One Conversation with to open their
profile.

3. Tap One-on-One.

How do I mute or unmute a Conversation?
To mute a Conversation:

1. On the sidebar menu, tap .

2. Swipe left on the Conversation you want to mute, then tap Mute.

The muted Conversation appears under the Muted filter.

Note: You can't mute one-on-one Conversations.

To unmute a Conversation:

1. On the sidebar menu, tap .

2. On the segment bar, tap Muted.

3. Swipe left on the Conversation you want to unmute, then tap Unmute.

How do I create, reply to, edit, or delete a message?
Note: If a Conversation is visible to people outside your company, you see a banner
stating "This Conversation is visible to outside users." at the top of the Conversation
and any associated message dialogs.

To create a new message:

1. Open a Conversation or wall.

Chapter 17
How do I open a One-on-One Conversation?

17-4



2. In the bottom bar, tap .

• To post a message, enter your message text.

• To post a photo, video, voice message, or document, tap . For more
information, see How do I add documents?

• To post a link to another Oracle Social Network item, such as a Conversation

or wall, tap , then tap the item.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

Note: If you don't see  in the bottom bar of someone's wall, you aren't
following the person or the person doesn't allow other people to post to his or her
wall.

3. Tap Post.

To reply to a message:

1. Tap  under the message you want to reply to.

2. Enter your reply, then tap Post.

Note: If you don't see  under a personal wall post shown on the Overview
panel or on a person's wall, the person doesn't allow other people to reply to his or her
wall posts.

To edit a message:

1. Tap  under the message you want to edit.

2. Tap Edit Message.

3. Make your changes, then tap Save.

Notes:

• You can edit only your own messages.

• Any special formatting on a message is lost when you edit the message.

To delete a message:

You can delete messages you posted or messages on your profile wall.
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Note: If you are a service administrator, you can delete any message.

1. Tap  under the message you want to delete.

2. Tap Delete.

How do I post a link to an Oracle Social Network item?
1. Open the Conversation.

2. In the bottom bar, tap .

3. Tap .

4. Tap the Conversation, document, or Social Object you want to reference.

5. Tap Post.

How do I add a referring item to a Conversation?
To add an existing item:

1. Open the Conversation.

2. On the segment bar, tap Referring.

3. In the bottom bar, tap .

4. Tap the collection or Social Object you want to add.

To add a new item:

1. Follow steps 1 through 3 above.

2. Tap , then tap New Collection.

3. Enter a name for the new collection, then tap Create.

How do I mark messages as read?
1. Open the Conversation.

2. Mark messages as read using one of the following methods:

• To mark all messages as read, at the bottom of the Conversation, tap
<Number> Unread.

• To mark a single message as read, tap the message.

Alternatively, tap  under the message, then tap Mark as Read.
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If you want a message status to be unread, but you've already marked it as read, you

can return the message to unread by tapping  under the message, then
tapping Mark as Unread. This works only with messages others have posted and not
your own posts.

Are there any features that are not supported on an iPad?
The following Oracle Social Network features are not available for iPad devices.

• Apps

How do I view collections?

1. On the sidebar menu, tap .

2. On the segment bar, tap:

• Yours to show the collections you created.

• Available to show all the collections available to you.

• Favorites to show the collections you have marked as favorite.

• Muted to show the collections that you have muted.

How do I add a Conversation to a collection?

1. On the sidebar menu, tap .

2. Tap the collection you want to add a Conversation to.

3. In the bottom bar, tap .

4. Tap a Conversation or wall to add it to the collection.

Alternatively, you can create a new Conversation or collection.

1. Tap .

2. Tap New Collection to create a collection or New Conversation to create a
Conversation.

3. Enter a name.

4. Tap Create.

How do I add a related item to a Social Object?
1. Open the Social Object.
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2. On the segment bar, tap Related.

3. In the bottom bar, tap .

4. Tap the Conversation, user wall, group wall, or Social Object you want to add.

Alternatively, you can create a new Conversation or collection.

1. Tap .

2. Tap New Collection to create a collection or New Conversation to create a
Conversation.

3. Enter a name.

4. Tap Create.

How do I add documents?
To add a picture, video, voice message, or document from Oracle Social
Network:

1. Open the Conversation or wall you want to add to.

2. Tap  to create a new message, or tap More, then tap Documents to add
items from the Documents panel.

3. Tap  (at the top of the message or at the bottom of the Documents
panel), then select one of the following options:

• To add a new photo or video, tap Take Photo or Video, take the photo or
video, then tap Use Photo.

• To add an existing photo or video, tap Choose Photo or Video, select one or
more photos or videos, then tap Done.

• To add a voice message, tap Record Voice Message. Tap Start Recording.
If necessary, allow Oracle Social Network to access your microphone. Record
your message. Tap Stop Recording. Tap Use.

• To add a document, tap Add Documents, select the cloud document store
(for example, iCloud, Dropbox, Google Drive), then select a document.

Note: To enable another document storage provider, tap More, then select the
provider.

If you want to crop or rotate your photo, tap the photo thumbnail, then tap Edit.

Edit mode opens.

• Use the pinch gesture to make your photo bigger or smaller.
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• Tap  to crop your photo vertically. Tap again to crop your photo
horizontally.

• Tap , to rotate your photo 90 degrees. Tap again to continue the
rotation.

When you are done editing, tap Save.

4. Optionally, add a message to be posted with the document.

5. Tap Post.

To upload a document from another application:

1. Open the document in the application you want to upload from.

2. Tap the action button, then tap Open In.

3. Tap Open in Social to open the document in Oracle Social Network.

Note: iOS lists up to 10 applications in the Open In menu. If you have more than
10 applications that support a file type, Oracle Social Network might not appear in
the menu. Unfortunately, there is no way to manage which applications appear in
the menu. If you uninstall other applications, Oracle Social Network eventually
appears.

4. In the Open In dialog, you can change the file name and add a description.

5. Choose a destination for your document:

• To post the document to your wall, tap Upload to your Wall.

• To post the document to another location, tap Choose Destination. Select a
destination, (optionally) select a folder, then tap Upload.

Notes:

– If you select a location that is visible to people outside your company, you
see a banner stating "This Conversation is visible to outside users." at the
top of the Open In dialog. When you tap Upload, you are warned that the
document will be visible to outside users. Tap Yes if you want to post the
document.

– If you can't upload a document to someone's wall, you either aren't
following the person or the person doesn't allow other people to post to his
or her wall.

6. Tap Upload.

How do I view a document?
To view a document, tap the document image.

After opening the document, you can switch to viewing it in its native viewer (the
application most suitable to the document type). Tap the action icon, then tap View in
Native Viewer.

Tip: To view documents added to a particular Conversation, wall, or collection open
the Conversation, wall, or collection, then tap the Documents segment.
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How do I view an earlier version of a document?
1. Locate the document (see How do I view a document?).

If necessary, open the folder that contains the document.

2. Tap <Number> Versions (<number> is the number of versions of the document).

How do I annotate a document?
Note: If the document is visible to people outside your company, you see a banner
stating "This Conversation is visible to outside users." at the top of any associated
annotation dialogs.

1. Open the document.

2. Tap , then tap the type of annotation you want to use:

• Tap , and tap the place you want the annotation to appear.

• Tap , and write or draw over an area of any size.

• Tap , and highlight one line.

• Tap , and draw a rectangle over an area of any size.

• Tap , and draw a circle around an area of any size.

3. If necessary, tap Edit to open the comment dialog.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

4. Add comment text, then tap Save.

5. Tap Publish <number> (<number> is the number of annotations that need to be
published) to add them to the document and the Conversation.
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To view annotations:

Open the annotated document or tap  under the annotation message.

To view a list of all annotations, tap the open annotation.

To show and hide annotations:

1. Open the annotated document.

2. Tap .

3. Tap All annotations to show all the annotations on the document, No
annotations to hide all the annotations, a person's name to view annotations
published by that user, or Unpublished annotations to see the annotations that
have not been published yet.

How do I copy a document?

1. From the Conversation or wall, tap  under the document, then tap Copy
Document

2. Select where you want to copy the document to.

• To create a new Conversation for the copied document, tap New
Conversation, then enter a name for the Conversation.

• To select an existing Conversation, Social Object, or wall, tap Existing, then
select a location.

Alternatively, while viewing the document, tap the action icon, then tap Copy
Document, and select where you want to copy the document to.

How do I delete a document?
You can delete documents you created or documents on your profile wall.

Note: If you are a service administrator, you can delete any document.

1. Locate the document (see How do I view a document?).

If necessary, open the folder that contains the document.

2. Swipe left on the file you want to delete, then tap Delete.

You can also delete a document while viewing it, by tapping the action button, then
tapping Delete.

Note: If you don't see the Delete option when working with a document on someone's
wall, the person doesn't allow other people to post to (or change) his or her wall.

How do I see who has viewed a document?
1. Locate the document (see How do I view a document?).
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If necessary, open the folder that contains the document.

2. Swipe left on the file you want to delete, then tap Access History.

How do I join or leave a file co-browsing session?
1. Open the document.

2. Above the file, tap .

A list of the people looking at the file appears.

3. Tap the person whose movement you want to follow.

To stop following the other person's movement through a file, open the co-browsing
menu, and tap the name of the person you're browsing with.

How do I create or remove a folder?

1. On the sidebar menu, tap .

2. Open the Conversation, and tap the Documents segment.

3. In the bottom bar, tap .

Note: If you don't see the  button when working on someone's wall, the
person doesn't allow other people to post to (or change) his or her wall.

4. Enter a name for the new folder, then tap Create.

Note: When you open a folder, a breadcrumb appears at the top of the Documents
tab to show you where you are in the folder structure. To return to a parent folder, tap
the folder name in the breadcrumb or tap the document icon to return to the top-level
folder.

You can delete folders you created (so long as it doesn't include anyone else's
documents or folders) or folders on your profile wall.

Notes:

• If you are a service administrator, you can delete any folder.

• If you don't see the Delete option when working with a folder on someone's wall,
the person doesn't allow other people to post to (or change) his or her wall.

To remove a folder, tap  next to the folder, then tap Delete.
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How do I move files?
You can't move existing Oracle Social Network documents from one location to
another. Instead, you can add the document to the new location (see How do I add
documents?), and delete the document from the original location (see How do I delete
a document?).

How do I view and edit my profile and picture?
1. On the sidebar menu, tap your picture.

2. On the segment bar, tap Profile.

3. On the bottom bar, tap Edit.

4. Tap any field to edit it.

5. Tap Save.

Note: To add a new photo, tap your picture, then tap Take Photo or Choose Photo.
Move or scale your image and tap Use.

How do I view or post to another person's wall?
To view another person's profile:

1. On the sidebar menu, tap .

2. Tap  next to the person to view their profile.

Note: Alternatively, tap a person's name or picture wherever you see it, to open that
person's profile.

To post to another person's wall:

1. Open the person's profile.

2. On the segment bar, tap Wall.

3. In the bottom bar, tap .

4. Enter your message.

5. Tap Post.

How do I post a status update to my wall?
1. On the sidebar menu, tap your picture.
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2. In the bottom bar of your wall, tap .

3. Enter your status update.

4. Tap Post.

How can I tell if a person is online?
You can view a person's presence status in the Conversation membership bar or on
the People page. The person's presence status is represented by the colored circle
around the person's picture:

•  - A full green circle around the person's picture shows that the person is
available (logged in to and currently interacting with Oracle Social Network).

•  - A three-quarter yellow circle around the person's picture shows that the
person is idle (logged in to but not currently interacting with Oracle Social
Network).

•  - A half gray circle around the person's picture shows that the person is
offline (not logged in to Oracle Social Network).

How do I view my contacts?

1. On the sidebar menu, tap .

2. On the segment bar, tap Contacts.

How do I follow or stop following someone?
To follow someone:

1. Open the person's profile by tapping their name or picture wherever you see it.

2. On the person's profile, tap Follow.

Alternatively, tap , then, in the desired segment, tap Follow next to the
person you want to follow.

To stop following someone:

To stop following someone, open the person's profile and tap Unfollow.

Alternatively, on the People page, you can long press the person you want to stop
following, then tap Stop Following.
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To view the people you are following:

1. On the sidebar menu, tap .

2. On the segment bar, tap People You Follow.

How do I add Oracle Social Network contacts?

1. On the sidebar menu, tap .

2. On the segment bar, tap Contacts.

3. Tap .

4. Enter a name, part of a name, or an email address.

5. In the results list, select the people you want to add, then tap Add.

How do I invite my iPad contacts to join Oracle Social
Network?

If your administrator has configured the system to allow you to invite users, you can
invite people from your iPad contacts. Inviting users to join Oracle Social Network
makes it easier to collaborate with them.

1. On the sidebar menu, tap  People.

2. Tap the action menu, then tap Invite Device Contacts.

3. Select the people you want to invite, then tap Invite.

An email is sent to the selected contacts inviting them to join Oracle Social
Network.

How do I save an Oracle Social Network contact to my iPad
contacts list?

1. Open the person's profile by tapping their name or picture wherever you see it.

2. At the bottom of the person's profile, tap Add to iPad Contacts.
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How do I create a group?

1. On the sidebar menu, tap .

2. Tap .

3. Enter a Group name.

4. Optionally, enter a Group description.

5. Tap Add Photo, to add a photo to your group profile.

6. Tap Done.

The new group opens and you are added to the group.

How do I add or remove members from a group?
To add members:

1. On the sidebar menu, tap .

2. Open the group.

3. In the membership bar, click .

4. In the Update Members pop-up, tap .

5. In the Add Members pop-up, select the people or groups you want to add.

Alternatively, search for a person or group to add.

Note: You can't add outside users (people outside your company) to a group.

Outside users' names appear in purple text, and they have icons ( ) after
their names.

To remove members:

1. Open the group.

2. In the membership bar, click .
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3. In the Update Members pop-up, tap Edit.

4. Tap  next to the member you want to remove, then tap Delete.

How do I assign or clear flags?
To assign a flag:

1. Next to the message you want to flag, click .

2. Tap  next to the person you want to flag, then select the type of flag to
assign:

•  - For your information

•  - Please reply

•  - Please reply - urgent

To clear a flag:

1. Navigate to the flag you want to clear:

• On the sidebar menu, tap  Flags.

By default, you see the flags assigned to you. To clear a flag you assigned to
someone else, tap Filter, then tap Flags You Assigned.

• Find the flagged message in the Overview, Conversation, or wall.

2. Tap the flag you want to clear.

3. Tap  next to the flag you want to clear.

How do I "like" a message?
1. Open the Conversation.

2. Next to the message you want to like, tap .
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How do I mark an object as a favorite?
1. Navigate to the object you want to mark as a favorite.

2. Long press the object, then tap Add to Favorites.

For Messages, next to the message you want to mark as a favorite, tap .

How do I view my favorites?

On the sidebar menu, tap . You can filter your favorites by item type by
tapping one of the segments at the top.

You can also view your favorites from the Collections or Conversations pages by
tapping Favorites on the segment bar.

How do I search Oracle Social Network?
To search all of Oracle Social Network:

1. On the sidebar menu, tap .

2. Enter your search term, then tap Search.

3. You can filter by object type by tapping All Results, then tapping an object type.

4. If you filtered by object type, you can sort the results by tapping Sort, then tapping
a sort order (relevancy or date).

5. If you filtered by an object type, you can further filter the results by tapping

 and selecting a filter option:

• Posted By: Limit your search to messages or documents posted by a
particular person.

• Posted When: Limit your search to messages or documents posted within a
particular period.

• Document Type: If you filter your results to show documents, you can select
which types of documents to show.

• Updated By: Limit your search to Conversations, collections, hashtags, or
Social Definitions updated by a particular user.
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• Updated When: Limit your search to Conversations, collections, hashtags, or
Social Definitions updated within a particular period.

• Created By: Limit your search to Conversations, collections, groups, or Social
Definitions created by a particular user.

• Created When: Limit your search to Conversations, collections, groups, or
Social Definitions created within a particular period.

• Favorites Only: Limit your search to only your favorite Conversations,
collections, or groups.

• Include Public: Control whether to show public Conversations, collections, or
Social Definitions in your results.

• Include Closed: Control whether to show closed Conversations, collections,
or Social Definitions in your results.

• Include Deactivated: Control whether to show deactivated groups in your
results.

• With Member: Limit your search to Conversations, collections, groups, or
Social Definitions with a particular member.

6. Tap a result to open the item.

• Tap a Conversation to open the Conversation.

• Tap a person's name to open the person's wall.

Note: Outside users (people outside your company) don't have walls. If you
tap an outside user, the outside user's profile opens. Outside users' names

appear in purple text, and they have icons ( ) after their names.

• Tap a group's name to open the group's wall.

• Tap a hashtag to open a page with all messages that include that hashtag.

You can mark an object in the list of search results as a favorite by tapping  next
to the result. For more information, see How do I view my favorites?

Example 17-1    To search in a Conversation:

Use the controls at the bottom of the screen to search and navigate through the results
in a Conversation. By default, you see the unread messages controls, but you can
switch to the other options to find flags assigned to you or text in messages and
documents.

• Tap  to navigate through the unread messages in the Conversation.

• Tap  to navigate through any flags assigned to you in the Conversation.
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• Tap  to search for text in the messages or documents. After tapping

, enter your search term, then tap Search.

Your search term is highlighted in the Conversation.

To clear your search, tap .

The number of unread messages, flags, or messages that include your text is shown
next to the navigation arrows. To step through the items, use the up and down arrows.

What are hashtags (#) and how do I use them?
You can use a hashtag (#) in a message to call out a meaningful term or topic, making
it easy to search for all content associated with that term or topic. For example,
imagine discounts is a popular topic in your group, but the discounts can come in the
form of dealer incentives, cash-back deals, seasonal discounts, or any other number
of forms. How do you find what everyone is saying about all those things? You use a
hashtag. Every time you or your colleagues say something about some form of
discount, you include the hashtag #discounts. You can then search for #discounts and
get a list of all messages in otherwise unrelated Conversations and walls that contain
the hashtagged term.

Adding Hashtags

You can add one or more hashtags to any message (comments, replies, annotations,
and document messages) simply by typing "#" before a term. When you start typing a
hashtag by typing "#" plus at least one letter, existing hashtags (ones that have been
used before) appear for you to select from.

Tips:

• You can include the following characters in a hashtag: A through Z, a through z, 0
through 9 and _.

• A hashtag can be a maximum of 25 characters (not including the "#").

Searching for and Viewing Hashtags

When you perform a search, available hashtags are included in the results. If your
search term starts with a hashtag (#), one of two things will happen. If the hashtag
exists, the hashtag page opens. If the hashtag doesn't exist, you see search results
that contain any tags similar to the hashtag you searched for.

Wherever you see them, hashtagged terms are tappable and will open a hashtag page
where all messages that include that hashtag are shown. So tapping #discounts in any
Conversation opens a #discounts page which shows any message (in a Conversation,
document annotation, wall, or such) that you have access to that includes the
discounts hashtag.
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On the hashtag page, you can filter the messages to show all messages that include
the hashtag (Recent) or just those messages posted by people you are following (By
People You Follow).

To mark a message as a favorite, next to the message, tap . For more
information, see How do I view my favorites?

Following Hashtags

You can also follow hashtags. When you follow a hashtag, messages in public
Conversations and walls that contain that hashtag appear on the Overview page,
even if you are not a member of those Conversations or walls.

To follow a hashtag, tap the hashtag to open the hashtag page, then tap Follow at the
top of the page. To stop following the hashtag, tap Unfollow.

How do I set up notifications?
Push notifications enable you to receive notifications from your Conversations and
walls when you are not currently active in Oracle Social Network.

Note: You can set up notifications only when you're logged in to the account.

1. On the sidebar menu, tap .

2. Tap  next to the account you're logged in to.

3. Under Alerts, tap Push Notifications.

4. By default, all notifications are set to On. Change the settings as desired:

Push Notifications: Turn on or off all notifications on this device.

All Posts: Set to On to receive notifications for all new posts to all of your
Conversations and walls.

This can be overridden on a Conversation-by-Conversation basis in the
Conversation's settings. To learn more see How do I change notification settings
for a selected Conversation or wall?

General Notifications

• Posts to Your Wall: Notifies you when someone posts a message to your
wall.

• One-on-One Posts: Notifies you when someone starts a One-on-One with
you.

• Added To: Notifies you when you are added as a member to a Conversation
or wall.

Flags Assigned To Me

• FYI: Notifies you when someone assigns a For Your Information flag to you.
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• Please Reply: Notifies you when someone assigns a Please Reply flag to
you.

Note: You are always notified when someone assigns a Please Reply - Urgent
flag to you.

Flags Cleared

• FYI: Notifies you when a For Your Information flag you assigned is cleared.

• Please Reply: Notifies you when a Please Reply flag you assigned is cleared.

• Please Reply-Urgent: Notifies you when a Please Reply - Urgent flag you
assigned is cleared.

Note: If you use more than one account, you must set up notifications for each
account individually.

How do I change notification settings for a selected
Conversation or wall?

To select your notification settings for a selected Conversation or wall:

1. Open the Conversation.

2. Tap , then tap Settings.

3. Tap the Notifications setting and change it as desired:

• Tap On to enable Oracle Social Network to send notifications for this
Conversation.

• Tap Off to disable notifications for this Conversation.

• Tap Use Global Setting to use your push notification settings. For more
information, see How do I set up notifications?

How do I add, edit, or remove an account?
To add a new account:

1. On the sidebar menu, tap .

2. Tap Add Account.

3. In the Username field, enter your Oracle Social Network user name.

4. In the Password field, enter your Oracle Social Network password.

5. Turn on Save Password to make future connections automatically.

6. In the Account Name field, enter a name for the new account.

7. In the Server field, enter the path to the server that is hosting your Oracle Social
Network instance.
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For example, enter:

 acme.social.us1.oraclecloud.com/client

8. Tap Connect.

To edit an account:

Note: To edit settings for an account, you must not be connected to it.

1. On the sidebar menu, tap .

2. Tap  next to the account you want to edit.

3. Change the information as desired.

4. Tap Connect.

To remove an account:

Note: To remove an account, you must not be connected to it.

1. On the sidebar menu, tap .

2. Tap  next to the account you want to remove.

3. Tap Delete.

How do I switch from one account to another?

1. On the sidebar menu, tap .

2. Tap the account you want to switch to.

How do I change an Oracle Social Network password?
If your company's password policy lets you change your password, you can do this in
the web version of Oracle Social Network. You can't change your password on mobile
devices.

How do I bring up help?

On the sidebar menu, tap .
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Note:  appears only when you are logged in.

How do I access support for Oracle Social Network?

On the sidebar menu, tap .

The Support dialog shows the following information:

• Oracle Social Network Version - The version number of the Oracle Social
Network application running on the server to which you are connected.

• iOS App Version - The version number of the Oracle Social Network application
you have installed on your iPhone.

Note:  appears only when you are logged in and connected to an Oracle
Social Network server that supports the Support menu.

How do I show the user tips if I previously dismissed them?

1. On the sidebar menu, tap .

2. At the bottom of the About dialog, tap Show User Tips Again to show user tips
when you first visit a new area.

The About dialog also displays the Oracle Social Network copyright. Tap Legal Terms
or Oracle Privacy Policy to view the associated information.
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18
Using Oracle Social Network on Your
Android Device

These topics describe how to interact with Oracle Social Network on Android devices:

• How do I start a Conversation?

• How do I edit Conversation settings?

• How do I add or remove members from a Conversation?

• How do I open a One-on-One Conversation?

• How do I mute or unmute a Conversation?

• How do I create, reply to, edit, or delete a message?

• How do I post a link to an Oracle Social Network item?

• How do I add a referring item to a Conversation?

• How do I mark messages as read?

• Are there any features that are not supported on my Android device?

• How do I view collections?

• How do I add a Conversation to a collection?

• How do I add a related item to a Social Object?

• How do I upload or download documents?

• How do I share a document with an application?

• How do I view a document?

• How do I view an earlier version of a document?

• How do I annotate a document?

• How do I delete a document?

• How do I see who has viewed a document?

• How do I join or leave a file co-browsing session?

• How do I create or remove a folder?

• How do I move files?

• How do I view and edit my profile and picture?

• How do I view or post to another person's wall?

• How do I post a status update to my wall?

• How can I tell if a person is online?

• How do I view my contacts?

• How do I follow or stop following someone?
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• How do I add or remove Oracle Social Network contacts?

• How do I save an Oracle Social Network contact to my Android device contacts
list?

• How do I create a group?

• How do I add or remove members from a group?

• How do I edit a group profile?

• How do I assign or clear flags?

• How do I "like" a message?

• How do I mark an object as a favorite?

• How do I view my favorites?

• How do I search Oracle Social Network?

• What are hashtags (#) and how do I use them?

• How do I set up notifications?

• How do I change notification settings for a selected Conversation or wall?

• How do I configure the appearance of Oracle Social Network?

• How do I control who can post to my wall?

• How do I set Oracle Social Network to automatically log me out?

• How do I add, edit, or remove an account?

• How do I switch from one account to another?

• How do I change an Oracle Social Network password?

• How do I bring up help?

• How do I access support for Oracle Social Network?

• How do I get my log files?

How do I start a Conversation?

1. Tap  in the action bar to open the slide-out navigation, then tap

 Conversations.

2. Tap  in the action bar to display the actions menu, then tap New
Conversation.

3. Enter a name for the new Conversation, then tap OK.
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The new Conversation appears in the list of Conversations. You can start posting
messages and adding documents.

How do I edit Conversation settings?
1. Open the Conversation you want to configure.

2. Tap  in the action bar to display the actions menu, then tap
Conversation Settings.

• To change the name of the Conversation, tap Name, edit the name, then tap
OK.

• To make the Conversation public, select Publicly Available.

• To hide membership messages for the Conversation, deselect Hide
Membership.

How do I add or remove members from a Conversation?
To add members:

1. Open the Conversation.

2. Open the Add Members dialog using one of the following methods:

• In the Conversation membership bar, tap .

• In the action bar, tap  to display the view menu, then tap Members. In the

action bar, tap .

3. Select a view from the Add Members menu:

• Contacts—View a list of your contacts.

• Groups—View a list of your groups.

• Selected—View the people and groups you've selected to add as members.

4. From the list, select the people or groups you want to add to the Conversation.

Alternatively, search for a person or group to add.

Note: People outside your company have a special avatar ( ) and their
names are in purple text. If you add an outside user to a Conversation, a banner
stating "Visible to outside users." appears at the top of the Conversation and any
associated message dialogs. Be careful not to post any sensitive information to
Conversations that include outside users.
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To remove members:

1. Open the Conversation.

2. In the Conversation membership bar, tap the picture of the person you want to
remove, then tap Remove from Conversation.

Alternatively, you can remove one or more people from the Members view.

1. Open the Conversation.

2. Tap  in the action bar to display the view menu, then tap Members.

3. Remove members using one of the following methods:

• To remove a particular member, tap  next to the member, then tap

 Remove Member.

• To remove more than one member, long press a member to bring up the
selection dialog, select the people or groups you want to remove, then tap

.

How do I open a One-on-One Conversation?
Note: The colored circle around the person's picture shows whether the person is
available. For more information, see How can I tell if a person is online?

To open a one-on-one Conversation, use one of the following methods:

• When viewing a Conversation, tap the person's picture in the Conversation
membership bar, then tap Open One-on-One.

• When viewing lists of people on the People page, tap  next to the person, then

tap  Open One-on-One.

• Anywhere else you see a person's name or picture, tap it to open their profile. At
the top of their profile, tap Open One-on-One.
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How do I mute or unmute a Conversation?
To mute a Conversation:

1. Tap  in the action bar to open the slide-out navigation, then tap

 Conversations.

2. Long press the Conversation you want to mute, then tap  Mute.

Alternatively, from within the Conversation, Tap  in the action bar to display
the actions menu, then tap Mute.

The muted Conversation now appears under the Muted filter.

To unmute a Conversation:

1. Tap  in the action bar to open the slide-out navigation, then tap

 Conversations.

2. Tap  in the action bar to display the view menu, then tap Muted.

3. Long press the Conversation you want to unmute, then tap  Unmute.

How do I create, reply to, edit, or delete a message?
Note: If the Conversation is visible to people outside your company, you see a banner
stating "Visible to outside users." at the top of the Conversation and any associated
message dialogs. Be careful not to post any sensitive information to Conversations
that include outside users.

To create a message:

1. Open the Conversation.
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2. Tap  in the action bar to open the New Message dialog.

• To post a message, enter your message text.

• To post a photo from your gallery, tap  in the action bar, then select the
photos you want to add.

• To post a video from your gallery, tap  in the action bar, then select the
videos you want to add.

• To post a file, tap  in the action bar, tap a document source, then follow
the steps to select a file.

• To post a link to another Oracle Social Network item, tap  in the action
bar to open the Insert Reference dialog, then select an item.

Tips:

• Alternatively, to quickly post a photo from your gallery, in the Conversation or wall,

tap , and select the photos you want to add. After selecting your photos,
you can optionally add a message before you post them.

• When you add photos, rotate and crop tools become available for adjusting the
file's size and orientation. Tap an image, then tap Edit.

• When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

Example 18-1    To reply to a message:

Tap  under the message.

Note: If you don't see  under a personal wall post shown on the Overview
page or on a person's wall, the person doesn't allow other people to reply to his or her
wall posts.

Example 18-2    To edit a message:

Tap  under the message, then tap  Edit Message.

Notes:

• You can edit only your own messages.

• Any special markup on a message is lost when you edit the message.
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Example 18-3    To delete a message:

You can delete messages you posted or messages on your profile wall.

Note: If you are a service administrator, you can delete any message.

Tap  under the message, then tap  Delete.

How do I post a link to an Oracle Social Network item?
1. Open the Conversation.

2. Tap  in the action bar to open the New Message dialog.

3. Tap  in the action bar to open the Insert Reference dialog.

4. Tap the collection or object you want to reference, then tap OK.

How do I add a referring item to a Conversation?
This action creates a relationship between the Conversation and the item you select,
making it easy to navigate between the two. You can add an existing item or add a
new one.

1. Open the Conversation.

2. Tap  in the action bar to display the view menu, then tap Referring.

3. Tap  to open the Add Related dialog.

Tip: Tap  to choose between Recent, Favorites, or Search to find the
collection or Social Object.

4. Tap the collection or Social Object to add.

Alternatively, you can create a new collection. Tap  in the action bar, enter
a new name for the collection, then tap OK.

How do I mark messages as read?
1. Open the Conversation, wall, or Social Object.

2. Use one of the following methods to mark messages as read:
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• To mark a single message as read, tap the message, or tap  under the

message, then tap  Mark Read. The blue unread indicator
disappears.

• To mark all messages as read, tap the unread message count in the tile bar;

tap  in the action bar to display the actions menu, then tap Mark All
Read; or, if you have the navigation for unread messages turned on, you can
tap the unread message count to mark all read.

Notes:

• Document annotation messages are marked as read when you view the
annotation in the document.

• To mark a message as unread, tap  under the message, then tap Mark
Unread. The blue unread indicator reappears.

Are there any features that are not supported on my Android
device?

Oracle Social Network Apps are not available on Android devices.

How do I view collections?

1. Tap  in the action bar to open the slide-out navigation, then tap 
Collections.

2. Tap  in the action bar to display the view menu, then tap:

• Yours to show the collections you created.

• Favorites to show the collections you have marked as favorite.

• Available to show all the collections available to you.

• Muted to show the collections that you have muted.

• Closed to show the collections that have been closed.
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How do I add a Conversation to a collection?

1. Tap  in the action bar to open the slide-out navigation, then tap 
Collections.

2. Open the collection to which you want to add a Conversation.

3. Tap  in the action bar to display the view menu, then tap Related.

4. Tap  to open the Add Related dialog.

Tip: Tap  to choose between Recent, Favorites, or Search to find the
collection or Social Object.

5. Tap the Conversation or wall to add it to the collection.

How do I add a related item to a Social Object?
You can add an existing item or create a new one.

1. Open the Social Object.

2. Tap  in the action bar to display the view menu, then tap Related.

3. Tap  to open the Add Related dialog.

Tip: Tap  to choose between Recent, Favorites, or Search to find the
collection or Social Object.

4. Select an existing item or create a new one:

• To select an existing item, tap the item you want to relate to the open Social
Object.

• To add a new Conversation, tap  in the action bar, enter a new name
for the Conversation, then tap OK.

• To add a new collection, tap  in the action bar, enter a new name for
the collection, then tap OK.
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How do I upload or download documents?
To add a picture, video, or document from Oracle Social Network:

You can upload a picture, video, or document from Oracle Social Network by creating
a new message in the Conversation or wall you want to add the item to. See How do I
create, reply to, edit, or delete a message?

To upload a document from another application:

1. Open the document in the application you want to upload from.

2. On the application's sharing menu, tap Oracle Social Network.

3. Optionally, rename the file and add a description.

4. Tap Conversation Select Destination to choose the Conversation, Social Object,
or wall to post the document to. The default location is your wall.

Notes:

• If the Conversation you select is visible to people outside your company, you
see a banner stating "Visible to outside users." at the top of the dialog. Be
careful not to post any sensitive information to Conversations that include
outside users.

• If you can't upload a document to someone's wall, you either aren't following
the person or the person doesn't allow other people to post to his or her wall.

5. Tap Upload.

Example 18-4    To download a document use one of the following methods:

• While viewing a list of documents, tap  under the document you want to
download.

• While viewing a message with a document, tap  under the message, then tap

 Download.

• While viewing the document, tap  in the action bar to display the actions
menu, then tap Download.

Tip: You can see the documents you've downloaded by tapping  in the action

bar to open the slide-out navigation, then tapping  Downloads.
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How do I share a document with an application?
1. Open the Share dialog in one of the following ways:

• While viewing a list of documents, tap  under the document.

• While viewing a message with a document, tap  under the message, then

tap  Share.

• While viewing the document, tap  in the action bar to display the
actions menu, then tap Share.

A list of applications appears.

2. Tap the application you want to copy the document to.

3. Tap Always if the application is the one you will always use; tap Just Once, to
choose an application each time you share a document.

Alternately, you can share the document while viewing it:

1. Open the document.

2. Tap  in the action bar to display the actions menu, then tap Share.

How do I view a document?
To view a document, while viewing a list of documents or a message about a
document, tap the document image or name.

How do I view an earlier version of a document?

While viewing a list of documents, tap  under the document, then tap 
Versions.

Alternately, you can view the versions while viewing the document:

1. Open the document for which you want to the versions.
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2. Tap  in the action bar to display the actions menu, then tap Versions.

How do I annotate a document?
Note: If the document is visible to people outside your company, you see a banner
stating "Visible to outside users." at the top of the document preview and any
associated annotation dialogs. Be careful not to post any sensitive information to
Conversations that include outside users.

1. Open the document you want to annotate.

2. Tap , then tap the type of annotation you want to use:

• Tap None to exit an annotation tool without selecting another.

• Tap  Pushpin, and tap the place you want the annotation to appear.

• Tap  Pen, and write or draw over an area of any size.

• Tap  Highlighter, and highlight one line.

• Tap  Rectangle, and draw a rectangle over an area of any size.

• Tap  Ellipse, and draw a circle around an area of any size.

3. Add a comment to the annotation, then tap OK.

Tip: When you type a hashtag (#) and at least one letter, you see suggestions of
hashtags that other people have used. For more information on hashtags, see 
What are hashtags (#) and how do I use them?

4. Tap Publish <number> Annotation (the <number> is the number of annotations
that need to be published) so everyone can see them.

Note: If you don't see  at the top of a document on a person's wall, the person
does not allow other people to post annotations to his or her personal documents.

To show or hide annotations:

1. Open the annotated document.
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2. Tap  to display the annotation filters.

3. Select the annotations you want to see:

• All Annotations—Show all annotations

• No Annotations—Show no annotations (hide annotations)

• Unpublished Annotations—Show annotations that have not been published

• <Name>—Show annotations from the specified person

Note: To view an annotation from a list view, click  under the annotation
message.

How do I delete a document?
You can delete documents you posted or documents on your profile wall.

Notes:

• If you are a service administrator, you can delete any document.

• If a document has multiple versions, delete removes only the selected version.

• Deleting a document or document version deletes it for all members of the
Conversation or wall.

• There's no undelete, so be sure about deleting the file before you act.

• If you don't see the  Delete option when working with a document on
someone's wall, the person doesn't allow other people to post to (or change) his or
her wall.

While viewing a list of documents, tap  under the document, then tap 
Delete.

Alternately, you can delete the document while viewing it:

1. Open the document.

2. Tap  in the action bar to display the actions menu, then tap Delete.
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How do I see who has viewed a document?

While viewing a list of documents, tap  under the document, then tap 
Access History.

Alternately, you can view the access history while viewing the document:

1. Open the document.

2. Tap  in the action bar to display the actions menu, then tap Access
History.

How do I join or leave a file co-browsing session?
1. Open the file you want to co-browse.

2. Above the file, tap  to display the people looking at the file.

3. Tap the person whose movement you want to follow.

To stop following the other person's movement through a file, tap , then
tap the person you are browsing with.

How do I create or remove a folder?
To create a folder:

1. Tap  in the action bar to open the slide-out navigation, then tap

 Conversations.

2. Open the Conversation where you want to create a new folder.

3. Tap  in the action bar to display the view menu, then tap Documents.
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4. Tap  in the action bar to display the actions menu, then tap New Folder.

Note: If you don't see the New Folder option when working on someone's wall,
the person doesn't allow other people to post to (or change) his or her wall.

5. Enter a name for the new folder, and tap OK.

Example 18-5    To remove a folder:

You can delete folders you created (so long as it doesn't include anyone else's
documents or folders) or folders on your profile wall.

Notes:

• If you are a service administrator, you can delete any folder.

• If you don't see the Remove Folder option when working with a folder on
someone's wall, the person doesn't allow other people to post to (or change) his or
her wall.

To remove a folder, long press it and tap Remove Folder.

How do I move files?
You can't move existing Oracle Social Network documents from one location to
another. Instead, you can add the document to the new location (see How do I upload
or download documents?), and delete the document from the original location (see 
How do I delete a document?).

How do I view and edit my profile and picture?

1. Tap  in the action bar to open the slide-out navigation, then tap your
name.

2. Tap  in the action bar to display the view menu, then tap Profile.

3. Tap  in the action bar to display the actions menu, then tap Edit Profile.

4. Modify any field or enter new data.

5. To update your profile picture, tap Change, tap Take a Photo or Choose a
Photo, then follow the steps for updating your profile picture.

6. Tap Update.

How do I view or post to another person's wall?
1. Open the person's wall using one of the following methods:
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• While viewing a Conversation, in the Conversation membership bar, tap the
picture of the person whose wall you want to view, then tap View wall.

• Tap  in the action bar to open the slide-out navigation, then tap

 People. Tap the person to open his or her profile. Tap  in the
action bar to display the view menu, then tap Wall.

To add someone new to your contacts list, see How do I add or remove Oracle
Social Network contacts?

2. Tap  in the action bar to open the New Message dialog. For more
information, see How do I create, reply to, edit, or delete a message?

Note: If you don't see  in the action bar, you aren't following the person or
the person doesn't allow other people to post to his or her wall.

Note: Outside users (people outside your company) have profiles, but they don't have

walls. Outside users' names appear in purple text, and they have icons ( )
after their names. If you want to post something to an outside user, you can do so
through a one-on-one conversation. For more information, see How do I open a One-
on-One Conversation?

How do I post a status update to my wall?

1. Tap  in the action bar to open the slide-out navigation, then tap  next
to your name.

2. Enter your status as you would any other message. For more information, see 
How do I create, reply to, edit, or delete a message?

How can I tell if a person is online?
The colored circle around a person's picture signifies the person's presence status:

•  - A full green circle around the person's picture shows that the person is
available (logged in to and currently interacting with Oracle Social Network).
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•  - A three-quarter yellow circle around the person's picture shows that the
person is idle (logged in to but not currently interacting with Oracle Social
Network).

•  - A half gray circle around the person's picture shows that the person is
offline (not logged in to Oracle Social Network).

How do I view my contacts?

Tap  in the action bar to open the slide-out navigation, then tap 
People.

To add someone new to your contacts list, see How do I add or remove Oracle Social
Network contacts?

How do I follow or stop following someone?
To follow someone:

Anywhere in Oracle Social Network you see a person's picture or name, tap it to get to
their profile. On their profile page tap +Follow.

You can also follow someone directly from the list of recommendations or followers on
the People page:

1. Tap  in the action bar to open the slide-out navigation, then tap

 People.

2. To view a list of people who follow you, tap  in the action bar to display the
view menu, then tap Followers.

Tap  next to the person, then tap  + Follow.

Note: You can't follow outside users (people outside your company), but you can add
them to your contacts. Outside users' names appear in purple text, and they have
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icons ( ) after their names. For more information, see How do I add or
remove Oracle Social Network contacts?

To view the people you are following and stop following someone:

1. Tap  in the action bar to open the slide-out navigation, tap 
People.

2. Tap  in the action bar to display the view menu, then tap Following.

3. Tap  next to the person, then tap  Stop Following.

How do I add or remove Oracle Social Network contacts?

1. Tap  in the action bar to open the slide-out navigation, then tap

 People.

2. Tap  in the action bar to open the Add Contacts dialog.

3. In the Search box, enter the name, part of the name, or the email address of the
person you want to add.

4. In the results list, select the person you want to add.

5. Tap Add.

You can also add contacts directly from the list of followers on the People page:

1. Tap  in the action bar to open the slide-out navigation, then tap

 People.
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2. Tap  in the action bar to display the view menu, then tap Followers.

3. Tap  next to the person, then tap  Add to Contacts.

To remove a contact:

1. Tap  in the action bar to open the slide-out navigation, then tap

 People.

2. Tap  in the action bar to display the view menu, then tap Following.

3. Tap  next to the person, then tap  Remove Contact.

How do I save an Oracle Social Network contact to my
Android device contacts list?

1. Tap  in the action bar to open the slide-out navigation, then tap

 People.

2. Tap a name to open that person's profile.

3. Tap Add to Phone Contacts at the bottom of the screen.

The person's contact information and picture are added to the contacts on your
phone.
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How do I create a group?

1. Tap  in the action bar to open the slide-out navigation, then tap

 Groups.

2. Tap .

3. In the Name field, enter the name of the new group.

4. In the Description field, enter a description of the group.

5. Tap Change to add a photo.

6. Tap Create.

The new group opens. To add members to the group, see How do I add or remove
members from a group?

How do I add or remove members from a group?
To add members:

1. Tap  in the action bar to open the slide-out navigation, then tap

 Groups.

2. Optionally, tap  and change the sorting from Name to Total Members.

3. Tap the group to which you want to add members.

4. Open the Add Members dialog using one of the following methods:

• In the Group membership bar, tap .
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• In the action bar, tap  to display the view menu, then tap Members. In the

action bar, tap .

5. Select a view from the Add Members menu:

• Contacts—View a list of your contacts.

• Groups—View a list of your groups.

• Selected—View the people and groups you've selected to add as members.

6. From the list of contacts, select the people or groups you want to add to the group.

Alternatively, search for a person or group to add.

Note: You can't add outside users (people outside your company) to a group.

Outside users' names appear in purple text, and they have icons ( ) after
their names.

7. In the action bar, tap Add.

To remove members:

1. Open the group.

2. Tap  in the action bar to display the view menu, then tap Members.

3. Remove members using one of the following methods:

• To remove a particular member, tap  next to the member, then tap

 Remove Member.

• To remove more than one member, long press a member to bring up the
selection dialog, select the people or groups you want to remove, then tap

.
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How do I edit a group profile?

1. Tap  in the action bar to open the slide-out navigation, then tap

 Groups.

2. Tap the group you want to edit.

3. Tap  in the action bar to display the actions menu, then tap Group
Settings.

4. Modify the current data, then tap Update.

How do I assign or clear flags?
To assign a flag:

1. Open the Conversation.

2. Next to the message you want to flag, tap .

3. In the Manage Flags dialog, perform one of the following actions:

• To assign a flag to a particular person, tap  next to the person you want to
flag, then select the type of flag to assign.

• To assign flags to everyone (other than yourself), tap  in the action
bar to display the actions menu, tap Flag Everyone Else, then select the type
of flag to assign.

You can select from the following types of flags:

•  Not Flagged

•  For Your Information

•  Please Reply
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•  Please Reply - Urgent

To clear a flag assigned to you:

1. Tap the flag you want to clear.

2. In the Manage Flags dialog, tap Clear next to your flag.

Tip: To view all flags assigned to you, tap  in the action bar to open the slide-

out navigation, then tap  Flags.

To clear a flag assigned by you:

1. Tap  in the action bar to open the slide-out navigation, then tap 
Flags.

2. In the action bar, tap , then select Flags You Assigned.

3. Tap the flag you want to clear.

4. In the Manage Flags dialog, perform one of the following actions:

• To clear a particular flag, tap  to the far right of the flag.

• To clear all flags, tap  in the action bar to display the actions menu,
then tap Clear Flags.

Alternatively, you can open the Manage Flags dialog by tapping a flag while viewing
messages in the Conversation.

How do I "like" a message?

Next to the message, tap .

How do I mark an object as a favorite?
1. Navigate to the object you want to mark as a favorite.
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2. Next to the object, tap .

How do I view my favorites?

Tap  in the action bar to open the slide-out navigation, then tap 
Favorites.

You can also view your favorites from the Collections, Conversations, or Social

Objects pages by tapping  in the action bar to display the view menu, then tapping
Favorites.

How do I search Oracle Social Network?
To search all of Oracle Social Network:

1. Tap  in the action bar to open the slide-out navigation, then tap 
Search.

2. Enter your search term, then tap .

3. Optionally, select an item type from the Search menu to show a particular result
type (for example, Conversations or documents).

4. Optionally, tap  to select how to sort your results. There are different sort
options depending on what type of results you've selected.

5. After filtering by a result type, there are additional filter options. To view filter

options, tap .

• Posted By: Limit your search to messages or documents posted by a
particular person.

• Posted When: Limit your search to messages or documents posted within a
particular period.

• Document Type: If you filter your results to show documents, you can select
which types of documents to show.

• Created By: Limit your search to Conversations, collections, groups, or Social
Objects created by a particular user.
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• Creation Time: Limit your search to Conversations, collections, groups, or
Social Objects created within a particular period.

• Favorites Only: Limit your search to only your favorite Conversations,
collections, or Social Objects.

• Include Deactivated: Control whether to show deactivated groups in your
results.

• With Member: Limit your search to groups with a particular member.

6. Tap a result to open the item.

• Tap a Conversation to open the Conversation.

• Tap a person's name to open the person's wall.

Note: Outside users (people outside your company) don't have walls. If you
tap an outside user, the outside user's profile opens. Outside users' names

appear in purple text, and they have icons ( ) after their names.

• Tap a group's name to open the group's wall.

• Tap a hashtag to open a page with all messages that include that hashtag.

You can mark an object in the list of search results as a favorite by tapping  next
to the result. For more information, see How do I view my favorites?

Example 18-6    To search in a Conversation:

Use the controls at the bottom of the screen to search and navigate through the results
in a Conversation. By default, you see the unread messages controls, but you can
switch to the other options to find flags assigned to you or text in messages and
documents.

• Tap  to navigate through the unread messages in the Conversation.

• Tap  to navigate through any flags assigned to you in the Conversation.

• Tap  to search for text in the messages or documents. After tapping

, enter your search term, then tap .

Your search term is highlighted in the Conversation.

To clear your search, tap .
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The number of unread messages, flags, or messages that include your text is shown
next to the navigation arrows. To step through the items, use the up and down arrows.

What are hashtags (#) and how do I use them?
You can use a hashtag (#) in a message to call out a meaningful term or topic, making
it easy to search for all content associated with that term or topic. For example,
imagine discounts is a popular topic in your group, but the discounts can come in the
form of dealer incentives, cash-back deals, seasonal discounts, or any other number
of forms. How do you find what everyone is saying about all those things? You use a
hashtag. Every time you or your colleagues say something about some form of
discount, you include the hashtag #discounts. You can then search for #discounts and
get a list of all messages in otherwise unrelated Conversations and walls that contain
the hashtagged term.

Adding Hashtags

You can add one or more hashtags to any message (comments, replies, annotations,
and document messages) simply by typing "#" before a term. When you start typing a
hashtag by typing "#" plus at least one letter, existing hashtags (ones that have been
used before) appear for you to select from.

Tips:

• You can include the following characters in a hashtag: A through Z, a through z, 0
through 9 and _.

• A hashtag can be a maximum of 25 characters (not including the "#").

Searching for and Viewing Hashtags

When you perform a search, available hashtags are included in the results. If your
search term starts with a hashtag (#), one of two things will happen. If the hashtag
exists, the hashtag page opens. If the hashtag doesn't exist, you see search results
that contain any tags similar to the hashtag you searched for.

Wherever you see them, hashtagged terms are tappable and will open a hashtag page
where all messages that include that hashtag are shown. So tapping #discounts in any
Conversation opens a #discounts page which shows any message (in a Conversation,
document annotation, wall, or such) that you have access to that includes the
discounts hashtag.

On the hashtag page, you can filter the messages to show all messages that include
the hashtag (All Results) or just those messages posted by people you are following
(By People You Follow).

To mark a message as a favorite, next to the message, tap . For more
information, see How do I view my favorites?

Following Hashtags

You can also follow hashtags. When you follow a hashtag, messages in public
Conversations and walls that contain that hashtag appear on the Overview page,
even if you are not a member of those Conversations or walls.
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To follow a hashtag, tap the hashtag to open the hashtag page, then tap  at

the top of the page. To stop following the hashtag, tap .

How do I set up notifications?

1. Tap  in the action bar to open the slide-out navigation, then tap 
Settings.

2. Tap Notifications.

• To turn notifications on or off, tap the On/Off toggle in the action bar.

• Under Alerts select Vibrate to make your device vibrate when there is a new
notification.

Select Device LED to make your device LED flash when there is a new
notification.

• Under Quiet Hours select Enable, and set a Start Time and End Time to
prevent notifications from alerting you during that period.

3. Under Accounts tap an account to set up notifications for that account.

Note: Fewer options are available when you configure an account you're not
logged in to.

General Notifications

• Select Posts to be notified when someone posts a message to the
Conversations and walls you're a member of.

• Select Your Wall to be notified when someone posts a message to your wall.

• Select One-on-One to be notified when someone starts a One-on-One with
you.

• Select Conversation Membership to be notified when you are added as a
member to a Conversation or wall.

Flags Assigned To You

• Select FYI to be notified when someone assigns a For Your Information flag to
you.

• Select Please Reply to be notified when someone assigns a Please Reply
flag to you.

• You are always notified when someone assigns an Urgent flag to you.

Flags Cleared

• Select FYI to be notified when a For Your Information flag you assigned is
cleared.

• Select Please Reply to be notified when a Please Reply flag you assigned is
cleared.
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• Select Urgent to be notified when a Please Reply - Urgent flag you assigned
is cleared.

How do I change notification settings for a selected
Conversation or wall?

1. Open the Conversation you want to configure.

2. Tap  in the action bar to display the actions menu, then tap
Conversation Settings.

General

• Tap Name to change the Conversation's name.

• Select Publicly Available to make the Conversation available for anyone to
join.

Deselect Publicly Available to make the Conversation available only to
members. Anyone who already joined the Conversation is automatically made
a member.

• Select Hide Membership to hide all membership messages from the
Conversation.

Deselect Hide Membership to show all past and present membership
messages in the Conversation.

Notifications

Tap the value under Notifications to open a selection list:

• Tap Default to use the current account's notification settings.

• Tap Enabled to always send notifications for this Conversation, regardless of
what is selected for the current account.

• Tap Disabled to disable notifications for this Conversation, regardless of what
is selected for the current account.

How do I configure the appearance of Oracle Social
Network?

1. Tap  in the action bar to open the slide-out navigation, and tap 
Settings.

2. Under Appearance:

• Tap Text Size to adjust the size of the text.

• Select Unread Messages to show next message and previous message
navigation for unread messages.
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• Select Conversation Members to show the Conversation membership bar
when viewing Conversations.

3. Under About:

• Tap User Tips to show user tips when you first visit a new area.

• Tap Oracle Social Network to read about Oracle Social Network, and view its
legal notices and privacy policy.

How do I control who can post to my wall?
Use Security preferences to control whether other people can post or reply to
messages and documents on your wall:

1. Tap  in the action bar to open the slide-out navigation, then tap 
Settings.

2. Under Wall Posts:

• Tap Who can post top-level messages... to specify whether other people
(your followers) can post messages on your wall.

• Tap Who can reply to messages... to specify whether other people (your
followers) can reply to messages or annotate documents on your wall.

How do I set Oracle Social Network to automatically log me
out?

1. Tap  in the action bar to open the slide-out navigation, and tap 
Settings.

2. Under Background Data:

a. Tap Automatic Logout to set a time after which you are automatically logged
out.

b. Select the amount of time your session should be inactive before you are
automatically logged out.

How do I add, edit, or remove an account?
To add an account:

Once you have installed Oracle Social Network on your mobile device:

1. Tap  in the action bar to open the slide-out navigation, then tap 
Accounts.
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2. To add a new account, tap .

3. In the Add Account pop-up, enter the path to the server that is hosting your
Oracle Social Network instance, then tap Save.

For example, enter:

acme.social.us1.oraclecloud.com/client

4. In the Account Name field, enter a name for the new account.

The default account name is the server URL.

5. If necessary, enter the Identity Domain.

6. In the User Name field, enter your Oracle Social Network user name.

7. In the Password field, enter your Oracle Social Network password.

8. To save your password for future connections, select Save Password.

9. Tap Connect in the action bar.

To edit an account:

1. Tap  in the action bar to open the slide-out navigation, then tap 
Accounts.

2. Select the account you want to edit, then tap  in the action bar.

3. Change the account information.

4. To save your changes, tap Connect.

To remove an account:

1. Tap  in the action bar to open the slide-out navigation, then tap 
Accounts.

2. Select the account you want to delete, then tap .

3. Confirm that you want to delete the account.
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How do I switch from one account to another?

1. Tap  in the action bar to open the slide-out navigation, then tap 
Accounts.

2. Tap the account you want to switch to.

How do I change an Oracle Social Network password?
If your company's password policy lets you change your password, you can do this in
the web version of Oracle Social Network. You can't change your password on a
mobile device.

How do I bring up help?

Tap  in the action bar to open the slide-out navigation, then tap 
Help.

Note:  Help appears only when you are logged in.

How do I access support for Oracle Social Network?

Tap  in the action bar to open the slide-out navigation, then tap 
Support.

The Support dialog shows the following information:

• OSN Version - The version number of the Oracle Social Network application
running on the server to which you are connected.

• Android Client Version - The version number of the Oracle Social Network
application you have installed on your Android device.

Note:  Support appears only when you are logged in and connected to an
Oracle Social Network server that supports the Support menu.
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How do I get my log files?
If you need to send your log files and device information to someone for support
purposes or other reasons, you can send the information from your device.

1. Tap  in the action bar to open the slide-out navigation, and tap 
Settings.

2. Under About, tap Oracle Social Network.

3. Tap Email Device Information.

4. Optionally, add a description or information about why you're sending the logs.

5. Tap Email.

6. Select the method you want to use to send the logs:

• Email—If necessary, set up your email account. Enter the email address to
send the logs to.

• Messaging—Enter the number you want to send the logs to. Enter a
message, then send the text.

• Oracle Social Network—Tap Select Destination. Select a Conversation to
post the logs to. Optionally, add a description. Tap Upload.
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19
Administering Oracle Social Network

The Oracle Social Network Administration page is the primary tool for administrators of
Oracle Social Network to manage the application. These topics discuss how to use the
Administration page:

• Getting Started with Administration

• Managing General Properties

• Managing Users

• Managing User Collaboration

• Managing Apps

• Managing Features

• Managing Social Definitions

• Managing Federated Authentication

Getting Started with Administration
These topics discuss how to get started with Administration:

• Accessing the Administration Features in Oracle Social Network

• Terms and Concepts

Accessing the Administration Features in Oracle Social Network
In the web client, administrators can manage the Oracle Social Network instance by
selecting Administration in the user menu drop-down list.
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Notes:

• The Administration selection is displayed only if you are logged in as a user with
administrator privileges.

• You access the Administration section in the same way on both the production
instance and the stage/test (staging) instance of Oracle Social Network. In nearly
all cases, the administration tasks that you perform are done on the production
instance. The primary task you do on the staging instance is to manage the Oracle
Social Network developer website. For more information about the staging
instance, see Terms and Concepts. For more information about managing the
developer website, see Editing General Properties and Editing User Properties.

Terms and Concepts
Important terms and concepts that you might need to understand when working with
the Administration page include:

• App. Apps are web-based applications that can be deployed in Oracle Social
Network. Apps are currently not applicable on other clients such as iOS or the
Outlook plug-in. There are two kinds of apps: Conversation apps and Social
Object apps. Conversation apps are standalone applications that you can add to a
Conversation. Examples include a poll, map, or a photo viewer. Social Object apps
are designed for creating a new Social Object type such as Customer,
Opportunity, and so on. Social Object apps incorporate information from a third-
party system to make the information viewable in a Conversation. For more
information, see Managing Apps.

• Blacklist. In the Extended Collaboration page, you can create a blacklist of
external email domains from which outside users are excluded from joining Oracle
Social Network. If the Invite Outside Users with Any Email Domain check box is
selected, you do not need to specify any domains in the whitelist to invite external
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users. If a user is invited from a domain in the blacklist, the invitation fails. For
more information, see Inviting/Creating a User from the Administration Page.

• Feature. Features are JavaScript libraries that provide apps with specific
functionality, such as communicating with the Oracle Social Network server,
adding interactive behavior, or manipulating data. Oracle Social Network includes
several features. Under normal circumstances you do not need to change features
that are included with Oracle Social Network, but you might want to add features
when adding apps into the environment. For more information, see Managing
Features.

• Service administrator. Oracle Social Network administrators are typically service
administrators; they do the normal day-to-day administrative tasks for the Oracle
Social Network application. Typically the word service is dropped when referring to
service administrators. For more information, see User Types.

• Site administrator. Site administrators are Oracle personnel. Site administrators
can do comprehensive administrative tasks for the Oracle Social Network server.
For more information, see User Types.

• Social Object. From a conceptual or user perspective, Social Objects are records
within a business application or business process—generically referred to as
Systems of Record—that are mapped into Oracle Social Network. For example,
accounts in a CRM system can be mapped into Oracle Social Network as
opportunities and customers.

From an implementation perspective, a Social Object is a special type of
Conversation that includes a Social Object app. A Social Object app incorporates
information from a third-party system to make the information viewable in a
Conversation. A Social Object Definition (also called a Social Definition) is a
"model" of a Social Object; after you create a Social Definition and publish it on
your system, users can create Social Object instances based on the definition.

For more information, see Managing Social Definitions.

• Staging instance. A staging instance (sometimes called the Stage/Test instance)
is a non-production environment that lets developers test apps, Social Definitions,
Social Plugins, and other implementations in an isolated system; after testing is
complete, the changes can be deployed in the production instance. When Oracle
Social Network is initially configured, you receive a URL for a staging instance as
well as the production instance.

• System of Record (SoR). A system of record is a business application or object
that is the source of a Social Object, such as a customer or an opportunity. For
example, a system of record might be your CRM system. For more information,
see Managing Social Definitions.

• Whitelist. In the Extended Collaboration page, you create a whitelist of external
email domains from which users can be invited to join Oracle Social Network. If
the Invite Outside Users with Any Email Domain check box is selected, you do
not need to specify domains in the whitelist to invite external users. For more
information, see Inviting/Creating a User from the Administration Page.

Managing General Properties
This topic discusses how to manage general properties:

• Editing General Properties
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Editing General Properties
1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click General. The General page is displayed by
default when you enter the Administration section of the user interface.

3. Edit the general properties of Oracle Social Network. For more information about
the properties, see General Properties Page.

4. Click Save.

General Properties Page
The following table describes the general properties.

Element Description

Branding To give your Oracle Social Network web client interface a customized look, you can
customize your branding text and logo; they appear in the user interface and in new
user invitation emails.

Oracle recommends that you always provide a branding logo, and optionally branding
text; if your logo already incorporates text, you don't need to add branding text
separately. Experiment with the sizes and content of your branding information to find
the best appearance for your needs. Test your new user invitation email to make sure
the logo and text appear as you expect them to.

Corporate Branding Text Specify text that you want to appear to the right of the logo in the banner, and in new
user invitation emails. By default, the text SOCIAL NETWORK displays. Type your
branding text into the field to replace the default. If you put one or more space
characters in the field, no corporate branding text displays.

Corporate Logo This logo appears in the top banner on the left side of the page. The current image is
displayed.

To change it, click Change and follow the instructions to upload a different image. The
maximum dimensions of the image are 22 pixels in height and 160 pixels in width. The
image is scaled to fit, keeping the aspect ratio the same.

Notifications These global settings let you control email and mobile notifications.

Email Notifications Globally enable or disable email notifications. When enabled, email notifications are
sent, based on user settings.

Apple Push Notification
Service (APNS)

When a user installs the Oracle Social Network app on their iOS device and connects it
to the server, the device is registered to the server and can receive notifications if you
enable them here.

Globally enable or disable push notifications to registered iOS devices. When enabled,
notifications are sent to iOS devices if selected by the user.

Android Push
Notifications (GCM)

When a user installs the Oracle Social Network app on their Android device and
connects it to the server, the device is registered to the server and can receive
notifications if you enable them here.

Globally enable or disable push notifications to Android devices. When enabled,
notifications are sent to Android devices if selected by the user.

Time Zone and
Language

End users configure these settings either explicitly in their Oracle Social Network
settings or implicitly based on their browser settings. You can specify fallback values for
the time zone, language, and date format to be used if no setting is available.
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Element Description

Time Zone Oracle Social Network uses the time zone in the user's settings if it is specified. If the
user did not select a time zone, the value in this field is used. If you do not select a time
zone, the time zone of the server where Oracle Social Network resides is used.

This time zone setting is used to determine when to send daily digest emails (midnight
in the user's time zone) and to specify the timestamps on email notifications.

This setting does not affect timestamps for actions such as posting messages or adding
users; the client machine's time zone setting is used.

Language Oracle Social Network clients (such as the browser client, Outlook, and Android) use
the language specified in the user's settings or browser. If a client setting does not
match an available language, or if no setting is found in the browser, the language
selected here is used instead.

Date Format Locale Oracle Social Network clients (such as the browser client, Outlook, and Android) try to
format the date as specified in the user's settings or using the locale of the browser. If a
client setting does not match an available format, or if no setting is found in the browser,
the date format selected here is used instead.

Support Message For clients that support it, users see the text shown in this field when they select the
Support option. By default, the text describes how to create a service request with
Oracle Support. In the web client a new browser page opens. (A target="_blank" is
included in the link.) You can customize the text if you want users to follow a different
process, such as contacting your company's internal support team.

Type any changes into the text entry field and click Save to save your changes, or click
Restore Default to return to the default message that was defined when Oracle Social
Network was initially configured.

Note: The support message is displayed in the language in which it is typed, and it is
not translated based on the locale.

Manage Hashtags Allows you to censor words or strings that you do not want to be used as hashtags.

Censored Hashtags Type one or more strings that you do not want to be used as hashtags, without the hash
(#) prefix. Wildcards such as the asterisk (*) are not supported. Use a comma to
separate each string in the field; for example, censorthistag,censorthattag.

When a user types a censored hashtag or views a message containing a censored
hashtag, the hashtag appears as regular text. Censored hashtags don't display in the
list of hashtag suggestions. If you censor a hashtag that previously existed on the
system, the link is removed. If a user previously selected to follow that hashtag, related
entries are removed from the Overview page when they refresh the browser, and the
hashtag page is removed. If you remove the tag from the censored list later, the
hashtag is restored as a followed tag and the hashtag page is restored.

CORS Cross-Origin Resource Sharing (CORS) allows a web page to make XMLHttpRequests
to another domain. If you have a browser application that integrates with Oracle Social
Network and makes HTTP calls to the server, you must add the machine that's hosting
the application to the CORS origins list.

Depending on the requirements for front channel or back channel interaction, you would
add the host machine information to either the list of Front Channel CORS Origins,
Back Channel CORS Origins, or both. Generally you need to enable and add origins
only for the Front Channel, which interacts with the REST API.

Back Channel CORS Enables or disables the use of Back Channel CORS. By default, this setting is enabled.

Back Channel CORS
Origins

Type one or more CORS Origin values in the entry field. Use a comma to separate
each value in the field.

Enter each CORS origin value in the format http[s]://<domain-name.com>.

Note: Do not use * as an origin value; it allows access from all hosts.

Front Channel CORS Enables or disables the use of Front Channel CORS. By default, this setting is enabled.
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Element Description

Front Channel CORS
Origins

Type one or more CORS Origin values in the entry field. Use a comma to separate
each value in the field.

Enter each CORS origin value in the format http[s]://<domain-name.com>.

Note: Do not use * as an origin value; it allows access from all hosts.

Export Data You can export conversation data for auditing purposes.

Important: Before exporting data, go to the Users page in Administration. Under
Integration Account, make sure that both options are selected. These privileges are
required to export conversations created by other users.

To export conversation data, select a From Date and a To Date, then click Export.
When the export is finished, you see a dialog to download the zip file with all the
exported conversation data.

Notes:
• The from and to dates start at 12:00am based on the server UTC time. For

example, to export conversations created on May 09, 2017, you'd select a From
Date of May 09, 2017 and a To Date of May 10, 2017.

• Only 1000 conversations can be exported at one time. The zip file contains a file
called archive-info.txt that summarizes what was exported. If the "Matching
conversations" count is 1000, you need to decrease the date range to export
additional conversations.

• The export job runs for a maximum of three minutes. If the "Actual time taken" is "3
minutes", you need to decrease the date range to allow the job to complete.

Managing Users
These topics discuss how to manage users:

• User Types

• About User Management in Oracle Identity Manager

• Finding a User

• Inviting/Creating a User from the Administration Page

• About New User Invitation Emails

• Enabling or Disabling a User

• Editing User Properties

• Synchronizing User Profile Information with OIM

• Adding Several Employee or Outside Users at Once

• Unlocking User Accounts

User Types
The following basic user types exist in Oracle Social Network:

• Participant: Participants are users who are employees of your company; this
category includes most other user types. Participants can create conversations,
post messages, assign flags to other users, and so on. They are normally created
when your organization configures users in the Oracle Cloud, but they also can be
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invited by other participants. A participant is typically a user whose email address
(user name) exists within your organization's email domain.

Within your environment, you might have two types of participant users; these two
participants are not distinguished from each other in Oracle Social Network. For
example, in an Oracle Cloud Application CRM integration you might have 50
licenses; these 50 users have access to both CRM and Oracle Social Network.
These users are added to Oracle Social Network and they are participant users.
You can invite additional users within the company to use Oracle Social Network,
but they do not have access to CRM; these non-CRM users are also participant
users.

Employee users are also participants. An employee is typically a user whose
email address (user name) exists outside your organization's email domain but
they are still employees who are entitled to full Oracle Social Network access,
possibly including service administrator permissions. You must explicitly add or
invite them to join Oracle Social Network. When these added/invited users log in,
they become Participant users. To allow employee users in your environment, you
use the Extended Collaboration page in the Administration UI. For more
information, see Managing User Collaboration.

Administrator: An administrator is a user who has been given additional
administrative privileges. Administrators can log in to the Oracle Social Network
web client to do administration tasks. There are two types of administrators: site
and service. Service administrators have access to features that allow them to do
all the typical management tasks for users, social definitions, and more. Site
administrators are Oracle personnel who have access to extended functionality for
Oracle Social Network administration. The site administrator privilege is not
managed in the administration UI.

• Integration account: This account type is for a program, not a user; it
authenticates to Oracle Social Network to integrate custom applications. An
integration account is not visible in the user interface. Optionally, you can allow the
integration account to act on behalf of actual users. This privilege lets the
integrating program do tasks as a user who is not logged in to Oracle Social
Network, such as posting a message from an on-premise application as if it were
posted by a user.

Caution: You can also optionally allow the integration account to access any data
in Oracle Social Network for any user. This privilege can be used for applications
that require access to this secured data, such as custom search indexing,
eDiscovery, and compliance. Make sure the credentials to this account are held
securely.

• Outside user: An outside user is a user whose email address (user name) exists
outside your organization's email domain and who is not an employee of your
company. Outside users cannot be given administrator permissions. For users
outside your email domain, you must explicitly add or invite them to join Oracle
Social Network. To allow outside users in your environment, the Invitations option
must be enabled, at least one value must exist in the Outside Users Whitelist
field on the Extended Collaboration page, unless the Invite Outside Users with
Any Email Domain check box is selected. To exclude outside users from a
specific email domain, you can add the domain name to the Outside Users
Blacklist field. If a user is invited from a domain in the blacklist, the invitation fails.
For more information, see Managing User Collaboration.
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About User Management in Oracle Identity Manager
When configured with an external user management system such as Oracle Identity
Manager (OIM), general user properties are typically managed in that system. By
default, when a user's general properties are changed in OIM, they are automatically
propagated to Oracle Social Network when the user logs in. Your specific system
configuration determines whether this change occurs.

By default, these properties are managed from OIM and are not editable in Oracle
Social Network:

• Display Name

• E-mail address

• Manager

• Name (user ID/login)

• Organization

• Phone Number

• Title

Your environment might have more or fewer properties managed in OIM, depending
on your specific configuration.

Role (privilege) properties can be changed from either OIM or from Oracle Social
Network, and the changes are propagated to the other system. When role properties
are changed using Oracle Identity Manager, it could take up to 10 minutes for that
change to be visible in Oracle Social Network. The change is visible after that user
logs in again. Changes made in Oracle Social Network become effective immediately
in Oracle Identity Manager as well as Oracle Social Network.

Role properties include:

• Developer

• Service Administrator

• Employee

• Outside User

If your OIM settings become out of sync with Oracle Social Network, or if you want to
replace property values for one or all users without waiting for the automatic sync that
occurs during login, you can do this task either for an individual user or for all users at
once. For more information, see Synchronizing User Profile Information with OIM.

Finding a User
On the Users page, you must find the user that you are interested in before you can
edit their properties.

You can view a list of administrators, developers, or outside users by selecting the
associated tab on the Users page, or you can search for an individual user.

To find an individual user, enter part of the user name, display name, or email address
in the Search field and click Search. All matching user accounts are listed in the
Users list.
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The user list shows some basic information about the users, including the name, email
address, user type, and verification status.

Verified user accounts have been verified using one of these methods:

• The user was located in an external account database such as an LDAP
(Lightweight Directory Access Protocol) directory service directory.

• An email was sent to the user, and the user clicked the link in that email to verify
their identity and logged in.

Inviting/Creating a User from the Administration Page
In an Oracle Cloud environment, you typically do not need to specifically invite users;
you can publicize the URL for the Oracle Social Network end-user-client login page,
and users inside your email domain can create their own accounts.

If you want to allow employee users (for example, non-Oracle Cloud users who are
within your company) or outside users to join Oracle Social Network, you must enable
the Employees option or the Outside Users option on the Extended Collaboration
page, and add the users' domain in the Employee Whitelist or Outside Users
Whitelist field. If the Invite Outside Users with Any Email Domain check box is
selected, you do not need to specify domains in the whitelist to allow external users.

To invite a user to join Oracle Social Network:

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Users. The Users page opens and displays the
user list.

3. Click New User.

4. Type an email address and click Create. An email invitation is sent to the address
you specify; the email contains a URL that the user can click to access Oracle
Social Network.

When the user clicks the invitation link, the browser client's password setup page
displays. After the user logs in to Oracle Social Network for the first time, the
Verified status appears in green text for that user in the user list.

Note: You can add many employee or outside users to Oracle Social Network at once
using the Bulk User Upload Wizard. For more information, see Adding Several
Employee or Outside Users at Once.

About New User Invitation Emails
By default, when you create/invite one or more users to Oracle Social Network, a new
user invitation email is sent at these times:

• A new user invitation email is sent immediately.

• If the new user has not accessed Oracle Social Network, a second invitation email
is sent two days after the user is created.

• If the new user still has not accessed Oracle Social Network, a third invitation
email is sent three days after the user is created.

In some cases (such as when creating users in bulk, or if your system is not being
used in production yet) you might not want to send invitation emails to new users. If
you disable all email notifications for more than three days, no invitation emails are
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sent. For more information about the global email notification setting, see Editing
General Properties .

Enabling or Disabling a User
When an administrator disables (deactivates) a user, the disabled user can't log in. In
addition, access for a disabled user is removed from all Conversations that they were
a member of, and other users can't follow that user or post to their wall.

Note: The Deleted check box is not editable; if you see that it's selected, it indicates
that the user account is managed in an external user directory, and the user account
no longer exists in that directory. You use the Enabled option rather than the Deleted
option to specify a user's status in Oracle Social Network.

To enable or disable a user:

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Users. The Users page opens. The page is
empty until you find the user you want to enable or disable.

3. Search for the user, using the instructions in Finding a User.

4. Click Edit for the user you want to enable or disable. The properties page opens.

5. Select or deselect the This User Account is Enabled check box.

6. Click Save.

Editing User Properties
You can manage Oracle Social Network privileges and other properties for participant,
employee, and outside user accounts from the Users page.

To view and edit a user's properties:

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Users. The Users page opens.

3. Search for the user, using the instructions in Finding a User.

4. Select the user whose properties you want to change. The properties page opens.

5. Edit the properties of the user. For more information about user properties, see 
User Properties Page.

6. Click Save.

User Properties Page
The following table describes the user properties.

Element Description

General Properties In this section you can view general information about the user; you cannot
edit the values.

Display Name The version of the user's name to be displayed in the client. If blank, the
User Name is used.

ID An identifier assigned by the system for this user's account.
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Element Description

Type The user type: Participant or Outside User.

User Name The user's name.

Email The user's email address.

Verified Users are verified by either finding them in the user directory, or after the
user clicked a link in an invitation email to verify their identity and joined
Oracle Social Network.

Created The date and time this user account was created in Social Network.

Last Modified The date and time this user account was last modified.

Last Connected The date and time this user last logged in to Oracle Social Network.

Last Disconnected The date and time this user's last session with Oracle Social Network ended.

Account Settings In this section you can enable or disable an account, and view the settings
for deleted or locked users.

This User Account is Enabled Specifies whether this user is enabled on the system. A disabled user can't
log in. In addition, access for a disabled user is removed from all
Conversations that they were a member of, and other users can't select to
follow that user or post to their wall.

This User Account is Deleted Not editable. Indicates that a user account is managed in an external user
directory, and the user account no longer exists in that directory. A user can't
be Enabled and Deleted at the same time.

This User Account is Locked Indicates that the user account is locked. You can't modify this property from
the properties page. For more information about locked accounts, see 
Unlocking User Accounts.

Privileges and Special Behavior In this section you can specify user types and configure integration accounts.

These properties do not display for Outside Users.

Service Administrator Specifies whether the user is a service administrator. Service administrators
have access to the Administration section of the Oracle Social Network
browser interface, and can do all the typical management tasks for users,
apps, social definitions, and more.

Developer Specifies whether the user is a developer. Developers can access the
Oracle Social Network developer website to use specialized tools for
development work; developer tools include the API Explorer, Social
Definition Builder, and more.

Note: Set this property only on the staging instance; the developer user type
is intended for use only on that instance. Changes you make on the
production instance are not copied to the staging instance.
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Element Description

Integration Account Specifies whether this is an integration account. This account type is for a
program, not a user; it authenticates to Oracle Social Network to integrate
custom applications. By default, an integration account has service
administrator privileges. An integration account is not visible in the user
interface.

Optionally, you can also set two special privileges:

• Allow the integration account to act on behalf of actual users. This
privilege lets the integrating program do tasks as a user who is not
logged in to Oracle Social Network, such as posting a message from an
on-premise application as if it were posted by a user. This privilege is
enabled by default.

• Allow the integration account to access any data in Oracle Social
Network for any user. This privilege can be used for applications that
require access to this secured data, such as custom search indexing,
eDiscovery, and compliance. Use this setting with caution. Make sure
the credentials to this account are held securely. This privilege is
enabled by default.

Tips:

• You use integration accounts on both the staging instance (for testing)
and on the production instance.

• We recommend that you not give integration account privileges to
developers.

Conversation Settings In this section you can configure Conversation settings for the user.

Show Conversation Membership
Messages by Default

When enabled, the user sees a message in Conversations whenever new
members are added to the Conversation; for example, The Conversation is
now accessible to <name>. When disabled, messages about new members
do not appear in Conversations. If you change the property, it takes effect
when the user logs out and then logs in again.

Delegates To define users or groups who can post to this user's wall on their behalf,
click Choose Delegates and then search for the users and groups that you
want to assign as delegates.

In the Update Delegates dialog, move people or groups to the right column
to add them, or to the left column to remove them.

Legal Hold and Retention A retention policy allows you to specify how log to keep data on the system
before deleting it. When using retention policies, you can place individual
users on legal hold. While a user is on legal hold, messages and documents
created or modified by this user, and Conversations, Collections, or Social
Objects in which this user participated are not deleted regardless of the
retention policy.

Retention policies are managed externally; contact Oracle Support for
questions about your retention policy configuration.

For more information on retention properties, see General Properties Page.

On Legal Hold Enable or disable legal hold for the user. While an account is on Legal Hold,
no user data for that account is deleted, regardless of the retention policy
settings.

Retention Extended If selected, the user's data is kept on the system for the time period defined
in the Extended Retention Period rather than the Standard Retention Period.

For more information on retention properties, see General Properties Page.
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Synchronizing User Profile Information with OIM
If your OIM settings become out of sync with Oracle Social Network, or if you want to
replace property values for one or all users without waiting for the automatic sync that
occurs during login, you can do this task either for an individual user or for all users at
once.

To synchronize profile information for an individual user, open the user's properties
page and click Sync Profile Now.

To synchronize profile information for all users at once, open the Users page and click
Sync Profile Data.

Adding Several Employee or Outside Users at Once
You can use the Bulk User Upload Wizard to add many employee or outside users to
Oracle Social Network in one action.

The process has two steps:

• Step 1. Download and Edit the New User Template File

• Step 2. Run the Bulk User Upload Wizard

Notes:

• The primary purpose of the wizard is to add users; however, if a user already
exists in the system, the wizard updates the user information based on the content
of the user properties CSV file.

• By default, invitation emails are sent to all new users. For more information about
these emails and how to disable them if needed, see About New User Invitation
Emails.

Step 1. Download and Edit the New User Template File
The wizard adds or updates users based on the information in a CSV file that you
upload. Before you can run the wizard you need to put user data into the file.

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Users.

3. Click Bulk User Creation.

4. Click Download Template. The template file is downloaded.

5. Add information to the file. The wizard requires, at a minimum, each user's name
and email address. Optionally, you can add more information about each user to
the file. Use the instructions and examples in the template file as a guide.

6. Save the file using a unique name.

Step 2. Run the Bulk User Upload Wizard
Use the wizard to upload the CSV file containing user information.

Chapter 19
Managing Users

19-13



Before you begin: Make sure your Extended Collaboration settings allow these
employee or outside users to be added. For more information, see Enabling Extended
User Collaboration.

Note: If you left the wizard open after downloading the template file, you can skip to
step 4 below.

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Users.

3. Click Bulk User Creation.

4. Click Select File and follow the screen prompts to upload the CSV file that you
previously set up.

5. Click Next. The wizard displays the list of users to be added. If any errors exist in
the CSV file, the errors are shown next to each user's information. If the file is
error-free, the Finish button is enabled.

6. If you need to fix any problems in the CSV file, click Back, fix the file, and then
click Select File again to upload the corrected file.

7. When the user information displays and no errors exist, click Finish to add or
update the users.

Unlocking User Accounts
If a user attempts to log in to Oracle Social Network but provides incorrect login
information five or more times, the user account is temporarily locked. Locked users
are identified in the Users page user list.

To manually unlock an account, click Unlock to the right of the user information in the
user list.

If you do not manually unlock a user account, it is unlocked automatically after 20
minutes.

Note: If you manage user locking in your environment using an external process such
as Oracle Access Management, user locking and unlocking is controlled from there
and not using the Oracle Social Network Administration interface.

Managing User Collaboration
These topics discuss how to manage user collaboration:

• Enabling Extended User Collaboration

• User Collaboration Settings

Enabling Extended User Collaboration
If enabled, any user other than an outside user can invite others who don't have
Oracle Cloud accounts to collaborate in Oracle Social Network. You can allow two
types of extended collaboration:

• Employee collaboration: these users have full user abilities.

• Outside user collaboration: these users have limited access to Oracle Social
Network content and a restricted set of abilities. Outside users cannot be given
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administrator or developer permissions. Outside users can be partners, suppliers,
and so on.

For more information about the types of users, see User Types.

Note: Not all environments allow extended collaboration. If your system does not have
this capability, the option does not display in the user interface.

To enable extended user collaboration:

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Extended Collaboration.

3. Enable the Invitations option.

4. Edit the Employee Whitelist, Outside Users Whitelist, and Outside Users
Blacklist fields as needed to specify email domains from which users can be
invited or excluded. If the Invite Outside Users with Any Email Domain check
box is selected, you do not need to specify domains in the whitelist to invite
external users. For more information about collaboration properties, see User
Collaboration Settings.

5. Add your company's "base" domains into the Employee Whitelist field. For
example, if you log in to Oracle Social Network as lia.kuang@example.com, put
example.com in the Employee Whitelist field. If you skip this step, you will be
unable to log in to Oracle Social Network after saving your change and logging
out.

6. Click Save.

User Collaboration Settings
The following table describes the user settings for extended collaboration.

Element Description

Employees In this section you can define which external email addresses can be invited as
employee users to Oracle Social Network.

Employee Whitelist This field is editable only if Invitations are enabled.

If you want to allow employee users outside your enterprise domain to join Oracle
Social Network as Participant users, you must add at least one domain in the whitelist.

Invitations can be sent only to email addresses that match a domain name in the
employee whitelist. For example, if you specify example.com, then a person with the
email address first.last@example.com can be invited to join Oracle Social Network as a
Participant (full privileges) user. The domain name value is not case-sensitive. To enter
more than one domain, separate them with commas. If an invitee's email address
matches any of the entries, it is allowed.

Creating a new employee account in Oracle Social Network triggers a corresponding
account creation process in an external database such as an LDAP (Lightweight
Directory Access Protocol) directory service.

Important Note: If you enable extended collaboration, you must add your company's
domains into the Employee Whitelist field. For example, if you log in to Oracle Social
Network as lia.kuang@example.com, put example.com in the Employee Whitelist field.
If you skip this step, you will be unable to log in to Oracle Social Network after saving
your changes and logging out.

Outside Users In this section you can define which external email addresses can be invited as outside
users to Oracle Social Network.
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Element Description

Outside Users Whitelist This field is editable only if Invitations are enabled.

If you want to allow users outside your enterprise domain to join Oracle Social Network,
you must add at least one domain to the whitelist, unless the Invite Outside Users
with Any Email Domain check box is selected.

If the check box is not selected, invitations can be sent only to email addresses that
match a domain name in the list. For example, if you specify example.com, then a
person with the email address first.last@example.com can be invited to join Oracle
Social Network as an outside (limited privileges) user. The domain name value is not
case-sensitive. To enter more than one domain, separate them with commas. If an
invitee's e-mail address matches any of the entries, it is allowed.

Creating a new outside user account in Oracle Social Network triggers a corresponding
account creation process in an external database such as an LDAP (Lightweight
Directory Access Protocol) directory service.

Outside Users Blacklist This field is editable only if Invitations are enabled.

If you want to exclude users from a domain outside your enterprise domain from joining
Oracle Social Network, you can add the domain to the blacklist. If a user is invited from
a domain in the blacklist, the invitation fails.

Managing Apps
These topics discuss how to manage apps:

• App Types

• Apps Included with Oracle Social Network

• Adding an App

• Deleting an App

• Editing App Properties

• Restoring Apps to their Default Settings

App Types
Apps (sometimes called applications or gadgets) are web-based applications that can
be deployed in Oracle Social Network. Apps are applicable only on the web client.

There are two types of apps:

• Conversation apps are external standalone applications that you can add to a
Conversation. Examples include a poll, map, or a photo viewer. An app definition
file, also called an app specification, is an XML file that defines its content,
behavior, properties, and the data it will display.

• Social Object apps represent business objects coming from a System of Record
or defined directly in Oracle Social Network, to make the information viewable in
the context of a Conversation. Social Object apps are managed using the Social
Definition Builder in the developer website.

From the Apps page, you can add Conversation apps that were defined in an app
definition file or Social Object apps that were exported from the Social Definition
Builder; and you can enable, configure, disable, or remove existing apps.
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Apps Included with Oracle Social Network
Oracle Social Network comes with two apps, which are enabled by default:

• The Oracle Social Network Site App allows you to embed a live web page into a
Conversation. Note that many external sites, such as http://www.google.com, don't
allow embedding; these sites do not appear when a user puts the URLs in the
Oracle Social Network Site app.

• The Oracle Social Network Photo App automatically displays all the images in
the Conversation as a slide show.

The Oracle Social Network Collection App is included to provide Collection
functionality. Although it is included in the product, it is not intended for use as a
sample app.

Note: If a developer on your team changes an app definition file or Social Object
definition file outside the Administration user interface, using the Oracle Social
Network REST API or another tool, you must re-upload the updated definition file to
Oracle Social Network from the app's properties page.

Adding an App
When you add an app, Oracle Social Network uploads the definition file containing the
code for the app and installs (deploys) it.

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Apps. The Apps page opens and lists the apps.

3. Click New App.

4. Enter a name and external ID for the app. For more information about these fields,
see App Properties Page.

5. Click Select File and follow the screen prompts to upload the file containing the
app definition. The definition file must be valid XML that conforms to the schema of
the app type.

6. Click Save.

7. Edit the properties of the app as needed, by following the steps in Editing App
Properties.

Deleting an App
To delete an app, click Delete to the right of the app in the list. If instances of the app
exist in the web client, you can't delete the app.

Deleting an app removes it only from the Oracle Social Network application. The
actual file used to create the app is not deleted.

Editing App Properties
1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Apps. The Apps page opens and lists the apps.

3. Select the app to open its properties page.
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4. Edit the properties of the app. For more information about fields in the user
interface, see App Properties Page.

5. Click Save.

App Properties Page
The following table describes app properties.

Element Description

The general properties of an app display at the top of the page.

App Name The name of the app, which is displayed in the client user interface.

App External ID Specifies an identifier that allows other apps or code to refer to the app.

The ID can be up to 256 characters in length and must contain at least one period
(.) character.

Make sure the identifier you specify is unique across your system. Do not change
the External ID of an app that is provided with Oracle Social Network.

ID Not editable. An identifier assigned by the system.

Type Not editable. An identifier assigned by the system for the app type.

Created Not editable. Shows the date and time when the app was created. For apps that are
included as part of Oracle Social Network, the installation date and time are
displayed.

Last Modified Not editable. Shows the most recent date and time that configuration changes were
made to the app.

App Definition File Click Select File and follow the screen prompts to upload the file containing the
app definition. The definition file must be valid XML.

General Properties This section displays properties that apply to both app types.

App Enabled Enables or disables the app. If an app is available but not enabled, it's visible but
not functional, and users can't add new instances of the app to Oracle Social
Network.

For certain system apps, such as the Collection App, this field is not editable.

App Available Makes the app available or unavailable to users. This control determines whether
the app is visible to users in the list of available apps.

For certain system apps, such as the Collection App, this field is not editable.

App Local Specifies whether the app communicates with the originating Oracle Social Network
server locally or over a proxy. The generated URL sent to the app on the client
varies depending on the selection. The default is deselected (not local). Do not
change this setting except at the direction of Oracle Support.

One App Instance Per
Conversation

Specifies whether more than one instance of the app can exist in a Conversation. If
you select this option, the client user can add only one instance of the app in the
Conversation. For example, it doesn't make sense to have two instances of the
Photo Viewer app in a Conversation, but you might want to allow more than one
instance of a polling app to be added.

App Type Specifies the functional type of the app. The options are:

• Social Object: The app is a Social Object app, and it displays in the Social
Objects drop-down list where applicable (if the app is Discoverable or if it was
shared with the user). If the Customizable option is enabled for the app, the
app can be customized using the Social Definitions page in the Administration
UI. For details, see Managing Social Definitions.

• Conversation: The app is a standalone app for use in Conversations.
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Element Description

Social Object App For Social Object apps (the App Type is Social Object), the following additional
properties display.

The properties are not editable from the Administration user interface. You can
change them using the REST API or (if you have the Developer privilege), using the
Social Definition Builder in the Oracle Social Network developer website.

Createable Instances (Social Objects) based on the Social Definition can be created. If the
option is not selected, neither the REST API nor users on any client (such as web,
mobile, or Outlook) can create an instance of the Social Definition.

Customizable You can customize the Social Definition. If this option is not selected, the Social
Object app does not display in the Social Definitions page.

Updateable The Social Object fields can be updated in Oracle Social Network; an Edit button
displays for the object, allowing the user to change the Social Object description,
for example. If the option is not selected, neither the REST API nor users on any
client (such as web, mobile, or Outlook) can update fields of the Social Object.

Deletable Instances of the Social Object can be permanently deleted. If the option is not
selected, neither the REST API nor users on any client (such as web, mobile, or
Outlook) can delete instances of the Social Object.

Renameable The Social Object can be renamed. If the option is not selected, neither the REST
API nor users on any client (such as web, mobile, or Outlook) can rename the
Social Object.

Closeable The Social Object can be closed (made inactive). If the option is not selected,
neither the REST API nor users on any client (such as web, mobile, or Outlook) can
close the Social Object.

Required Features If applicable, a table displays features that the app requires in order to work
properly. You can click a feature name to go to its properties page.

Restoring Apps to their Default Settings
When Oracle Social Network is installed, certain apps and features are included
(seeded). If changes occurred after installation that you want to revert, you can re-
seed the default apps and features.

Reseeding your apps and features will not affect any apps and features that you
added; only the ones included as part of Oracle Social Network are changed.

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Apps.

3. Click Seed Apps and Features.

Note: Both features and apps are re-seeded. You can't re-seed one without the other.

Managing Features
These topics discuss how to manage features:

• About Features

• Adding a Feature

• Deleting a Feature

• Editing Feature Properties
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About Features
Features are JavaScript libraries that provide apps with specific functionality, such as
communicating with the Oracle Social Network Server, adding interactive behavior, or
manipulating data. Oracle Social Network adds several features as part of the
installation process. Under normal circumstances you do not need to change features
that are included with Oracle Social Network, but you might want to add features that
are needed by new apps that you add into the environment.

Do not modify or disable any of the default features unless advised to do so by Oracle
Support. Doing so might disable critical functions of Oracle Social Network.

From the Features pages, you can add features, and enable, configure, disable, or
remove existing features. Features currently installed in Oracle Social Network are
listed, along with fields indicating a version number and a date/time stamp indicating
the most recent update to the feature files.

Adding a Feature
When you add a feature, Oracle Social Network uploads the file for the feature and
adds (deploys) it.

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Features. The Features page opens and lists the
features.

3. Click New Feature.

4. Enter a name for the feature in the Feature Name field.

5. Enter a version number for the feature in the Version field. You can have more
than one version of a feature on the system; each version is shown separately in
the feature list.

6. Click Create.

7. Open the properties file for the new feature and add its feature file. For more
information, see Editing Feature Properties.

Deleting a Feature
To delete a feature, click Delete to the right of the feature in the list.

Note: Deleting a feature removes it only from the Oracle Social Network application.
The actual file used to create the feature is not deleted.

Editing Feature Properties
Do not make changes to the default features that come with Oracle Social Network
unless advised to do so by Oracle Support. Doing so might disable critical functions of
Oracle Social Network.

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Features. The Features page opens and lists the
features.
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3. Select the feature that you want to change. Its properties page opens.

4. Edit the properties of the feature. For more information about fields in the user
interface, see Features Properties Page.

5. (Optional) To edit the properties of the feature files for the feature, select the file in
the Feature Files list, edit its properties, then click Save.

6. (Optional) The order of feature files is significant. To change the order of the
JavaScript files for a feature, click Move Up or Move Down next to the file that
you want to move.

7. Click Save.

Features Properties Page
Select a feature in the list to edit its properties.

Element Description

Feature These general properties are at the top of the page.

Feature Name The name of the feature.

Version The version of the feature. The version must contain only numbers and one or more
period (.) characters. You can have more than one version of a feature on the system;
each version is listed separately in the feature list.

ID Not editable. An identifier assigned by the system.

Type Not editable. An identifier assigned by the system for the feature type.

Last Modified Not editable. Shows the most recent date and time that configuration changes were made
to the feature.

Feature Files Each feature file for the feature is listed. Click the file name to edit it.

File Name The name of the feature file.

File Order The order of the file in the feature files list.

File MIME Type Not editable. A MIME type assigned by the system for the feature type, based on the
content of the file.

File Length Not editable. The length of the file in bytes.

Last Modified Not editable. Shows the most recent date and time that configuration changes were made
to the file.

Add Feature File To add a new file, click Select File. Browse to the location of the file you want, and click
Upload.

Managing Social Definitions
These topics discuss how to manage social definitions:

• Social Definition Properties in the Administration UI

• Where to Customize Social Definitions

• Adding a Social Definition

• Editing Social Definition Properties
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Social Definition Properties in the Administration UI
A Social Definition is a "model" of a Social Object; after you add a Social Definition on
your system, users can create Social Object instances based on the definition. A
Social Definition specifies the properties of its corresponding Social Object and how to
display it in different client interfaces.

You can create a Social Definition in different ways, including using the Social
Definition Builder tool in the Oracle Social Network developer website, or using the
Oracle Social Network REST API. For more information, see the Oracle Social
Network Developer's Guide (accessible from the developer website).

If the customizable property of a Social Definition is enabled, you can change some of
its properties using the Administration UI. After you save a change, it is visible to end
users when they start a new browser session or do a full page refresh. You can set the
customizable property from the Social Definition Builder in the developer website, or
using the Oracle Social Network REST API. For more information, see the Oracle
Social Network Developer's Guide (accessible from the developer website).

The following table shows the (non-editable) properties that display for Social
Definitions when you navigate to Social Definitions. Additional properties display
when you choose to edit an individual definition.

Element Description

Social Definition
Name

The name of the Social Definition as it appears in the Administration user interface. This
property is editable from the Social Definitions page when you add the definition, and
editable from the Apps page after creation.

External ID The unique identifier for the Social Definition. This identifier uses namespacing to specify
the originating application; for example, a Social Definition named Opportunities might
have the External ID companyname.crm.opportunities. This property is editable from the
Social Definitions page when you add the definition, and editable from the Apps page
after creation.

Enabled Shows whether the Social Definition is enabled. Enabled Social Definitions display in the
client user interface's Social Objects drop-down list (if the app is Discoverable or if it was
shared with the user). This property is editable from the Social Definitions page when you
add the definition, and editable from the Apps page after creation.

Where to Customize Social Definitions
The following table lists the properties of a Social Definition and shows where the
property can be changed after it has been created. Note that only Social Definitions
that are defined as Customizable can be edited from the Social Definitions page. For
more information about Social Object properties and the Social Definition Builder, refer
to the Oracle Social Network Developer's Guide (accessible from the developer
website).

The editable properties on your system might differ from those shown in this table.
Your specific configuration determines which properties are available in Oracle Social
Network.

Note: If a developer on your team changes a Social Object definition file outside the
Administration user interface using the Oracle Social Network REST API or another
tool, you must re-upload the updated definition file to Oracle Social Network from the
Apps properties page.
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Property Type Property Apps
Page

Social
Definitions
Page

Social
Definition
Builder

Social Definition Social Definition Name X

Display Name X

External ID X X

Fields X

Group X

Enabled X X

Available X X

Local X X

Definition File X X

Social Definition Field Columns to Display X X

Label Position X X

Show in Summary X X

Show in Detail X X

Show in Digest X X

Sortable X X

Filterable X X

Read Only X

Required X

Social Object Instance Customizable X

Createable X

Deleteable X

Discoverable X X

Updateable X

Closeable X

Renameable X

Adding a Social Definition
When you add a Social Definition, Oracle Social Network uploads the definition file
containing the code for the Social Definition and installs (deploys) it.

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Social Definitions. The Social Definitions page
opens and lists the existing definitions.

3. Click New Social Definition.

4. Enter a name and external ID for the Social Definition. For more information about
these fields, see Social Definition Properties Page.

5. Click Select File and follow the screen prompts to upload the Social Definition.
The definition file must be valid XML that conforms to the Social Definition
schema.
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6. Click Create.

7. Edit the properties of the Social Definition as needed, by following the steps in 
Editing Social Definition Properties.

Editing Social Definition Properties
To customize a Social Definition:

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Social Definitions.

3. Select the Social Definition that you want to change. Its properties page opens.

4. Edit the values that are displayed. For more information about a field, see Social
Definition Properties Page.

5. To reorder a field, select it and click Up or Down.

6. To preview your selections as they would be displayed in the web client, click
Preview. A popup window opens and displays the Social Object as it would look
with your changes.

7. Click Save. The change is visible to end users when they start a new browser
session or do a full page refresh.

Social Definition Properties Page
If the Social Definition specifies that it is Customizable, some of its properties can be
changed using the Social Definitions properties page.

Element Description

General Properties General properties appear at the top of the page. They are not editable.

Display Name The name of the Social Definition as it appears in the client user interface.

Display Name Plural The plural name of the Social Definition as it appears in the More drop-down list in the
client user interface.

Social Definition Name The name of the Social Definition as it appears in the administrator user interface.
Editable from the Apps page.

Namespace Oracle Social Network supports namespacing all the objects under their respective
originating applications. The use of namespacing ensures that External IDs remain
unique across all Social Object definitions and Social Object instances. In addition to
External ID namespacing, you should namespace Social Object field names. Social
Definition fields are restricted to the Social Definition namespace and must be unique
within the definition.

External ID The unique identifier for the Social Definition. This identifier uses namespacing to
specify the originating application; for example, a Social Definition named Opportunities
might have the External ID companyname.crm.opportunities. Editable from the Apps
page.

Group Name The name of the group, such as CRM. Typically the Group Name corresponds to the
name of the System of Record providing data for the Social Definition, but this is not
required. In the Oracle Social Network browser client, Social Definitions generally are
grouped and displayed in the Social Objects drop-down list.

Enabled Shows whether the Social Definition is enabled. Enabled Social Definitions display in
the client user interface (if the Social Definition is also Discoverable). Editable from the
Apps page.
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Element Description

Closeable Shows whether a Social Definition instance (Social Object) can be closed by the end
user in the web client interface.

Deletable Shows whether a Social Definition instance (Social Object) can be deleted by the end
user in the web client interface.

Updateable Shows whether a Social Definition instance (Social Object) can be updated by the end
user in the web client interface.

Renameable Shows whether a Social Definition instance (Social Object) can be renamed by the end
user in the web client interface.

Visibility These options affect whether users can make Social Definition instances (Social
Objects) public, and the default setting for new Social Objects.

Allow Public
(Discoverable) Social
Objects

If enabled, the Social Definition displays in the Social Objects drop-down list in the user
interface, and users can make Social Objects public in the same way they would make
a Conversation public. Public Social Objects appear in search results and in the
Available area on the Social Objects page. If disabled, the user does not see the Social
Definition or any of its Social Objects unless it is shared with them.

Default Visibility Setting Specifies whether newly-created Social Objects are publicly available or members-only
by default. After the Social Object is created, users can change this setting.

Layout Options These options affect the position of the fields in the Social Object.

Columns to Display Specifies the number of columns to use when displaying the Social Object in the user
interface.

Label Position Specifies whether to display the field name above the field or to the left of the field in
the Social Object.

Ordered Fields These options affect the fields in the client user interface.

Field Order (arrows) Use these arrows to change the order of the fields as displayed in the user interface.

Field Name Not editable. The name of the field as it appears in the user interface.

Type Not editable. The data type of the property.

Read Only Specifies whether the field is read-only in the Detail view of the Social Object.

Required Specifies whether the field must have a value.

Show in Summary Specifies whether the field displays in the Summary (List) view of the Social Object.

Show in Detail Specifies whether the field displays in the Detail view of the Social Object.

Show in Digest Specifies whether the field displays in the email digest.

Sortable Specifies whether the user can sort the list view of the content using this field. If
enabled, the field displays as a Sort by selection.

Filterable Specifies whether the user can filter (search on) the list view of the content based on
this field.

Managing Federated Authentication
These topics discuss how to manage federated authentication:

• When to Configure Federated Authentication

• Editing Federated Authentication Properties
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When to Configure Federated Authentication
Federated authentication support is required when you are using Oracle Social
Network in an Oracle Cloud environment (such as Oracle Sales Cloud or HCM) and
you require user authentication using your own identity management provider. For
example, you might be using an on-premise authentication solution in your
environment, or a Cloud-based provider. In this situation, you must define URLs to be
used at specific points during the automatic client authentication process.

In addition, you use the federated authentication settings to help mobile client users
define their account settings after installation, based on their existing browser client
account settings. With the standard authentication process, no special configuration is
required. However, if you use a custom login page (you might need to do this if your
users provide a PIN number, captcha, or other information to log in), you must define
properties for your Login URL, Login Success URL, and so on, so that Oracle Social
Network can send the client user to the correct destinations during the login process.

Editing Federated Authentication Properties
To edit the federated authentication properties:

1. Log in to Oracle Social Network as an administrator.

2. From the Administration UI, click Federated Authentication. The Federated
Authentication properties page opens.

3. Edit the properties. For more information about fields in the user interface, see 
Federated Authentication Properties Page.

Note: The URL properties display after you select the Enabled option.

4. Click Save.

Federated Authentication Properties Page
These properties are applicable only if you require user authentication using your own
identity management provider.

Element Description

Enable Federated
Authentication URLs

When enabled, the URL property fields are displayed.

Select this option only if you require user authentication using your own identity
management provider.

Note: The Federated Authentication page does not control whether or not another
authentication is enabled; you work with Oracle Support to configure that process
outside the Administration UI.

Login URL Required. Specify the URL to which the user will be taken to log in, in the format
http[s]://<host>:<port>/<path>. For example:

https://companyname.com:12345/osn/federatedLogin.html/

Logout URL Required. Specify the URL to which the user will be taken to log out, in the format
http[s]://<host>:<port>/<path>. For example:

https://companyname.com:12345/oam/server/federatedLogout/
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Element Description

Login Success URL Required. Specify the URL to which the user will be taken at the completion of a
successful login, in the format http[s])://<host>:<port>/<path>. For example:

https://companyname.com:12345/fedauthcompleted/?authentication=success

Login Failure URL Required. Specify the URL to which the user will be taken after an unsuccessful
authentication, in the format http[s]://<host>:<port>/<path>.

The user is authenticated by your server, which you configure with a maximum
number of login attempts; after the user fails to authenticate in that number of tries,
the failure URL is used. For example:

https://companyname.com:12345/fedauthcompleted/?authentication=failed
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20
Collaborating Through Social Networking
for Outside Users

This section talks about features available to you when you collaborate with a
company as an outside user using social networking.

• What does social networking have to do with my job?

• How do I view the social activity?

• How do I collaborate with the people I'm working with?

• How do I edit my profile?

• How do I work with messages?

• How do I show or hide membership messages in a Conversation?

• How do I mark a Conversation as a favorite?

• How do I share a document with others?

• How do I view a file?

• How do I delete a document?

• How do I view document annotations?

• How can I alert people to an important message?

• How can I see all flags assigned to me or by me?

• What are hashtags (#) and how do I use them?

• How do I search?

• How do I start a chat with someone?

• How do I mute or unmute a Conversation?

• How can I view a list of closed Conversations?

• How do I download an archive of a Conversation?

• How is the social network accessible?

• What keyboard shortcuts are available to the social network?

• How do I change my notifications settings, preferences, and conference settings?

What does social networking have to do with my job?
As an outside user (partner, supplier, or such), you can use the social network to
collaborate with internal users in the company.

Whether you've been invited to collaborate on a particular project or you collaborate
regularly as a partner, the social network provides the following features to make that
collaboration easier:
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• Have an ongoing Conversation about an issue. Anyone new that joins the
Conversation can quickly get up to speed on what's already been done or said.

• Share presentations and other documents and get input from other team
members.

Web conference and juggling email responses not required.

• Know when you need to review or respond to something by viewing your flagged
items.

• Get real-time notifications about updates to key Conversations.

How do I view the social activity?
Depending on the company you're working with, you might access social activity
through a Social application or through a Social panel in the company's application:

• If you were invited to join a Conversation via an email, click the link in the email.

• If you have access to the company's application, while viewing the landing page,
click the Social icon, or in the Navigator, click Social.

The Social application or panel opens, showing the Overview page with the most
recent messages in all Conversations that are available to you.

You can also see the most recent messages in the Recent Activity section on the right
side of the Social application or panel. It includes the following sections:

• Recent Activity—Displays the most recent messages in all Conversations that
are available to you.

• Trending—Displays the Conversations that are available to you with the most
people in them at the moment.

Note: If you don't see the sections on the right, your browser window is not wide
enough. Expand your browser window to see it.

How do I collaborate with the people I'm working with?
First someone in the company you're working with invites you to participate in a
Conversation in their social network. The Conversation includes messages centered
around the business situation you're collaborating on.

In the Conversation, you also see the members participating in the Conversation. Each
member has an picture to show you what they look like or how they want to represent
themselves. A colored border appears around the picture to indicate people's
presence—that is, whether they are online (a dark green whole circle), online but
inactive (a yellow three-quarter circle), or offline (a gray half-circle).

Note: You and other people outside the company you're working with (outside users)

have a special avatar ( ) and have names in purple text.

You can click a user name or picture to navigate to that person's profile, where you
can see information such as the person's title, organization, email, and possibly other
contact information.
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How do I edit my profile?
To edit your personal information or picture on your social network profile:

1. From the navigation on the left, click My Profile.

2. On your profile, click Edit Profile.

3. Edit your personal information. Don't forget to add a bit about what you do in the
Description box under Basic Information and your contact information in the
boxes under Contact Information.

Note: Some information is read only. If you need to change the read-only
information, contact your administrator.

4. To change your profile picture, click it, then select Upload Photo. Select
a .gif, .png, or .jpg file. After you select a picture, you can use the crop tools to re-
size it. Your picture is scaled to 150x150 pixels square.

Note: If you use Mozilla Firefox and JAWS, you must disable pop-ups before you
upload a profile picture. If you don't disable pop-ups, the upload dialog won't
appear.

How do I work with messages?
To add a message:

1. Open the Conversation.

2. In the text box at the bottom of the display, type your message.

Formatting options are available beneath the text box after you click it. Hover over
the icons to see what they do.

3. Click Post.

To add a link to another item:

While writing a message, you might find it handy to link to a Conversation or
document, or folder. Here's how:

1. While writing your message, click  under the text box to open the Insert
Reference dialog.

2. Select a source:

• Recent Items—To select from items you've visited recently

• Viewed Documents—To select from files you've opened recently

• Favorites—To select from items you've marked as a favorite

• Search Results—Type text into the search box, then press Enter to search for
an item

3. Select the item you want to refer to.

4. Click Insert to add a link to your selection to the message field.

5. Optionally, enter text before or after the reference link.

Chapter 20
How do I edit my profile?

20-3



6. Click Post.

Example 20-1    To reply to a message:

Click  Reply under the message.

Example 20-2    To like a message:

Click  Like under the message.

Tip: To see who has liked a message, click the link that shows the number of people
who have liked it.

Example 20-3    To mark a message as read or unread:

Click the blue dot next to a message to mark it as read.

To mark a message as unread, click  More under the message, then click
Mark as Unread.

Example 20-4    To edit a message:

Click  More under the message, then click Edit.

Notes:

• You can edit only your own messages.

• Any special markup on a message is lost when you edit the message.

Example 20-5    To delete a message:

You can delete only messages you posted.

Click  More under the message, then click Delete.

To restore a deleted message, locate the deleted message icon ( ) where the

message used to be, click , then confirm that you want to restore the message.

Note: Only a service administrator, the person who posted the message, or the person
who deleted the message can restore the deleted message.

How do I show or hide membership messages in a
Conversation?

To show or hide membership messages in your view of a Conversation:

1. Open the Conversation.

2. Click , then select:

• Hide Membership Messages to hide messages like, The Conversation is
now accessible to: John Doe.
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• Show Membership Messages to show these messages in the stream of the
Conversation

Note: To set your default preference for showing or hiding membership messages,
click your user name at the top of Oracle Social Network, click Settings, then, under
Preferences, select the option you want.

How do I mark a Conversation as a favorite?

Next to the Conversation name or message, click .

To view your favorite Conversations, navigate to the list of Conversations (from the
navigation menu on the left, select Conversations), click Show, then click Favorites.

To view all your favorites, including messages, from the navigation menu on the left,
select Favorites.

You can filter or sort your favorites to change your view.

• To filter your favorites by object type (for example, messages, documents, or
groups), select an option from the Show menu.

• To sort your favorites, select options in the Sort by menu: sort by options (Date
Added or Name), and the order you want them sorted in (Ascending or
Descending).

How do I share a document with others?
1. Open the Conversation where you want to share the document.

2. Click the text box to show additional options, then click  and select a
document.

3. Optionally, in the text box add a message to post with the document.

4. Click Upload.

Your document, with any message you added, is posted to the Conversation.

How do I view a file?
There are several ways to view a file:

• To open a preview of the file in Oracle Social Network, click the file's thumbnail.

Notes:

– Document previews are limited to the first 100 pages of a document.

– The list of file types you can preview is long, but there are some file types you
can't preview, like an archive or executable file. Oracle Social Network
supports adding these types of files but not previewing them. For these file
types, you can download the file and open it on your computer.

• To download a file and open it on your computer, click Download under the
document.
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To view a list of all documents and folders in a Conversation, click the Documents
tab.

How do I delete a document?
You can delete documents you posted. Under the document you want to delete, click
More, then select Delete.

Notes:

• Service administrators can delete any document.

• If a document has multiple versions, and you delete the document from the
messages list (rather than from the Documents tab), you delete only the selected
version.

• Deleting a document or document version deletes it for all members of the
Conversation.

How do I view document annotations?
Annotations provide a way to comment on a document. You can view annotations
when previewing the document.

1. Open a preview of the file. For more information, see How do I view a file?

2. Optionally, filter your view of annotations by user. Click the annotations drop-down
list to select All Annotations, No Annotations, or a particular person.

Note: As an outside user, you can't add annotations.

How can I alert people to an important message?
You can assign a flag on the message.

Every message posted to a Conversation or wall shows a flag icon that tells you
instantly whether a flag is assigned on the message. For example:

• If the flag icon is hollow ( ), then no flag is assigned on the message.

• If the flag icon is not hollow ( )—that is, it's a solid color, possibly with
secondary marker on it—then one or more flags are assigned on the message.

There are several types of flags:

•  For Your Information (flag with "i")—Look at this when you have time.

•  Please Reply (flag with black arrow)—Look at this, and let me know
what you think.
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•  Please Reply - Urgent (flag with red arrow)—Look at this now, and let
me know what you think immediately. (An email notification is always sent for
Please Reply - Urgent flags.)

To get more information about a flag, you can either mouse over the flag to see a
tooltip (for example, "For Your Information flag for another from Name.") or click the
flag icon to see all the flag assignments.

To manage flags on an individual message:

1. Click the flag icon next to the message.

2. Assign or clear flags:

• To remove a flag assigned to you, click .

• To quickly assign a For Your Information flag to someone, click the flag next to
the person.

• To assign a particular flag to someone, select the type of flag in the drop-down
list next to the person.

• To quickly flag everyone, click Flag All (in the Not Flagged section), and
select the type of flag you want to assign.

• To quickly remove all flags (whether assigned by you or not), click Clear All
(in the Others Flagged section).

• To remove a particular flag, click  next to the person.

• To search for someone, enter part of the person's name in the search box.

How can I see all flags assigned to me or by me?
To view your flags, from the navigation menu on the left, select Flags

You can filter or sort the flags to change your view.

• To view flags you assigned to yourself or others, click Flags You Assigned. To
return to the flags assigned to you, click Flags for You.

• To filter the flags by type, click Show, then select an option: All, For Your
Information, Please Reply, or Please Reply - Urgent.

• To sort the flags, click the current sort option (Flag Date or Message Date), then
select what you want to sort by and the order you want them sorted in (Ascending
or Descending).

For more information on flags, see How can I alert people to an important message?

What are hashtags (#) and how do I use them?
You can use a hashtag (#) in a message to call out a meaningful term or topic, making
it easy to find all content associated with that term or topic. For example, imagine
discounts is a popular topic in your group, but the discounts can come in the form of
dealer incentives, cash-back deals, seasonal discounts, or any other number of forms.
How do you find what everyone is saying about all those things? You use a hashtag.
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Every time you or your colleagues say something about some form of discount, you
include the hashtag #discounts.

You can then click a #discounts hashtag link to view a list of all messages in otherwise
unrelated Conversations that contain the hashtagged term.

Adding Hashtags

You can add one or more hashtags to any message (comments, replies, and
document messages) simply by typing "#" before a term. When you start typing a
hashtag by typing "#" plus at least one letter, existing hashtags (ones that have been
used before) appear for you to select from.

Tips:

• You can include the following characters in a hashtag: A through Z, a through z, 0
through 9 and _.

• A hashtag can be a maximum of 25 characters (not including the "#").

Viewing Hashtags

Wherever you see them, hashtagged terms are clickable and will open a hashtag page
where all messages that include that hashtag are shown. So clicking #discounts in any
Conversation opens a #discounts page which shows any message that you have
access to that includes the discounts hashtag.

How do I search?
You can do a global search from the search box at the top of the Social panel, or you
can search within a Conversation.

Performing a global search:

1. Enter at least two characters in the search box at the top of the Social panel, then

press Enter or click .

2. Optionally, select a filter from the Show menu to show a particular result type (for
example, Conversations or documents).

3. After filtering by a result type, you see some additional sort and filter options:

• Sort By: Select how to sort your results.

• Posted By: Limit your search to messages or documents posted by a
particular person.

• Posted When: Limit your search to messages or documents posted within a
particular period.

• Updated By: Limit your search to Conversations, collections, hashtags, or
Social Objects updated by a particular user.

• Updated When: Limit your search to Conversations, collections, hashtags, or
Social Objects updated within a particular period.

• Created By: Limit your search to Conversations, collections, groups, or Social
Objects created by a particular user.

• Created When: Limit your search to Conversations, groups, or Social Objects
created within a particular period.
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• Includes Member: Limit your search to Conversations, collections, groups, or
Social Objects with a particular member.

• Favorites Only: Limit your search to only your favorite Conversations,
collections, or Social Objects.

• Include Public: Control whether to show public Conversations, collections, or
Social Objects in your results.

• Include Closed: Control whether to show closed Conversations, collections,
or Social Objects in your results.

• Document Type: If you filter your results to show documents, you can select
which types of documents to show.

• Include Deactivated: Control whether to show deactivated groups in your
results.

If you don't see an option that applies to your selected item type, click  to show
more options.

Click a result to open it.

Example 20-6    Searching within a Conversation:

• To find unread messages, click the unread messages count ( ) in the

toolbar, and use the up and down arrows ( ) to navigate through the
unread messages.

• To find flags assigned to you, click the flag count ( ) in the toolbar, and use

the up and down arrows ( ) to navigate through your flags.

• To find text in the messages or documents, click the search icon in the toolbar,
enter the text you want to search for, then press Enter. The matching text is

highlighted in the messages. Use the up and down arrows ( ) to
navigate through the results.

How do I start a chat with someone?
Other users can start a one-on-one chat with you. You can respond to these
messages the same way you would any other Conversation. If the other person is not
available now, they'll see your message the next time they're active in the social
network.

Note: As an outside user, you can't initiate a chat with another user.
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How do I mute or unmute a Conversation?
If you have items in your object lists that you never look at (for example a
Conversation that doesn't apply to you), or you're seeing updates in your recent
activities or in your email digests about items you don't care about, you can mute
those items. Muting an item hides it and its activity from your view. It's still there; you
just won't hear about it anymore. (The only exception is if you're flagged on a message
in a muted item, for which you will still be alerted by email based on your notification
settings.)

To mute an item:

1. Open the Conversation.

2. Click , then select Mute Conversation.

A banner appears at the top, showing that the Conversation is muted.

To unmute an item:

1. From the navigation menu on the left, select Conversations.

2. Click Show, then select Muted.

3. Click a Conversation to open it.

4. In the banner showing that the item is muted, click Unmute.

If you dismissed the banner, click , then select Unmute Conversation.

How can I view a list of closed Conversations?
A closed Conversation is a Conversation that doesn't allow people to post new
messages or documents to it. By default, your list of Conversations shows only open
Conversations.

To view closed Conversations, navigate to the list of Conversations (from the
navigation menu on the left, select Conversations), click Show, then click Closed.

How do I download an archive of a Conversation?
At some point you might want to download an archive of a Conversation, possibly to
view when you're offline or maybe to keep a record of the Conversation's content at a
certain point.

The archive is in the form of a .zip file (named after the item). It contains the
Conversations's list of members, messages, and replies in an HTML file (named by
default index.html) and all the documents uploaded to the item.

To download an archive of an Conversation:

1. Open the Conversation.

2. Click , then select Download and save the file.

To work with an archive of a Conversation:
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1. Unzip the files to your computer.

2. Open index.html.

Clicking a document link opens the copy of the document that is included in
the .zip file. All other links in index.html (user names, like, reply, and so on) open
the full version of Oracle Social Network in the browser.

Note: You can't make changes to an archive of a Conversation (though you can click a
link to open the Conversation in a browser and make changes there).

How is the social network accessible?
You can use your keyboard to navigate your social network. To see a list of keyboard
shortcuts, make sure focus is in the social network area of your application, and press
the question mark key (?). For more information, see What keyboard shortcuts are
available to the social network?

Tips

• To navigate between list items and messages, use up and down arrow keys.

• To navigate into the elements of a listed item, like a Conversation, press Shift
+Enter.

• To manage flags in the Manage Flags pop-up, press Enter to assign or change a
flag, or press Delete to clear a flag.

• When you press Esc to close a dialog, focus moves to the button used to open the
dialog, even if you used a keyboard shortcut to open the dialog.

Notes:

• The supported screen reader browser is Mozilla Firefox 26 or later with the latest
version of your screen reader software.

• If you use a Mac, by default Tab moves to the next object that isn't a link.
Therefore, to move to the next tappable element, you must use Option+Tab or
change your browser preferences to switch the behavior.

What keyboard shortcuts are available to the social
network?

Your social network offers keyboard shortcuts and support for keyboard navigation. To
see a list of keyboard shortcuts, make sure focus is in the social network area of your
application, and press the question mark key (?).

Note: If you're using a screen reader, the social network keyboard shortcuts work only
if your focus is in application mode (for example, in a list of messages in a
Conversation), so they won't otherwise interfere with your screen reader's keyboard
shortcuts. However, you can use your screen reader's pass-through or bypass
functionality if you want to use the social network keyboard shortcuts outside of
application mode.

Keyboard shortcuts are available for the following types of actions:

• Application—Use these shortcuts anywhere they are relevant in the application.
For example, pressing ESC works when you're in a menu or dialog, and doesn't
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work when you're not; pressing "j" or "k" works in a list, but doesn't work outside a
list.

• Jumping—Use these shortcuts anywhere in the application. They jump you to a
different view or to the current view's navigation actions.

Note: Jumping shortcuts are available only when the navigation menu is in view.
When the navigation menu is not in view, the social network does not respond
when you use jumping shortcuts.

• List Actions—Use these shortcuts with the list item that currently has focus.

• Conversation Actions—Use these shortcuts within Conversations.

Note: Some of these shortcuts work regardless of the current focus, for example,
"t," "b," "o," "u." Some of them operate differently depending on the current focus,
for example, in a Conversation "m" and "v" mark all messages as read and mark/
unmark the Conversation as a favorite; on a message, "m" and "v" mark the
message as read and mark/unmark it as a favorite.

• Message Actions—Use these shortcuts with the message that currently has
focus.

• Post and Reply Entry Actions—Use these shortcuts within the post and reply
entry areas.

You can add one or more hashtags to any message (comments, replies, and
document messages) simply by typing "#" before a term. When you start typing a
hashtag by typing "#" plus at least one letter, existing hashtags (ones that have
been used before) appear for you to select from. Use the up and down arrows to
select an existing hashtag, then press Enter or Tab to use the selected hashtag.
For more information, see What are hashtags (#) and how do I use them?

How do I change my notifications settings, preferences, and
conference settings?

You can configure settings in Oracle Social Network to personalize your experience:

• Notifications let you know when certain events occur in Oracle Social Network, like
when someone flags you, or when someone clears a flag that you have set. You
can set up your notifications to send emails just for the events you're interested in.

• Use preferences to customize your Oracle Social Network experience, like your
interface language and date format.

• You can enter your conference account information so that when you join a
conference you don't have to enter the information each time.

To configure your settings:

1. Click your user name at the top of Oracle Social Network, then click Settings.

2. Use the settings under Notifications to:

• Confirm your email address where notifications will be sent. If it's incorrect,
change it yourself if you can or, if the email address is not editable, inform your
administrator.

• Select which events you want to be notified about.
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Note: You are always notified when a Please Reply - Urgent flag is assigned
to you.

• Select whether you want a daily email summary of all the activity in your
Conversations.

• Set your desired time and date stamp format.

3. Use the settings under Preferences to:

• Change your interface language or date format.

If you change the primary language, all the buttons, labels, and so on are
changed to the language you choose. The things you supply, like messages
and documents, are in the language used when you posted the message or
when the file was created.

• Specify whether to use the Enter key or the Post key to post messages.

• Control whether you see a message every time someone joins or leaves a
Conversation.

• Mark all messages in every Conversations as read, so you don't have to do it
on a Conversation-by-Conversation basis.
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